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About STAAD.Pro

STAAD.Pro is a general purpose structural analysis and design program with
applications primarily in the building industry - commercial buildings, bridges and
highway structures, industrial structures, chemical plant structures, dams, retaining
walls, turbine foundations, culverts and other embedded structures, etc. The program
hence consists of the following facilities to enable this task.

1. Graphical model generation utilities as well as text editor based commands for
creating the mathematical model. Beam and column members are represented using
lines. Walls, slabs and panel type entities are represented using triangular and
quadrilateral finite elements. Solid blocks are represented using brick elements.
These utilities allow the user to create the geometry, assign properties, orient cross
sections as desired, assign materials like steel, concrete, timber, aluminum, specify
supports, apply loads explicitly as well as have the program generate loads, design
parameters etc.

2. Analysis engines for performing linear elastic and pdelta analysis, finite element
analysis, frequency extraction, and dynamic response (spectrum, time history,
steady state, etc.).

3. Design engines for code checking and optimization of steel, aluminum and timber
members. Reinforcement calculations for concrete beams, columns, slabs and shear
walls. Design of shear and moment connections for steel members.

4. Result viewing, result verification and report generation tools for examining
displacement diagrams, bending moment and shear force diagrams, beam, plate and
solid stress contours, etc.

5. Peripheral tools for activities like import and export of data from and to other
widely accepted formats, links with other popular softwares for niche areas like
reinforced and prestressed concrete slab design, footing design, steel connection
design, etc.

6. A library of exposed functions called OpenSTAAD which allows users to access
STAAD.Pro’s internal functions and routines as well as its graphical commands to
tap into STAAD’s database and link input and output data to third-party software
written using languages like C, C++, VB, VBA, FORTRAN, Java, Delphi, etc.
Thus, OpenSTAAD allows users to link in-house or third-party applications with
STAAD.Pro.




About the STAAD.Pro Documentation

The documentation for STAAD.Pro consists of a set of manuals as described below.
These manuals are normally provided only in the electronic format, with perhaps some
exceptions such as the Getting Started Manual which may be supplied as a printed book
to first time and new-version buyers.

All the manuals can be accessed from the Help facilities of STAAD.Pro. Users who
wish to obtain a printed copy of the books may contact Research Engineers. REI also
supplies the manuals in the PDF format at no cost for those who wish to print them on
their own. See the back cover of this book for addresses and phone numbers.

Getting Started and Tutorials : This manual contains information on the contents of
the STAAD.Pro package, computer system requirements, installation process, copy
protection issues and a description on how to run the programs in the package.
Tutorials that provide detailed and step-by-step explanation on using the programs are
also provided.

Examples Manual

This book offers examples of various problems that can be solved using the STAAD
engine. The examples represent various structural analyses and design problems
commonly encountered by structural engineers.

Graphical Environment

This document contains a detailed description of the Graphical User Interface (GUI) of
STAAD.Pro. The topics covered include model generation, structural analysis and
design, result verification, and report generation.

Technical Reference Manual

This manual deals with the theory behind the engineering calculations made by the
STAAD engine. It also includes an explanation of the commands available in the
STAAD command file.

International Design Codes
This document contains information on the various Concrete, Steel, and Aluminum

design codes, of several countries, that are implemented in STAAD.

The documentation for the STAAD.Pro Extension component(s) is available separately.
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1. Introduction

STAAD.Pro is an analysis and design software package for
structural engineering. This manual is intended to guide users who
are new to this software as well as experienced users who want
specific information on the basics of using the program.

Part-1 of this manual describes the following:

e Hardware Requirements

e Contents of the STAAD.Pro CD
e Installation

e Copy Protection Device

e Running STAAD.Pro

Part Il of this manual contains tutorials on using STAAD.Pro. The
tutorials guide a user through the processes of:

e Creating a structural model. This consists of generating
the structural geometry, specifying member properties,
material constants, loads, analysis and design
specifications, etc.

e Visualization and verification of the model geometry

e Running the STAAD analysis engine to perform analysis
and design

e Verification of results - graphically and numerically

e Report generation and printing

e Inter-operability. In other words, using STAAD.Pro in
conjunction with other programs created by REI, such as
STAAD..etc.
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2. Hardware Requirements

The following requirements are suggested minimums. Systems
with increased capacity provide enhanced performance.

e PC with Intel-Pentium or equivalent.

e Graphics card and monitor with 1024x768 resolution, 256
color display (16 bit high color recommended).

e 128 MB RAM or higher.

e Windows NT 4.0 or higher operating system. Windows 95,
Windows 98 & Windows Me are no longer supported. The
program works best on Windows 2000 and XP operating
systems.

e Sufficient free space on the hard disk to hold the program and
data files. The disk space requirement will vary depending on
the modules you are installing. A typical minimum is 500MB
free space.

e A multi-media ready system with sound card and speakers is
needed to run the tutorial movies and slide shows.

Note: Additional RAM, disk space, and video memory will
enhance the performance of STAAD.Pro.

Starting with STAAD.Pro Version 2001, the size of structures that
the program can handle has been increased significantly. As a
result of this, the minimum amount of physical + virtual memory
required by the program also has increased to over 600MB. Users
may need to ensure that adequate amounts of virtual memory are
available, and in Windows NT and 2000 systems, parameters such
as paging file sizes should be large enough or span over multiple
drives if the free space on any one drive runs low.

Another issue to keep in mind is the location of the “TEMP”
parameter as in the “SET TEMP” environment variable in
Windows NT and 2000 systems. While performing calculations,
depending on the structure size, the program may create gigantic
scratch files which are placed in the folder location associated with
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the “TEMP” parameter. Users may wish to point the “SET TEMP”
variable to a folder on a drive that has disk space sufficiently large
to accommodate the requirements for large size structures.

Note: The user must have a basic familiarity with Microsoft
Windows systems in order to use the software.
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3. Contents of the STAAD.Pro CD

Typically, a startup screen appears when the CD is placed in the
drive. If it does not, you may initiate it by running SPROCD.EXE
located at the root folder of the CD (This can be done by clicking
on the file named SPROCD.EXE from Windows Explorer). The
SPROCD Title screen appears as shown in Figure 1.

@ Install STAAD Structural Suite
STAAD Pro, STAAD stt, Sectionizard and STALD foundation

@ View STAAD.Pro Manuals

@ Install STAAD.beam

@EXT Research Engineers International
a Bentley Solutions Center

Figure 1: The SPROCD Title Screen

The choices offered by the Title screen are described below:

Install STAAD Structural Suite

This is the installation module containing the programs
STAAD.Pro Version 2006, STAAD.etc, Sectionwizard and
STAAD.foundation. STAAD.etc is a program that enables design of
structural components such as base plates, bolt groups, cantilever
retaining walls, rectangular footings, etc. Sectionwizard is a
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program for calculating properties such as area, moments of
inertia, section modulii, torsional constants, etc., of various cross
sections. STAAD.foundation is a program for designing reinforced
concrete pile caps and pile groups, mat foundations, individual
footings, etc. In order to use STAAD.etc, Sectionwizard and
STAAD.foundation to their full capability, users must have
purchased them as additional items of software. In the absence of a
valid license to use them, those modules will work only in a
demonstration mode.

The installation procedure is explained in detail in the next
section.

View STAAD.Pro Manuals

This takes the user to another screen which displays links to
various STAAD.Pro manuals.

Note: STAAD.beam is not a part of the STAAD.Pro family of products.
You need to purchase it separately.

Install STAAD.beam

STAAD.beam is a utility type of program for designing simple steel
beams. Its usefulness lies in its ease of use, and its ability to create
reports of the detailed calculations that goes into the design of
members per standard codes like AISC ASD and AISC LRFD.

Exit
Exits the SPROCD program.

All online documentation that comes with the program is created in
HTML format. These may be accessed using any Internet browser
such as Microsoft’s Internet Explorer or Netscape Navigator.

A set of multi-media movies which demonstrate the procedure for
using STAAD.Pro are accessible after installing the program. They
can be accessed from the Help menu of the main screen of the
program. These too can be viewed using a web browser.
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4. |nstallation

If you receive a document titled Installation Notes, it will
supercede all other related instructions.

Close all applications before installing STAAD.Pro. Typically, a
startup screen appears when the CD is placed in the drive. If it
does not, you may initiate it by running SPROCD.EXE located at
the root folder of the CD (This can be done by clicking on the file
named SPROCD.EXE from Windows Explorer). For an
explanation of the different facilities offered by the SPROCD
program, please refer to the previous section.

Note: In Windows NT, Windows 2000, and Windows XP systems,
you have to log in with administrative rights before commencing
installation.

To commence installation, select the option named Install STAAD
Structural Suite. Standard installation procedure available with any
software running on Microsoft Windows is followed and hence is
self-explanatory.
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Users installing the commercial version of the program will
encounter the following screen.

InstallShield Wizard

your name, the name of the compary for which you work and the product senial

Compary Name:

'v'our Compary Name:

' r
InstallShield [ <Back || Net> | I

Figure 2: Customer Information & Serial Number

If an older version of STAAD.Pro has already been installed in the
machine, the serial number information will show up automatically
in this dialog box. If STAAD.Pro is being installed for the first
time in the machine, the Serial number box will be blank. In that
case, enter the serial number provided in the CD case.

If you are under Bentley Select Contract, you will be asked to
confirm that you will be using a Bentley SELECT License by
checking the box titled ‘I am under Bentley Select Contract’. This
will provide the serial number that is required for this method of
security only.
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When this box is checked, the following confirmation message box
will be displayed.

ouestion =
‘:/- ARE YOU SURE THAT ¥OU ARE UNDER "BENTLEY SELECT COMTRACT"?
-
~d

(PLEASE VERIFY YOUR CONTRACT. IF YOU DO NOT HAYE A "BEMTLEY SELECT CONTRACT", ¥OU SHOULD USE THE
SERIAL MUMBER THAT HAS BEEM PROVIDED IM THE CD CASE (YOUR EXISTING SERIAL NUMBER). IF YOU ARE
PLAMNING TO USE LEGACY HARDWARE LOCK OR NETWORK/CORPORATE LICENSE PROVIDED BY REI, IT IS VERY
IMPORTAMNT THAT ¥OU ENTER YOUR SERIAL MUMBER CORRECTLY.)

Figure 2a: Customer Information

One of the initial screens you will encounter is the one shown in
Figure 3. It pertains to the type of software security system that
you purchased with STAAD.Pro. SELECT XM system refers to
Bentley’s SELECT Server based licensing system .A Local
Security generally refers to a hardware lock, which is an adapter-
like device that is placed on the parallel or USB port of your
computer. It could also be a software based system (instead of a
hardlock), in which case, it will be a software license which binds
STAAD.Pro to the specific computer you are installing it on.
Network Security refers to a system that supports simultaneous
multiple-user access. A separate instruction document containing
the steps for network installations is provided to users who

have opted for this latter type. Please refer to the file
"Quickstart.pdf" located in the CD for further description of these
systems.
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| [T Cancel

[<Back |

InstallShield

Figure 3: Selection of security system type

If you have purchased SELECT XM license for the products,
please refer to Quick Start & Troubleshooting Guide to understand
how to install and configure SELECT XM licenses. If you do not
have SELECT XM license information, you can still choose the
“SELECT XM License” option during installation. The program
will run in Trial Mode for 15 days. You should complete the
SELECT XM License configuration within that period.

9
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If you choose Local Security, you are asked to select the type of
hardware lock supplied to you, or the software license if that is
applicable. The name of the lock is engraved on the cover of the
lock. Make sure the type of lock you choose from Figure 4 matches
that name. This is absolutely necessary to ensure that the program
functions to its full capacity.

Please note that if you do not have a license for STAAD.etc,
Sectionwizard and/or STAAD.foundation, they will work only in
the Demonstration mode.

STAAD.Pro 2006 - Installshield Wizard

Select the lock type

STAAD.Pro

5 Loch Nu, SUDM6L - |

FEpEEHmOoOW

‘ I Cancel

InstallShield

Figure 4: Selection of Local Security type
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You may install the program in any folder of your choice. A
default folder name is supplied to you.

STAAD.Pro 2006 - InstallShield Wizard

Choose Destination Location

InstallShicld < Back (Hewts Cancel

Figure 5: Selection of the Installation Folder
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The next dialog box seeks confirmation from you as to whether
you wish to install all the programs shown in the list. Advanced
Mesher is a standalone program for generating finite element
meshes for panel type entities like walls and slabs and is available
for those who want advanced meshing facilities besides those
which are built into the STAAD.Pro software. OpenSTAAD is a
library of functions which enables users to access input and output
data from their STAAD.Pro projects for extraction into their own
applications. While Advanced Mesher and OpenSTAAD are free
utilities supplied along with STAAD.Pro, the remainder of the
programs in the list require your copy-protection device/system to
support those. If you do not wish to have any specific item(s)
installed, uncheck the associated box.

STAAD.Pro 2006 - InstallShield Wizard E3

Select Features
5 fea

L do not want to install

[
etwark. Client
[.Pra Add On Programs

STAAD etc
STAsD etc 4.0 [US)
STAsD etc 5.0 (UK, India)

STAAD foundation 3.5
Section Wizard

InstallShield I < Back “ Mext > ‘ . Cancel

Figure 6: Selection of programs to install
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You also have to choose a default unit system. This is to ensure
that the length and force units frequently used by you will be
available upon entry into the program each time. This is known as
the base unit system, and mainly affects the units in which results
are displayed, as well as default values for certain quantities.
Please refer to one of the tutorials for additional information on
these. Of course, it is always possible for you to change the base
unit system within the program, at run-time, as frequently as you
please.

STAAD.Pro 2006 - InstallShield Wizard

Select Unit Spstem

InstallShield < Back Mest > Cancel

Figure 7: Selection of Default Unit System for STAAD.Pro
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Towards the end of the installation process, a message resembling
the one shown in Figure 8 will appear. It is pertinent only to users
who have received this program as an upgrade from earlier
versions of STAAD.Pro, and are already using a security device
with those versions. For those users, their hardware lock also
needs to be upgraded to enable it to work with STAAD.Pro 2006.
That process is done electronically - called re-programming the
lock - and there is no need to physically replace the lock (in most
of the cases).

STAAD.Pro 2006 - InstallShield Wizard x|

& If wou are upgrading From an older version of 3TAAD.Pro, such as 2005, 2004 or 2003,
\!J) wour hardware lock needs to be electronically updated to enable it toowork
with STAAD.Pro 2006 .

IF vour compuker is connected to the Internet, this process will be automatically
initiated when wou first skark STAAD.Pro 2006,

IF our computer is NOT connected ko the Internet, please follow the procedure
explained in the "hardlockGuide. pdf* file which is located inside your CD jacket
cover or Found in xsproz00aihardiock Folder where Y is the drive and

where vou installed STAAD,Pro 2006,

IF wou need assistance, please contact REL by phone or by email {license@reiusa, con).

If wou are a new user or you have a new or updated lock For STAAD,Pro 20086,
please disregard this message.

Figure 8: Information regarding upgrade of lock

After the installation is complete, please restart your machine for
the changes to take effect.
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5. Copy Protection Device

As explained in the previous section, a copy protection device in
the form of a Select XM License, a hardware lock, or a software
license, is required to run STAAD.Pro, STAAD.etc,
STAAD.foundation and Sectionwizard.

If you are using a hardware lock, it must be inserted in the parallel
port of your computer and must remain there during the entire
duration that you are in one of the programs. If any other device,
such as printer cable, hardware lock for other software, etc., is
attached to the parallel port, we recommend that you attach the
STAAD.Pro / STAAD.etc hardware lock in front of such devices.
In case you have multiple locks, and cannot stack them for any
reason, REI can replace your parallel port type with a USB type of
lock.

The hardware lock is configured for the programs and modules that
you have purchased. If you install one of the programs or modules
that is not supported by the hardware lock, that component may
not be accessible, or will be operable only as a Demonstration
version.

The hardware lock driver(s) are automatically installed during the
installation process. For computers running on Windows NT,
Windows 2000, or Windows XP, you must have administrative
rights before installing the program to enable proper installation of
the hardware lock driver files.

As can be seen from the tutorials in the later sections of
this book, STAAD.Pro consists of various modules, each
designed to perform a certain type of task in the model
generation, analysis and result verification process.
Version 2006 requires the hardlock to be in place during
the entire time that any and all of these tasks are being
performed.
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In other words, from the moment you start the program
till the moment you exit it, the lock has to be in place. If
the lock is detached at any time in between, the program
will stop running, and request that you re-attach the lock.
In the event that you are unable to, it will provide the
opportunity to save the work and exit the program. To
resume your work, you will have to put the lock back in
the port and re-start the program.

Another important aspect to note is that if you are
upgrading from an earlier version of STAAD.Pro such as
2000, 2001 or 2002, one of the following is applicable with
regards to the lock:

a. The upgrade package should contain a new lock
which replaces your old lock.

b. The upgrade package should contain information
outlining how you can re-program your earlier lock
so that it becomes compatible with STAAD.Pro
2006.
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6. Running STAAD.Pro

Click on the STAAD.Pro icon from the STAAD.Pro 2006 program
group.

— e g s v
‘ _ I/ muves Technologies »
¥ e @ Oriine Services » STAAD.etc
@ Notepad PrintMe Internet Printing » T STAAD.foundation

QuickTime N STAAD.Pro 2005 Learning Resources
E Micrasaft Word @ sonic 4 2 Mesher

Startup N @ OpenSTAAD Reference Documentation
i STAAD.Pro 2005 Zone.com Deluxe Games 5 ¥ REI Application Assistant

[Z] Revison History

Adobe Reader 8.0

@, Adobe Acrobat 6.0 B rtemetExplorer ¥ srasDPro

@ Microsoft Photo Editg Bousohfes e 59“’”95.
Microsaft Excel |'_§Q STAAD.Pro Online Documentation

Microsoft Excel @) Microsoft Money 2005

. @] Microsoft Office PowerPoint Viewer 2003

Lﬁ Caleuiator Microsoft Outlock
Microsoft PowerPoint

Alprograms |7 Microsoft Word

Microsoft Works Task Launcher

LABE

MSH
@ Qutlook Express

Figure 9: Starting STAAD.Pro
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The STAAD.Pro main screen appears as shown in below.

=lslx|

Fie Help
DEe DR o AN |[|[FRRmesn @b |[DLMcas gz KA |[PERR||n | 3| v

| e ) A e e e = 0 — | |
LH VW R ST @@ || GRS S P RS b

Lexalin

[Chieart. m

SPACL truchae. whechis & Sise-denantionsl iamed suchas vt ads socked in
ey plore. i By ered gerseril.

PR o | [ ond e
& Fool © Mol * KhePourd  © Decabiewen
© Milmete Kot T Ko Edibiewton
" Centmeter

¥ Diinpay thes chaog bow: ot e Shamup
|

Figure 10: The STAAD.Pro screen

If you are a first time user who is unfamiliar with STAAD.Pro, we
suggest that you go through the tutorials shown in Section Il of
this manual.
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To launch the STAAD.etc program, click on the STAAD.etc icon.

i STAAD.Pro 2005

D
@ FullShot 6.0

All Programs

7 start

@, Adobe Acrobat 6.0
@ Microsoft Photo Edi

Qi

— —_—
% _ @) muvee Technologies
W Paint

) Online Services

[E) PrintMe Internet Printing
@ Quicktime

@ sonic

[ startup

[F Zone.com Deluxe Games
[ Adobe Reader 6.0

@ ntemnet Explorer
Microsoft Access
Vicrosoft Excel

@ Wicrosoft Money 2005
[# micresoft Office PowerPoint Viewer 2003
Microsoft Outiook.

Vicrosoft PowerPoint
Vicrosoft Word

B Microsoft Works Task Launcher
w msn

Bl 5) Outiook Express

b

fi STAAD.Pro 2006 »

I Section Wizard »
M@ STAAD.etc v | (B sTAAD.etc
I 5TAAD.foundation 3
IF) STAAD.Pro 2005 Learning Resources b
&5 Mesher

[ OpenSTAAD Reference Documentation

F® RET Application Assistant

[Z] Revison History

¥ sTasDFro

€38 STAAD.Pro Language Settings
[ STAAD.Pro Oniine Documentation

Figure 11: Starting STAAD.etc

For help on using this program, we suggest that you go through the
STAAD.etc Documentation accessible by clicking on its icon
shown in the above figure.
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8. Running Sectionwizard

To launch Sectionwizard, choose one of the programs from the

Sectionwizard menu.

E Microsoft Word
i STAAD Pro 2005
@- Adobe Acrobat 6.0 5
@ Microsoft Phato Eitg
@ Microsoft Excel

@ Fulshot 6.0

Allprograms B

—_—
I muvee Technologies

I Online Services

I@ Printie Interet Printing

@ Quickme

I sonic

i@ startup

I Zone.com Deluxe Games

[ Adobe Reader 6.0

@ Internet Explorer

Microsoft Access

Microsoft Excel

@ Microsoft Money 2005

[& Microsoft Office PowerPoint Viewer 2003
Microsoft Outiook

Microsoft PowerPoint

Microsoft Word

&) Mrosoft Works Task Launcher
A MsN

. =

iy start £l [5) outiook Express

fii STAAD.Pro 2006

fi Section Wizard
IF) SsTAAD.etc
I STAAD.foundation

I STAAD.Pro 2005 Leaming Resources
& Mesher

[ OpenSTAAD Reference Documentation
¥ REI Application Assistant

[E] Revison History

¥ stasnpro

€9 STAD Pro Language Settings
[& STAAD.Pro Cniine Documentation

fM Equivalent Section
I Freesketch
X Section Builder

@) Sectionwizard Help

Figure 12: Starting Sectionwizard

For help on using this program, please go through Sectionwizard

Help shown in the above figure.
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9. Running STAAD.foundation

To launch STAAD.foundation, click on the STAAD.foundation

i swee
i STAAD Pro 2005 ) Zone.com Dahuve Games

e = =
s STAAD Fro 2006
w o T muves Technobges »
i) Crine Serders. .
B Notepad (&) Prinsie Intemet Printing » ’ I? STAAD. foundation
G Y . m STAAD Pra 20051 Resources * J" STAAD. foundation Doaumentabion
QuickTime £aming
sornaoft Ward @ sonk v & Mesher ) STAAD. frumdation Tutnrinis
N [ CuenSTAAD Reference Docusentation
»

T REl Appication Assistant
[F] mevison pstary

[ Adobe Resder 6.0
E Adobe Acrobt 6.0 & nernet Explacer ¥ stasoen
[ BB 5TA80.Pro Langusge Settngs
Kerossft Phatn Edeg S— [ 5TAAD.Pre Online Dosumentation
%] Muusaft B

MooseltEne | @ Mossoftboney 205

] Merasaft Office Powerant Viewer 2003

@ fullshot 5.0 B Morosaf outook
Marosoft PowerPoint

Al Fropacs b Marasaft Ward

8 Morosaft Werks Tark Launcher
N s
74 start LS () cutiook Express

Figure 13: Starting STAAD.foundation

For help on using this program, please go through the
STAAD.foundation Documentation shown in the above figure.
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10.

Running Mesher

To launch Mesher, click on the Mesher icon.

— — e

‘\l ~an [ muvee Technologies
Cnline Services

@ Notepad PrintMe Internet Printing
QuickTime

E Microsoft Word Sonic
@ startup

i STAAD Pro 2005 I Zone.com Deluxe Games
lir Adobe Reader 6.0

Adobe Acrobat 6.0
ﬁ 058 Aerene & Internet Explorer
Mid ft A

@ Microsoft Photo Edit ferosoft Access
Microsoft Excel

Microsoft Excel @ Microsoft Money 2005

@5 Microsoft Office PowerPoint Viewer 2003
@ Fullshot 6.0 Microsoft Qutinok
Microsoft PowerPoint
LTS | Microsoft Word

Microsoft Works Task Launcher
MSN
[3) Outiook Express

<5 E

NI fii sTAAD.Pro 2006 » I IF) Section Wizard

STAAD.etc
STAAD. foundation
STAAD.Pro 2005 Learning Resources

[ OpenSTAAD Reference Documentation
B2 REI Application Assistant
[Z] Revison History
® staanrro
STAAD.Pro Language Settings
Eg STAAD.Pro Online Documentation
=

Figure 14: Starting Mesher

Information on using this program is available from the Help

menus of the program.
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Introduction

STAAD.Pro is a general purpose program for performing the
analysis and design of a wide variety of types of structures. The
basic three activities which are to be carried out to achieve that
goal - a) model generation b) the calculations to obtain the
analytical results c) result verification - are all facilitated by tools
contained in the program's graphical environment. This manual
contains four sample tutorials which guide the user through those 3
activities.

The first of those tutorials demonstrates these processes using a
simple two-dimensional steel portal frame. It is a good starting
point for learning the program. If you are unfamiliar with
STAAD.Pro, you will greatly benefit by going through this tutorial
first.

For the second tutorial, we have chosen a reinforced concrete
frame. We generate the model, perform the analysis, and design the
concrete beams and columns. It contains extensive details on the
various facilities available for visualization and verification of
results.

The modelling and analysis of a slab is demonstrated in the third
tutorial. Slabs, and other surface entities like walls are modelled
using plate elements. Large surface entities may have to be defined
using several elements and this sometimes requires a tool called a
mesh generator. This tutorial shows the simple techniques as well
as the mesh generation method for generating the finite element
model of the slab. It also explains the methods by which one can
check the results for plate elements.

A tutorial which demonstrates the inter-operability features
between STAAD.Pro and STAAD.etc. is presented in the fourth
tutorial. STAAD.etc is a set of modules which can be used to
perform component designs such as for a rectangular footing, base
plate, cantilever retaining wall, moment connection, bolt group,



etc. Users who have purchased STAAD.etc in addition to
STAAD.Pro may go through this tutorial to familiarize themselves
with the process of utilizing STAAD.etc to perform secondary
analysis and design tasks on a structure for which the primary
analysis and design is done using STAAD.Pro.
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Tutorial Problem 1: 2D Portal Frame

Section 1

This chapter provides a step-by-step tutorial for creating a 2D
portal frame using STAAD.Pro. This tutorial covers the following
topics.

e Starting the Program

e Creating a New Structure

e Creating Joints and Members

e Switching On Node and Beam Labels

e Specifying Member Properties

e Specifying Material Constants

e Specifying Member Offsets

e Printing Member Information

e Specifying Supports

e Specifying Loads

e Specifying the Analysis Type

e Specifying Post-Analysis Print Commands
e Specifying Steel Design Parameters

e Performing Analysis and Design

e Viewing the Output File

o Verifying results on screen — both graphically and numerically
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1.1 Methods of creating the model

There are two methods of creating the structure data:

a. using the command file
b. using the graphical model generation mode, or graphical
user interface (GUI) as it is usually referred to.

The Command File is a text file which contains the data for the
structure being modeled. This file consists of simple English-
language like commands. This command file may be created
directly using the editor built into the program, or for that matter,
any editor which saves data in text form, such as Notepad or
WordPad available in Microsoft Windows.

This command file is also automatically created behind the scenes
when the structure is generated using the Graphical User Interface.
The graphical model generation mode and the command file are
seamlessly integrated. So, at any time, you may temporarily exit
the graphical model generation mode and access the command file.
You will find that it reflects all data entered through the graphical
model generation mode. Further, when you make changes to the
command file and save it, the GUI immediately reflects the changes
made to the structure through the command file.

Both methods of creating our model are explained in this tutorial.
Section 1.3 through 1.6 explain the procedure for creating the file
using the GUI. Section 1.7 describes creation of the command file
using the STAAD.Pro text editor.
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1.2 Description of the tutorial problem

The structure for this project is a single bay, single story steel

portal frame that will be analyzed and designed. The figure below
shows the structure.

2.5 KIP/FT

ke gy gV ITIIITITINNNITNT NG

wiax34 (2

W12 x 35 W12 x 35 15'-0"

® ®

77,

200-0" ——— =
Figure 1.1

An input file called "Tut-01-portal.std” containing the input data
for the above structure has been provided with the program. This
file contains what would otherwise have resulted had we followed
the procedure explained in Section 1.7.
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BASIC DATA FOR THE STRUCTURE

ATTRIBUTE

DATA

Member properties

Members 1 & 3 : W12X35

Member 2 : W14X34

Material Constants

Modulus of Elasticity : 29000 ksi

Poisson's Ratio : 0.30

Member Offsets

6.0 inches along global X for member 2 at both ends

Supports Node 1 : Fixed
Node 4 : Pinned
Loads Load case 1 : Dead + Live

Beam 2 : 2.5 Kkips/ft downward along global Y

Load case 2 : Wind From Left
10 Kips point force at Node 2

Load case 3 : 75 Percent of (DL+LL+WL)
Load Combination - L1 X 0.75 + L2 X 0.75

Analysis Type

Linear Elastic (PERFORM)

Steel Design

Consider load cases 1 and 3 only.

Parameters: Unsupported length of compression
flange for bending : 10 ft for members 2 and 3, 15 ft
for member 1.

Steel Yield Stress : 40 ksi

Perform member selection for members 2 and 3
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1.3 Starting the program

Select the STAAD.Pro icon from the STAAD.Pro 2006 program
group.

—_— e T - - .
g 3

Y Oniine Services b [ sTAAD.etc
[ STAAD.foundation 3

PrintiMe Internet Printing 3

T N [ STAAD.Pro 2005 Leaming Resources #

. 8 &8 Mesher
[ OpenSTAAD Reference Documentation

8] e
i STAAD.Pro 2005

Startup 3

858808 606¢C

Zone.com Deluxe Games v ¥® REI Application Assistant

(] Revison History

Il Adobe Reader 6.0

@ Adobe Acrobat 6.0 B intemst Exlorer % staapPro I
[ €3 STAAD.Pro Language Settings

@ Ll 5 RE— [ STAAD.Pro Online Documentation

E Micrasoft Excel @ Microsoft Money 2005
@] Microsoft Office PowerPoint Viewer 2003

Calaulator

&)

5| Microsoft Outiook

Microsoft PowerPoint
All Programs B

Microsoft Word
Microsoft Works Task Launcher
MsN

(€) Outlook Express

Figure 1.2
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The STAAD.Pro Graphical Environment will be invoked and the
following screen comes up.

el
Fle Help
BEaEbieXicikiin? [Brrsadd|Dracanepr KA ||[Baes||n-Fam| v
|[emesscasctssew||Eleaaaamansaec” |

AXEESLFEAREESTOR [ du@A||put 2 r 85 FaWs [ =|m

[a@WHHEF||+ &80 " SREK T

7 Diplay Bus ko b o B Sty
ik | Metr | Cewd | W |

& 1 & &

Figure 1. 3

This New dialog box will come up every time we start the program.
To turn this feature off, simply uncheck the Display this dialog box
at the Startup box at the lower left hand corner. This feature can be
turned on again at a later time when File | New is invoked from the
main menu.
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Note about the unit system :

There are two base unit systems in the program which control the
units (length, force, temperature, etc.) in which, values,
specifically results and other information presented in the tables
and reports, are displayed in. The base unit system also dictates
what type of default values the program will use when attributes
such as Modulus of Elasticity, Density, etc., are assigned based on
material types — Steel, Concrete, Aluminum — selected from the
program’s library (Please refer to Section 5 of the STAAD.Pro
Technical Reference Manual for details). These two unit systems
are English (Foot, Pound, etc.) and Metric (KN, Meter, etc.).

If you recall, one of the choices made at the time of installing
STAAD.Pro is this base unit system setting. That choice will serve
as the default until we specifically change it.

The place from where we can change this setting is under the File |
Configure menu. To get to that option, first close down the dialog
box shown in the earlier figure by clicking on Cancel. Then, click
on the File | Configure menu option (see figure below) and choose
the appropriate unit system you want. For this tutorial, let us
choose the English units (Kip, Feet, etc.).

50 Help
2 new Cirl+N
= Cpen... Ctrl+0
Open Archive...
COpen Backup Manager

Import...

Create Archive. ..

Extract Archive...
Recent STAAD Files 4
Recent STAAD Archives ’

Exit

Figure 1.4
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Configure Program

| STAAD Default Design Codes || Global Axds Orientation || Working Directony |
Input/Output File Format || Emor File Format || File Options |
Base Unit | Background Color || Section Profile Table || Analysis Engine |

Cument Default Base English
Select Base Unit:

|

Accept H Cancel H Apply Help

Figure 1.5

Click on the Accept button to close the above dialog box.
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Following this, select File | New once again.

3= Help

2) = Cirl+N

& Open... Cirl+0
Open Archive...

Open Backup Manager
Import...

Create Archive...

Extract Archive...
Configure...
Recent STAAD Files L4
Recent STAAD Archives L4
Exit

Figure 1.6

The dialog box shown in Figure 1.3 will re-appear.
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1.4 Creating a new structure

1.

In the New dialog box, we provide some crucial initial data
necessary for building the model.

The structure type is to be defined by choosing from among Space,
Plane, Floor and Truss. A Space type is one where the structure,
the loading or both, cause the structure to deform in all 3 global
axes (X, Y and Z). In a Plane type, the geometry, loading and
deformation are restricted to the global X-Y plane only. A Floor
type is a structure whose geometry is confined to the X-Z plane. A
Truss type of structure carries loading by pure axial action. Truss
members are deemed incapable of carrying shear, bending and
torsion. For our model, let us choose Plane.

We choose Foot as the length unit and Kilo Pound as the force
unit in which we will start to build the model. The units can be
changed later if necessary, at any stage of the model creation.

We also need to provide a name in the File Name edit box. This is
the name under which the structure data will be saved on the
computer hard disk. The name “Structure?” (? will be a number) is
recommended by the program by default, but we can change it to
any name we want. Let us choose the name PORTAL.

A default path name - the location on the computer drive where the
file will be saved — is provided by the program under Location. If
you wish to save the file in a different location, type in the name,

or click the E‘ button and specify the desired path.

After specifying the above input, click on the Next button.
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< Back I MHeut » RJ Cancel Help

Figure 1.7

In the next dialog box, we choose the tools to be used to initially
construct the model. Add Beam, Add Plate or Add Solid are,
respectively, the starting points for constructing beams, plates or
solids. Open Structure Wizard provides access to a library of
structural templates which the program comes equipped with.
Those template models can be extracted and modified
parametrically to arrive at our model geometry or some of its parts.
If the model is to be created initially using the STAAD command
language, the Open STAAD Editor box can take us to the STAAD
editor. Please remember that all these options are also available
from the menus and dialog boxes of the GUI, even after we dismiss
this dialog box.

Note: If you wish to use the Editor to create the model, choose
Open STAAD Editor, click Finish, and proceed to Section 1.7.
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For our model, let us check the Add Beam option. Click on the
Finish button. The dialog box will be dismissed and the
STAAD.Pro graphical environment will be displayed.

Where do you want to go 7

[ 4dd Flate

O 4dd Salid

[ Open Structure Wizard
[0 Open STAAD Editar
[ Edit Job Infarmation

<1 I

Begin building pour model by creating new joints and beams uzing the construction grid,
drawitg tools and spreadshests.

¥ Dizplay thiz dialog box at the Startup

< Back I Firizh IZI Cancel Help

Figure 1.8
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1.5 Creating the model using the graphical user
interface

In order to generate the model graphically, we have to familiarize
ourselves with the components of the STAAD.Pro screen. A sample
of the STAAD.Pro screen is shown in Figure 1.9.

The screen has five major elements as described below:

Menu bar
Located at the top of the screen, the Menu bar gives access to all
the facilities of STAAD.Pro.

Toolbar
The dockable Toolbar gives access to the most frequently used
commands. You may also create your own customized toolbar.

Main Window
This is the largest area at the center of the screen, where the model
drawings and results are displayed in pictorial form.

Page Control

The Page Control is a set of tabs that appear on the left-most part
of the screen. Each tab on the Page Control allows you to perform
specific tasks. The organization of the Pages, from top to bottom,
represents the logical sequence of operations, such as, definition of
beams, specification of member properties, loading, and so on.

Each tab has a name and an icon for easy identification. The name
on the tabs may or may not appear depending on your screen
resolution and the size of the STAAD.Pro window. However, the
icons on the Page Control tabs always appear.

The Pages in the Page Control area depend on the Mode of
operation. The Mode of operation may be set from the Mode menu
from the Menu bar.



6 'T 24nb14

U] S ) WO WO 900 J03 S LPe0T  Sp0p Bupo K| [ELR L F]

N

Uz 0y L 0¥

|

E L

pisasiiry
|| srecal wmg =
| ____|*=A

paadddy  Soey]  ssahay ]

_ any WEL:  EEeEy
WL ZO0Tw0 ) ]
ey

QISEQINWAD - uousgy

MOpULN

g
=

p T | uBmeg Mt
1M AW

5

Elements of the STAAD.Pro Screen

BALY BIB(]

L]
e———
I

T
I
- |

B

~ B33

. | Apscsn g | s
Ey{'

Tonuo
ageg

2=

ﬂ‘lﬂBtI

IV ||| ¥y M XA T REY 0

Eaf:

Joaee m@ Lt REBE Ty s

s wiunmenrEn [P BI D beeEwe B e bbb 4P PAOEEE

UFYUemMUS|| oD, cima
R MpaE, pop solmng spusuan  damen

LI

T T L I T

Jed [oo]

(1L BlGAYRT - 25 OWVLS

1-14 | Tutorial 1




Tutorial 1
Data Area
The right side of the screen is called the Data Area, where
different dialog boxes, tables, list boxes, etc. appear depending on
the type of operation you are performing. For example, when you
select the Geometry | Beam Page, the Data Area contains the Node-
Coordinate table and the Member-incidence table. When you are in
the Load Page, the contents of the Data Area changes to display the
currently assigned Load cases and the icons for different types of
loads.

The icons in the toolbar as well as in the Page Control area offer
ToolTip help. As we move the mouse pointer over a button, the
name of the button — called a ToolTip — appears above or below the
button. This floating Tool tip help will identify the icon. A brief
description of the icon also appears in the status bar.

We are now ready to start building the model geometry. The steps
and, wherever possible, the corresponding STAAD.Pro commands
(the instructions which get written in the STAAD input file) are
described in the following sections.

1-15
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1.5.1 Generating the model geometry

The structure geometry consists of joint numbers, their
coordinates, member numbers, the member connectivity
information, plate element numbers, etc. From the standpoint of the
STAAD command file, the commands to be generated for the
structure shown in section 1.2 are :

JOINT COORDINATES
10.0.;20.15.;3 20. 15.;4 20. 0.
MEMBER INCIDENCE

112;223;,334

Steps:

1.  We selected the Add Beam option earlier to facilitate adding beams
to create the structure. This initiates a grid in the main drawing
area as shown below. The directions of the global axes (X,Y,Z) are
represented in the icon in the lower left hand corner of the drawing

area.
STAAD.Pro - PORTAL st srzap06 640,550 TN C)F K
Fle Edt View Tosls Select Gesmety Commands Analyre Mode Window Help
o o el R ¥ : ol NS | Sl meadh | D@L B2 TS BEES N G

gFFFFFFestr+oeqa B QEaQQETQrtqQ e = T
ArnnnaBpBBs: TOE AXN4GH pra FED L ~ @[
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] =
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Figure 1. 10
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A Snap Node/Beam dialog box also appears in the data area on the
right side of the screen. The Linear tab is meant for placing the
construction lines perpendicular to one another along a "left to
right - top to bottom" pattern, as in the lines of a chess board. The
Radial tab enables construction lines to appear in a spider-web
style, which makes it is easy to create circular type models where
members are modelled as piece-wise linear straight line segments.
The Irregular tab can be used to create gridlines with unequal
spacing that lie on the global planes or on an inclined plane. We
will use the Linear tab.

In our structure, the segment consisting of members 1 to 3, and
nodes 1 to 4, happens to lie in the X-Y plane. So, in this dialog
box, let us keep X-Y as the Plane of the grid. The size of the
model that can be drawn at any time is controlled by the number of
Construction Lines to the left and right of the origin of axes, and
the Spacing between adjacent construction lines. By setting 20 as
the number of lines to the right of the origin along X, 15 above the
origin along Y, and a spacing of 1 feet between lines along both X
and Y (see next figure) we can draw a frame 20ft X 15ft, adequate
for our structure. Please note that these settings are only a starting
grid setting, to enable us to start drawing the structure, and they do
not restrict our overall model to those limits.

1-17
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Figure 1. 11
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3.  To start creating the nodes, let us first activate the Snap
Node/Beam button by clicking on it. Then, with the help of the
mouse, click at the origin (0, 0) to create the first node.

s;»-

s;w

s;»-

4;»_

1%’- R |
?__.1'-"2

0, 0) - origin
Figure 1. 12
4. In a similar fashion, click on the following points to create nodes

and automatically join successive nodes by beam members.

(0, 15), (20, 15), and (20, 0)
The exact location of the mouse arrow can be monitored on the
status bar located at the bottom of the window where the X, Y, and
Z coordinates of the current cursor position are continuously

updated.

Add nodes/beams to line intersections using cursor, Hold CTRL key down to reset N X T000 Y0000 20000 InputUnis: kipdt
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When steps 1 to 4 are completed, the structure will be displayed in

the drawing area as shown below.

Figure 1. 13
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At this point, let us remove the grid from the structure. To do that,
click on the Close button in the Snap Node/Beam dialog box.
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The grid will now be removed and the structure in the main
window should resemble the figure shown below.

[ PORTAL std - Whole Structure =] B3

L

Figure 1. 15

It is very important that we save our work often, to avoid loss of
data and protect our investment of time and effort against power
interruptions, system problems, or other unforeseen events. To save
the file, pull down the File menu and select the Save command.
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1.5.2 Switching on node and beam labels

1.  Node and beam labels are a way of identifying the entities we have
drawn on the screen. In order to display the node and beam
numbers, right click anywhere in the drawing area. In the pop-up
menu that comes up, choose Labels. Alternatively, one may access
this option by selecting the View menu followed by the Structure
Diagrams option from the top menu bar, and the Labels tab of the
dialog box that comes up.

[ Wiew

Zoanm 4
&% Pan

Wiew Selected Objects Only
IT Alwayz Fit in Current Window

[ Iables.. # ot Chrl 3¢
E “hole Structure T Chl+E
Drientation. .. F4 2 Faste [t
= 7 Select Cursor 3
Structure Dhagrams.
@ Structure Diagrams. .. £ clection Mode 5
Dperiien.. i3 Take Picture
Hew Wiew..
Yiew Management L4 £+ Add Beam
[ Iables...
Toolbars... -
. Hpen Yiew..
Optiong. ..
Set Structure EDI.DISN . Tl =
Structural Tool Tip Optiong .. = Stucture Diagrams. .
& 3D Rendering @ Madel iew Details
Refresh F5 4 3D Rendering

Figure 1. 16
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2. In the Diagrams dialog box that appears, turn the Node Numbers
and Beam Numbers on and then click on OK.

Diagrams El
Force Limits Animation Design Results
Structure Loads and Results Scales | Labels
[odes Physical Members Fropeties
Mode Mumbers {N) ] [1Member Mumber (™M) O References )
T Node Poirts (K) (] Design Group (*G) © Sections ()
Samints (5 [] Design Envelope (“E) ® None
[] Dimension (D) [ Design Brief ("B)
Fipes
Beams ] Pipe Node Numbers

Beam Mumbers (B) ] ] Pipe Node Tags
[[] Beam Oriertation {0)
[]Beam Spec (&) Loading Display Options
Releasss (R) [ Load Values ()
[[]Beam Ends (E) Display Floor Loading (F)
Display Floor Load Distribution (Y)

ﬂ Et:d”ﬁ'm Display Wind Load Contributory Area (H)
eer Display Wind Load (W)
Flates General

[1 Piate Numbers {F) Show fxes Window (*8) [ Master Slave (L)
[ Plate Orientation (T} | [] Show Axes & Org (1)

Solids [1Material (M}

[ Solid Numbers () Show Diagram Info (G)

Surfaces
[]5urface Numbers (“F)

[ Surface Crientation (“T)

(#) Mlways Use STAAD.Pro Default Label Settings.
() Mways Use Cument Label Settings.

For quick access to the labels using keyboard hotkeys,
press Shift +the |etter shown in brackets.

[ ok || cancel ][ ey || Heb

Figure 1. 17
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The following figure illustrates the node and beam numbers
displayed on the structure. The structure in the main window
should resemble the figure shown below.

3
2
3
(
4
1
Figure 1. 18

If you are feeling adventurous, here is a small exercise for you.
Change the font of the node/beam labels by going to the View menu
and selecting the Options command, and then selecting the
appropriate tab (Node Labels / Beam labels) from the Options

dialog box.
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1.5.3 Specifying member properties

Our next task is to assign cross section properties for the beams
and columns (see figure in section 1.2). For those of us curious to
know the equivalent commands in the STAAD command file, they

are :
MEMBER PROPERTY AMERICAN
1 3 TABLE ST W12X35
2 TABLE ST W14X34

Steps:

1. To define member properties, click on the Property Page icon
located on the top toolbar.

|Blges

Property Page

Figure 1. 19
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Alternatively, one may go to the General | Property page from the
left side of the screen as shown below.

STAAD.Pro - PORTAL.std

File Edit Wiew Tools Seleck Geometry Commands  Analvze

|lasdEmsBX2te B E

lopoaoaaestdocw

AR LLHBEBR.S T EE

I

A7
a3

*1 PORTAL.std - Whole Structure

I B8 Material [ k- Load I 8- Suppart I 2 Spec

TMRHHF| + 88T " EHE R 7|

\/ 5
E
£
:
[1]
z
j!
5
— | &
= i
- ||
Iz (
5
5%

Figure 1. 20
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In either case, the Properties dialog box comes up (see figure
below). The property type we wish to create is the W shape from
the AISC table. This is available under the Section Database
button in the Properties dialog box as shown below. So, let us
click on the Section Database button.

i Properties - Whole Structure E
Section | Beta Anglel

Fef Section f aterial

¥ Highlight &ssighed Geometmy
Edit...

Delete... |

Yalues... W Section Database ' Define. . |

b aterialz. . | Thickness. .. | Uzer Table. .. |

Agzignment Method
") Agsion To Selected Beams % |se Cursor To Assign
= fesign To Edit List = Assign ToView

Agzign | Cloze Help

Figure 1. 21
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In the Section Profile Tables dialog box that comes up, select W
Shape under the American option. Notice that the Material box is
checked. Let us keep it that way because it will enable us to
subsequently assign the material constants E, Density, Poisson, etc.
along with the cross-section since we want to assign the default
values.

Choose W12X35 as the beam size, and ST as the section type.
Then, click on the Add button as shown in the figure below.
Detailed explanation of the terms such as ST, T, CM, TC, BC, etc.
is available in Section 5 of the STAAD Technical Reference
Manual.

Section Profile Tables

Steel | Coldformed Steel || Timber || Aluminum
W Shape S smeedmeme
E M Shaps Select Beam . Type Specrflcatlon
E S - (%) ST (Single Section from Table)
i W12X14 e’ (O T (Tee Section Cut from Beam)
I HP Shape e O D (Double Profile)
B 6 Shape W12X19 = ]
I Chanrel wi2xzz
E MC Channel W12X26 (O CM {Composite Section)
Angle W12X30
B T L]
B Fie W12X4D |:|
E HS5 Rectangle W1ZX45
E HS55 Round W1ZXE0 v l:l
Castellated
B soid Red View Table |:|
E Cable | Material (O TC (Top Cover Plate)
@ American Steel Joist (O BC (Bottom Cover Plate)
% Australian STEEL | (OB (Top & Bottom Cover Plate)
British
@ Canadian |:|
@ Chinese
@ Dutch l:l
@ European w
(o ) [
Figure 1. 22

To create the second member property (ST W14X34), select the
W14X34 shape and click on the Add button.

After the member properties have been created, let us Close the
Section Profile Tables dialog box.

1-29
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5.  The next step is to associate the properties we just created with
selected members in our model. Follow these steps.

a. Select the first property reference in the Properties dialog
box (W12X35).

b. Make sure that the “Use Cursor to Assign” button is
selected under the Assignment Method box.

4

c. Click on the Assign button. The cursor changes to I
Using the cursor, click on members 1 and 3.
Finally, click on the Assign button again, or click on the
‘Esc’ button on your keyboard to stop the assignment
process.

i Properties - Whole Stiucture [=]

Section | BetaAngl |

Ref Section Material
_9 1. Select the first
TG ETE STEEL property reference.

¥ Highlight Assigned Geometry

Edi Delets.
Valuss.. | SectionDatsbase | Defire.. |
Materis.. | Thickness. | UserTable.. |
Bssignmen
€ Assign To Selected Beams & Use Cursor Ta Assign 2. Make sure this

" Assign To Edit List  Assign To View assignment method is
4. Using the cursor, click on selected.
members 1 and 3. I

By | Oese | Hen |

5. Click on the Assign button
again, or click on the ‘Esc’

button on your keyboard to stop L) 3. Click on the Assign
the assignment process. hutton.

Figure 1. 23

6. In a similar fashion, assign the second property reference
(W14X34) to member 2.



After both the properties have been assigned to the respective

Tutorial 1

members, our model should resemble the following figure.

-lolx]
<]
2:R2
e
B:R1
M:R1
4
1
Tx
S5ign property ,m‘
Figure 1. 24

Let us once again save our structure by pulling down the File menu

and selecting the Save command.
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1.5.4 Specifying material constants

In Section 1.5.3, we kept the Material check box “on” while
assigning the member properties. Consequently, the material
constants got assigned to the members along with the properties,
and the following commands were generated in the command file:

CONSTANTS

E 29000 MEMB 1 TO 3

POISSON 0.3 MEMB 1 TO 3
DENSITY 0.000283 MEMB 1 TO 3
ALPHA 6.5e-006 MEMB 1 TO 3

Hence, there is no more a need to assign the constants separately.
However, if we hadn’t assign them as before, we could go to the
menu option Commands | Material Constants and assign them
explicitly as shown in the figure below.

Command:  Analyze  Mode  Window Help

Flate Thlcklness W 5 @ JJ D Jﬁm
Surface Thickness
kember Property 3 ':':")\ a @“ @ @ L S? Q
M aterial Congtants taterial T able...
Geometric Congtants
Support Specifications Elasticity..
Member 5 pecfications 4 Puoizzon's Fatio...
::Iate EETEN gpec.ifflicat.ions 4 Alpha.
»

aster/slave 3pecitication el Feta.,

Pre Analysiz Print 4 G [Shear Modulus] ...
F=# Define Damping far Dynamics Clear &bove Commands...

Loading 3
Analysiz »
Fost-tnalpgiz Print 4
Design »
Mizcellaneous »

Figure 1. 25
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1.5.5 Changing the input units of length

For specifying member offset values, as a matter of convenience, it
is simpler if our length units are inches instead of feet. The
commands to be generated are:

UNIT INCHES KIP
Steps:

1.  To change the length units from feet to inch, click on the Input
Units icon from the appropriate toolbar.

L

[ gl et b 2 A
Inpmns

Figure 1. 26

Alternatively, one may select the Tools | Set Current Input Unit
menu option as shown in the next figure.
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2.

Select Geometry Commands  Analyze Mode Window)|
Check Multiple Structures. ..

Check Duplicate 4
Orphan Modes 4
Check for Warped Plates. ..

Check Zero Length Members
Check Overlapping Collinear Members

Calculator. ..
Unit Conwverter. ..

b+ Dimension Beams...
%3- Dizplay Mode to Mode Distance

=M=t Current Input Unit. ..

Set Current Display Unit. ..
% Cut Section...

Query »
Figure 1. 27

In either case, the following dialog box comes up. Set the Length
Units to Inch and click on the OK button.

Set Current Input Units E3

—LengthUnits——— r— Farze Units
& lnch " Decimeter  Pound = Mewtan
" Foot " Meter & KiloPound  © Decatlewton
 Millimeter  © Kilometer © Metiic Ton  © KiloNewton
' Centimeter = Kilogram " Megaewton

ak. [I Catizel |

Figure 1. 28
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1.5.6 Specifying member offsets

Since beam 2 actually spans only the clear distance between the
column faces, and not the center to center distance, we can take
advantage of this aspect by specifying offsets. Member 2 is
OFFSET at its START joint by 6 inches in the global X direction,
0.0 and 0.0 in Y and Z directions. The same member is offset by
negative 6.0 inches at its END joint. The corresponding STAAD
commands are:

MEMBER OFFSET
2 START 6.0 0.0 0.0

2 END -6.0 0.0 0.0

Steps:

1. Since we know that member 2 is the one to be assigned with the
offset, let us first select this member prior to defining the offset
itself. Select member 2 by clicking on it using the Beams Cursor

M. The selected member will be highlighted. (Please refer to the
‘Frequently Performed Tasks’ section at the end of this manual to
learn more about selecting members.)

2.  To define member offsets, click on the Specification Page icon
located in the top toolbar.

Ty

| B &2 =

R

Specification Page

Figure 1. 29
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Alternatively, one may go to the General | Spec Page from the left

side of the screen.

M[=1E3

El PORTAL std - Whole Structure

Geometry | @ Setup

I B Material [ b Load | B= Suppart (rg_spﬁﬂ Property

[ & Desion | W araysisiPrint

Figure 1. 30
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In either case, the Specifications dialog box shown below comes
up. Member Releases and Offsets are defined through the Beam
button in this dialog box as shown below.

i Specifications - Whole Structure |

S pecification

[ Highlight Aszigned Geometry
Edi.. | Delete... |

Mode... | Beam... Flate...

[ Toggle Specification
—Azzighment Method

£ Azsign To Selected Beams
= Aszzign To View

% |Jze Curzor To Assign

£ Assign To Edit List

Agzign Cloze Help

Figure 1. 31
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4, In the Beam Specs dialog box that opens, select the Offset tab. We
want to define the offset at the start node in the X direction. Hence,
make sure that the Start option is selected under Location . Then,
enter 6.0 in the X edit box. Since we have already selected the
member, let us click on the Assign button.

Member Specification |

Inactive | Fire: Proofing I Imperfection
Releaze Dffset | Cable I Truss I Comprezszion Tenzion
Location—————————— Direction——————————————
’7 IStE"t 'I ’7 IGIDbaI 'I
Offzets

% |B.E1 in

Add Cloze Azzign '\J Help
L

Figure 1. 32

5. To apply the offset at the end node, repeat steps 3 and 4, except for
selecting the End option and providing -6.0 in the X edit box.
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After both the Start and End offsets have been assigned, the model
will look as shown below.

Figure 1. 33

Click anywhere in the drawing area to un-highlight the member.

Let us save the work again by pulling down the File menu and
selecting the Save command.
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1.5.7 Printing member information in the
output file

We would like to get a report consisting of information about all
the members including start and end joint numbers (incidence),
member length, beta angle and member end releases in the STAAD
output file. The corresponding STAAD command is:

PRINT MEMBER INFORMATION ALL
Steps:

1. Since the information is required for all the members, select all the
members by going to Select | By All | All Beams menu option.

Geometry Commands Analyze Mode Window Help
ls Modes Cursor
k Beams Cursor
& Physical Member Cursor
138 Plates Cursor
157 surface Cursor
132 solids Cursor

Plates & Solids Cursor
@ Geometry Cursor
ok Filtered Selection Cursor

Selection Mode 4

Configure Selection Filter...

I¥M Load Edit Cursor
[@ Support Edit Cursor

[/ Release Edit Cursor /

Beams Parallel To 4
Plates Parallel To L4
By Range »

By Group Name...

Entity at node...

Entity Connects Beam
Entity Connects Plate
Entity Connects Solid

By All 3 All Nodes

- v v -

By Inverse 3
All Plates
By List Pl AlSolids
By Spedfication » e

Figure 1. 34
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2.  Then, go to Commands | Pre Analysis Print | Member
Information from the top menu bar as shown in the figure below.

Commandz  Analyze  Mode ‘window  Help

Plate Thickness & 5 D‘m JJ & &
Surface Thickness

tember Froperty 4 @l a @l @ & P SQ Q
M aterial Constants L P = A My 9 (@ i
Geometric Constants 3 .

Support S pecifications 4 ;
tember Specfications 3

Plate Element Specifications 3

td azter/Slave Specification 3

Froblem Statistics...

P=2 Defing Darnping for Dynarnics Joint Coordinates. .
Loading b Elerent [nfarmmation...
o Member Information...

nalysis " :

g Salid [nformatian, .
Past-Analysis Print ' Support Information. .
Design r M aterial Properties...
Miscelaneous 3 Member Properties. ..

Entire Tahle...
Frint &l...

Clear Above Commands...

Figure 1. 35



1-42 | Tutorial 1

3.  Notice that the assignment method is set To Selection. Press the
OK button in this dialog box.

Print Member Information |

Thiz command requires no additional
parameters.

Azzigh
™ Toview % ToSelection

k. [_: I Cancel Help

Figure 1. 36

Click anywhere in the drawing area to un-highlight the members.

Let us also save our structure again by using the Save option of the
File menu.
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1.5.8 Specifying Supports

The specifications of this problem (see section 1.2) call for
restraining all degrees of freedom at node 1 (FIXED support) and a
pinned type of restraint at node 4 (restrained against all
translations, free for all rotations) The commands to be generated
are :

SUPPORTS
1 FIXED ; 4 PINNED

Steps:

1.  To create a support, click on the Support Page icon located in the
top toolbar as shown below.

M@;s@ -

Support Page

Figure 1. 37
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Alternatively, one may go to the General | Support Page from the

left side of the screen.

=101 x|

[ PORTAL std - Whole Structure

o
=
o
&
i
=
o
15
=1
il
o

¢ General

I B8 Material [ - Load{ §- Support )E Spec [ H Property
S

[ & Design | ., analysisiPrint I

Figure 1. 38
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In either case, the Supports dialog box comes up as shown in the
next figure. Since we already know that node 1 is to be associated

with a Fixed support, using the Nodes Cursor R_Ol select node 1.
It becomes highlighted. (Please refer to the ‘Frequently Performed
Tasks’ section at the end of this manual to learn more about
selecting nodes.)

Then, click on the Create button in the Supports dialog box as
shown below.

: Supports - Whole Structure |

R ef D escription

51 Mo suppaort ><

Edit | Create Delete

—Azsignment Method
¥ Azzign To Selected Maodes
i~ Azzign To View

" Use Cursor To Assign

" Azsign To Edit List

Azzign Cloze Help

Figure 1. 39
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4, In the Create Support dialog box that opens, select the Fixed tab
(which also happens to be the default) and click on the Assign
button as shown below. This creates a FIXED type of support at
node 1 where all 6 degrees of freedom are restrained.

Create Suppont E3

Enforced But I Multiinear Spring | Foundation | |nclined
Fined | Pinred I Fized But I Erforced
— Restraint
F R o oMx
¥ py [ My
| 7wz
Add Cancel Azzigh %l Help
Figure 1. 40

5. To create a PINNED support at node 4, repeat steps 2 to 4, except
for selecting node 4 and selecting the Pinned tab in the Create
Support dialog box.
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After the supports have been assigned, the structure will look like
the one shown below.

B
2

P

5]
f

&
7]

Figure 1. 41

After assigning both the supports, let us save our structure using
the File | Save option.
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1.5.9 Viewing the model in 3D

Let us see how we can display our model in 3D. To do this, either
right-click and select Structure Diagrams or go to View |
Structure Diagrams menu.

ah Cut [l
Lapy [Chrl+C
R Faste [l
Select Curzor r
Selection Mode r
WH Take Picture Wiew Tools Select Geometry Commarn
#% Add Beam Zoarn 4
] Tables.. % Pan
Wiew Selected Objects Only
Dpen ey, . ’T Alwayz Fit in Current Window
Lahels. .
Orientation. . F4 [ Tables..
@ Structure Diagrams. . I 8] whole Stucture
@ Model View Details L. =
£ 30 Rendering Eitn_n::ture Diagrarms...

Figure 1. 42

In the ensuing dialog box, the Structure tab page allows you to set
up structural view parameters as explained below.

The options under 3D Sections control how the members are
displayed. Selecting None displays the structure without displaying
the cross-sectional properties of the members and elements.
Selecting Full Sections displays the 3D cross-sections of members,
depending on the member properties. Sections Outline displays
only the outline of the cross-sections of members.

Let us select Full Sections to draw the 3D sections. You can also
change the color of the sections by clicking on the Section Outline
color button under the Colors section. Then, click on OK.



Tutorial 1 1-49

5I
Farce Limits I Apimation I Design Results I
Structure | Loads and Results | Scales | Labelz
30 Sections View
" Mone [ Fill Plates/Salids/Suface [~ Shrink |1U %
' Full Sections [™ Hide Plates/Solids [T Perspective
" Sections Dutine [™ Hide Struchure ¥ Sort Gearmetry
¥ Shaw Center Lines [ SortModes
[V Draw Deck Hatch
Colars

Beams Default... | Section Outline . ¢
Plates Default | Selected Entities .
Solids Diefault... | I~ Show Color Legend

Margin around structure |1 1] %

Figure 1. 43

The resulting diagram is shown below.

Figure 1. 44
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1.5.10 Specifying Loads

Three load cases are to be created for this structure. Details of the
individual cases are explained at the beginning of this tutorial. The
corresponding commands to be generated are listed below.

UNIT FEET KIP

LOADING 1 DEAD + LIVE
MEMBER LOAD
2 UNI GY -25

LOADING 2 WIND FROM LEFT
JOINT LOAD
2 FX 10.

LOAD COMBINATION 3 75 PERCENT OF (DL+LL+WL)
10.75 2 0.75

Steps:

The creation and assignment of load cases involves the following
two steps:

a. First, we will be creating all 3 load cases.
b. Then, we will be assigning them to the respective

members/nodes.

Creating load cases 1 and 2

1.  To create loads, first click on the Load Page icon located on the
top tool bar.

|& & |

Load Page
Figure 1. 45
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Alternatively, one may go to the General | Load Page from the left
side of the screen.

REE)

| i s |, et @mm | 4 senp
| 0 st ﬂ—ua:hﬁ—&wwl 2 gpec | i Popety
S
-

B

E]

Figure 1. 46

Before we create the first load case, we need to change our length

. oy & . .
units to feet. To do that, as before, utilize the = Input Units icon
(see section 1.5.5).

Notice that a window titled “Load” appears on the right-hand side
of the screen. To create the first load case, highlight Load Cases
Details and then click on the Add button in the Load dialog box.

Load &l

[
Load Cases Details {1. Highlight Load Cases Deta\\s]
L) Load

[] Toggle Load : 2 Click on the Add button I
Assignment Method

|
| Close Help

Figure 1. 47
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The Add New Load Cases dialog box comes up.

The drop-down list box against Loading Type is available in case
we wish to associate the load case we are creating with any of the
ACI, AISC or IBC definitions of Dead, Live, Ice, etc. This type of
association needs to be done if we intend to use the program's
facility for automatically generating load combinations in
accordance with those codes. Notice that there is a check box
called Reducible per UBC/IBC. This feature becomes active only
when the load case is assigned a Loading Type called Live at the
time of creation of that case. Please refer to STAAD.Pro 2004
Release Report for further details.

As we do not intend to use the automatic load combination
generation option, we will leave the Loading Type as None. Enter
DEAD + LIVE as the Title for Load Case 1 and click on the Add
button.

Detre Combrishons:
Aute Lowd Combination

Humbes [1 Landing Type - [Hore =]
I | Aschaciae per U

Title DEAD + LIV

m&m]ﬂw]

Figure 1. 48

The newly created load case will now appear under the Load Cases
Details option.

+-[D] Definitions
= Load Cases Details
1:DEAD + LIVE
Load Envelopes

Figure 1. 49
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To create the Member load, first highlight DEAD + LIVE. You
will notice that the Add New Load Items dialog box shows more
options now.

+-[D] Definitions
= Load Cases Details

1:DEAD + LIVE

LpadErwelnpes

Figure 1. 50

In the Add New Load Items dialog box, select the Uniform Force
option under the Member Load item. Specify GY as the Direction,
enter -2.5 as the Force and click on the Add button.

Add New : Load [tems [g|

@ Seffweight

@ Nodal Load

@ Member Load Force
Uniform Farce a1 i
| Uniform Momert D
E Concentrated Force w1 |_2 5 ‘k\pﬁ‘t d2|D |H
E Concentrated Momen Wi
i Linear Varying d3 43 f
E Trapezoidal D
B Hydrostatic o

Direct

[ FPre/Post Stress i g reetion
B Ficed End OX(ocall OGX  OPX

@ Physical Member Load

@ Area Load OY(eca) ®GY  OPY
Floor Load

% Plate Loads OZiecal) OGZ OPrz

@ Suface Loads

@ Solid Loads

Q Temperature Loads

@ Seismic Loads

Q Time Histary

@ Wind Load

Q Snow Load

Q Response Spectra

@ Repeat Load

Q Frequency

< |

| ™

[ Add ] [ Close ] [ Help

Figure 1. 51
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The next step is to create the second load case which contains a
joint load.

5.  Highlight Load Cases Details in the Load dialog box. In the Add
New Load Cases dialog box, once again, we are not associating the
load case we are about to create with any code based Loading Type
and so, leave that box as None. Specify the Title of the second load
case as WIND FROM LEFT and click on the Add button.

Add New : Load Cases d
Primary i#-[D) Definitions

| Load Generation i=-[L] Load Cases Details
i Define Combinations S 1: DEAD +LIVE
| 2uto Load Combination 2% UNIGY 25kip/ft

[D Load Envelopes

| 1. Highlight Load Cases Details I

Number [2 Loading Typs - | Nere v

Tile | WIND FROM LEFT ey |

3. Click on Add

[ ! | C o J [ e
Figure 1. 52

6.  Next, to create the Joint load, highlight WIND FROM LEFT.

+-[D| Definitions
= Load Cases Details
- 1: DEAD + LIVE
2% UNIGY -25kipft

2 - WIND FROM LEFT

LoadErwelnpes

Figure 1. 53
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Add New : Load Items

@ Nodal Load
Node
E Support Displacemen
Q Member Load
@ Physical Member Load
@ Ares Load
@ Floor Load
@ Plate Loads
Q Surface Loads
@ Solid Loads
@ Tempersture Loads
Q Seismic Loads
@ Time History
@ Wind Load
Q Snow Load
Q Response Spectra
Q Repeat Load
Q Frequency
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In the Add New Load Items dialog box, select the Node option
under the Nodal Load item. Specify 10 for Fx, and click on the

E3)

S
W s

Add ] [ Close ] [ Help

Figure 1. 54
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Creating load case 3

Load cases 1 and 2 were primary load cases. Load case 3 will be
defined as a load combination. So, the next step is to define load
case 3as 0.75 x (Load 1 + Load 2), which is a load combination.

8.  To do this, once again, highlight the Load Cases Details option. In
the Add New Load Cases dialog box, click on the Define
Combinations option from the left-hand side. Specify the Title as
75 Percent of [DL+LL+WL].

Add New Load Cases

H Load Generation

Difine Cognbinations

Load Mo, |3
B 4uto Loaq Combination

Name : I[DL+LL+WL]

Typ

" SRSS
" ABS

Factor

Default

= Homal General Format :

*

1 I™ | Algebraic Component

Available Load Cases:

Load Combination Definition: [A] = Algebraic.

1: DEAD + LIVE
2 'WIND FROM LEFT

2. Select Define
Combinations.

BERER

Load Cases Factor

[3. Specify the Title.

s | Cose

Heln

E Primary Define Combinations

#-[D] Definitions
=-[L) Load Cases Delails m—
£l [ 1:DEAD +LIVE
2% UNIGY 25 kip/ft
£ @ 2: wIND FROM LEFT
~7% P 10kipft

1. Highlight Load Cases
Details.

Mew... Add... Edit...

Figure 1. 55

In the Define Combinations box, the default load combination type
is set to be Normal, which means an algebraic combination. The
other combination types available are called SRSS (square root of
sum of squares) and ABS (Absolute). The SRSS type offers the
flexibility of part SRSS and part Algebraic. That is, some load
cases are combined using the square root of sum of squares
approach, and the result is combined with other cases algebraically,

as in

A + SQRT(B*B + C*C)
where A, B and C are the individual primary cases.

We intend to use the default algebraic combination type (Normal).
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9. In the Define Combinations box, select both load cases from the
left side list box (by holding down the “Ctrl” key) and click on the

button. The load cases appear in the right side list box. Then,
enter 0.75 in the Factor edit box. (These data indicate that we are
adding the two load cases with a multiplication factor of 0.75 and
that the load combination results would be obtained by algebraic

summation of the results for individual load cases.) Press the Add

button.
Add Hew Load Cases (%]
E Primary Define Combinations
[ Load Generation
] Define Combinations Load Na: |3 Hame : I[DL+LL+W’L]

B Auto Load Combination T

(:. Homal fiensralFome!

" SRSS
- Factor 1 I~ | &lgebraic Component
s Default 1

Awailable Load Cases: Load Combination Definition: [4] = &lgebraic

Load Cages Factor
Load Caze 1 ;=075
;=

;I Load Gase 2 075
by d

«
[<]

Add Close Help

Figure 1. 56

Now that we have completed the task of creating all 3 load cases,
let us Close the Add New Load Cases dialog box.
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Our next step is to associate load case 1 with member 2. Follow
these steps.

a. Select the first load reference in the Load dialog box (UNI
GY -2.5 kip/ft).

b. Make sure that the “Use Cursor to Assign” button is
selected under the Assignment Method box.

c. Click on the Assign button. The cursor changes to &
Using the cursor, click on member 2.

e. Finally, click on the Assign button again, or type the ‘Esc’
button on your keyboard to stop the assignment process.

BLEf - Hj
i [0 Definitions
F L Luad Cases Datads
[ 1 DEAD 4+ LVE
* NIRRT
=-[0 2. WIND FROM LEFT
3 +2 Filkpit
=1 3: [DLalLowi]
[0 10.75) 4 Load 1
[0 0754 Laad 2
z
§
I 3
1 A, Uksing this o
member 2,
4 2. Make
sure the
Hew.. | 4| ese | o | Assignm
unt
I Togge Losd
b2 of e
4. Fin an thie ‘Aszsign’ O ihies et Erlr & e Cuarvon To A Ve
&4 buttan a ke un hee et o Tothion e e Bk i ]
button on your keyboard 1o stop the JI;::.I“'!“
assignmeant process. &l_| | L L
#
Luad 1 Aisign Cloze Hrip
A, Click un the Assign button,

Figure 1. 57
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After the member load has been assigned, the model will look as
shown below.

Figure 1. 58

In a similar fashion, assign the second load case (FX 10 kip, ft) to
Node 2.

After assigning the joint load, the model will look as shown below.

R

Figure 1. 59

Let us once again save our model by pulling down the File menu
and selecting the Save command or by holding the ‘Ctrl’ key and
pressing the ‘S’ key.
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1.5.11 Specifying the analysis type

The analysis type we are required to do is a linear static type. We
also need to obtain a static equilibrium report. This requires the
command:

PERFORM ANALYSIS PRINT STATICS CHECK

Steps:

1.  To specify the Analysis command, go to Analysis/Print Page from
the left side of the screen. By default, the Analysis sub-page from
the second row is in focus as shown below.

o Analysis/Print Commands
3
21
;’ : Perfform Cable Analysis | PDelta Analysis | Change || Perfform Pushover Analysis
= Perform Analysis | Perform Imperfection Analysis
=
)i Print Option
(=]
] % No Print
. " (O Load Data
=l () Statics Check
ElE
S| = () Statics Load
= | =
=2 (") Mode Shapes
32
@ =] © Both
5 OAl
£
]
E.
=
= ] After Current Assign [ Close ] [ Help

Figure 1. 60
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In the Analysis/Print Commands dialog box that appears, make
sure that the Perform Analysis tab is selected. Then, check the
Statics Check print option. Finally, click on the Add button
followed by the Close button.

Analysis/Print Commands

Perform Cable Analysis || PDelta Analysis | Change | Pedomm Pushover Analysis
Perform Analysis | Perform Imperfection Anabysis

Prirt Option
() Mo Print
(") Load Data
() Statics Check
() Statics Load
{3 Mode Shapes

{73 Bath
O Al

[] After Cumert Azsign [ Close ] [ Help

Figure 1. 61

Let us save the data once again using the File | Save option.
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1.5.12 Specifying post-analysis print
commands

We would like to obtain the member end forces and support
reactions written into the output file. This requires the
specification of the following commands:

PRINT MEMBER FORCES ALL
PRINT SUPPORT REACTION LIST 1 4

Steps:

1. The dialog box for specifying the above commands is nested in the
Post-Print sub-page of the Analysis/Print page.

B [ [ PORTAL std - Whole Stiu =10] x|
&
|2
i
| = N
P 3
S
gl =
ey E
. 2
_ \
%f.‘é
ofE
af % .
ST E 2
5
E &.‘ 8
-5
2
£
[x]
<
=
5
& 1
-L
— &
2% Load 2

Figure 1. 62
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Next, select all the members by rubber-banding around them
using the mouse.

Click on the Define Commands button in the data area on the right
hand side of the screen.

[+ Highlight &ssigned Geometry
[ Toogle Assign

Define Cnmmar_‘l E |

— Azzighment Method

| Assign To Selected Beams
= Assign ToView

% |se Cursor To Assign

' Assign To Edit List

Azzigh | Cloze | Help

Figure 1. 63



1-64 | Tutorial 1

4.

In the Analysis/Print Commands dialog box that appears, select the

Member Forces tab and click on the Assign button followed by

the Close button.

Analysis/Print Commands

Analysis Results

Mode Shapes

Max Force
Load List

Stary Drift
Section

Member Section Forces
Element Stress Solid

Member Stresses | Element Forces/Stresses

Section Displacement Force

Cag Surface Forces Physical Member Forces
Joint Displacement | Member Forces Support Reactions

[ Global

] After Cument

J |

Close Help

J | J |

[ Add Assign

selecting the Suppo

Figure 1. 64

Repeat steps 2 to 4 except for selecting both the supports and

rt Reactions tab in the Analysis/Print

Commands dialog box. (Recall that the supports can be selected by
turning the Nodes Cursor on, holding the ‘Ctrl” key down, and
clicking on the supports.) After clicking on the Assign button,
Close the dialog box.
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At this point, the Post Analysis Print dialog box should resemble
the figure shown below.

Il Post Analysis Print - Whole Struckure x|

----- # INPUT WIDTH 73 -
----- / UNIT FEET KIP
..... / JOINT CODRDINATES
..... / MEMBER INCIDENCES
E-E3 DEFINE MATERIAL START
®-E3 MEMBER PROPERTY AMERICAN
E-E3 CONSTANTS
----- / UNIT INCHES KIP
®-E3 MEMBER OFFSET
®-E SUPPORTS
----- / UNIT FEET KIP
E-E3 LOAD 1LOADTYPE None TITLE DEAD +
E-E3 L0AD 2 LOADTYPE None TITLE WIND FF
E-E3 LOAD COMB 3 75 Percent of [DL + LL + il
----- / PERFORM ANALYSIS PRINT STATICS CH
/ UNIT INCHES KIP
----- / PRINT MEMBER INFORMATION

----- # UMIT FEET KIF
----- + PRINT MEMBER FORCES
----- + PRINT SUPFORT REACTION

----- # FINISH

1 |

[¥ Highlight Assigned Geometry

%

afl

[~ Toggle Assign

Define Commands...

—Aszighment Method

) Agsign To Selected Beams
 Agsign To View

% Use Cursor To Assign

€ fesign To Edit List

Azgign | Cloze | Help

Figure 1. 65

Save the work using the File | Save menu option.
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1.5.13 Short-listing the load cases to be used
in steel design

The steel design has to be performed for load cases 1 and 3 only
per the specification at the beginning of this tutorial. To instruct
the program to use just these cases, and ignore the remaining, we
have to use the LOAD LIST command.

The command will appear in the STAAD file as :
LOADLIST13
Steps:

1. In the menus on the top of the screen, go to Commands | Loading
| Load List option as shown below.

Commands Analpze Mode Window Help
Plate Thickness WS 5 I} HJ i - e

Surface Thickness
Q Q& Q »et Q &0
et rnsoa®

-

tember Property

-

Material Constants

peemets Feraants L
Support Specifications 4
Member Specifications 4
Plate Element Specifications 4
I aster/Slave 5 pecification 4
Pre Analysis Print 4

P Define Diamping for Dynamics

Ainalyziz 4 Frimary Load...

Maoving Load Generation..

Post-Ainalyzis Print 4 o

Load Combination...
Design 4 Automatic Load Combination. .
Mizcellaneous L Load Commands

Define Primary Load Types..

Load List...

Edit Auto Load Rules
Figure 1. 66
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A Load List dialog box comes up. From the Load Cases list box on
the left, double click on 1: DEAD + LIVE and 3: 75 Percent of
[DL+LL+WL] to send them to the Load List box on the right, as
shown below. Then click on the OK button to dismiss the dialog
box.

Load List E

r— Load Case: r—Load List

SN

7. DEAD + LIVE
3 75 Percent of [DL+LL+wL ] ﬂl
Help |

2 W/MD FROM LEFT

|2 =l

Use the » button to transfer selected Usge the < button to remove selected load
lpad cases to the load list. Use »> to cases from the load list, Use << to remove
transfer all all

Figure 1. 67
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1.5.14 Specifying steel design parameters

The specifications listed in section 1.2 of this tutorial require us to
provide values for some of the terms used in steel design because
the default values of those terms are not suitable. The
corresponding commands to be generated are:

PARAMETER
CODE AISC

FYLD 5760 ALL
UNT 10.0 MEMB 2 3
UNB 10.0 MEMB 23
TRACK 2 MEMB 2 3
SELECT MEMB 2 3

Steps:

1.  To specify steel design parameters, go to Design | Steel Page from
the left side of the screen. Make sure that under the Current Code
selections on the top right hand side, AISC ASD is selected.

M= || SteetDess
Cunert cmﬂm
7-E MEMBER PR
1  UNIT INCHES KIF
73 MEMBER OFFSET
-3 SUPPORTS
 UNIT FEET KIP
- LOAD 1 DEAD +LIVE
7-(E0 LOAD 2WIND FROM LEFT
7 LOAD COME 3 75 Percent of [DLsLL#
- PERFORM ANALYSIS PRINT STATICS
# UNIT INCHES KIF
-« PRINT MEMBER INFORMATION
 UNIT FEET KIP
& PRINT MEMBER FORCES
3 «# PRINT SUPFORT REACTION
# L0&D LST
~ FINISH
|
[ Highlight Assigned Geometry
I~ Toggle Assign

Select efine
Parameters. SramElErs.
5 Method

! Assign To Selected Beams
 Assign TaView

& Use Cursor T Assign
 Assign To Edit List

A e

2]

Figure 1. 68
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2.  Click on the Define Parameters button in the Steel Design dialog
box.

¥ Highlight Assighed Geometry
[~ Toggle Assign

Select Define
Parameters.. Farameters..

— Bssignment b et e -

Commands...

| Assign To Selected Beams
 Assign To View

¢ Use Curzor To Assign

= Assign To Edit List

Bazign | Cloze | Help |

Figure 1. 69

3. In the Design Parameters dialog box that comes up, select the
FYLD option. Then, provide the Yield Strength as 5760 Kip/ft?
and click on the Add button.

B conpia
COMNHEIGHT
CyCLES
DFF
[wAh}
o2 ‘rield strength of steel: IS?BD kip/ft2
DLR2
DLRATIO
Db
DM

P Errrrrrrrrrrrrw
o
£
=1
=
T

r 'é[:?r:ant Add Assigh Clase Help

Figure 1. 70
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4.  To define the remaining parameters, repeat step 3 except for
selecting the parameters and providing the values listed below.

Parameter Value
UNT 10
UNB 10

TRACK 2

5.  When all the parameters have been added, click on the Close
button in the Design Parameters dialog box.

6.  The next step is to assign these parameters to specific members of
the model. From looking at the requirements listed in the beginning
of this tutorial, we know that the FYLD parameter is to be assigned
to all the members, while the remaining parameters are to assigned
to members 2 and 3.

As before, use the Use Cursor to Assign method to assign these
parameters.

rbzzignment Method

€ fesign To Selected Beams
 Agsign To View

% ' Use Cursor ToAssign
C posignToEdiLin 5ot Group/Deck |

Aszign | Cloze | Help |

Figure 1. 71
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After all the design parameters have been assigned, the Steel
Design dialog box will look as shown below.

Il Steel Design - Whole Structure x|

Current Code:

=-3 MEMEER OFFSET -
m-E3 SUPPORTS

----- / UNIT FEET KIP

-3 LOAD 1LOADTYPE None TITLE DEAD -
-3 LOAD 2 LOADTYPE None TITLE WIND |
@-E3 LO&D COME 3 75 Percent of [DL + LL + 3
----- / PERFORM ANALYSIS PRINT STATICS C
----- / UNIT INCHES KIP

----- / PRINT MEMBER INFORMATION

----- / UNIT FEET KIP

..... / FRINT MEMBER FORCES

----- / PRINT SUPPORT REACTION

----- &3 L0AD LIST

1423 PARAMETER

./ CODE AISC

- FYLD 5760
o UNT 1D
e UNB 10
e | TRACK 2
----- # FINISH (.
4| | e

[¥ Highlight Assigned Geometry
[~ Toggle Assign

Define
Farameters..

Select
Farameters..

| Commands...

rbzzignment Method

€ fesign To Selected Beams
= fesign To View

% Use Cursor To Assign
" ssign To Edit List 54”"3'3‘ Group/Deck

Azgign | Cloze | Help |

Figure 1. 72
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7. To specify the SELECT command, click on the Commands button
in the Steel Design dialog box as shown below. The SELECT
command is an instruction to the program to fetch and assign the
least-weight cross-section which satisfies all the code requirements
(PASSes) for the member.

Il Steel Design - Whole Structure |

Current Code:;

E-E3 MEMBER OFFSET =
®-E3 SUPPORTS

----- / UNIT FEET KIP

E-E3 LOAD 1LOADTYPE Mone TITLE DEAD -
B-E3 LOAD 2 LOADTYPE Mone TITLE WIND |
E-E3 LOAD COMB 3 75 Percent of [DL + LL +
----- / PERFORM ANALYSIS PRINT STATICS C
----- / UNIT INCHES KIP

----- / PRINT MEMBER INFORMATION

----- / UNIT FEET KIP

..... / PRINT MEMBER FORCES

..... / PRINT SUPPORT REACTION

----- &3 L0aD LIsT

=23 PARAMETER

b/ CODE AISC

- FrLD 5760

~og UNT 10

i UNB 10

i/ TRALK 2
..... / FINISH [
« I [

¥ Highlight &ssianed Geametry
[ Toogle &ssign

Define
Farameters..

Select

Commands. ..
Farameters..

Mo

—Aszighment Method

) Agsign To Selected Beams
 Agsign To View

& Use Cursor To Assign
C Boogn ToEdi Lt _Setest Groun/Deck

Aszign | Cloze | Help |

Figure 1. 73
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In the Design Commands dialog box that appears, click on the
SELECT option. Then, click on the Add button followed by the
Close button.

Design Commands

|8 CHECK CODE SELECT

B Fi<ED GROUP

i GrouP

E MEMBER TAKE OFF Select least weight section size bazed on

SELECT zpecifications of the desired code. The selection iz

E SELECT OFTIMIZED done uging the results from the most recent analysis

E SELECT WELD and iterating on section sizes until a least weight size
iz obtained.

i SELECTWELD TRUSS

[l TakE OFF

Thiz command has no additional parameters.

I After Add Bzsign Cloze Help

Current
Figure 1. 74

Once again, we need to associate this command with members 2
and 3. You may either use the Use Cursor to Assign method or
first select members 2 and 3 and then use the Assign to Selected
Beams option.

After the parameters are assigned, click anywhere in the drawing
area to un-highlight the members.

Let us save our structure by pulling down the File menu and
selecting the Save command.
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1.5.15 Re-specifying the analysis command

When the analysis & design engine executes the member selection
operation we specified in the previous step, a new set of properties
will end up being assigned to those members. This has the effect of
changing the stiffness distribution for the entire structure. Since
the structure is statically indeterminate, we ought to re-analyze it if
we want the nodal displacements, member forces, etc. to reflect
this new stiffness distribution. The command to be generated is
hence:

PERFORM ANALYSIS
Steps:

1.  To specify the Analysis command, repeat step 1 of Section 1.5.11
of this tutorial. In the Analysis/Print Commands dialog box that
comes up, select the Perform Analysis tab. Since we are not
interested in a statics check report once again, let us check the No
Print option. Finally, click on the Add button followed by the
Close button.

We should again save the work using File | Save.
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1.5.16 Re-specifying the TRACK parameter

The final calculation we need to do is make sure the current set of
member properties pass the code requirements based on the up-to-
date member forces. This will require that we do a code checking
operation again. To restrict the output produced to a reasonable
level, we specify the TRACK parameter again as:

TRACK 1 ALL
Steps:

1.  To define and assign 1.0 for the TRACK parameter, repeat steps 1
to 4 of Section 1.5.14 of this tutorial.

2. Next, select all the members by rubber-banding around them
using the mouse. (Please refer to the ‘Frequently Performed Tasks’
section at the end of this manual to learn more about selecting
members.) Then, assign this parameter to all the members.
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1.5.17 Re-specifying the CHECK CODE
command

The analysis operation carried out in response to the command in
Section 1.5.15 will create a new set of member forces. These forces
will very likely be quite different from those which were used in
the member selection operation (see the commands of section
1.5.14). Consequently, we have to verify that the structure is safely
able — from the standpoint of the design code requirements — to
carry these new forces. A code checking operation, which uses the
up-to-date cross sections of the members, and the latest member
forces, will provide us with a status report on this issue. The
command to be generated is hence:

CHECK CODE ALL
Steps:
1. If you have wandered away from the Steel Design page, from the

Commands menu on top of the screen, select Design | Steel
Design.
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Click on the Commands button in the Steel Design dialog box as

shown below.

Il Steel Design - Whole Struckure

Current Code:

=-E3 SUFFORTS
----- # UMNIT FEET KIF
M-E3 L0AD 1 LOADTYPE Mone TITLE DEAD -
M-E2 L0AD 2 LOADTYPE Mone TITLE WIND F
E-E] L0AD COME 3 75 Percent of [DL + LL +
..... ¢ PERFORM AMALYSIS PRIMT STATICS C
..... ¢ UNIT INCHES KIF
..... ¢ PRINT MEMBER INFORMATION
..... ¢ UNIT FEET KIP
..... ¢ PRINT MEMEER FORCES
..... / PRINT SUPPORT REACTION
..... / LOADLIST
#-[Z0 PARAMETER
----- . SELECT
----- £ PERFORM AMALYSIS
=53 PARAMETER

----- . CODE al5C

- . TRACK 1
----- # FIMISH

1| |
¥ Highlight Assigned Geometry
[ Toggle Assign

Select
Parameters..

Define

Commands...
Parameters..

-0 MEMBER OFFSET s

 Azzignment bethod

| Assign To Selected Beams
 Assign ToYiew

{® Uz Cursor To Assign
 fssignToEdiLige  _ooiect Group/ DBCkl

\""-—-“""

Agzign | Cloze | Help |

Figure 1. 75
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3.

In the Design Commands dialog box that appears, click on the
Check Code tab. Then, click on the Add button followed by the
Close button.

Design Commands

I CHECK. CODE CHECK CODE

B Fi<ED GROUP

i GrouP

B MEMBER TAKE OFF Check the adequacy of members based on
i sELEcT specifications of the desired code.
E SELECT OPTIMIZED
i SELECT WELD

E SELECT WELD TRUSS
[l TakE OFF

Thiz command has no additional parameters.

After .
I Cument Add N Bzsign Cloze Help

Figure 1. 76

Since the CHECK CODE command has to be assigned to all the
members, the easiest way to do that is to click on the Assign to
View button.

—bzzignment bethod

" Assign To Selected Beams
% Azsign To Wiew ‘{
= Use Cursor To Assign

€ Aszsign To Edit List

Agzign | Cloze | Help |

Figure 1. 77

We have now completed the tasks for assigning the input for this
model. Let us save the file one last time using the File | Save
option.



1.6 Viewing the input command file

Steps:

Tutorial 1 1-79

Let us now take a look at the data that has been written into the file
that we just saved earlier. The contents of the file can be viewed
either by clicking on the STAAD Editor icon or, by going to the
Edit menu and choosing Edit Input Command File as shown below.

STAAD Pro - PORTAL. std

File Edit “iew Toolz Select Geomety Command:  Analyze

IEE e - AR

looooaoae e+

STAAD Editar

A GLeBEBRE TSR

|

Figure 1. 78

Edit
=2 Undo Assign Suppoart Chil+Z
£ Fedo Ll
o Cut Ll
Copy Chl+E
2 Faste Ll
75 Delete el
B Take Ficture

Copy Picture

Edit Input Command File

Create Mew VE Macro...
Edit Existing B Macra...

Figure 1. 79
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A new window will open up with the data listed as shown here:

EXPORTAL std - STAAD Editor M[=] B3

File Edit ‘iew Toolz Help

= A
| & R
A R|E= | B 2R

STLAT PLANE PORTAL FRAME
START JOE INFORIMATION
ENGINEEE. DATE

END JOE INFORIMATION
INPUT WIDTH 79

UNIT FEET EKIFP

JOINT COOFRDIMATES

MEMEEF. INCIDENCES

112y 22333 4;
DEFINE MATERIAL S5TART
IS0TROPIC STEEL

E 4.176e+0068

POISS0N 0.3

DENSITY 0.4539024

ALPHA 6. 5e-008

DAMFP 0.03

END DEFINE MATERIAL
MEMEEF. FROPERTY AMERICAN
1 3 TAELE 3T W1zZX35

Z TABELE 5T W14x34
CONSTANTS

MATERIAL 5TEEL MEME 1 TO 3
UNIT INCHES EKEIFP

P

Faor Help, presz F1 Line 1Cal 1 /;

loo0y 201507 3 201507 42000

5

Figure 1. 80

This window and the facilities it contains is known as the STAAD

Editor.
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We could make modifications to the data of our structure in this
Editor if we wish to do so. Let us Exit the Editor without doing so
by selecting the File | Exit menu option of the editor window (not
the File | Exit menu of the main window behind the editor
window).

As we saw in Section 1.1, we could also have created the same
model by typing the relevant STAAD commands into a text file
using either the STAAD editor, or by using any external editor of
our choice. If you would like to understand that method, proceed
to the next section. If you want to skip that part, proceed to section
1.8 where we perform the analysis and design on this model.
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1.7 Creating the model using the command file

Let us now use the command file method to create the model for
the above structure. The commands used in the command file are
described later in this section.

The STAAD.Pro command file may be created using the built-in
editor, the procedure for which is explained further below in this
section. Any standard text editor such as Notepad or WordPad may
also be used to create the command file. However, the STAAD.Pro
command file editor offers the advantage of syntax checking as we
type the commands. The STAAD.Pro keywords, numeric data,
comments, etc. are displayed in distinct colors in the STAAD.Pro
editor. A typical editor screen is shown below to illustrate its general
appearance.

PDHTAL.std - STAAD Editor M=l B3
File Edit “iew Toolz Help

PeESR|+RR|q
| A R
A%% R | BN TN

FTARD PLANE —
START J0B INFORMATION
ENGINEER DATE

END J0E INFORMATION

INPUT WIDTH 79

UNIT FEET KIP

J0INT COORDINATES

1000;20150;320150; 4200 0;

MEMEEF. INCIDENCES

112:223;:334;

DEFINE MATERIAL START

IS0TROPIC STEEL -
AEIN -
For Help, press F1 Lre 1Cal 1 [ [ [ 2

Figure 1. 81
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To access the built-in editor, first start the program using the
procedure explained in Section 1.3. Next, follow step 1 of Section

1.4.
e ]

OGpace File: Marne :
O Floer IPDHTAL
O Truss Location :

IC:\tesl\ _I

4 PLAME structure is bound by a global %Y coordinate system with loads in the zame

plane
Length Urits ——————————————— Force Units
" Inch = Decimeter " Pound " Newton
% Foat = Meter @ KiloPound € DecaNewton
" Milimeter ¢ Kilometer © Kiogam 7 KilMewton
' Centimeter " Metic Ton  { MegaNewton

[ Display this dialog box at the Startup
< Back I Mext > %J Cancel Help

Figure 1. 82

You will then encounter the dialog box shown in the figure shown
below. In that dialog box, choose Open STAAD Editor.

‘Where do you want to go ? 5'

Oadd Beam
[J44dd Plate
O 2 Soiid
[ Open Structure 'Wizard
|0 ST&AD Editor
[ EditJab Information

Kill i

Begin building your model using STAAD syntax commands (non-graphical interface] through
the STAAD editor.

[ Display this dialog box at the Startup
< Back I Finish I Cancel Help

Figure 1. 83
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At this point, the editor screen similar to the one shown below will
open.

portal_std - SproE dit _ O =]

File Edit ‘“iew Tools Help

0w W &

d BB |
OB %L L BB TN

ETLAD SPACE

START T0E INFORMATION
ENGINEER DATE

END JOE INFORMATION
INPUT WIDTH 79

FINISH

]

I o

For Help. press F1 [Line 1Cal 1 | 2
Figure 1. 84

Delete all the command lines displayed in the editor window and
type the lines shown in bold below (You don’t have to delete the
lines if you know which to keep and where to fill in the rest of the
commands). The commands may be typed in upper or lower case
letters. Usually the first three letters of a keyword are all that are
needed -- the rest of the letters of the word are not required. The
required letters are underlined. (“PLANE” = “PLA” = “plane” =

“pla”)
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STAAD PLANE PORTAL FRAME

Every STAAD.Pro input file has to begin with the word STAAD.
The word PLANE signifies that the structure is a plane frame (in
the XY plane). The remainder of the words are the title of the
problem, which is optional.

If a line is typed with an asterisk in the first column, it signifies
that the line is a comment line and should not be executed. For
example, one could have put the optional title above on a separate
line as follows.

* PORTAL FRAME

NIT EEET KIP

Specify the force and length units for the commands to follow.

JOINT COORDINATES
10.0.;20.15.;3 20. 15.;4 20. O.

Joint numbers and their corresponding global X and Y coordinates
are provided above. For example, 3 20 15. indicates that node 3 has
an X coordinate of 20 ft and a Y coordinate of 15 ft. Note that the
reason for not providing the Z coordinate is because the structure
is a plane frame. If this were a space frame, the Z coordinate would
also be required. Semicolons (;) are used as line separators. In
other words, data which is normally put on multiple lines can be
put on one line by separating them with a semicolon.

MEMBER INCIDENCE
112;223;334

The members are defined by the joints to which they are connected.
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MEMBER PROPERTY AMERICAN
1 3 TABLE ST W12X35
2 TABLE ST W14X34

Members 1 and 3 are assigned a W12X35 section from the built-in
AMERICAN steel table. Member 2 has been assigned a W14X34.
The word ST stands for standard single section. Sections 5.20.1
through 5.20.5 of the STAAD Technical Reference Manual explain
the convention for assigning member property names.

UNIT INCHES
CONSTANTS

29000.0 ALL
ISSON 0.3 ALL

oim

The length unit is changed from FEET to INCHES to facilitate
input of the modulus of elasticity (E). The keyword CONSTANT is
required before material properties such as E, density, Poisson’s
ratio, coefficient of thermal expansion (ALPHA) etc. can be
provided. See Section 5.26 of the STAAD Technical Reference
Manual for more information.

MEMBER OFFSET
2 START 6.00. 0.
2END -6.00.0.

The beam member is physically connected to the 2 columns at the
face of the column, and not at the column centerline. This creates a
rigid zone, about half the depth of the columns, at the 2 ends of the
beam 2. This rigid zone is taken advantage of using member offsets
(It is the user’s choice whether or not he/she wishes to use these).
So, the above commands define that member 2 is eccentrically
connected or OFFSET at its START joint by 6 inches in the global
X direction, 0.0 and 0.0 in Y and Z directions. The same member is
offset by negative 6.0 inches at its END joint. See Section 5.25 of
the STAAD Technical Reference Manual for more information.
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PRINT MEMBER INFORMATION ALL

The above command is self-explanatory. The information that is
printed includes start and end joint numbers (incidence), member
length, beta angle and member end releases.

SUPPORTS
1 FIXED ; 4 PINNED

A fixed support is located at joint 1 and a pinned support (fixed for
translations, released for rotations) at joint 4. More information on
the support specification is available in Section 5.27 of the STAAD
Technical Reference Manual.

TE

c
=

The length unit is changed to FEET to facilitate input of loads.

LOADING 1 DEAD + LIVE
MEMBER LOAD
2 UNIGY -2.5

The above commands identify a loading condition. DEAD + LIVE
is an optional title to identify this load case. A UNIformly
distributed MEMBER LOAD of 2.5 kips/ft is acting on member 2
in the negative global Y direction. Member Load specification is
explained in Section 5.32 of the STAAD Technical Reference
Manual.

LOADING 2 WIND FROM LEFT
JOINT LOAD
2 FX 10.

The above commands identify a second load case. This load is a
JOINT LOAD. A 10 kip force is acting at joint 2 in the global X
direction.
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LOAD COMBINATION 3 75 PERCENT OF (DL+LL+WL)
1075 2 0.75

This command identifies a combination load with an optional title.
The second line provides the components of the load combination
case - primary load cases and the factors by which they should be
individually multiplied.

PERFORM ANALYSIS PRINT STATICS CHECK

This command instructs the program to proceed with the analysis
and produce a report of static equilibrium checks. Section 5.37 of
the STAAD Technical Reference Manual offers information on the
various analysis options available.

PRINT MEMBER FORCES ALL

PRINT SUPPORT REACTION LIST 1 4

The above print commands are self-explanatory. The member
forces are in the member local axes while support reactions are in
the global axes.

LOADLIST 13
PARAMETERS
CODE AISC

UNT 10.0 MEMB 2 3
UNB 10.0 MEMB 2 3
YLD 5760 ALL

RACK 2.0 MEMB 2 3

ELECT MEMBER 2 3

=l

The above sequence of commands is used to initiate the steel
design process. The command PARAMETERS is followed by the
various steel design parameters. Parameters are specified typically
when their values differ from the built-in program defaults.
Specifications of the AISC ASD code are to be followed. A
parameter list for the AISC code is available in Table 3.1 of the
Technical Reference Manual. ALL members have 10 ft
unsupported length for the top and bottom flange (UNT and UNB).
UNT and UNB are used to compute the allowable compressive
stress in bending. The yield strength of steel is specified as 5760
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ksf (40 ksi) since it is different from the default value of 36 ksi.
The TRACK parameter controls the level of description of the
output, 2.0 being the most detailed. The LOAD LIST command
lists the load cases (1 and 3) to be used in the design. The SELECT
MEMBER command asks the program to come up with the most
economical section for members 2 and 3 in the context of the above
analysis.

PERFORM ANALYSIS

When the analysis & design engine executes the member selection
operation we specified in the previous step, a new set of properties
will end up being assigned to those members. This has the effect of
changing the stiffness distribution for the entire structure. Since
the structure is statically indeterminate, we ought to re-analyze it if
we want the nodal displacements, member forces, etc. to reflect
this new stiffness distribution. The above command instructs the
program to do another cycle of analysis.

PARAMETER
TRACK 1 ALL

The TRACK parameter is re-specified. It controls the level of
information produced in the steel design output. We have lowered
it from 2.0 we specified earlier to 1.0 since we aren’t interested in
the highest level of detail at this time.

CHECK CODE ALL

The analysis operation carried out earlier will create a new set of
member forces. These forces will very likely be quite different
from those which were used in the member selection operation.
Consequently, we have to verify that the structure is safely able —
from the standpoint of the design code requirements — to carry
these new forces. A code checking operation, which uses the up-to-
date cross sections of the members, and the latest member forces,
will provide us with a status report on this issue.

EINISH
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A STAAD run is terminated using the FINISH command.
Save the file and return to the main screen.

This concludes the session on generating our model as a command
file using the built-in editor. If you wish to perform the analysis
and design, you may proceed to the next section of this manual.
The on-screen post-processing facilities are explained in Section
1.10.

(Remember that without successfully completing the analysis
and design, the post-processing facilities will not be accessible.)
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1.8 Performing Analysis/Design

STAAD.Pro performs Analysis and Design simultaneously. In
order to perform Analysis and Design, select the Run Analysis
option from the Analyze menu.

File Edit Yiew Toolz Select Geometry Eammands|,-i\nal_|,|ze Mode ‘wWindow Help

B EE e ClF5
Figure 1. 85

If the structure has not been saved after the last change was made,
you should save the structure first by using the Save command
from the File menu.

When you select the Run Analysis option from the Analyze menu,
the following dialog box appears:

Select Analysiz Engine E3

Analyziz Option |

f* STALD Analysis

™ Stardyre Sdvanced Snalysis

Run Ainalyzis I Cancel | Apply Help
Ly

Figure 1. 86

We are presented with the choice of 2 engines : the STAAD engine
and the STARDYNE Advanced Analysis engine. The STARDYNE
Analysis engine is suitable for advanced problems such as
Buckling Analysis, Modal Extraction using various methods, etc.
However, if the calculations call for steel or concrete design, UBC
load generation, etc., we have to select the STAAD engine. So, let
us ensure that the radio button is on the STAAD engine.
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Click on the Run Analysis button.

As the analysis progresses, several messages appear on the screen

as shown in the figure below.

=i
++ Proce=sing and =setting up Load Vector. 21:19:52:]
++ Processing Element Stifiness Matris. 21:19:52
++ Processing Global Stiffness Matriz. 21:19:52
++ Finished Processing Global Stiffness Hatrix. 0 =ec
++ Processing Triangular Factorization. 21:19:52
++ Finiszhed Triangular Factorization. 0 =ec
++ Calculating Joint Displacement=. 21:19:52
++ Finished Joint Displacemsnt Calculation. 0 =ec
++ Calculating Hember Forces. 21:19:52
++ Analv=is Successiully Completed ++
++ Calculating Section Forces
++ Performing Steel Design
++ Start Stesl Design 21:19:53
++ Finished Design 0 =ec
++ Creating Displacement File {(DSP). .. 21:19:53
++ Creating Reaction File (EEA4) . . .
++ Calculating Section Forces
++ Creating Section Force File (BMDY . ..
++ Creating Section Displace File (SCH)Y. ..
++ Creating Design information File (DGH) . ..
++ Done. 21:19:53

0 Error{s). 0 Warningis)

*% End STAAD Pro Run Elaps=ed Time = 2 Secs
*#* Output Written to File:
PORTAL . anl

£ Wiew Output File
™ Goto Post Processing Mode
*' Stay in Modeling Mode

Dane

Figure 1. 87

Notice that we can choose from the three options available in the

above dialog box:

" iew Output File
" Goto Post Processing Mode
¥ Stay in Modeling Maode

Figure 1. 88
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These options are indicative of what will happen after we click on
the Done button.

The View Output File option allows us to view the output file
created by STAAD. The output file contains the numerical results
produced in response to the various input commands we specified
during the model generation process. It also tells us whether any
errors were encountered, and if so, whether the analysis and design
was successfully completed or not. Section 1.9 offers additional
details on viewing and understanding the contents of the output
file.

The Go to Post Processing Mode option allows us to go to
graphical part of the program known as the Post-processor. This is
where one can extensively verify the results, view the results
graphically, plot result diagrams, produce reports, etc. Section 1.10
explains the Post processing mode in greater detail.

The Stay in Modelling Mode lets us continue to be in the Model
generation mode of the program (the one we currently are in) in
case we wish to make further changes to our model.
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1.9 Viewing the output file

During the analysis process, STAAD.Pro creates an Output file.
This file provides important information on whether the analysis
were performed properly. For example, if STAAD.Pro encounters
an instability problem during the analysis process, it will be
reported in the output file.

We can access the output file using the method explained at the
end of the previous section. Alternatively, we can select the File |
View | Output File | STAAD Output option from the top menu.
The STAAD.Pro output file for the problem we just ran is shown in
the next few pages.

STAAD.Pro - Structure1.std

=W Edit View Tools Select Geometry Commands Analyze Mode Window Help

— cotai KEOS> [BREen
= Open... Ctrl+0
i Clos= b oo @& (B @8

Open Archive... T E T @ ] o o A CR

iteel Design Concrete Design Component De

Mhole Structure
Open Backup Manager

View Input Command File

Job Information

Report Setup...

Output File » B=)isTaAD output

Printer Setup... I

Figure 1. 89
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The STAAD.Pro output file is displayed through a file viewer
called SproView. This viewer allows us to set the text font for the
entire file and print the output file to a printer. Use the appropriate
File menu option from the menu bar.

rcframe. anl - 5proYiew

File Edit ‘iew Help
[pern... [Ctrl+d

Print.... Ctrl+F
Print Preview
Print Setup...

?

Page Setup

Font Setup

v Top Mozt

Fecent File

E it

Figure 1. 90

By default, the output file contains a listing of the entire Input
also. You may choose not to print the echo of the Input commands
in the Output file. Please select Commands | Miscellaneous | Set
Echo option from the menu bar and select the Echo Off button.

It is quite important that we browse through the entire output file
and make sure that the results look reasonable, that there are no
error messages or warnings reported, etc. Errors encountered
during the analysis & design can disable access to the post-
processing mode — the graphical screens where results can be
viewed graphically. The information presented in the output file is
a crucial indicator of whether or not the structure satisfies the
engineering requirements of safety and serviceability.
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STAAD.Pro

Version Bld
Proprietary Program of
Research Engineers, Intl.
Date=

Time=

Ok ok % ok ok X o F

USER ID:

¥ ok ok X ok o X %

. STAAD PLANE PORTAL FRAME

. START JOB INFORMATION

. ENGINEER DATE

- END JOB INFORMATION

- INPUT WIDTH 79

- UNIT FEET KIP

. JOINT COORDINATES
-1000;20150; 320150; 42000
. MEMBER INCIDENCES

10. 112;223; 334

11. DEFINE MATERIAL START

12. ISOTROPIC STEEL

13. E 4.176E+006

14. POISSON 0.3

15. DENSITY 0.489024

16. ALPHA 6.5E-006

17. DAMP 0.03

18. END DEFINE MATERIAL

19. MEMBER PROPERTY AMERICAN
20. 1 3 TABLE ST W12X35

21. 2 TABLE ST W14X34

22. CONSTANTS

23. MATERIAL STEEL MEMB 1 TO 3
24. UNIT INCHES KIP

25. MEMBER OFFSET

26. 2 START 6 0 O

27. 2 END -6 0 O

28. SUPPORTS

29. 1 FIXED

30. 4 PINNED

31. UNIT FEET KIP

32. LOAD 1 DEAD + LIVE

33. MEMBER LOAD

34. 2 UNI GY -2.5

35. LOAD 2 WIND FROM LEFT

36. JOINT LOAD

37. 2 FX 10

38. LOAD COMB 3 75 PERCENT OF {DL+LL+WL]
39. 1 0.75 2 0.75

40. PERFORM ANALYSIS PRINT STATICS CHECK

OCONOOUDWNE

PROBLEM STATISTICS

NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS = a/ 3/
ORIGINAL/FINAL BAND-WIDTH= 1/ 1/ 6 DOF
TOTAL PRIMARY LOAD CASES = 2, TOTAL DEGREES OF FREEDOM =

SIZE OF STIFFNESS MATRIX
REQRD/AVAIL. DISK SPACE

1 DOUBLE KILO-WORDS

STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO.
DEAD + LIVE

SUMMATION FORCE-X
SUMMATION FORCE-Y
SUMMATION FORCE-Z

***TOTAL APPLIED LOAD ( KIP FEET ) SUMMARY (LOADING 1)
= -47.50
= 0.00
SUMMATION OF MOMENTS AROUND THE ORIGIN-
MX= 0.00 My= 0.00 Mz= -475.00

1

7

12.0/ 3884.9 MB, EXMEM = 488.4 MB
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***TOTAL REACTION LOAD( KIP FEET ) SUMMARY (LOADING 1)
SUMMATION FORCE-X = 00
SUMMATION FORCE-Y = 47_50
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= 0.00 My= 0.00 Mz= 475.00
MAXIMUM DISPLACEMENTS ( INCH /RADIANS) (LOADING 1
MAXIMUMS AT NODE
X = 1.82363E-01 2
Y = -1.46578E-02 3
Z = 0.00000E+00 0
RX=0.00000E+00 0
RY=0.00000E+00 0
RZ= -4.82525E-03 2

STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO.
WIND FROM LEFT

***TOTAL APPLIED LOAD ( KIP FEET ) SUMMARY (LOADING 2)
SUMMATION FORCE-X = 10.00
SUMMATION FORCE-Y = 0.00
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= 0.00 My= 0.00 Mz= -150.00
***TOTAL REACTION LOAD( KIP FEET ) SUMMARY (LOADING 2)

SUMMATION FORCE-X = -10.00

SUMMATION FORCE-Y = 0.00

SUMMATION FORCE-Z 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= 0.00 My= 0.00 Mz= 150.00
MAXIMUM DISPLACEMENTS ( INCH /RADIANS) (LOADING 2)
MAXIMUMS AT NODE
X = 7.27304E-01 2
Y = 2.47268E-03 2
Z = 0.00000E+00 0
RX=0.00000E+00 0
RY=0.00000E+00 0
RZ= -5.48842E-03 4

sexkkasxsnkxx END OF DATA FROM INTERNAL STORAGE **icksacsdss

41. UNIT INCHES KIP

42. PRINT MEMBER INFORMATION ALL

MEMBER INFORMAT ION

MEMBER ~ START  END LENGTH BETA
JOINT  JOINT (INCH) (DEG) RELEASES

1 1 2 180.000 0.00

2 2 3 228.000 0.00

3 3 4 180.000 0.00

s END OF DATA FROM INTERNAL STORAGE s

2
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43. UNIT FEET KIP
44. PRINT MEMBER FORCES ALL

MEMBER END FORCES

STRUCTURE TYPE = PLANE

ALL UNITS ARE -- KIP FEET

MEMBER LOAD JT

1

1

2

WNWNWN NEFENRPNPRE

PWPWHPW

FkA K g IIIFFIIIE END

45. PRINT SUPPORT

AX

23.
-23.
-4.
4.
14.
-14.

3.
-3.
2.
-2.
4.
-4.

24.
-24.
4.
-4.
21.
-21.

1AL

18
18
10
10
30
30

99
99
32
32
73
73

32
32
10
10
32
32

SHEAR-Y SHEAR-Z

-3.
3.
7.

-7.
2.

-2.

23.
24.
-4.

4.
14.
21.

3.
-3.
2.
-2.
4.
-4.

99
99
68
68
7
7

18
32
10
10
30
32

99
99
32
32
73
73

jelejeloNoNa] [elejojoNoNa]

[eNejoNoNoNa]

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

TORSION

jelejeloNoNa] [elejojoNoNa]

[elejojoNoNa]

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

OF LATEST ANALYSIS RESULT **aiorkasdoix

REACTION LIST 1 4

SUPPORT REACTIONS -UNIT KIP FEET

JOINT

1

LOAD

WNPFPWN P

FORCE-X

3.
-7.
-2.
-3.
-2.
-4.

99
68
7
99
32
73

FORCE-Y

23.
-4.
14.
24.

4.
21.

18
10
30
32
10
32

STRUCTURE TYPE = PLANE

FORCE-Z

[eNejoNoNoNa]

.00
.00
.00
.00
.00
.00

MOM-X

[elejoNoNoNa]

.00
.00
.00
.00
.00
.00

MOM-Y

[elejoNoNoNa]

.00
.00
.00
.00
.00
.00

FxwrwrHxFxF*A* END OF LATEST ANALYSIS RESULT FHassksoksksss

46.
47.
48.
49.
50.
51.
52.
53.

LOAD LIST 1 3
PARAMETER

CODE AlISC

FYLD 5760 MEMB 1 TO 3
UNT 10 MEMB 2 3
UNB 10 MEMB 2 3
TRACK 2 MEMB 2 3
SELECT MEMB 2 3

MOM-Y

jelejeloNoNa] [elejojoNoNa]

[elejoNoNoNa]

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

.00
.00
.00
.00
.00
.00

MOM Z

-11.
67
42

48

.93
.34
.00
.00
.00

MOM-Z

-11.
-48.
.93
.32
.34
-0.

67
47
42

36.
.72

-47

-45.
.69

-32

-6.
-60.

59.
.00
34.
.00
70.
.00

48
40

81

81

27

34
31

88

74

97
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STAAD.PRO MEMBER SELECTION - (AISC 9TH EDITION)

| |
| Y PROPERTIES |
 Tolalaialaioiaioiaiaiaioil | IN INCH UNIT |
| * | | :::|:: _____________ |
IMEMBER 2 * | | | AX = 8.85 |
| * | ST W14X30 | | --Z AY = 3.39 |
|DESIGN CODE * | | | AZ = 3.47 |
| AISC-1989 =* ===|=== sy = 5.82 |
| * SZ = 42.05 |
1 * |<---LENGTH (FT)= 19.00 --->| RY = 1.49 |
I FhhhkAkhkhhhkh RZ = 5 . 73 I
| |
] 70.5 (KIP-FEET) |
| PARAMETER | L1 L1 STRESSES |
JIN KIP INCH 1 L1 IN KIP INCH |
|- + L3 - |
| KL/R-Y= 153.21 | L3 FA = 6.36 |
| KL/R-Z= 39.76 + fa = 0.45]
] UNL = 120.00 | L3 L1 FCz = 21.68 |
| CB = 1.00 +L1 FTZ = 24.00 |
] cMy = 0.8 | L3 L3 FCY = 30.00 |
|] cMZ = 0.8 + FTY = 30.00 |
| FYLD = 40.00 | L1 fbz = 20.13 |
| NSF = 1.00 H———t—— oo | fbhy = 0.00 |
| DFF = 0.00 13.8 Fey = 6.36 |
| dFf = 0.00 ABSOLUTE MZ ENVELOPE Fez = 94.46 |
| (WITH LOAD NO.) FV = 16.00 |
| fv = 0.17 |
| |
| MAX FORCE/ MOMENT SUMMARY  (KIP-FEET) |
| |
1 AXTAL SHEAR-Y SHEAR-Z MOMENT-Y MOMENT-Z ]
| |
1 VALUE 4.7 24.3 0.0 0.0 70.5 ]
| LOCATION 0.0 19.0 0.0 0.0 9.5 |
1 LOADING 3 1 0 0 1

| |
| |
1 *1
I* DESIGN SUMMARY  (KIP-FEET) *1
= *|
1 *1
1* RESULT/ CRITICAL COND/ RAT10/ LOADING/ *
1 FX MY Mz LOCATION ]
| |
| PASS AISC- H1-3 0.999 1 |
| 3.99 C 0.00 -70.55 9.50 |
1 *1
| |
| |
| |
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STAAD.PRO MEMBER SELECTION - (AISC 9TH EDITION)

| |
| Y PROPERTIES |
| e | IN INCH UNIT |
1 * | ===|=== = e |
IMEMBER 3 * | | | AX = 10.00 |
| * | ST W14X34 | | --z Avr= 361 |
IDESIGN CODE * | | | AZ = 4.10 |
| AISC-1989 * ===|=== SY = 6.91
| * SZ = 48.64 |
1 * |<---LENGTH (FT)= 15.00 --->] RY = 1.53 |
| e RZ = 5.83 |
| |
| 71.0 (KIP-FEET) |
| PARAMETER L3 STRESSES |
JIN KIP INCH | L3 IN KIP INCH |
|-———— + L3 3 mmmme |
| KL/R-Y= 117.92 | L3 FA = 10.72 |
| KL/R-Z= 30.87 + fa = 2.13 |
] UNL = 120.00 | L3 L3 FCz = 21.95 |
| cB = 1.00 + FTZ = 24.00 |
] cMy = 0.8 | L3 FCY = 30.00 |
| CMz = 0.8 + L3 L3 FTY = 30.00 |
| FYLD = 40.00 | LO fbz = 17.51 |
| NSF = 1.00 H--—tmm oo m e et e | foy = 0.00 |
| ODFF = 0.00 -3.9 Fey = 10.74 |
| dff = 0.00 ABSOLUTE MZ ENVELOPE Fez = 156.71 |
| (WITH LOAD NO.) FV = 16.00 |
| fv = 1.31]
| |
1 MAX FORCE/ MOMENT SUMMARY  (KIP-FEET) ]
I I
| AXIAL SHEAR-Y SHEAR-Z MOMENT-Y MOMENT-Z |
| |
| VALUE 24.3 4.7 0.0 0.0 71.0 |
|  LOCATION 0.0 0.0 0.0 0.0 0.0 I
| LOADING 1 3 0 0 3
| |
| |
™ 1
1* DESIGN SUMMARY  (KIP-FEET) *1
I* ______________ *I
1 *1
I* RESULT/ CRITICAL COND/ RATI10/ LOADING/ *1
| FX MY Mz LOCATION |
| |
| PASS AISC- H1-2 0.886 3 |
| 21.32 C 0.00 70.97 0.00 |
1 *1
| |
| |
| |

54. PERFORM ANALYSIS

55. PARAMETER

56. CODE AISC

57. TRACK 1 MEMB 1 TO 3

58. CHECK CODE MEMB 1 TO 3
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STAAD.PRO CODE CHECKING - (AISC 9TH EDITION)

ALL UNITS ARE - KIP FEET (UNLESS OTHERWISE NOTED)

MEMBER TABLE RESULT/  CRITICAL COND/ RATI0/ LOADING/
FX Mz LOCATION
1 ST W12X35 PASS AISC- H1-1 0.855 1
23.02 C 0.00 52.01 15.00
MEM= 1, UNIT KIP-INCH, L= 180.0 AX= 10.30 SZ= 45.6 SY= 7.5
KL/R-Y= 116.7 CB= 1.00 YLD= 40.00 ALLOWABLE STRESSES: FCZ= 18.19

FTZ= 24.00 FCY= 30.00 FTY= 30.00 FC= 10.94 FT= 24.00 FV= 16.00
2 ST  W14X30 PASS AISC- H1-3 0.969
5.16 C 0.00 66.64 19.00
MEM= 2, UNIT KIP-INCH, L= 228.0 AX= 8.85 SZ= 42.1 SY= 5.8 |
KL/R-Y= 153.2 CB= 1.00 YLD= 40.00 ALLOWABLE STRESSES: FCZ= 21.68

FTZ= 24.00 FCY= 30.00 FTY= 30.00 FC= 6.36 FT= 24.00 FV= 16.00
3 ST W14X34 PASS AISC- H1-2 0.959 3
21.45 C 0.00 77.36 0.00
MEM= 3, UNIT KIP-INCH, L= 180.0 AX= 10.00 SZ= 48.6 SY= 6.9
KL/R-Y= 117.9 CB= 1.00 YLD= 40.00 ALLOWABLE STRESSES: FCZ= 21.95

FTZ= 24.00 FCY= 30.00 FTY= 30.00 FC= 10.72 FT= 24.00 FV= 16.00

59. FINISH

*xxkwxAxFExx END OF THE STAAD.Pro RUN **#sskskssxr

o DATE=

ok

TIME=

* For questions on STAAD.Pro, please contact *
* Research Engineers Offices at the following locations *
* *
* Telephone Email *
* USA: +1 (714)974-2500 support@reiusa.com *
* CANADA +1 (905)632-4771 detech@odandetech.com *
* CANADA +1 (604)629 6087 staad@dowco.com *
* UK +44(1454)207-000 support@reel .co.uk *
*  FRANCE +33(0)1 64551084 support@reel.co.uk *
*  GERMANY +49/931/40468-71 info@reig.de *
*  NORWAY +47 67 57 21 30 staad@edr.no *
* SINGAPORE +65 6225-6015/16 support@reiasia.net *
* INDIA +91(033)2357-3575 support@calcutta.reiusa.com *
*  JAPAN +81(03)5952-6500 eng-eye@crc.co.jp *
* CHINA +86(411)363-1983 support@reiasia.net *
* *
* North America support@reiusa.com *
* Europe support@reel .co.uk *
* Asia support@reiasia.net *
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1.10 Post-Processing

STAAD.Pro offers extensive result verification and visualization
facilities. These facilities are accessed from the Post Processing
Mode. The Post Processing mode is used to verify the analysis and
design results and generate reports.

For this tutorial problem, we shall perform the following tasks:

o Display deflection diagrams
e Annotate Displacements
e Display the force and moment diagrams.

e Change the degree of freedom for which the force/moment
diagram is plotted

e Annotate the force diagram

« Displaying dimensions of members
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1.10.1 Going to the post-processing mode

Steps:

1. At the end of section 1.8, we saw how one could go directly from
the Analysis window to the post-processing screen. However, the
formal method of accessing the Post Processing mode is either by

clicking on the Post-Processing icon from the top toolbar or from
the Mode menu as shown in the figures below.

[
GE =

Post-Processing

Figure 1. 91

Interactive Designs

Bridge Deck Preprocesszor

Iﬁ Fage Contral

Figure 1. 92




1-104

Tutorial 1

The Results Setup dialog box appears as shown below. Select the
load cases for which to display the results. For this tutorial, let us

select all the load cases. Then click on the OK button.

Results Setup

Loads | Range | Resutt View Options |

X

(®) Envelope of Load Cases in Selected List
Load Cazes

Available: Selected:

1 DEAD + LIVE
2 WIND FROM LEFT
375 Percent of [DL + LL + WL]

o
L

Lok J[ ey J[ Heb

Figure 1. 93
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Notice that in the Post-Processing mode, the tabbed Page Control
bar and the menu bar change to offer the post processing functions.

Page Control in Page Control in
Modeling Mode Post-Processing Mode

l & Job

-1~ Reactions l 3 Displacem ent

[

II_T Reports [ 2 Apimation [ I Beam l “* Node

I 1y Design [U Analysis/Print [ it General [ £ Geometry I = Setup

AGdH|| nevnir] 288 " ewnE -7

AHGH| neRHNE||&88d " eREARFF||

Al
&0

Figure 1. 94

Menu Bar in Modeling Mode

File Edit “iew Tools Select Geometry Commands Analyze Mode ‘window Help

Menu Bar in Post-Processing Mode

File Edit “iew Toolz Select Resultz Repot Mode ‘Window Help

Figure 1. 95
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1.10.2 Annotating the displacements
Steps:
The screen will now look like the figure shown below.

STAAD.Pio - PORTAL std M=
File Edit View Tooks Select Results Repot Mode Window Help

BEEHE s RX i B |[SReenal| 0 annkE KA |[BFeEF|
F888880c+sboca | |BlaacaanarstQefim.ne 52| [nk(o]
[prrccnapems s O [da46| T 2@AHPEBc @3 |

f PRI | E1 PORTAL std - Whole Stiucture M[=1 3 || &= PORTAL std - Node Di 1ol x|
) HE 4[4[ [P AlLA Summary /
!; = | 8 i Vertical | Horizontal | Resultant Rotational
— = X Y z [ 3] Z
= Wode | LI ft " f f rad rad rad
Elm 1 [1DEAD+LIV 0.000 0.000 0.000 0.000 0.000 0.000 0.000
(% R el ZVAIND FROM 0.000 0.000 G.000 0000 0.000 0.000 0.000
1% —| 2 375 PERCEN 0.000 0.000 0.000 0000 0.000 0.000 0.000
<l 8 2 [1DEAD +LIV 0013 0.0 0.000 0013 0.000 0.000 -0.005
b 2 3 ZVAIND FROM 0061 0.000 G.000 0081 0.000 0.000 0003
| E| 375 PERCEN 0.056 -0.0m 0.000 0055 0.000 0.000 -0.008
b § I 3 [1DEAD < LIV 0013 0.0 0.000 0013 0.000 0.000 0.004
A ZWAIND FROM 0061 -0.000 4.000 0081 0.000 0,000 0001
B 375 PERCEN 0056 -0om 4.000 0056 0.000 0000 0.002
|— | = 4 [1DEAD < LIV 0.000 0.000 0.000 0000 0.000 0.000 -0.003
E g ZWAIND FROM 0,000 0.000 4.000 0.000 0.000 0,000 0005
= 375 PERCEN 0.G00 0.G00 4.600 0.000 0.000 0,600 0008
=L
= & PORTAL.std - Beam Re o [=] 5|
= JA[ATRIT ANl Relative Displacement /A Max Relative Displacements /
s rrmll o I]fltsl ; ; ; Res;llﬂm -
= 1 [1DEAD + LIV 0.000 0.000 0.000 0.000 0.000
— 3750 0005 -0.000 0.000 0.005
E 7.500 -0.009 -0.000 0000 0.009
st 11.250 -0.003 0.000 0.000 0.008
L7 15.000 0.0 d.600 0000 0.000
15 2 WIND FROM 0000 0.000 0.000 0000 0.000
= 3750 -0.008 0.000 0.000 0.008
55 7.500 0004 d.600 0.000 0.005
11.250 -0.0m 0.000 0000 0.0M
15.000 0.000 0.000 0.000 0.000
375 PERCEN 0000 0.000 G.000 0000 0.000
Yﬁx 3750 -0.009 -0.000 0000 0.009
Displacement 7.500 0011 -0.000 0.000 0011
Tl e R i i =
For Help, press F1 |Past Mode [Load 1: DEAD + LIVE Input Units: [kip-ft

Figure 1. 96

The diagram currently on display is the node deflection diagram
for load case 1 (DEAD + LIVE). The title at the bottom of the
diagram is indicative of that aspect. If you, say, wandered off into
any other result diagram, and wanted to get back to the deflection
diagram, just select the Node | Displacement tab along the page
control area on the left side.
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Displaceme

I -|- Reactions

II_TRepnns [2?3’4 Animation I i Beany

Figure 1. 97

Annotation is the process of displaying the displacement values on
the screen. Select the View Value option from the Results menu.

Resultz

B Animation...

Bending kMoment
Dreflection

'? Section Displacement

Utilization Fatio...

{Fp Beam Stresses
O PFlate Stress Cartour...
" Solid/Stess Eomtour..

c}) IMode Shape Displacement...
Thrne Higtany Graph...

Select Load Case...
Scale...
Update Properties i

Slab Heinforeement. .

Figure 1. 98
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The following dialog box comes up. From the Ranges tab, select
All nodes. If you wish to annotate deflection for just a few nodes,
specify the node numbers in the node list.

i Annotation - PORTAL .std - Whole Structure E

Ranges |Beam Hesultsl MHode I Heactinnsl
= Mone
Al
) Wiew I j
| Group I j
" Property I j
" Ranges Modes: I

Bearns: I

Remove Al | Anhotate Cloze
Figure 1. 99

We will annotate the results for all the nodes. So, keep the button
on All.
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From the Node tab, check the Resultant option. Resultant stands
for the square root of sum of squares of values of X,Y and Z
displacements. Click the Annotate button and notice that the
values appear on the structure. Click the Close button to close the
dialog box.

+ Annotation - PORTAL. std - Whole Structure E2

Hangesl Beam Fiesults  Mode |F!eactions|

— Modal Dizplacement
I | Global
I | Global
I~ Global 2

¥ Fesultart

Remowe Al | Amnotate Nl Cloze
L&

Figure 1. 100
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The following figure shows the annotated deflection diagram for
load case 1.

El PORTAL std - Whole Structure (_ O]

013 1t

[].013 ft

2
T%x Displacement
Displacement - ft

Figure 1. 101
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1.10.3 Displaying force/moment diagrams

Steps:

The simplest method to access the facilities for displaying
force/moment diagrams is from the Beam | Forces page along the
page control area on the left side of the screen. The bending
moment MZ will be plotted by default, evidence of which can be
found in the form of the Mz icon show in the diagram below which

becomes active.

o
@
=
(=]
[
—I—
E
@ o
gl 2
fp— o
A
=
= =
|
[
S )
—| £
" =
=
6% L [1: DEAD +LivE j‘
El§] M REA%PED s
—| £ |
15 Bending 2 Moment
— Envelope

Figure 1. 102
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B PORTAL.std - Whole Structure M=l B3

fo Load 1 : Bending £

Figure 1. 103
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The option for selecting the forces/moment diagram is available
from another facility also - the Results | Bending Moment menu
option.

Rezultsz

&1 Animation...

<

Jending korment

Deflection
Section Displacernent
tilization B atio...

Beam Sheszes
Plate Stress Contour...

Salid Stress Contour....

ol 1 RN

Mode Shape Displacement...
Time Hiztony Graph...

Select Load Caze...

Scale...
Wiew WYalue. ..

|Ipdate Properties

5lab Benforcement...

Figure 1. 104
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1.10.4 Annotating the force/moment diagram

Steps:

Annotation is the process of displaying the force/moment values on
the screen. Select the View Value option from the Results menu.

Results

B Animation...

[w  Bending Moment
Deflection

A7 Section Displacement
Ltilization Ratio...

([ Beam Stesses
€ Flate Stress Cartour...
€ Sclid Stress Contour...

C]D IMade Shape Dizplazement...
Tirne Histany Graph,..

Select Load Case...

Scale...

Update Properties

5lab Benforzement. .

Figure 1. 105

In the dialog box that comes up, click on the Ranges tab and select
All members. If you wish to annotate the force/moment for just a
few members, specify the beam numbers in the beam list.



1 Annotation - PORTAL std - Whole Structure E

Ranges | Beam Hesultsl MNode I Heactionsl

" Naone

Lol |

 iew I j
C Group I j
" Property I j

" Ranges  MNodes: l—
Beams: I

Fiemove Al | Annotate | Close |

Figure 1. 106
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We will annotate the results for all members. So, keep the button

on All.

From the Beam Results tab, check the Ends and Mid Point

options under the Bending section. Click the Annotate button and
notice that the values appear on the structure. Click the Close
button to close the dialog box.

1 Annotation - PORTAL std - Whole Structure E

Ranges Beam Results | Mode I Heactionsl

— Bending
v Ends

[~ Maximum W Mid point

~ Shear

[ End:

[~ Maximum T Mid point

1al

[ End:

r— Displacement

[ Maw Fesulant

[ End:

r— Combined Bending and Axial Stress

[~ Maximum T Mid point

Remave Al | Annotate FL Cloze
| 2%

Figure 1. 107
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The following figure shows the annotated MZ diagram for load

case 2.
Edl PORTAL. std - Whole Structure _(Of x|
H12 i|}-in_ .
-7 437,370 kip-in
218.685 kip-in
132.029 kip-in
A kip-in
813.341 kip-in
TEX Bending 7
Moment - kip-in

Figure 1. 108
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1.10.5 Changing the degree of freedom for
which forces diagram is plotted

Force and moment diagrams can be plotted for 6 degrees of
freedom — Axial, Shear-Y, Shear-Z, Torsion, Moment-Y, Moment-
Z. One may select or de-select one of more of these degrees of
freedom from View | Structure Diagrams | Loads and Results.
Let us select Shear yy and select load case 3 (75 PERCENT OF

[DL+LL+WL] as

shown below.

Farze Limits | Animation I Design Results
Stucture Loads and Results I Scales I Labels
( Load Case: |3: TR FERCENT OF [DL + LL +wWL] j]

x|

stk Deflection Eeam Forces Diagram——
[ Loads: Diect [ || & Maore !
 Defiection J " Hatch © Fil
g .
Moment _| " Outline
¥ Show Load dmraw " Section Displacement
r Mode Shape
tiode Shape: INone vI [~ Mode Shape .
r~ Beam Forces
I Awial C . T. From To =~
- = = 244645 24 4045
[iaaram Calar CA o4 dna S i5ds
= Intensity -21 4242 -158.3636
. -158.3636 -15.303
] : |-24.4848
mimIm I 45303 472424
W asimum: |24.4848 -12.2424 -81513
7 -81513 61212
Mo of valuss: |—1E E B 612121 -30606
9 -3.0606 0
] 10 0 3.0606
W Shearyy T Bendinaw || |57 |30606 gaz11 |
I~ Shearzze [l I Bendnazz | |12 512121 a1a1a
. 13 918181 122424
I Tosion W JE D (e N5 < B
Ccress -l 1 <] | »
ak I Cancel | Apply | Help |

Figure 1. 109
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The resulting figure is shown below.

Edl PORTAL std - Whole Structure

b

SRR N NN

IS[=] E3

Shear ¥

Figure 1. 110

All degrees of freedom currently plotted will be indicated with a
tick mark in the Diagrams dialog box.

The icons of the Results toolbar may also be used to turn on/off
specific degrees of freedom.

w7 W

N Shear Y Force !EI E

Figure 1. 111
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For the sake of easy identification, each degree of freedom (d.o.f)
has been assigned a different color (see Diagrams dialog box
shown above). One may change the color for that d.o.f. by clicking
on the color button alongside the d.o.f, and make a new choice
from the color palette.

[ Bending yy J

¥ Bending zz
‘ol ocd

Figure 1. 112

The appearance of the diagram may also be set to one of the 3 —
Hatch, Fill or Outline by turning on the relevant option in the
dialog box shown earlier.

— Beam Forces Diagram——

f* Hatch © Fill
i Dutline

Figure 1. 113
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1.10.6 Displaying the dimensions of the
members

To display the dimension of the members, click on the Dimension
icon. Alternatively, one may select the Dimension Beams option
from the Tools menu. In the dialog box that opens, the option
Dimension to View is active. Click on the Display button followed
by the Close button, and the dimensions of the members will
appear alongside the members.

[ & 28 Al T I B2 7 B A
) '
Dimension

Figure 1. 114

Digplay/Remove Dimension E2

' Display  © Remove

— Optionz
¢ Dimension ta Wiew Dizplay k
£ Dimension to Selected Beams Close

" Dimension to List
I Help |

Figure 1. 115
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The diagram will look like the one shown below.

B PORTAL std - Whole Stucture M= E
1
-
-
—1
|
(] L1
n 5 it
1
I 1
I 1
7 |
et .~
A
I .
T%X ShearY |

Figure 1. 116

We can opt to save the screenshot by clicking on the Take Picture
icon (shown below). This picture may be included in custom
reports. See Chapter 2 for a tutorial on taking pictures as well as
generating custom reports.

EYET 1= Y=Y
) @ & (Teroudr £t Q & |

Figure 1. 117
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For obtaining a quick print of the plot on the screen, select the
Print Current View icon as shown below.

GReazm&b |0 &
LB ® Q& ||A§rir'|t Eurren‘t"-.-"iewlﬁ

Figure 1. 118

For detailed information on the Post Processing features, please
refer to the Post Processing section in the STAAD.Pro Graphical
Environment manual.
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Tutorial Problem 2: RC Framed Structure

Section 2

This tutorial provides step-by-step instructions for creating the
model of a reinforced concrete framed structure using STAAD.Pro.
The following topics are covered :

e Starting the Program

e Creating Joints and Members

e Switching On Node and Beam Labels

e Specifying Member Properties and Material Constants

e Specifying Member Orientation using Beta Angle

e Specifying Supports

e Specifying Loads

e Specifying the Analysis Type

e Specifying the parameters and instructions for Concrete Design
e Performing Analysis and Design

e Viewing results using the Output File

e Viewing results on screen — both graphically and numerically
e Producing customized reports



2-2 | Tutorial 2

2.1 Methods of creating the model

As explained in Section 1.1 of tutorial problem 1, there are two
methods of creating the structure data:

a) using the graphical model generation mode, or graphical
user interface (GUI) as it is usually referred to.
b) using the command file.

Both methods are explained in this tutorial also. The graphical
method is explained first, from Section 2.2 onwards. Section 2.8
describes the process of creating the model using the command file
method and the STAAD.Pro text editor.
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2.2 Description of the tutorial problem

The structure for this project is a 2 bay, 2 story reinforced concrete
frame. The figure below shows the structure. Our goal is to create
the model, assign all required input, and perform the analysis and
concrete design.

Figure 2.1
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BASIC DATA FOR THE STRUCTURE

ATTRIBUTE

DATA

Member properties

Beams 2 & 5 : Rectangular, 275 mm width X
350 mm depth

Columns 1 & 4 : Rectangular, 275 mm width X
300 mm depth

Column 3 : Circular, 350 mm diameter

Member Orientation

All members except column 4 : Default

Column 4 : Rotated by 90 degrees with respect
to default condition

Material Constants

Modulus of Elasticity : 22 KN/sg.mm
Density : 25 kn/cu.m

Poisson's Ratio : 0.17

Supports

Base of all columns : Fixed

Loads

Load case 1 : Dead Load
Selfweight of the structure.
Beams 2 & 5 : 400 kg/m in global Y downward

Load case 2 : Live Load
Beams 2 & 5 : 600 kg/m in global Y downward

Load case 3 : Wind Load

Beam 1 : 300 kg/m along positive global X
Beam 4 : 500 kg/m along positive global X
Load Case 4 : DEAD + LIVE

L1 X 1.2+L2X 1.5 (Use REPEAT LOAD, not
Load Combination)

Load Case 5: DEAD + WIND
L1 X 1.1+L2X 1.3 (Use REPEAT LOAD, not
Load Combination)
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ATTRIBUTE

DATA

Analysis Type

PDELTA

Concrete Design

Consider load cases 4 and 5 only.

Parameters: Ultimate Strength of Steel : 415 N/sq.mm
Concrete Strength : 25 N/sg.mm

Clear cover for top : 25 mm
Clear cover for bottom : 30 mm
Clear cover for side : 25 mm

Design beams 2 and 5
Design columns 1, 3 and 4
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2.3 Starting the program

Select the STAAD.Pro icon from the STAAD.Pro 2006 program
group.

o e : —
19 Paint 1) muvee Technologies » 1) section Wizard
v I Oniine Services » ) STAAD.etc
@ Notepad [E) PrintMe Internet Printing > ) STAAD. foundation
) QuickTime 5 77 STAAD.Pro 2005 Learming Resources
E Micrasoft Word ) Soric 4 L3 et
i starup 5 [ OpenSTAAD Reference Documentation
i STAAD.Pro 2005 || () Zone.com Deluxe Games v B REI Application Assistant
[& Adobe Reader 5.0 (] Revison History
@ adebe ATt 505 g e cociorer $ st
Microsoft Access @3 STAAD.ProLanguage Settings
@ Mcrosoft Photo Edit] Microsaft Excel [ STAAD.Pro Online Documentation
E Microsoft Excel @ Microsoft Money 2005
& Microsoft Office PowerPoint Viewer 2003
Calaulator Microsoft Outiook
Microsoft PonerPoint
e Microsoft Word
Microsoft Works Task Launcher
MSN
i start ) Outiook Express

Figure 2. 2
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The STAAD.Pro Graphical Environment will be invoked and the
following screen comes up.

=lelx
Fie Help

DES DB X D2ty G EES (@A ED ||| A N2 MA(|BREES

[T R e Y a— ||
AHYRERLSARZTOR||S G G vt 2 E PSS T

AR

rmmmia hserrmenaion Fmed iruchas vih kads sppbed
vy plar. i B vl greweal

ot T Mo @ FioPond O Docaiewton
 Millmeter " Fiometer T Fdogam T FdoMowdon

Length Lints Force Units
Floch  C Decanelee CPond " Newon
" Centimetes T Mot Ton T Megalowhon

¥ Dinpay thes chsiog bew: af the Starmp.
e T |

Figure 2. 3

This New dialog box will come up every time we start the program.
To turn this feature off, simply uncheck the Display this dialog box
at Startup box at the lower left hand corner. This feature can be
turned on again at a later time when File | New is invoked from the
main menu.
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Note about the unit system :

There are two base unit systems in the program which control the
units (length, force, temperature, etc.) in which, values,
specifically results and other information presented in the tables
and reports, are displayed in. The base unit system also dictates
what type of default values the program will use when attributes
such as Modulus of Elasticity, Density, etc., are assigned based on
material types — Steel, Concrete, Aluminum — selected from the
program’s library (Please refer to Section 5 of the STAAD.Pro
Technical Reference Manual for details). These two unit systems
are English (Foot, Pound, etc.) and Metric (KN, Meter, etc.).

If you recall, one of the choices made at the time of installing
STAAD.Pro is this base unit system setting. That choice will serve
as the default until we specifically change it.

The place from where we can change this setting is under the File |
Configure menu. To get to that option, first close down the dialog
box shown in the earlier figure by clicking on Cancel. Then, click
on the File | Configure menu option (see figure below) and choose
the appropriate unit system you want. For this tutorial, let us
choose the Metric units (KN, Meter, etc.).

File Egl]

2 new Ctrl+M

= Open... ctrl+0
Open Archive. ..

Cpen Backup Manager
Import...

Create Archive...
Extract Archive...

Recent STAAD Files 4
Recent STAAD Archives L

Exit

Figure 2. 4
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Configure Program

| STAAD Default Design Codes || Global Axds Orientation || Working Directony |

InputOutput File Format || Emor File Format || File Options

Base Unit | Background Color || Section Profile Table || Analysis Engine |

Cument Default Base Metric

Select Base Unit:

e

Accept H Cancel ][ Apply ] Help

Figure 2.5

Click on the Accept button to close the above dialog box.
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Following this, select File | New once again.

2=8 Help

2) = Crl+N

= Cpen... Ctrl+0
Open Archive. ..

Open Backup Manager
Import...

Create Archive...

Extract Archive...
Configure, ..
Recent STAAD Files »
Recent STAAD Archives »
Exit

Figure 2. 6

The dialog box shown in Figure 2.3 will re-appear.
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2.4 Creating a new structure

1. In the New dialog box, we provide some crucial initial data
necessary for building the model.

The structure type is to be defined by choosing from among Space,
Plane, Floor and Truss. A Space type is one where the structure,
the loading or both, cause the structure to deform in all 3 global
axes (X, Y and Z). In a Plane type, the geometry, loading and
deformation are restricted to the global X-Y plane only. A Floor
type is a structure whose geometry is confined to the X-Z plane. A
Truss type of structure carries loading by pure axial action. Truss
members are deemed incapable of carrying shear, bending and
torsion. For our model, let us choose Space.

We choose Meter as the length unit and Kilo Newton as the force
unit in which we will start to build the model. The units can be
changed later if necessary, at any stage of the model creation.

We also need to provide a name in the File Name edit box. This is
the name under which the structure data will be saved on the
computer hard disk. The name “Structure?” (? will be a number) is
recommended by the program by default, but we can change it to
any name we want. Let us choose the name rcframe.

A default path name - the location on the computer drive where the
file will be saved — is provided by the program under Location. If
you wish to save the file in a different location, type in the name,

or click the E‘ button and specify the desired path.

After specifying the above input, click on the Next button.
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New x|
File Mame :
Plane
O Ilcframe
O Flaar
O Truss Location :

IE:'\test‘\ _I

4 SPACE structure, which iz a three-dimensional framed structure with loadz applied in
any plane, is the most general.

Length Units—————————————— Force Units
" |nch " Decimeter " Pound = Mewton
" Faot * Meter " KiloPound € Decaklewtan
= Milimeter 1 Kilometer " Kilogram & KiloMewton
" Centimeter " Metic Ton " MegaMNewton

[v Dizplay this dialog bos at the Startup

< Back I Mext > N I Canhcel Help

Figure 2.7

2. In the next dialog box, we choose the tools to be used to initially
construct the model. Add Beams, Add Plates or Add Solids are,
respectively, the starting points for constructing beams, plates or
solids. Open Structure Wizard provides access to a library of
structural templates which the program comes equipped with.
Those template models can be extracted and modified
parametrically to arrive at our model geometry or some of its parts.
If the model is to be created initially using the STAAD command
language, the Open STAAD Editor box can take us to the STAAD
editor. Please remember that all these options are also available
from the menus and dialog boxes of the GUI, even after we dismiss
this dialog box.

Note: If you wish to use the Editor to create the model, choose
Open STAAD Editor, click Finish, and proceed to Section 2.8.
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For our model, let us check the Add Beam option. Click on the
Finish button. The dialog box will be dismissed and the
STAAD.Pro graphical environment will be displayed.

Where do you want to go 7 il

[ 4dd Flate
O 4dd Salid
[ Open Structure Wizard
[0 Open STAAD Editar
[ Edit Job Infarmation

<1 I

Begin building pour model by creating new joints and beams uzing the construction grid,
drawitg tools and spreadshests.

¥ Dizplay thiz dialog box at the Startup

< Back I Firizh .E I Cancel Help

Figure 2. 8
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2.5 Elements of the STAAD.Pro screen

The STAAD.Pro main window is the primary screen from where
the model generation process takes place. It is important to
familiarize ourselves with the components of that window before
we embark on creating the RC Frame. Section 1.5 in tutorial
problem 1 of this manual explains the components of that window
in detail.
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2.6 Building the STAAD.Pro model

We are now ready to start building the model geometry. The steps
and, wherever possible, the corresponding STAAD.Pro commands
(the instructions which get written in the STAAD input file) are
described in the following sections.
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2.6.1 Generating the model geometry

The structure geometry consists of joint numbers, their
coordinates, member numbers, the member connectivity
information, plate element numbers, etc. From the standpoint of the
STAAD command file, the commands to be generated for the
structure shown in section 2.2 are :

JOINT COORDINATES

1000.00.0;,20.0350.0
36.03.500;46.00.00.0
56.00.06.0;66.03.56.0

MEMBER INCIDENCE
112;223;334;456;536

Steps:

We selected the Add Beam option earlier to enable us to add beams
and columns to create the structure. This initiates a grid in the main
drawing area as shown below. The directions of the global axes (X,
Y, Z) are represented in the icon in the lower left hand corner of
the drawing area.
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A Snap Node/Beam dialog box also appears in the data area on the
right side of the screen. In our structure, the segment consisting of
members 1 to 3, and nodes 1 to 4, happens to lie in the X-Y plane.
So, in this dialog box, let us keep X-Y as the Plane of the grid. The
size of the model that can be drawn at any time is controlled by the
number of Construction Lines to the left and right of the origin of
axes, and the Spacing between adjacent construction lines. By
setting 12 as the number of lines to the right of the origin along X,
7 above the origin along Y, and a spacing of 0.5 meter between
lines along both X and Y (see figure below) we can draw a frame
6m X 3.5m, adequate for our segment. Please note that these
settings are only a starting grid setting, to enable us to start
drawing the structure, and they do not restrict our overall model to
those limits.

Linear IHadiaIl Inegularl

—Plane Angle of Plane®
LOA'S LI5S
oz vy o]
CYZ 22
— Girid Origin [m)
# i z
N i R
r Construction Lines
Spacing
Left Fight m Skew®
o @ B b

—Labels
™ Local Coordinate

[~ Rel Coords I Awislds Font... |

End(s]  Freg
3 R | = N -
vt =[x Tz |

[~ Snap to existing nodes too

Snap Mode/B eaml Close I
Figure 2. 10
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To start creating the nodes, let us first activate the Snap
Node/Beam button by clicking on it. Then, with the help of the
mouse, click at the origin (0, 0) to create the first node.

35
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O e R L vt
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. FEEE |
0.5
0

0, 0) - origin

Figure 2. 11

In a similar fashion, click on the following points to create nodes
and automatically join successive nodes by beam members.

(0, 3.5), (6, 3.5) and (6, 0)
The exact location of the mouse arrow can be monitored on the
status bar located at the bottom of the window where the X, Y, and

Z coordinates of the current cursor position are continuously
updated.

A nodesbeams o e intersections sing eursar, Hold CTRL key down to reset % R000 Yo|0000  Z 0000 \nputUnils:W
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When steps 1 to 4 are completed, the frame will be displayed in
the drawing area as shown below.

Ed rcframe.std - Whole Structure =] 3

0 - i i
Y
Yy

Figure 2. 12
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5. At this point, let us remove the grid display from the structure. To

do that, click on the Close button in the Snap Node/Beam dialog
box.
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The grid will now be removed and the structure in the main
window should resemble the figure shown below.

Ed rcframe. std - Whole Structure =] B3

L

Figure 2. 14

It is very important that we save our work often, to avoid loss of
data and protect our investment of time and effort against power
interruptions, system problems, or other unforeseen events. To save
the file, pull down the File menu and select the Save command.
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Switching on node and beam labels

Yiew

Zoarm

&% Pan

Wiew Selected Objects Only
IT Alwayz Fit in Current Window

[ Tables...
E] 'hole Structure

Node and beam labels are a way of identifying the entities we have
drawn on the screen. In order to display the node and beam
numbers, right click anywhere in the drawing area. In the pop-up
menu that appears, choose Labels. Alternatively, one may access
this option by selecting the View menu followed by the Structure
Diagrams option from the top menu bar, and the Labels tab of the
dialog box that comes up.

Orientatian. .. F4

ey Structure Diagrams...

Hpen Wiew..
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Wiew M anagement

Toolbars. ..
Optiong...
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& 3D Rendering

Figure 2. 15
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In the Diagrams dialog box that appears, turn the Node Numbers
and Beam Numbers on and then click on OK.

[] Dimension (D)

Beams

Beam Mumbers (B) ]

[] Beam Orientation (O}
[]Beam Spec (&)
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[[]Beam Ends (E}
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Structure Loads and Results Scales | Labels
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Figure 2. 16
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The following figure illustrates the node and beam numbers
displayed on the structure. The structure in the main window
should resemble the figure shown below.

Ed rcframe. std - Whole Structure =] B3
3
2
3
1 4
1

Figure 2. 17

If you are feeling adventurous, here is a small exercise for you.
Change the font of the node/beam labels by going to the View menu
and selecting the Options command, and then selecting the
appropriate tab (Node Labels / Beam labels) from the Options

dialog box.
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Examining the structure shown in section 2.2 of this tutorial, it can

be seen that members 4 and 5 can be easily generated if we could

first create a copy of members 1 and 2 and then rotate those copied

units about a vertical line passing through the point (6, 0, 0, that is,
node 4) by 90 degrees. Fortunately, such a facility does exist which

can be executed in a single step. It is called Circular Repeat and is
available under the Geometry menu.

First, select members 1 and 2 using the Beams Cursor . (Please
refer to the ‘Frequently Performed Tasks’ section at the end of this
manual to learn more about selecting members.)

Then, either click on the Circular Repeat icon from the appropriate
toolbar, or, go to the Geometry | Circular Repeat menu option as
shown below.

Geometry

Modes

Snap/Grid Node »
& Insert Node...

Add Beam L4
Add Plate 4
g Add Solid
1o Add Surface
Create Colinear Beams
Connect Beams Along 4

ﬁ Create Infill Plates

Create Parametric Models,

i Translational Repeat. ..

EN

3
@ Generate Surface meshing

Generate Plate Mesh

Generate Slabf'wall Connection

Move. . L4
(-3 Rotate...

ﬁ» Mirrar. ..

™ Stretch Selected Member(s)
Intersect Selected Members L4

— Merge Selecked Members

IMerge Selected Modes

ﬂﬁ @"I\ _H_ G Renumber 4

Split Beam

S Break Bzams at Selecked Nodes
Circular Repeat

Run Structure Wizard

Figure 2. 18
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11. In the 3D Circular dialog box that comes up, specify the Axis of
Rotation as Y, Total Angle as 90 degrees, No. of Steps as 1 and the
vertical line as passing through Node 4. Instead of specifying as
passing through Node 4, one may also specify the X and Z co-
ordinates as 6 and 0 respectively. Leave the Link Steps box
unchecked and click on the OK button.

3D Circular E2
— Through

Ok

MNode: |4
E " I Cancel |
Faint; # Coordinate
Help |

IE

Z Coordinate

II:I
[~ Use thiz as Reference

Faint fo_r Beta angle
generation {1 Geomety Only

Total Anigle: IEID E degrees [ Link Steps
MNa of Steps: |1 E [ OpenBase

Ak of Rotation

Rakne e Poly

G obal Aues

iz of Rotation

Cw oy 2z

Figure 2. 19
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After completing the circular repeat procedure, the model will

look as shown below.
Before

Figure 2. 20
After
2
4
1
Figure 2. 21

If any of the members are presently selected, let us unselect them
by clicking anywhere else in the drawing area. Then, let us once
again save the work by pulling down the File menu and selecting

the Save command.
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2.6.2 Changing the input units of length

As a matter of convenience, for specifying member properties for
our structure, it is simpler if our length units are millimeter instead
of meter. This will require changing the current length units of
input. The commands to be generated are:

UNIT MMS KN
Steps:

1.  Click on the Input Units icon from the appropriate toolbar.
P
|l al e 2 A

!
Input Units

Figure 2. 22

Alternatively, one may select the Tools | Set Current Input Unit
menu option as shown in the next figure.
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Figure 2. 23

Tutorial 2

In either case, the following dialog box comes up. Set the Length
Units to Millimeter and click on the OK button.

Set Current Input Units

— Length Unitz —Force Unitz
= Inch " Decimetsr " Pound
 Faot = Meter " KiloPound
& Milimeter € Kilomster " Metiic Ton
" Centimeter ' Kilogram

= Mewatar

" DecaMewton
& KiloNewton

" MegaMewton

ak [E I Cahicel |

Figure 2. 24
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2.6.3 Specifying member properties

Our next task is to assign cross section properties for the beams
and columns (see section 2.2). For those of us curious to know the
equivalent commands in the STAAD command file, they are :

MEMB PROP

14 PRIS YD 300 ZD 275
25PRIS YD 350 ZD 275
3 PRIS YD 350

Steps:

1. Click on the Property Page icon located on the Structure Tools
toolbar.

|Blgw s

Property Page

Figure 2. 25
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Alternatively, one may go to the General | Property page from the
left side of the screen as shown below.
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Figure 2. 26
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2. In either case, the Properties dialog box comes up. The property
type we wish to assign is called PRISMATIC, and is available
under the Define button in the Properties dialog box as shown

below.
x
Section | Beta .-’-‘mglel
Fef Section I aterial
[¥ Highlight Assigned Geometry
Edt. | Delete...
Walues. . | Section Database Define...
b aterials.. | Thickness... | | dzer Table... |
Azzignment Method
{71 Assign To Selected Beams & Use Cursor To Assign
= Assign To Edit List = fesign To View
Azgign | Cloze Help
Figure 2. 27
3. In the dialog box that comes up, select the Rectangle tab. Notice

that the field called Material is presently on the checked mode. If
we keep it that way, the material properties of concrete (E,
Poisson, Density, Alpha, etc.) will be assigned along with the
cross-section name. The material property values so assigned will
be the program defaults. We do not want default values, instead we
will assign our own values later on. Consequently, let us uncheck
the Material box. Then, enter the following values:

YD =300mm ZD =275mm
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Finally, click on the Add button as shown below.

Property B
g Rectangle
i
==]

h Trapezaidal
h General
B Tapeedi p—2z0—
B Tapored Tube T
B 2ssion Profile vD: |300 m

il

l ZD: IZ?S— i

I Material ( Uncheck this I
|concRETE <]
Add Assign Closs Help
Figure 2. 28

To create the second member property (PRIS YD 350 ZD 275),
provide 350 for YD and 275 for ZD (instead of 300 and 275) and
click on the Add button.

To create the third member property, in the Property dialog box,
select the Circle option. Specify the diameter (YD) as 350 mm.
Once again, uncheck the Material box and click on the Add
button.

Property [ x|
% Cicle Circle
= Rectangle
- Tee
= Tigpezoidal
= General
= Tapered|
= Tapered Tube
= Assign Profile

vb o |35 mm

™ Material
COMCRETE =
Add Bssign Close Help

LI
Material box in unchecked mode

Figure 2. 29

Now that we have finished creating the member properties, let us
Close this dialog box.
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The next step is to assign these member properties in the following
manner:

Rect 0.30x0.28 — members 1 and 4
Rect 0.35x0.28 — members 2 and 5
Cir 0.35 - member 3

To assign the member properties, follow these steps:

a. Select the first property reference in the Properties dialog
box (Rect 0.30x28).

b. Make sure that the “Use Cursor to Assign” button is
selected under the Assignment Method box.

4

c. Click on the Assign button. The cursor changes to I
Using the cursor, click on members 1 and 4.
Finally, click on the Assign button again, or type the ‘Esc’
button on your keyboard to stop the assignment process.

M[=]E3| : Properties - Whole Structure

Section | Beta Angle |

) B Halzial 1. Select the first
2 Rect0.350.28 > |property

3 Ci03s reference.
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4. Using this cursor, click on ﬁsig”me"; M:n‘mdt " £ Usel: o % assignment method
members 1 and 4. ssign o Selectzd Beams * Use Cursar To Assige s selected.

5 € Assign ToEdit List & fssign To View e

r_éwsm | ooe | Hen |
|

5. Go back and click on the 3. Click on the Assign button.
Assign button again to stop the
assiunment process.

Figure 2. 30

In a similar fashion, assign the remaining properties.
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After all the member properties have been assigned, the model will
look as shown below.

Edrcframe.std - Whole Structure =10l x|

2:R2

Ry

H:R1

-

Figure 2. 31

We ought to save the model once again by pulling down the File
menu and selecting the Save command.
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2.6.4 Specifying geometric constants

In the absence of any explicit instructions, STAAD will orient the
beams and columns of the structure in a pre-defined way.
Orientation refers to the directions along which the width and
depth of the cross section are aligned with respect to the global
axis system. The rules which dictate this default orientation are
explained in Section 1 of the STAAD.Pro Technical Reference
Manual.

We wish to orient member 4 so that its longer edges (sides parallel
to local Y axis) are parallel to the global Z axis. This requires
applying a beta angle of 90 degrees. The command which needs to
be generated is :

BETA 90 MEMB 4
Steps:
1.  Select the Beta Angle tab in the Properties dialog box.

2.  Click on the Create Beta Angle button. In the ensuing dialog box,
specify the angle as 90 degrees. Select member 4 using the Beams

Cursor
Notice that as we select the member, the Assignment Method
automatically sets to Assign to Selected Beams. Click on the

Assign button.

Click anywhere in the drawing area to un-highlight the member.
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e hole T Beta Angle
Section | Beta Angle Angle
(®) Angle in Degrees
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Highlight Assigned Geometry
Creas Beta Angle Edit Jl Lok [ caea | [ Hew
e
Assignment Method
(%) Use Cursor To Assign
() Assign To Edit List () Assign To View
Assign ‘ Close Help

Figure 2. 32

(An alternative method to assign beta angles is the following. First
select the member for which you wish to assign the beta angle.
Then, go to the Commands | Geometric Constants | Beta Angle
menu option. Specify the Angle in Degrees to be 90, ensure that the
assignment method is “To Selection” and click on OK. )

Bela Angle
i rhnge———————————————————
Commands Analyze Mode Window Help
Plate Thickness P 5 I} |“ 0 ~ A & Angle in Degress IBD
| o 4
Surface Thickness " Angle
Member Fopery Raanamastq e
Material Constants 4«
Geometric Constants  Assign
Support Specifications » O Tolfiew & ToSelsction
- Flate Reference Faint. .
Member Specfications »
Plate Element 5pecifications 3 Clear Above Commands. .. 0K |: I Cancel Help
I aster/Slave 5pecification T
Figure 2. 33

One may view the orientation of the member local axes by going to
the View | Structure diagrams | Labels menu option and switching
on Beam Orientation.
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2.6.5 Specifying material constants

At the time of assigning member properties, we deliberately chose
not to assign the material constants simultaneously, since we
wanted to specify values which are different from the built-in
defaults. The desired values are listed at the beginning of this
tutorial. The corresponding commands we wish to generate in the

STAAD input file are:

CONSTANTS

E 22 ALL

UNIT METER
DENSITY 25.0 ALL
POISSON 0.17 ALL

Steps:

1. From the Commands menu, select Material Constants. To define
the Modulus of Elasticity, select the Elasticity option as shown

below.

Commands A&nalyze Mode ‘Window Help
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G [Shear Modulus] ...

Clear &bove Commands...

Loading

Analysiz

Post-Analpsiz Print

Design

4

Mizcellaneous

3

Figure 2. 34
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In the Material Constant dialog box that appears, enter 22 in the
Enter Value box. Since the value has to be assigned to all the
members of the structure, the current setting of the assignment
method, namely, To View, allows us to achieve this easily. Then,
click on OK.

Material Constant - Elasticity E2

I aterial Canstant

 Aluminum
" Concrete
" Steel

{5 Erter Value [24 kM 2

Azzigh
’7 & Toview € ToSelection

Ok & I Cancel | Help

Figure 2. 35

For specifying the DENSITY constant, it will be convenient if we

change our length units to meters. To change the length units, as
=

before, click on the Input Units icon == from the Structure
toolbar, or select the Tools | Set Current Input Unit menu option
from the top menu bar. In the Set Current Input Units dialog box
that comes up, specify the length units as Meter.

Set Current Input Units
Length Units——————— Force Unitz
" Inch " Decimeter " Pound " Newtaon
" Foot * Meter  KiloPound 7 DecaMewtan
€ Millimeter " Kilometer € Metic Ton % KiloMewton
" Centimeter " Kilogram " MegaMewton
’TI Cancel I

Figure 2. 36



2-40 | Tutorial 2
4.  Following the steps 1 and 2 above, we choose Commands |
Material Constants | Density, specify the value as 25KN/m?, and
assign To View.

5. To define the POISSON’S RATIO, using the similar procedure as
described above, provide the value 0.17 to all members in the
View.
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2.6.6 Specifying Supports

The base nodes of all the columns are restrained against translation
and rotation about all the 3 global axes (see section 2.2). In other
words, fixed supports are to be specified at those nodes. The
commands to be generated are :

SUPPORTS
1 4 5 FIXED

Steps:

1.  To create supports, click on the Support Page icon located in the
Structure Tools toolbar as shown below.

M@;s@ -

Support Page

Figure 2. 37
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Alternatively, one may go to the General | Support Page from the
left side of the screen.
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Figure 2. 38
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In either case, the Supports dialog box comes up. Since we already
know that nodes 1, 4 and 5 are to be associated with the Fixed

support, using the Nodes Cursor i’l select these nodes.

Then, click on the Create button in the Supports dialog box as
shown below.

i Supports - Whole Structure E3

Fef Degcription

51 Mo support

Edit Create RJ Delete

Azsignment Method
& Agsign To Selected Nodes
 Agsign To View
" Use Cursor To Assign
 Agsign To Edit List

Aszzign | Cloze | Help

Figure 2. 39
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4.  The Create Support dialog box comes up. In the dialog box, the
Fixed tab happens to be the default which is convenient for this
case. Click on the Assign button as shown below.

Create Suppoit |
Enforced But I kultilinear Spring I Foundation I Inclined
Fixed | Finned | Firmed But | Enfarced

— Restraint
¥ R 7
¥ Fy 7 My
| v wz
Add Cancel Azzigh %J Help

Figure 2. 40
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After the supports have been assigned, the structure will look like
the one shown below.

Figure 2. 41

Click anywhere in the drawing area to un-select all selected nodes
and prevent accidental assignment of unwanted data to those nodes.

As earlier, save the work completed so far by going to the File
menu and clicking on the Save command.
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2.6.7 Specifying Loads

5 load cases are to be created for this structure. Details of the
individual cases are explained at the beginning of this tutorial. The
corresponding commands to be generated are listed below. Notice
that cases 4 and 5 are to be generated not as the standard
combination type, but using a combination load type called
REPEAT LOAD. The instructions at the beginning of this tutorial
require us to analyze this structure using an analysis type called
PDelta. A Pdelta analysis is a non-linear type of analysis. In
STAAD, to accurately account for the PDelta effects arising from
the simultaneous action of previously defined horizontal and
vertical loads, those previous cases must be included as
components of the combination case using the REPEAT LOAD

type.
UNIT METER KG

LOAD 1 DEAD LOAD
SELFWEIGHT Y -1
MEMBER LOAD

25 UNI GY -400

LOAD 2 LIVE LOAD
MEMBER LOAD
25 UNI GY -600

LOAD 3 WIND LOAD
MEMBER LOAD

1 UNI GX 300

4 UNI GX 500

LOAD 4 DEAD + LIVE
REPEAT LOAD
112215
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LOAD 5 DEAD + WIND
REPEAT LOAD
111313

Steps:
LOAD CASE 1

To create loads, click on the Load Page icon located on the
Structure Tools tool bar.

|Bme=

Load Page
Figure 2. 42

Alternatively, one may go to the General | Load Page from the left
side of the screen.
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Figure 2. 43
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2. A window titled “Load” appears on the right-hand side of the
screen. To initiate the first load case, highlight the Load Cases
Details option and click on the Add button.

Load 3]

1)
17} | oad Cases Details r1. Highlight Load Cases Deta\\s]
D Losd \

[ Toggle Load : 2. Click on the Add button I
Assignment Method

| Close Help
Figure 2. 44

3. The Add New Load Cases dialog box comes up. The drop-down list
box against Loading Type is available in case we wish to associate
the load case we are creating with any of the ACI, AISC or IBC
definitions of Dead, Live, Ice, etc. This type of association needs
to be done if we intend to use the program's facility for
automatically generating load combinations in accordance with
those codes.

Notice that there is a check box called Reducible per UBC/IBC.
This feature becomes active only when the load case is assigned a
Loading Type called Live at the time of creation of that case.
Please refer to STAAD.Pro 2004 Release Report for further details.

As we do not intend to use the automatic load combination
generation option, we will leave the Loading Type as None. Enter
DEAD LOAD as the Title for Load Case 1 and click on Add.
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Add Hew Load Cases
o Prnary
B Load Generation

B Define Combinations

B 4uto Load Combination

Murnber |1 Loading Type INone j

I~ Fedicible per IBEABE

Title IDEAD Loa0]

Add Cloge Help

Figure 2. 45

The newly created load case will now appear under the Load Cases
Details option.

+-[D] Definitions
= Load Cases Details
1: DEAD LOAD
Load Envelopes

Figure 2. 46
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4.  To generate and assign the selfweight load type, first highlight
DEAD LOAD. You will notice that the Add New Load Items dialog
box shows more options now.

+-[D] Definitions
- Load Cases Details

1: DEAD LOAD

[L] Load Envelopes

Figure 2. 47

5. In the Add New Load Items dialog box, select the Selfweight Load
option under the Selfweight item. Specify the Direction as Y, and
the Factor as -1.0. The negative number signifies that the
selfweight load acts opposite to the positive direction of the global
axis (Y in this case) along which it is applied. Click on the Add
button. The selfweight load is applicable to every member of the
structure, and cannot be applied on a selected list of members.

Add New : Load ltems fg

@ Sefwegt
Setfweight Load

@ Nodal Load )

@ Member Load Direction

@ Physical Member Load Ox (Oh4 Qz

g Area Load
Floor Load

@ Plizte Loads Factor

% Surface Loads

@ Soiid Loads

9 Temperature Loads

Q Seismic Loads

@ Time History

@ Wind Load

@ Snow Load

Q Response Spectra
Q Repeat Load
Q Frequency

[ Add I [ Cloge ] [ Help

Figure 2. 48
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Load 1 contains an additional load component, the member loads
on members 2 and 5. However, notice that the load values are
listed in the beginning of this tutorial in kg and meter units. Rather
than convert those values to the current input units, we will
conform to those units. The current input units, which we last set
while specifying Density, are KN and METER. We have to change
the force unit to Kilogram.

STAAD has a limitation in that one cannot change the units while
editing load cases. If we attempt to, the following message will be
displayed.

x
\I) Input unit change is not allowed while addingediting load items.
Figure 2. 49

Click on OK. Close the Add New Load Items dialog box. Then, go
to the Setup Page as shown below (or any other page).

I < Job

I L Design [L] AnalysisiPrint [ i Gengral [ F Geometry I = Setup

Figure 2. 50
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As before, click on the Input Units icon E from the top toolbar,
or select the Tools | Set Current Input Unit menu option from the
top menu bar. In the Set Current Input Units dialog box that comes
up, specify the force units as Kilogram. Again, click on General |
Load page to resume creating the load cases.

To create the member load, first, click on the expression DEAD
LOAD followed by the Add button. Then, click on the Member
Load item in the Add New Load Items dialog box.

Add New : Load ltems E

@ Sefweight
@ Nodal Load
@ Member Load Force
Uniform Farce d1|0 m
B Uniform Moment
[§ Concertrated Force W |-400 ka/m 2|0 m
B Concentrated Momen W

[ Linear Vaning d3 43|0 -
B Tepezoidal
B Hydrostatic
Direct
B Pre/Post Stress d g2 rEeen
B Ficd End

OX(ca) OGX  OPX
Q Physical Member Load

@ Area Load OYioca) @Gy OPY
g Elifg LLDD::S QZ(oca) QGZ Orz
@ Surface Loads

@ Solid Loads

@ Temperature Loads
@ Seismic Loads

@ Time History

@ Wind Load

@ Snow Load

0 Response Spectra
Q Repeat Load

Q Frequency

£ >

l Add I [ Close ] [ Help

Figure 2. 51

Select the Uniform Force option and specify GY as the Direction
and -400 as the Force. For these members, since the local Y axis
coincides with the global Y axis, one may choose the direction of
the load as either “Y” or “GY”, they will both have the same
effect. (One may view the orientation of the member local axes by
going to View | Structure Diagrams | Labels | Beam Orientation.)
The negative value signifies that the load acts along the negative
GY direction. Then, click on the Add button followed by the Close
button.
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9.  The member load we just created has to be assigned to members 2
and 5. First, make sure that the expression UNI GY -400Kg/m is
selected in the Load dialog box as shown below.

#-[D) Definitions
E| Load Cases Details
2@ 1:DEAD LOAD
ol SELPWEIGHT ¥ A1
(SR I Gr 400 ko/m

Figure 2. 52

10. Next, select members 2 and 5 using the Beams Cursor ‘ by |
(Please refer to the ‘Frequently Performed Tasks’ section at the
end of this manual to learn more about selecting members.)

Then, click on Assign to Selected Beams followed by the Assign

button.
Azzignment Method
" Aszign To Selected Beams " Use Cursor To Assign
" Agzign To View " Aszign To Edit List
Assigh | Cloze | Help
Figure 2. 53

As we click on the Assign button, the following dialog box
appears. This message box appears just to confirm that we indeed
wish to associate the loadcase with the selected beams. So, let us
choose Yes.

STAAD Pro for Windows E

The Azzighment method you have chozen iz Assign to Selected Beams.
Do pou want to proceed?

es Mo |

Figure 2. 54
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After the load has been assigned, the structure will look as shown
below:

Ed ricframe_std - Whole Structure

(O] ]

-

P

&

Figure 2. 55



LOAD CASE 2

11. The next step is to initiate the second load case which again

Tutorial 2

contains MEMBER LOADs. Highlight Load Cases Details and
click on the Add button. Once again, the Add New Load Cases

dialog box comes up.

Load

X

+- [0 Definitions
= Load Cases Details

= 1:DEAD LOAD

[L) Load Envelopes

& SELFWEIGHT Y -1
e UNIGY -400ka/m

: 1. Highlight this I

: 2. Click on Add I

[ Toagle Load
Assignment Method

| Close Help

In this dialog box, once again, we are not associating the load case

Figure 2. 56

we are about to create with any code based Loading Type and so,
we will leave that box as None. Specify the Title of the second
load case as LIVE LOAD and click on the Add button.

Add New Load Cases =
Fimay
B Load Generation
B Define Combinations
Auto Load Combination
Humber [2 Loading Type : [None =
I~ | Aedusible per UEE/BE
Tite |LWE LoAD|

Figure 2. 57

2-55
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12. To create the member load, highlight LIVE LOAD as shown
below.

Load

#-[D] Definitions
E|"- Load Cazes Detailz
= [ 1:DEAD LOAD

Figure 2. 58

13. Follow steps 7 to 10 to create and assign a uniformly distributed
force of -600Kg/m on members 2 and 5.

After the second load case has been assigned, the structure will
look as shown below:

Ed icframe.std - Whole Structure | _ O] x|
5]
2
5

2 3
B

n |
1

]

E‘x 2]

Figure 2. 59

Click anywhere in the drawing area to un-highlight the members.



14.

15.

16.
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LOAD CASE 3

Creating the third load case, which again has MEMBER LOADs,
involves the same procedure as that for load case 2. As before, first
highlight Load Cases Details in the Load dialog box to initiate the
third load case. Enter WIND LOAD as the Title for Load Case 3.

To apply the load on member 1, follow the procedure similar to
that in steps 7 to 10. The only differences are, the member which
receives this load is 1, the Direction is GX and the Force is
+300Kg/m.

Similarly, for member 4 and the third load case, specify the Force
as 500Kg/m and the Direction as GX.

After the third load case has been assigned, the structure will look
as shown below:

E rcframe._std - Whole 5 tucture = 3

™~
=]

Figure 2. 60
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17.

18.

19.

20.

LOAD CASE 4

We now come to the point where we have to create load case 4 as
(1.2 x Load 1) + (1.5 x Load 2). We saw in the beginning of this
section that we should be creating a “REPEAT LOAD” type of
combination, and not the “LOAD COMBINATION” type. To
initiate load case 4, highlight Load Cases Details in the Load
dialog box and specify the title as DEAD + LIVE.

Then, click on DEAD + LIVE in the Load dialog box as shown
below.

Load E2 I

@ Definitions
E-[L) Load Cases Details
= 1:DEAD LOAD

el UNIGY 500 kg/m
2@ 2:wIND LOaAD

Figure 2. 61

In the Add New Load Items dialog box, click on the Repeat Load
option. Then, select Load Case 1 (DEAD LOAD), click on the
button and enter the Factor as 1.2. (This indicates that the load
data values from load case 1 are multiplied by a factor of 1.2, and
the resulting values are utilized in load case 4.)

Similarly, select Load Case 2 (LIVE LOAD), click on the
button and enter the Factor as 1.5.
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The Add New Load Items dialog box will now look as shown

below. Click on the Add button.

Add New : Load Items

@ Nodal Load

0 Member Load

@ Physical Member Load

@ Area Load

@ Floor Load

@ Plate Loads

0 Surface Loads

@ Soid Loads
Temperature Loads

@ Seismic Loads

0 Time Histary

@ Wind Load

0 Snow Load

Q Response Spectra

Q Repeat Load
Repeat Load

Q Frequency

6 Seffweight

|

Available Load Cases:

Repeated Load Definition:

X

3: WIND LOAD

W
II

~
EI

Load Cases

Factor |

Load Case 1

Load Case 2

12
15

Close

] [ Help

Figure 2. 62

No further operation is required for load case 4. The recipients
(members) of the loads in load case 4 are automatically chosen to
be the very same ones to which the components of the REPEAT
LOAD cases (loads 1 and 2) were assigned.
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The structure will now look similar to the one shown below.

Ed rcframe.std - Whole Stucture | [=] B3
1[5\“
~¥
~¥ F
2 Ny
¥ 57
2 3 \IF\lr
\1F\“
~¥
b
1 a5
4
2
2
gx Load 4

Figure 2. 63
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LOAD CASE 5

Since load cases 4 and 5 are near identical in nature, the same
procedure used in creating load case 4 is applicable for case 5 also.
Let us highlight Load Cases Details in the Load dialog box to
initiate the fifth load case. Enter DEAD + WIND as the Title for
Load Case 5.

Follow steps 18 to 20 except for associating a Factor of 1.1 with
the first load case and a Factor of 1.3 with the third load case.

The Add New Load Items dialog box will now look as shown
below. Click on the Add button.

X

Add New : Load Items

6 Selfweight
@ Nodal Load
@ Member Load Available Load Cases: Repeated Load Definition:

Q Physical Member Load 2 LIVE LOAD Load Cases Factor |
@ frea Load 4: DEAD = LIVE Z
Floor Load oad Caze 1 L
g Piate Loads Load Caze 3 13
Q Surface Loads
@ Solid Loads
@ Temperature Loads
Q Seismic Loads
Q Time Histary
@ Wind Load
@ Snow Load
Q Response Spectra
@ Fepeat Load
Repeat Load
@ Frequency

W
II

[

[ Add ] [ Close ] [ Help

Figure 2. 64

Since we have completed creating all the load cases, we may now
click on the Close button to dismiss the Add New Load Items
dialog box.
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The structure will now look similar to the one shown below.

E rcframe_std - Whole Structure [[=] B3
1;\“
|
~¥
2 ~
~Y
~¥
51
3 \IF\!F
\1F\“

—

2 ﬁ
/’
/
//r
/_’4
,’-’/’
/’
/’
5
/%

EX Load 5

Figure 2. 65

Let us save the work completed so far by going to the File menu
and selecting the Save command or by holding the ‘Ctrl’ key and
pressing the ‘S’ key.
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2.6.8 Specifying the analysis type

The analysis type for this structure is called P-Delta. Since this
problem involves concrete beam and column design per the ACI
code, second-order analysis is required and has to be done on
factored loads acting simultaneously. The factored loads have been
created earlier as cases 4 and 5. Now is the time to specify the
analysis type.

The command for a pdelta analysis will appear in the STAAD file
as:

PDELTA ANALYSIS
Steps:

1.  Go to Analysis/Print Page on the left side of the screen.

o Analysis/Print Commands
3
21
;‘ : Perfform Cable Analysis | PDelta Analysis | Change || Perfform Pushover Analysis
L= Perform Analysis | Perform Imperfection Analysis
=
)i Print Option
(=]
] % No Print
. " (O Load Data
=l () Statics Check
ElE
S| = () Statics Load
= | =
=2 (") Mode Shapes
32
@ =] © Both
5 OAl
£
]
E.
=
= ] After Current [ Close ] [ Help

Figure 2. 66



2-64

Tutorial 2

In the Analysis/Print Commands dialog box that appears, select the
PDelta Analysis tab. Then, click on the Add button followed by
the Close button.

Analysis/Print Commands

| Perform Analysis Perform Imperdection Analysis |

| Perform Cable Analysis | PDeta Analysis |Change || Perform Pushover Analysis |

Prirt Option
(¥ Mo Print

(") Load Data

Mumber of terations EI () Statics Load
[]Converge I:I ") Mode Shapes

(") Both
O Al

[] After Cumert Azsign Close ] [ Help

Figure 2. 67

Save the work again using the Save option of the File menu.
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2.6.9 Short-listing the load cases to be used

in concrete design

The concrete design has to be performed for load cases 4 and 5
only since only those are the factored cases. To instruct the
program to use just these cases, and ignore the remaining, we have
to use the LOAD LIST command.
The command will appear in the STAAD file as :

LOADLIST 45
Steps:

1. In the menus on the top of the screen, go to Commands | Loading
| Load List option as shown below.

Commands Analpze Mode Window Help
Plate Thickness WS 5 I} HJ D - e
Surface Thickness

€ @ @& @ Frfst Q £ [1: 0K
et rnsoa®
et Farsn: "

-

tember Property

-

Material Constants

Support Specifications 4
Member Specifications 4
Plate Element Specifications 4
I aster/Slave 5 pecification 4
Pre Analysis Print 4

P Define Diamping for Dynamics

Ainalyziz 4 Frimary Load...

Moving Load Generatian..
Pozt-tinalyziz Print 4 2 o

Load Combination...
Desian r Automatic Load Comnbinatior. .
Mizcellaneous L Load Commands

Define Primary Load Types..

Edit Auto Load Rules |

Figure 2. 68
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2. In the Load List dialog box that comes up, select load cases 4
(DEAD + LIVE) and 5 (DEAD + WIND) by holding the “Ctrl” key
down. Then, click on the button. Load cases 4 and 5 will be
selected and placed in the Load List selection box as shown below.
Click on the OK button.

Load List E

r— Load Case: r—Load List Ok %J
1: DEAD LOAD 5 4: DEAD + LIVE
2 LIVE LOAD —l 5 DEAD +WIND _Icame'
3 wIND LOAD 33 | Help |
<4 |
<
Use the » button to transfer selected Use the < button to remove selected load
load cases to the load list. Use »» to cazes from the load list. Use << to remove
tranzfer all all

Figure 2. 69
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2.6.10 Specifying concrete design parameters

Among the various terms which appear in the equations for design
of concrete beams and columns, some of them can be user
controlled, such as, the grade of concrete, or the maximum size of
reinforcing bar one may wish to use. Such terms are called
concrete design parameters. For the ACI code, a list of these
parameters is available in Section 3 of the STAAD.Pro Technical
Reference Manual. The parameters we wish to use, and the
corresponding command which ought to appear in the STAAD
input file are :

UNIT MMS NEWTON
CODE ACI

CLT 25 ALL

CLB 30 ALL

CLS 25 ALL

FC 25 ALL

FYMAIN 415 ALL
TRACK 1 ALL

Steps:

1.  Before we can start assigning the parameters, we want our force
units to be Newton and our length units to be millimeter. We last
set the units during load specification as Kg and Meter. To change

the units, as before, click on the Input Units icon E from the
appropriate toolbar, or select the Tools | Set Current Input Unit
menu option from the top menu bar. In the Set Current Input Units
dialog box that comes up, specify the force units as Newton and
the length units as Millimeter.

2. Next, go to Design | Concrete Page from the left side of the
screen. Make sure that under the Current Code selections on the
top right hand side, ACI is selected. Then, click on the Define
Parameters button in the Concrete Design dialog box.
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I % General Ii: Geometry I # Setup

[ = snearwal | B Footng | Auminum [ﬂnmne@lnucmﬂ Stel
~

. analysis/Print

L, Design

Il Concrete Desian - Whale Skruckur

K reframe. hole Structure

Current Code: ]
/ UNIT METER KN j‘
\ o JOINT COORDINATES

. MEMBER INCIDENCES
. UNIT MG KN

{22 MEMBER FROFERTY AMERICAN

# UNIT MMS KG
-E3 DEFINE MATERIAL START
/ UNIT S KN
- COMSTANTS

# UNIT METER KM
3 SUFFORTS
# UNIT S KN
{3 LOAD 1 LOADTYPE Nons TITLE DEAD |
(E3 LOAD 2 LOADTYPE Nons TITLE LIVE LC
(2 LOAD 3 LOADTYPE None TITLE WIND |
{22 LOAD 4 LOADTYPE None TITLE DEAD |
{23 LOAD 5LOADTYPE Nons TITLE DEAD |
# PDELTAANALYSIS
— LOAD LIST

# FINISH

e o
¥ Highlight Assigned Geometiy
I~ Toogle Assign

Select Define
Parameters: | Commands..

~ Assignment Methot——

€ fission Tio Selected Beams
£ ssian ToView

& Use Cursor To Assign
© dogn ToEdiL | _oectBroupDeck |

Ex pssion |

Cose | Hep |

Figure 2. 70

In the Design Parameters dialog box that opens, select the Clt
(Clear Cover for top) tab. Then, provide the value as 25mm and
click on the Add button as shown below.

Design Parameters | |

CLE CLT
CLS

CLT
DEFTH
EFACE

FC
FrralN
FYSEC

M AMAIN
MINMAIN
MINSEC
MMAG
MSECTION
REIMF
RHOMM
SFACE
TRACK
WIDTH

Clear cover for outermost top |25 mm

teinforcement:

u After add

Curent Azzign Cloze Help

Figure 2. 71
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Parameter Value
Clb 30
Cls 25
Fc 25

Fymain 415
Track 1.0

Il Concrete Design - Whole Struck

Current Code: | ACI vl

x|

g SELFWEIGHT ¥ -1
&-[E MEMBER LOAD
7-(E3 LOAD 2 LOADTYPE None TITLE LIVE LC
f-{E0 LOAD 3 LOADTYPE None TITLE WiIND L
£-(E0 LOAD 4 LOADTYPE None TITLE DEAD -
2-{E0 LOAD 5 LOADTYPE None TITLE DEAD -

vy PDELTAANALYSIS
-2y LOADLIST
=43 START CONCRETE DESIGN
./ CODE AC)
# UNIT MMS NEWTON
7
g CLE30
-~ CL525
@ FL25
G FrMalN 15
@ TRACK1
./ END CONCRETE DESIGN
# FINISH

all

Ll |

[V Highlight Assigned Geometry
I™ Toggle Assign

Select
Parameters..

Define

Commands...
Parameters..

- UNIT METER KG -

Lezignment b ethod
" Assign To Selected Beams/Plates
= Assign TaView

& Use Cursor To Assign
O AssinToEdkLis | 2obe oo /Derk|

Assign | Clase I Help |

Figure 2. 72
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To define the remaining parameters, follow the above procedure
and provide the following values.

When all the above parameters have been assigned, click on the
Close button in the Design Parameters dialog box.

After all the design parameters have been assigned, the Concrete
Design dialog box will look as shown below.

2-69
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The next step is to assign these parameters to all the members in
our model. The easiest way to do that is to use the Assign To View
method. Follow the steps as shown in the figure below.

CLE 30
CLS 25
FC25
FriaiN 415
TRACK 1

| e/ END CONCRETE DESIGN
b FINISH

4| |
Iv Highlight Assigned G eometry
[~ Toggle &ssign

Select Define
Parameters.. Parameters..

nll

Commands...

Aszighment Method

" Assign To Selected Beams/Flates
% fszign To View

" Use Cursor To Azsign
€ Assign To Edit List

Aezighn Cloze | Help

(1. Highlight the parameter]

(2. Click on Assign To View ]

Ei. Click on the Assign huttun]

Figure 2. 73

Let us save our structure once again using the Save option of the

File menu.
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2.6.11 Specifying design commands

Design commands are the actual instructions for the design of
beams and columns. We intend to design beams 2 and 5 and
columns 1, 3 and 4. The commands to be generated are :

DESIGN BEAM 25
DESIGN COLUMN 13 4

Steps:

1.  Design commands are generated through the dialog boxes available
under the Commands button in the Concrete Design dialog box. So,
let us click on the Commands button as shown below.

Il Concrete Design - Whole Structu x|
Curent Cod: [T ~|

-3 DEFINE MATERIAL START A
g UNIT MMS KN
-3 CONSTANTS
gt UNIT METER KN
-3 SUPPORTS
g UNIT MMS KN
E+E3 LOAD 1 LOADTYPE Nane TITLE DEAD |
/ UMIT METEF: K
7 SELPWEIGHT ¥ -1
£3 MEMEER LOAD
g0 LOAD 2 LOADTYPE Mane TITLE LIVE LC
10 LOAD 3 LOADTYPE Mane TITLE WIND |
g0 LOAD 4 LOADTYFE Mane TITLE DEAD -
#-(E3 LOAD 5 LOADTYPE Mane TITLE DEAD -
g POELTA AMALYSIS
&3 L0AD LIST
=23 $TART CONCRETE DESIGN
. CODE ALl
7 UNIT MMS MEWTON
. CLT 25

.4 [CLB 30 i
4| | »

¥ Highlight Assighed Geometmy

™ Toagle Assign
Select Define Commands
Parameters.. Parameters.

Assignment Method

]

S

{7 Assign To Selected Beams
" Agsign ToView

% se Cursor To Assign
C bssign To B L _Select roup/Deck |

Assign | Cloze | Help |

Figure 2. 74
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2. In the Design Commands dialog box that comes up, select the
DESIGN BEAM option and click on the Add button.

Design Commands

DESIGN BEAM

G DESIGN BEAM

| DESIGN COLUMN
E DESIGM 5LAB/ELEMEN"

E TAKE OFF Design beans For flesure. shear and torsion.

Thiz command haz no additional parameters.

K

m é[:ﬁ:int Add Assign Cloze Help

Figure 2. 75

3. We also need to add a command for designing columns. So, select
the DESIGN COLUMN option and click on Add button.

After steps 2 and 3 are completed, let us Close this dialog box.

4.  The next step is to associate the Desigh Beam command with
members 2 and 5 and the Design Column command with members
1, 3 and 4.

To do this, as before, first highlight the expression DESIGN
BEAM. Then, select members 2 and 5 using the Beams Cursor

‘ by | Click on Assign to Selected Beams followed by the Assign
button.

Azzighment Method

@ Azzign To Selected Beams
= pssign ToView
" se Cursor To Assign

' Assign To Edit List Select Group/Deck

Aszzigh | Cloge | Help |

Figure 2. 76
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As we click on the Assign button, the following dialog box
appears. This message box appears just to confirm that we indeed
wish to associate the design command with the selected beams. So,
let us say Yes.

STAAD Pro for Windows

The Azzignment method you have chozen iz Azzign to Selected Beams.
Do pou veant to proceed?

Yes Mo |

Figure 2. 77

Similarly, assign the Design Column command to members 1, 3
and 4

This concludes the task of assigning all the input for our model.
Let us Save the file one final time.
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2.7 Viewing the input command file

Let us now take a look at the data that has been written into the file
that we just saved above. The contents of the file can be viewed
either by clicking on the STAAD Editor icon or, by going to the
Edit menu and choosing Edit Input Command File as shown below.

Edit
2 Undo &dd Beam Chil+Z
£ Fedo Ll
& Cut Cirl+=
Copy Ctrl+C
B, Faste Ll
2 Delete Del
B Take Picture
|
File Edit Wiew Tools Select Geometry Commands Analyze I:gp-l" Ficture
BEa B XD _'Q BE B H Edit Input Command File
- ot = | |
PHIDD DD &S P P fsriancan Create New VB Macro...
_ﬁ b N o N O O = J E dit E xisting B Macro...

Figure 2. 78
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A new window will open up with the data listed as shown here:

lcflame.std - STAAD Editor M=l E3
File Edit ‘iew Toolz Help
= A
| M
AAAR|E = B TR
STAAD SPACE RC FRAMED STRUCTURE —
START JOE INFORMATION —
ENGINEER DATE

END JOE INFORMATION

INPUT WIDTH 79

UNIT METER EN

JOINT COORDIMATES

looo; 203,50 36 3.504a00 5606686 3.56;
MEMEEE. INCIDENCES

11 2; 22 3; 33 4;45¢a8; 56 3;

TNIT MMS EM b
MEMEEE. FROPERTY

1 4 PRIS ¥Dr 300 ZD 275

2 5 PRIZ ¥D 350 ZD 275

3 PEIS ¥D 350

COMNSTANTS

E 22 MEME 1 TO 5

DENZITY Z.5e-003 MEME 1 TO 5

POISS0M 0.17 MEME 1 TO 5
UNIT METEE EN

SUPPORTS

1 4 5 FIXED

LOAT 1 DEAD LOAD -
| 4 | | »
For Help, press F1 Line 1Caol 1 /;

Figure 2. 79

This window and the facilities it contains is known as the STAAD
Editor.
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We could make modifications to the data of our structure in this
Editor if we wish to do so. Let us Exit the Editor without doing so
by selecting the File | Exit menu option of the editor window (not
the File | Exit menu of the main window behind the editor
window).

As we saw in Section 2.1, we could also have created the same
model by typing the relevant STAAD commands into a text file
using either the STAAD editor, or by using any external editor of
our choice. If you would like to understand that method, proceed
to the next section. If you want to skip that part, proceed to section
2.9 where we perform the analysis and design on this model.
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2.8 Creating the model using the command file

Let us now use the command file method to create the model for
the above structure. The commands used in the command file are
described later in this section.

The STAAD.Pro command file may be created using the built-in
editor, the procedure for which is explained further below in this
section. Any standard text editor such as Notepad or WordPad may
also be used to create the command file. However, the STAAD.Pro
command file editor offers the advantage of syntax checking as we
type the commands. The STAAD.Pro keywords, numeric data,
comments, etc. are displayed in distinct colors in the STAAD.Pro
editor. A typical editor screen is shown below to illustrate its general
appearance.

rcframe. std - SproEdit H=] E3
File Edit “iew Toolz Help

DEHISR| s 2R | | Rl
A R|E= | B 2R

STLAT SPACE RC FRAMED STRUCTURE ﬂ

START JOBE INFORMATION

ENGINEEE DATE

END JOE INFORMATION

INPUT WIDTH 79

UNIT METEER EM

JOINT COOEDINATES

loono; 203.5036 3.504600: 560666 3.56;
MEMEEER INCIDENCES

11 2; 22 3; 33 4;45¢a8; 506 3;

DEFINE MATERTAL 3TAET

IS0TROPIC MATERIALL -
[<]] _'|_I
For Help, press F1 [Gre 1Ca 1 [ [ [ [ 2

Figure 2. 80
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To access the built-in editor, first start the program using the
procedure explained in Section 2.2. Next, follow step 1 of Section

2.4.
e x|

File Mame :

Ilcframs

Location :

[ stest [-]

&4 SPACE structure, which is a three-dimensional framed stiucture with loads applied in
any plane. is the most general.

Length Upits————————————— Force Urits
" Inch " Decimeter " Pound " Mewiton
" Foat = Mater " KioPound ¢ Decalewton
O Milimeter " Kiometer © Kiogram % KiloNewton
' Centimeter © Metric Tan ¢ MegaMewtan

¥ Display this dialog box at the Startup

< Back I Mext > I Cancel Help
3
Figure 2. 81

You will then encounter the dialog box shown below. In this dialog
box, choose Open STAAD Editor.

Where do you want to go ? 5‘

[ 4dd Beam

[ 2dd Flate

O dd Selid

O Open Stucture Wizard
Open S ) Editor

[ Edit Job Intormatian

411 |

Begin building your model using STAAD spntax commands [non-graphical interface) through
the STAAD editor.

¥ Display this dialag bo at the Startup
< Back I Finish I Cancel Help

Figure 2. 82
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At this point, the editor screen will open as shown below.

3 rcframe. std - SproEdit M=l E3
File Edt “iew Toolz Help

U w &
o B B D o |
R AL A E R TR

ST4AT SPACE

START JOE INFORMATION
ENGINEEE. DATE

END JOE INFORMATION
INPUT WIDTH 72

FINI:H

L

[«

For Help, press F1 |Lime 1Cal 1 | .z
Figure 2. 83

"

Delete all the command lines displayed in the editor window and
type the lines shown in bold below (You don’t have to delete the
lines if you know which to keep and where to fill in the rest of the
commands). The commands may be typed in upper or lower case
letters. Usually the first three letters of a keyword are all that are
needed -- the rest of the letters of the word are not required. The
required letters are underlined. (“SPACE” = “SPA” = “space” =

“spa’)
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Actual input is shown in bold lettering followed by explanation.

STAAD SPACE RC FRAMED STRUCTURE

Every input has to start with the word STAAD. The word SPACE
signifies that the structure is a space frame structure (3-D) and the
geometry is defined through X, Y and Z coordinates.

NIT METER K

Specifies the unit to be used.

JOINT COORDINATES
1000;20350;36350
4600;5606,66356

Joint number followed by X, Y and Z coordinates are provided
above. Semicolon signs (;) are used as line separators. That enables
us to provide multiple sets of data on one line.

MEMBER INCIDENCES
112;223;334
456,563

Defines the members by the joints they are connected to.

UNIT MMS KN

MEMBER PROPERTY AMERICAN
1 4 PRIS YD 300 ZD 275

2 5 PRIS YD 350 ZD 275

3 PRIS YD 350

Member properties have been defined above using the PRISMATIC
attribute for which YD (depth) and ZD (width) values are provided
in MM unit. When YD and ZD are provided together, STAAD
considers the section to be rectangular. When YD alone is
specified, the section is considered to be circular. Details are
available in Section 5 of the Technical Reference Manual.
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Material constant E (modulus of elasticity) is specified as
22KN/sg.mm following the command CONSTANTS.

NIT METER KN

CONSTANTS

ENSITY 25.0 ALL

ISSON 0.17 ALL

U|O

Length unit is changed from MMS to METER to facilitate the input
of Density. Next, the Poisson’s Ratio is specified.

BETA 90 MEMB 4

In the absence of any explicit instructions, STAAD will orient the
beams and columns of the structure in a pre-defined way (see
Section 1 of the Technical Reference Manual for details.) In order
to orient member 4 so that its longer edges (sides parallel to local
Y axis) are parallel to the global Z axis, we need to apply a beta
angle of 90 degrees.

Force units are changed from KN to KG to facilitate the input of
loads. Load case 1 is initiated along with an accompanying title.
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ELFWEIGHT Y -1
One of the components of load case 1 is the selfweight of the
structure acting in the global Y direction with a factor of -1.0.
Since global Y is vertically upward, the factor of -1.0 indicates that
this load will act downwards.

MEMBER LOAD
2 5 UNI GY -400

Load 1 contains member loads also. GY indicates that the load is in
the global Y direction. The word UNI stands for uniformly
distributed load. Loads are applied on members 2 and 5.

LOAD 2 LIVE LOAD

Load case 2 is initiated along with an accompanying title.

MEMBER LOAD
2 5 UNI GY -600

Load 2 also contains member loads. GY indicates that the load is in
the global Y direction. The word UNI stands for uniformly
distributed load. Loads are applied on members 2 and 5.

LOAD 3 WIND LOAD

Load case 3 is initiated along with an accompanying title.

MEMBER LOAD
1 UNI GX 300
4 UNI GX 500

Load 3 also contains member loads. GX indicates that the load is in
the global X direction. The word UNI stands for uniformly
distributed load. Loads are applied on members 1 and 4.

LOAD 4 DEAD + LIVE

Load case 4 is initiated along with an accompanying title.
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REPEAT LOAD
112215

Load case 4 illustrates the technique employed to instruct STAAD
to create a load case which consists of data to be assembled from
other load cases specified earlier. We are instructing the program
to analyze the structure for loads from cases 1 and 2 acting
simultaneously. The load data values from load case 1 are
multiplied by a factor of 1.2, and the resulting values are utilized
in load case 4. Similarly, the load data values from load case 2 are
multiplied by a factor of 1.5, and the resulting values too are
utilized in load case 4.

LOAD 5 DEAD + WIND
Load case 5 is initiated along with an accompanying title.

REPEAT LOAD
111313

We are instructing the program to analyze the structure for loads
from cases 1 and 3 acting simultaneously.

PDELTA ANALYSIS

The PDELTA ANALYSIS command is an instruction to the
program to execute a second-order analysis and account for P-delta
effects.

LOAD LIST 45

The above LOAD LIST command is a means of stating that all
further calculations should be based on the results of load cases 4
and 5 only. The intent here is to restrict concrete design
calculations to that for load cases 4 and 5 only.
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EC 25 ALL

YMAIN 415 ALL
RACK 1 ALL

2
3
2
5
A

T

—

We first line is the command that initiates the concrete design
operation. The values for the concrete design parameters are
defined in the above commands. Design is performed per the ACI
Code. The length units are changed from METER to MMS to
facilitate the input of the design parameters. Similarly, force units
are changed from KG to NEWTON. The TRACK value dictates the
extent of design related information which should be produced by
the program in the output. The parameters specified include
CLT(Clear cover for top surface), CLB (Clear cover for bottom
surface), CLS (Clear cover for sides), FC(Strength of concrete),
and FYMAIN(UItimate strength of steel). These parameters are
described in Section 3 of the Technical Reference Manual.

)

ESIGN BEAM 2 5

ESIGN COLUMN 1 3 4

)

The above commands instruct the program to design beams 2 and 5
for flexure, shear and torsion, and to design columns 1, 3 and 4 for
axial load and biaxial bending.

END CONCRETE DESIGN
This command terminates the concrete design operation.
EINISH

This command terminates the STAAD run.

Let us save the file and exit the editor.
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2.9 Performing the analysis and design

STAAD.Pro performs Analysis and Design simultaneously. In
order to perform Analysis and Design, select the Run Analysis
option from the Analyze menu.

File Edit Yiew Toolz Select Geometry Eammands|,-i\nal_|,|ze Mode ‘wWindow Help
|asaEm s B el B
Figure 2. 84

If the structure has not been saved after the last change was made,
you should save the structure first by using the Save command
from the File menu.

When you select the Run Analysis option from the Analyze menu,
the following dialog box appears:

Select Analysiz Engine E3

Analyziz Option |

f* STALD Analysis

™ Stardyre Sdvanced Snalysis

Run Ainalyzis l Cancel | Apply Help
Ly

Figure 2. 85

We are presented with the choice of 2 engines : the STAAD engine
and the STARDYNE Advanced Analysis engine. The STARDYNE
Analysis engine is suitable for advanced problems such as
Buckling Analysis, Modal Extraction using various methods, etc.
However, if the calculations call for steel or concrete design, UBC
load generation, etc., we have to select the STAAD engine. So, let
us ensure that the radio button is on the STAAD engine.
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Click on the Run Analysis button.

As the Analysis progresses, several messages appear on the screen
as shown in the next figure.

=i
++ Read Checlk Data in Load Ca=zes 18:19:49;'
++ Proce=ssing and setting up Load Vector. 18:19:49
++ Processing Element Stiffness Matri=. 18:19:49
++ Processing Global Stiffness Matrix. 18:19:49
++ Finished Processing Global Stifiness Hatrix. 0 =zec
++ Proce=sing Triangular Factorization. 18:19:49
++ Finished Triangular Factorization. 0 =ec
++ Calculating Joint Displacemnents. 18:19:49
++ Finished Joint Displacement Calculation. 0 =ec
++ Adju=sting Displacements 18:19:49
++ Calculating Hember Forces. 18:19:49
++ Analy=is Successfully Completed ++
++ Performing Concrete Design 18:19:49
++ Calculating Section Forces
++ Creating Displacement File {(DSP). .. 18:19:50
++ Creating Reaction File (EEA4) . . .
++ Calculating Section Forces
++ Creating Section Force File (BMDY . ..
++ Creating Section Displace File (SCH)Y. ..
++ Creating Design information File (DGH) . ..
++ Done. 18:19:50
0 Error{s). 0 Warningis)
*% End STAAD Pro Run Elaps=ed Time = 1 Secs=
*#* Output Written to File:
rofrans. anl =

£ Wiew Output File
™ Goto Post Processing Mode
*' Stay in Modeling Mode

Dane

Figure 2. 86

Notice that we can choose from the three options available in the
above dialog box :

" iew Output File
" Goto Post Processing Mode
¥ Stay in Modeling Maode

Figure 2. 87

These options are indicative of what will happen after we click on
the Done button.
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The View Output File option allows us to view the output file
created by STAAD. The output file contains the numerical results
produced in response to the various input commands we specified
during the model generation process. It also tells us whether any
errors were encountered, and if so, whether the analysis and design
was successfully completed or not. Section 2.10 offers additional
details on viewing and understanding the contents of the output
file.

The Go to Post Processing Mode option allows us to go to
graphical part of the program known as the Post-processor. This is
where one can extensively verify the results, view the results
graphically, plot result diagrams, produce reports, etc. Section 2.11
explains the post processing mode in greater detail.

The Stay in Modelling Mode lets us continue to be in the Model
generation mode of the program (the one we current are in) in case
we wish to make further changes to our model.
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2.10 Viewing the output file

During the analysis process, STAAD.Pro creates an Output file.
This file provides important information on whether the analysis
was performed properly. For example, if STAAD.Pro encounters an
instability problem during the analysis process, it will be reported
in the output file.

We can access the output file using the method explained at the
end of the previous section. Alternatively, we can select the File |
View | Output File | STAAD Output option from the top menu.
The STAAD.Pro output file for the problem we just ran is shown in
the next few pages.

STAAD.Pro - Structure1.std
F=0 Edit View Tools Select Geometry Commands Analyze Mode Window Help

£ tew 2 KEFEX BRasn

[ Cpen... Cirl+0

5 Close RO R IR S S R R )
Open Archive. .. G T Eb o o M G

NVhole Structure
Open Backup Manager

View Input Command File
Job Information

Report Setup,..

Output File + JEf[sTAAD Output

Printer Setup... [

Figure 2. 88
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The STAAD.Pro output file is displayed through a file viewer
called SproView. This viewer allows us to set the text font for the
entire file and print the output file to a printer. Use the appropriate
File menu option from the menu bar.

rcframe. anl - 5proYiew

File Edit ‘iew Help
[pern... [Ctrl+d

Print.... Ctrl+F
Print Preview
Print Setup...

?

Page Setup

Font Setup

v Top Mozt

Fecent File

E it

Figure 2. 89

By default, the output file contains a listing of the entire input also.

You may choose not to print the echo of the input commands in the
output file. Please select Commands | Miscellaneous | Set Echo
option from the menu bar and select the Echo Off button.

It is quite important that we browse through the entire output file
and make sure that the results look reasonable, that there are no
error messages or warnings reported, etc. Errors encountered
during the analysis & design can disable access to the post-
processing mode — the graphical screens where results can be
viewed graphically. The information presented in the output file is
a crucial indicator of whether or not the structure satisfies the
engineering requirements of safety and serviceability.
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STAAD.Pro

Version Bld
Proprietary Program of
Research Engineers, Intl.
Date=

Time=

Ok ok % ok o X % F
¥ ok ok X ok o X %

USER ID:

. STAAD SPACE RC FRAMED STRUCTURE
. START JOB INFORMATION
. ENGINEER DATE

- END JOB INFORMATION

- INPUT WIDTH 79

- UNIT METER KN

. JOINT COORDINATES
-.1000;203.50;363.50;4600;,5606; 663.56
. MEMBER INCIDENCES

10. 1 12; 223;334;456;563
11. UNIT MMS KN

12. MEMBER PROPERTY AMERICAN
13. 1 4 PRIS YD 300 ZD 275
14. 2 5 PRIS YD 350 ZD 275
15. 3 PRIS YD 350

16. CONSTANTS

17. E 22 MEMB 1 TO 5

18. UNIT METER KN

19. CONSTANTS

20. DENSITY 25.0 ALL

21. POISSON 0.17 ALL

22. BETA 90 MEMB 4

23. SUPPORTS

24. 1 4 5 FIXED

25. UNIT METER KG

26. LOAD 1 DEAD LOAD

27. SELFWEIGHT Y -1

28. MEMBER LOAD

29. 2 5 UNI GY -400

30. LOAD 2 LIVE LOAD

31. MEMBER LOAD

32. 2 5 UNI GY -600

33. LOAD 3 WIND LOAD

34. MEMBER LOAD

35. 1 UNI GX 300

36. 4 UNI GX 500

37. LOAD 4 DEAD + LIVE

38. REPEAT LOAD

39. 11.221.5

40. LOAD 5 DEAD + WIND

41. REPEAT LOAD
42.11.131.3

43. PDELTA ANALYSIS

OCONOOUODWNE

PROBLEM STATISTICS

NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS = 6/ 5/
ORIGINAL/FINAL BAND-WIDTH= 3/ 3/ 12 DOF
TOTAL PRIMARY LOAD CASES = 5, TOTAL DEGREES OF FREEDOM =

SIZE OF STIFFNESS MATRIX = 1 DOUBLE KILO-WORDS
REQRD/AVAIL. DISK SPACE = 12.0/ 43064.0 MB

18




Tutorial 2
44 . LOAD LIST 4 5
45_. START CONCRETE DESIGN
46. CODE ACI
47 . UNIT MMS NEWTON
48. CLT 25 MEMB 1 TO 5
49. CLB 30 MEMB 1 TO 5
50. CLS 25 ALL
51. FC 25 MEMB 1 TO 5
52. FYMAIN 415 MEMB 1 TO 5
53. TRACK 1 ALL
54_. DESIGN BEAM 2 5
BEAM NO. 2 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02
LEN - 6000. MM FY - 415. FC - 25. MPA, SIZE - 275. X 350. MMS
LEVEL HEIGHT BAR INFO FROM TO ANCHOR
(D} o) o) STA END
1 51. 2 - 16MM 313. 5437. NO NO
| |
1 CRITICAL POS MOMENT= 39.16 KN-MET AT 3000.MM, LOAD 4]
1 REQD STEEL= 366.MM2, ROW=0.0044, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ZACTUAL BAR SPACING= 273.7 41./ 184. MMS 1
1 REQD. DEVELOPMENT LENGTH = 480. MMS 1
| |
Cracked Moment of Inertia Iz at above location = 20964.0 cm™M4
2 306. 3 - 12mMm 0. 860. YES NO
| |
1 CRITICAL NEG MOMENT= 33.29 KN-MET AT 0.MM, LOAD 4]
1 REQD STEEL= 301.MM2, ROW=0.0036, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ZACTUAL BAR SPACING= 273./ 37.7 94. MMS 1
1 REQD. DEVELOPMENT LENGTH = 360. MMS 1
| |
Cracked Moment of Inertia Iz at above location = 19148.5 cm™4
3 306. 3 - 12mMm 4390. 6000. NO YES
| |
1 CRITICAL NEG MOMENT= 36.18 KN-MET AT 6000.MM, LOAD 4]
1 REQD STEEL= 329.MM2, ROW=0.0039, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ZACTUAL BAR SPACING= 273./ 37.7 94. MMS 1
1 REQD. DEVELOPMENT LENGTH = 360. MMS 1
| |
Cracked Moment of Inertia Iz at above location = 19148.5 cm™4
BEAM NO. 2DESIGN RESULTS - SHEAR
AT START SUPPORT - Vu= 43.94 KNS Vc= 72.44 KNS Vs= 0.00 KNS
Tu= 2.55 KN-MET Tc= 2.4 KN-MET Ts= 3.4 KN-MET LOAD 4
STIRRUPS ARE REQUIRED FOR TORSION.
REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1.
PROVIDE 12 MM 2-LEGGED STIRRUPS AT 130. MM C/C FOR 2705. MM
ADDITIONAL LONGITUDINAL STEEL REQD. FOR TORSIONAL RESISTANCE = 0.75 SQ.CM.
AT END SUPPORT - Vu= 44.91 KNS Vc= 71.94 KNS Vs= 0.00 KNS
Tu= 2.55 KN-MET Tc= 2.4 KN-MET Ts= 3.4 KN-MET LOAD 4

STIRRUPS ARE REQUIRED FOR TORSION.

REINFORCEMENT FOR SHEAR IS PER CL.11.5.5.1.

PROVIDE 12 MM 2-LEGGED STIRRUPS AT 130. MM C/C FOR 2705. MM
ADDITIONAL LONGITUDINAL STEEL REQD. FOR TORSIONAL RESISTANCE =

0.75 SQ.CM.
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2J 6000X 275X 350

!
3Nol2 H 306. 0.TO 860 3N0o12|H]306.4390.TO 6000 |
22*12c/c130 I | 122*12c/c130 ]

2Nol6 H 51. 313.TO 5437 1111111 |
|
|
|
11 11 11 11 |
000 I 1 I 1 11 000 I 1 000 |
3#12 1 1 1 1 | | 3#12 | | 3#12 ]
I 1 I 1 11 I 1 |
| | 2#16 | | 2#16 | | 2#16 1 1 ]
1 1 oo 1 1 oo 1 1 oo I 1 |
11 11 11 11 |
I 1 I 1 I 1 I 1 |
BEAM NO. 5 DESIGN RESULTS - FLEXURE PER CODE ACI 318-02
LEN - 6000. MM FY - 415. FC - 25. MPA, SIZE - 275. X 350. MMS
LEVEL HEIGHT BAR INFO FROM TO ANCHOR
(D) (D) (D) STA END
1 51. 2 - 16MM 313. 5437. NO NO
| |
1 CRITICAL POS MOMENT= 39.16 KN-MET AT 3000.MM, LOAD 4]
1 REQD STEEL= 366.MM2, ROW=0.0044, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ACTUAL BAR SPACING= 273./ 41./ 184. MMS ]
1 REQD. DEVELOPMENT LENGTH = 480. MMS 1
| |
Cracked Moment of Inertia 1z at above location = 20964.0 cm™M4
2 306. 3 - 12wMm 0. 860. YES NO
| |
1 CRITICAL NEG MOMENT= 33.29 KN-MET AT 0.MM, LOAD 4]
1 REQD STEEL= 301.MM2, ROW=0.0036, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ACTUAL BAR SPACING= 273./ 37./ 94. MMS ]
1 REQD. DEVELOPMENT LENGTH = 360. MMS 1
| |
Cracked Moment of Inertia 1z at above location = 19148.5 cm™M4
3 306. 3 - 12uMm 4890. 6000. NO YES
| |
1 CRITICAL NEG MOMENT= 36.18 KN-MET AT 6000.MM, LOAD 4]
1 REQD STEEL= 329_MM2, ROW=0.0039, ROWMX=0.0193 ROWMN=0.0033 |
1 MAX/MIN/ACTUAL BAR SPACING= 273./ 37./ 94. MMS ]
1 REQD. DEVELOPMENT LENGTH = 360. MMS 1
| |
Cracked Moment of Inertia 1z at above location = 19148.5 cm™M4
BEAM NO. 5DESIGN RESULTS - SHEAR
AT START SUPPORT - Vu= 18.56 KNS Vc= 72.56 KNS Vs= 0.00 KNS
Tu= 4.73 KN-MET Tc= 2.3 KN-MET Ts= 6.3 KN-MET LOAD 5

STIRRUPS ARE REQUIRED FOR TORSION.

REINFORCEMENT FOR SHEAR 1S PER CL.11.5.5.1.

PROVIDE 12 MM 2-LEGGED STIRRUPS AT 130. MM C/C FOR 2705. MM
ADDITIONAL LONGITUDINAL STEEL REQD. FOR TORSIONAL RESISTANCE =

1.40 SQ.CM.




Tutorial 2
AT END  SUPPORT - Vu= 19.11 KNS Vc=  71.87 KNS Vs= 0.00 KNS
Tu= 4.73 KN-MET Tc= 2.3 KN-MET Ts= 6.3 KN-MET LOAD 5
STIRRUPS ARE REQUIRED FOR TORSION.
REINFORCEMENT FOR SHEAR 1S PER CL.11.5.5.1.
PROVIDE 12 MM 2-LEGGED STIRRUPS AT 130. MM C/C FOR 2705. MM
ADDITIONAL LONGITUDINAL STEEL REQD. FOR TORSIONAL RESISTANCE =  1.40 SQ.CM.

6J 6000X 275X 350 3J

3No12 H 306. 0.T0 860 3No12 H 306.4890.T0 6000
22*12¢/c130 22*12¢/c130
2No16 H 51. 313.T0 5437 R

I 1 I 1 I 1 I 1
000 [ [ 1 1 1 1 000

3#12 11 11 11 | | 3#12
[ [ 1 1 1 1
| | 2#16 | | 2#16 | | 2#16 11
[ 00 [ 00 1 1 00 1 1
I 1 I 1 I 1 I 1
I 1 I 1 I 1 I 1

END OF BEAM DESIGN
55. DESIGN COLUMN 1 3 4
COLUMN  NO. 1 DESIGN PER ACI 318-02 - AXIAL + BENDING
FY - 415.0 FC - 25.0 MPA, RECT SIZE - 275.0 X 300.0 MMS, TIED
AREA OF STEEL REQUIRED = 882.8 SQ. MM
BAR CONFIGURATION REINF PCT.  LOAD  LOCATION  PHI
8 - 12 MM 1.097 4 END 0.650

(PROVIDE EQUAL NUMBER OF BARS ON EACH FACE)
TIE BAR NUMBER 8 SPACING 192.00 MM

COLUMN INTERACTION: MOMENT ABOUT Z -AXIS (KN-MET)

PO Pn max P-bal. M-bal . e-bal. (MM)
2109.38  1687.50 785.43 97.75 124.5

MO P-tens. Des.Pn Des.Mn e/h

47.51 -375.48 75.04 51.21 0.19497

COLUMN INTERACTION: MOMENT ABOUT Y -AXIS (KN-MET)

PO Pn max P-bal . M-bal . e-bal. (MVM)
2109.38 1687.50 775.80 88.78 114.4
MO P-tens. Des.Pn Des.Mn e/h

43.01 -375.48 75.04 3.92 0.01492
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COLUMN NO. 3 DESIGN PER ACI 318-02 - AXIAL + BENDING

FY - 415.0 FC - 25.0 MPA, CIRC SIZE 350.0 MMS DIAMETER TIED
AREA OF STEEL REQUIRED = 1096.8 SQ. MM

BAR CONFIGURATION REINF PCT. LOAD LOCATION PHI

10 - 12 MM 1.176 4 STA 0.650
(EQUALLY SPACED)
TIE BAR NUMBER =~ 8 SPACING 192.00 MM

COLUMN INTERACTION: MOMENT ABOUT Z/Y -AXIS (KN-MET)

PO Pn max P-bal . M-bal . e-bal. (MVM)
2489.81 1991.85 939.46 109.84 116.9
MO P-tens. Des.Pn Des.Mn e/h
62.23 -469.35 153.06 73.18 0.09660
COLUMN  NO. 4 DESIGN PER ACI 318-02 - AXIAL + BENDING

FY - 415.0 FC - 25.0 MPA, RECT SIZE - 275.0 X 300.0 MMS, TIED
AREA OF STEEL REQUIRED = 1056.0 SQ. MM

BAR CONFIGURATION REINF PCT. LOAD LOCATION PHI

4 - 20 MM 1.523 5 STA 0.650
(PROVIDE EQUAL NUMBER OF BARS ON EACH FACE)
TIE BAR NUMBER 8 SPACING 192.00 MM

COLUMN INTERACTION: MOMENT ABOUT Z -AXIS (KN-MET)

PO Pn max P-bal. M-bal . e-bal. (MM)
2247.93  1798.34 764.68 123.35 161.3

MO P-tens. Des.Pn Des.Mn e/h

63.35 -521.51 43.92 10.50 0.06829

COLUMN INTERACTION: MOMENT ABOUT Y -AXIS (KN-MET)

PO Pn max P-bal . M-bal . e-bal. (MVM)
2247.93 1798.34 755.33 111.44 147.5

MO P-tens. Des.Pn Des.Mn e/h

57.35 -521.51 43.92 47.50 0.30898

END OF COLUMN DESIGN RESULTS

56. END CONCRETE DESIGN
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57. FINISH

HxsxcwxxHxxxx END OF THE STAAD.Pro RUN **xsssssss

k% DATE= TIME=

Fekkk

* For questions on STAAD.Pro, please contact

* Research Engineers Offices at the following locations
*

* Telephone Email

* USA: +1 (714)974-2500 support@reiusa.com

* CANADA +1 (905)632-4771 detech@odandetech.com
*  CANADA +1 (604)629 6087 staad@dowco.com

* UK +44(1454)207-000 support@reel.co.uk

*  FRANCE +33(0)1 64551084 support@reel .co.uk

*  GERMANY +49/931/40468-71 info@reig.de

*  NORWAY +47 67 57 21 30 staad@edr.no

* SINGAPORE +65 6225-6015/16 support@reiasia.net

* INDIA +91(033)2357-3575 support@calcutta.reiusa.com
*  JAPAN +81(03)5952-6500 eng-eye@crc.co.jp

* CHINA +86(411)363-1983 support@reiasia.net

* North America support@reiusa.com

* Europe support@reel .co.uk

* Asia support@reiasia.net

Ok o % ok R X ok o X b Ok X X b X % ok X
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2.11 Post-Processing

STAAD.Pro offers extensive result verification and visualization
facilities. These facilities are accessed from the Post Processing
Mode. The Post Processing mode is used to verify the analysis and
design results and generate reports.

For this tutorial problem, we shall perform the following tasks:

o Display deflection diagrams

e Annotate Displacements

e Change the Display units for displacement values shown in the
tables.

e Switching between load cases for viewing deflection diagrams.

e Display the force and moment diagrams.

e Changing the degree of freedom for which the force/moment
diagram is plotted

e Annotating the force diagram

e Changing the Display units for the force and moment values
shown in the tables.

e Restricting the load cases for which results are viewed

e Using Member Query

e Viewing Concrete Design results using Query.

e Producing an on-screen report

e Taking pictures

e Creating Customized Reports
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2.11.1 Going to the post-processing mode

Steps:

1. At the end of section 2.9, we saw how one could go directly from
the Analysis window to the post-processing screen. However, the
formal method of accessing the Post Processing mode is either by
clicking on the Post-Processing icon from the top toolbar or from
the Mode menu as shown in the figures below.

-
B Sl

Post-Processing

Figure 2. 90
| Mode
Iﬁ taodeling
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The Results Setup dialog box appears as shown below. Select the
load cases for which to display the results. For our case, let us
select all the load cases. Then click on the OK button.

Results Setup

Loads | Range || Result View Options|

X

(%) Envelope of Load Cases in Selected List
Load Cases

Available: Selected:

1 DEAD LOAD
2 LIVE LOAD
3WIND LOAD
4 DEAD + LIVE
5 DEAD + WIND

e
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Figure 2. 92
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2.11.2 Viewing the deflection diagram

The screen will now look like the figure shown below.

STAAD.Pro - rehiame. std =] 3
Fie Edit View Took Select Resuts Repot Mode ‘Window Help

Y@EHr R g BEER” |2l esnab|[0sd -t A [BAEA|
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CIEIE - i
dlE = LA Do AL Surmmar
!l; s | 8 Horizontal | Vertical | Horizontal | Resultant Rotational |-
—| = 3 v z X 2] Z
5| 5 z tode ue mm mm mm mm rad rad rad
Elm 1 [1DEADLOA 0.000 0.000 0.000 0.000 0.000 0000 0000
£ A el ZLIVELOAD 0.000 0.000 0.000 0.000 0.000 0.000 0.000
1| e FVIND LOAD| 0.000 0.000 0.000 0.000 0.000 0.000 0.000
| 2 4DEAD + LIV 0.000 0.000 0.000 0.000 0.000 0.000 0000
kS £ g 5 DEAD + Wl 0.000 0.000 0.000 0.000 0.000 0000 0000
e} g i 2 [1DEADLOA -0.089 -0.043 0406 0414 0.000 0.000 -0.001
[V 2LIVELOAD -0.064 -0.03 0377 0384 0.000 0.000 -0.00
§ SWIND LOAD| 1108 0.003 0325 1155 0.000 -0.000 -0.000
= 4DEAD + LIV 0179 0102 1.081 1081 0.001 0000 -0.002
— £ 5 DEAD + Wl 1373 -0.044 0474 1828 0.000 -0.000 -0.001
L 5 3 [1DEADLOA -0.084 -0.070 0.084 0438 0.001 -0.000 0.0m H
b e aan nnen nnea nnra nans A ann o
= £ 4 i Y
= i rcframe. std - Beam Relati — o]
- LA [F ANl Relative Disy menté Max Relative Displacements /
Dist x z Resultant =
El 1 [1DEADLOA 0.000 0.000 0.000 0.000 0.000
— 875,000 0129 -0.000 0079 0151
E 750,000 0383 0,000 0409 0370
s 2625000 -0.401 -0.000 -0.085 0410
73 3500.000 0.000 0.000 0.000 0.000
5 2LIVELOAD 0.000 0.000 0.000 0.000 0.000
= 675.000 0420 -0.000 0073 0140
2 750,000 0328 -0.000 0401 0344
I 2625 000 0373 -0.000 -0.079 0.381
3500.000 0.000 0.000 0.000 0.000
SWIND LOAD| 0.000 0.000 0.000 0.000 0.000
Ex 675.000 -0.067 -0.000 -0.050 0.083
Displacement 1750.000 0.055 -0.000 -0.052 0.076
o ey i e E|
Far Help, press F1 [Post Mode [Load 1 : DEAD LOAD Input Units: [Nemm

Figure 2. 93

The diagram currently on display is the node deflection diagram
for load case 1 (DEAD LOAD). The title at the bottom of the
diagram is indicative of that aspect. If you, say, wandered off into
any other result diagram, and wanted to get back to the deflection
diagram, just select the Node | Displacement tab along the page
control area on the left side.
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Figure 2. 94

The option for selecting the deflection diagram is available from
another facility also - the Results | Deflection menu option - as
shown below.
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2.11.3 Switching between load cases for
viewing the deflection diagram

Steps:

1.  To change the load case for which to view the deflection diagram,
you may click in the list box called Active Load and choose the
one you want.
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Figure 2. 96

2. Alternatively, either click on the Symbols and Labels icon or, go to
View | Structure Diagrams menu option as shown below.
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Zonfi L4

&% Pan
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3. In either case, the Diagrams dialog box comes up. Select the
Loads and Results tab and choose the desired load case from the
Load Case list box. Then, click on OK.
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The diagram below shows the deflected shape of the structure for
load case 3.

B rcframe. std - Whole Structure = =] E3
2

2

b
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2]
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‘{ix Displacement

Figure 2. 99

To display the deflection for say, load case 5 (DEAD + WIND),
follow step 1 or 2 and select load case 5.
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The deflection of Load Case 5 will now displayed on the model as

shown below.

Ed| reframe. std - Whole Structure

T
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Displacement

Figure 2. 100
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2.11.4 Changing the size of the deflection
diagram

Steps:

If the diagram appears too imperceptible, it may be because it may

be drawn to too small a scale. To change the scale of the deflection
plot, you may

a) click on the Scale icon

EEer e e
¢ ) & [5 DEAD +wiND |
%28 -mm

Figure 2. 101

b) choose Scale from the Results menu
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Figure 2. 102

or
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¢) go to View | Structure Diagrams | Scales menu option.

All of the above will bring up the following dialog box.

x
Foree Limits I Apnimation | Desgign Results
Stucture I Loads and Results Scales | Labels
 Load Scales

[~ &pply Immediately

Paint Force: IW M per mn
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Paint. M anment: ME kipin per mm
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Bending v : IWE kiprin per mm
Bending £ : IWE kiprin per mnm
Shear r: IWE M per mni
Shear £ IWE M per mni
Anial: IWE M per mni

Torsion: 0.0393701 kipin per mm
( Dizplacement; |05 i per mm]

Beam Stress: |196.85 E psi per mm Save Az Default |
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ok I Cancel | Apply | Help |

Figure 2. 103

In the Displacement field, specify a smaller number than what is
currently listed, and click on OK. The deflection diagram should
now be larger.
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In the above dialog box, if you switch on the check box Apply
Immediately, pressing the up or down arrow keys alongside the
number will produce immediate results in terms of a smaller or a
larger diagram depending on whether you click the up or the down
arrow keys.
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-
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0k I Cancel | Apply | Help |

Figure 2. 104
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2.11.5 Annotating displacements

Annotation is the process of displaying the displacement values on
the screen.

Steps:

1.  Select the View Value option from the Results menu.
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Figure 2. 105

2.  The following dialog box comes up. From the Ranges tab, select
All nodes. If you wish to annotate deflection for just a few nodes,
specify the node numbers in the node list.
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* Annotation - rcframe. std - Whole St
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Figure 2. 106

We will annotate the results for all nodes. So, keep the button on
All.

From the Node tab, check the Resultant option. Resultant stands
for the square root of sum of squares of values of X,Y and Z
displacements. Click the Annotate button and notice that the
values appear on the structure. Click the Close button to close the
dialog box.

1+ Annotation - rcframe. std - Whole Structure

Hangesl Beam Results  Mode |F|eacti0ns

— Modal Displacement
I~ Glohal %
I~ Global'y
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Figure 2. 107
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The following figure shows the annotated deflection diagram for

load case

Eldl rcframe.std - Whole Structure
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2.11.6 Changing the units in which
displacement values are annotated

The units in which displacement values are displayed in the post-
processing mode are referred to as the display units.

Steps:

1.  Display units may be modified by using any one of the following
methods:

a. by clicking on the Change Graphical Display Unit icon,

YRRl Y Y T
i$ Q £ IChange Graphical Dizplay Unit j| ‘?
P EBS L = |

Figure 2. 109

b. by going to Tools | Set Current Display Unit menu option

Select Geometry Commands Analyze Mode \Window|
Check Multiple Structures. ..

Check Duplicate L3
Orphan Nodes 4
Check for Warped Plates,..

Check Zero Length Members

Check Improperly Connected Plates

Calculator. ..
Unit Converter...

b+ Dimension Beams. ..
[%3' Display Node to Mode Distance

F‘m Set Current Input Unit...

Set Current Display Unit. ..

#1 Cut Section. ..

Query L3

Figure 2. 110

or,
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c. by selecting the V

iew | Options menu option.

Yiew Toolz Select Results Repor

Zoom »
Pan
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v Always Fit it Current window

Tables...
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Orientation... Fd
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Figure 2. 111

In the Options dialog box that comes up, select the Structure
Units tab. Change the Dimensions of Displacement from

Millimeter to say, cm or inches or anything else you desire, and

click on OK.

E View Highlight
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<
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] Show dec places

<
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Temperature Show dec places
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The diagram will be updated to reflect the new units.

Ed| reframe. std - Whole Structure !EE
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2.11.7 The Node Displacement Table

Upon entering the Post-Processing mode, the first screen that we
came across is shown below.

STAAD.Pro - icframe. std

=] E3

File Edt View Tools Select Resuts Repot Mode Window Help

BEEET B x g |[Sheenab |[0ad e KA ||BRES

PHIIEIHIE S+ ok

Hlaaaaa®aqret Q éioe oo 1| e
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RKH G T REEBPED @@ || n o]

I -1 Reactions I 2 Displacement

Il_T%pnrts I 4 Arimation [ i Beam [ i Mode

anGa|neRHNE| 28T reREE 77|

For Help, press F1

= rirome 0o D BT
LA TR AlLA Sumrnar
Horizontal | Vertical | Horizontal | Resultant Rotational |~
Node Lic X ¥ 3 53 ™ [3
mm mm mm mm rad rad rad
1 |TDEADLOA 0.000 0.000 0.000 0.000 0.000 0.000 0.000
2 LIVE LOAD 0.000 0.000 0.000 0.000 0.000 0.000 0.000
3VAIND LOAD)| 0.000 0.000 0.000 0.000 0.000 0.000 0.000
4DEAD + LIV 0.000 0.000 0.000 0.000 0.000 0.000 0.000
5 DEAD + 0.000 0.000 0.000 0.000 0.000 0.000 0.000
2 [1DEADLOA -0.063 -0.043 0.406 0414 0.000 0.000 -0.001
2 LIVE LOAD -0.064 -0.034 0377 0.364 0.000 0.000 -0.004
3 WIND LOAD| 1108 0.003 0325 1155 0.000 -0.000 -0.000
4DEAD + LIV 0178 -0.102 1.081 1.081 0.001 0.000 -0.002
5 DEAD + W 1373 -0.044 0874 1628 0.000 -0.000 -0.001
3 |1DEADLOA -0.084 -0.070 0.084 0135 0.001 -0.000 0.001
AR AR arvn anea A Fins o n i 2|
4] ] ay
i reframe. std - Beam Rel =10] x|
4[4 [\ All Relative Displacerment A Max Relative Displacements
Dist ® ¥ 2 Resultant -
1_|1DEADLOA 0.000 0.000 0.000 0.000 0.000
575,000 0129 -0.000 00 0.151
1750.000 0353 -0.000 0108 0.370
2625000 0401 -0.000 -0.085 0.410
3500.000 0.000 0.000 0.000 0.000
2 LIVE LOAD 0.000 0.000 0.000 0.000 0.000
575.000 0420 -0.000 0073 0.140
1750.000 -0.328 -0.000 0101 0.344
2625000 0373 -0.000 0078 0.381
500,000 0.000 0.000 0.000 0.000
3 WAIND LOAD)| 0.000 0.000 0.000 0.000 0.000
&75.000 -0.067 -0.000 -0.050 0.083
Displ 1750000 0.055 -0.000 -0052 0076
e s 75 E]
[Post Mode [Coad 1 : DEAD LOAD Input Urits: [Manm 7

Figure 2. 114

For the Node | Displacement page on the left side, notice that there
are 2 tables displayed along the right side. The upper table, called
the Node Displacements table, lists the displacement values for
every node for every selected load case. Load cases may be
selected or de-selected for the purpose of this table from the
Results | Select Load Case menu. (See section 2.11.16 for details)
The lower table is called the Beam relative displacement table.
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If you happen to close down any of these tables, you can restore
them from the View | Tables menu.

Tables

Tables:

[ Modes -
[~ Beams

[~ Section Properties

[ taterials

™ Supports

[~ Supported Modes

¥ Mode Dizplacements

iew Toole Select Results Reporl | Beam End Displacements
[+ Beam Displacement Detai

200 3 [~ Suppart Reactions
Fan [~ Beam End Forces.
[~ Beam Force Detail
Wiew Selected Objects Only I Man Forces bu Section Froperts ™)
. . List
v Always Fitin Current wWindow *
¥ &nalysis Input W Analysiz Results

whhole Struchure oK I Cancel

Figure 2. 115

The Node Displacement table window has two tabs: All and
Summary (see figure below).

B8 rcframe. std - Hode Displ

[l A B[R A A Summary

Horizontal Vertical Horizontal | Resultant
Hode Lic b v &
cm cm cm cm
1 1 DEAD LA 0.000 0.000 0.000 0.000
2LIVE LOAD 0.000 0.000 0.000 0.000

Figure 2. 116
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All - This tab presents all nodal displacements in tabular form for
all load cases and all degrees of freedom.

rcframe_std - Hode Displacements =] &3 I

[ LR Al A Summary
Horizontal Vertical Horizontal | Resultant ional o
Hode Lic X ¥ Z rx Y ré
cm cm cm cm rad rad rad
1 1 DEAD LOA 0.000 0.000 0.000 0.000 0.000000 0000000 0.000000
2 LIWE LOAD 0.000 0.000 0.000 0.000 0.000000 0.000000 0.000000
3WWIND LOAD 0.000 0.000 0.000 0.000 0.000000 0000000 0.000000
4 DEAD + LIV 0.000 0.000 0.000 0.000 0.000000 0000000 0.000000
5 DEAD + WMl 0.000 0.000 0.000 0.000 0.000000 0000000 0.000000
2 1 DEAD LOA -0.007 -0.004 0.041 0.041 0.000249 0000062 -0.000505
2 LIWE LOAD -0.006 -0.003 0.035 0.038 0.000232 0000055 -0.000751 |
3WWIND LOAD o111 0.000 0032 0116 0.000120 -0.000063 -0.000063 |
4 DEAD + LIV 0015 -0.010 0106 0103 0.0006:50 0000163 -0.002095
5 DEAD + 0137 -0.004 0.037 0.163 0.000432 -0.000013 -0.000971
3 1 DEAD LOA -0.005 -0.007 0.005 0014 0.0007 46 0000000 0.0007 46
2 LIWE LOAD -0.005 -0.006 0.005 0013 0.000694 -0.000000 0.000694
3D LOAD] 0.110 -0.000 -0.006 0111 -0.000004 0.000333 -0.000336 LI

Figure 2. 117

Summary - This tab, shown in the figure below, presents the
maximum and minimum nodal displacements (translational and
rotational) for each degree of freedom. All nodes and all Load
Cases specified during the Results Setup are considered. Maximum
values for all degrees of freedom are presented with the
corresponding Node of occurrence and Load Case number (L/C).

B8 rcframe.std - Node Displacements: M= E3
Swowary/
Horizontal Vertical Horizontal | Resultant Rotational
X
cm
]
Iufin X 5] 4 DEAD + LIV -0.0001 63 0.000650
Max % 2 3 VIRD LOAD 0111 0.000 0.032 0416 0.000120 -0.000083 -0.000083
Min 3 4 DEAD + LIV -0.022 -0.017 0.2z 0.036 0.001937 0.000000 0.001837
e £ 2 4 DEAD + LIV -0.015 -0.010 0106 0108 0.000650 0.000163 -0.002085
hfin £ el 3 WYWIND LOAD 0110 -0.000 -0.006 0411 -0.000004 0.000355 -0.000336
Infax X El 4 DEAD + LIV -0.022 -0.m7 0.0z2 0.036 0.001937 0.000000 0.001837
Mfin Fi ;] 4 DEAD + LIV -0106 -0.010 0018 0408 -0.002095 -0.000163 0.000850
It 1y E S DEAD + Wil 0E7S -0.005 -0.000 0675 -0.000904 0000866 -0.002009
hdir r 3] 4 DEAD + LIV -0.106 -0.010 0018 0108 -0.002085 -0.000163 0.000650
Ifax rZ el 4 DEAD + LIV -0.022 -0.m7 0.0z2 0.036 0.001937 0.000000 0.001937
Mfin rE 2 4 DEAD + LIV -0.01a -0.010 0.106 0408 0.000650 0.000163 -0.002095
Iax Rt ;] 5 DEAD + 'yl 0675 -0.005 -0.000 0.675 -0.000904 0.000366 -0.002009

Figure 2. 118
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For the Beam Relative Displacement table, the details are as
follows :

All

The All tab presents the displacements of members at intermediate
section points. All specified members and all specified load cases
are included. The table shows displacements along the local axes of
the members, as well as their resultants.

Max Displacements

The Max Displacements tab presents the summary of maximum
sectional displacements (see figure below). This table includes the
maximum displacement values and location of its occurrence along
the member, for all specified members and all specified load cases.
The table also provides the ratio of the span length of the member
to the resultant maximum section displacement of the member.

B rcframe_std - Beam Relative Displacement Detail:

[4[ 4> [M ]\ Al Relative Displacement ), Max Relative Displacements f
Ream Lic Length Max x Dist Max Length Max z Dist Max -
1 DE& \ 3500 -0.001 -00oo: 3208:  -0000: 0.500 0.001
2 LIVE LOAD 3.500 -0.00 2333 0.000 2625 -0.000 0.500 0.001
3WUIND LOAD 3.500 0.000 2625 -0.000 3208 -0.000 o417 0.000
4 DEAD + LIV 3500 -0.004 2333 -0.000 3.208 -0.001 0.500 0.004
S DEAD + W 3500 -0.001 2042 0.000 3.208 -0.001 0.500 0.001
2 1 DEAD LOA 6.000 -0.000 4000 -0.007 3.000 -0.000 0667 0.007
2LWE LOAD £.000 0.000 5.000 -0.006 3.000 -0.000 0.667 0.006
3WIND LOAD £.000 0.000 5.500 0.om 4.000 0.00m 0.583 0.00
4 DEAD + LIV 6.000 0.000 5.500 -0.018 3.000 -0.000 0867 0.mE
5 DEAD + Wl 6.000 0.000 5500 -0.007 3.000 0.001 0.583 0.007
3 1 DEAD LOA 3500 0.00m 1167 -0.000 0.292 -0.001 0333 0.002
2LIVELOAD 3500 0001 1167 0.000 2625 -0.001 0333 0.002
AN | (AT = &N 1 A 23R i nnn 11A7 i’ n7=n n'nn A
< i H oz

Figure 2. 119



2-118

Tutorial 2

The sub-pages under the Node page are described below in brief.

Page

Sub-Page

Purpose

Node

Displacement

Displays nodal displacements along with
tabular results for Node-Displacements
and sectional Beam displacements.

Reactions

Displays support reactions on the
drawing as well as in a tabular form.

Modes

Displays mode shapes for the selected
Mode shape number. The eigenvectors
are simultaneously displayed in tabular
form. This Page appears only for
dynamic analyses cases, namely,
response spectrum, time history, and if
modal calculations are requested.

Time History

Displays Time history plots, for time
history analysis. This sub-page too will
appear only if time history analysis is
performed.
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2.11.8 Displaying force/moment diagrams

Steps:

1.  The simplest method to access the facilities for displaying
force/moment diagrams is from the Beam | Forces page along the
page control area on the left side of the screen. The bending
moment MZ will be plotted by default, evidence of which can be
found in the form of the Mz icon show in the diagram below which
becomes active.

Q ’ ua
2l8
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I—
=]
@ o
g ¢
i =
[
=124
T
E| £
|| 2 77 &% |2 LIVE LDAD =] |
|
Y M RS EATE A K R
2 = "3
& L Bending £ Moment
[ - Summary & Envelope £
— | e I e 1 F2

Figure 2. 120
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Ed rcframe.std - Whole Structure =] 3
2
b
l

EX Load 1: BendingZ |

Figure 2. 121
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2.  The option for selecting the force/moment diagram is available
from another facility also - the Results | Bending Moment menu
option - as shown below.

Resultz

& Animation...

Deflection !

IE Section Displacemant
Ltilization Fatio...

@ Beam Stresses
4§ Flate Stress Contour...
g Solid Stress Contaur...

C]D Mode Shape Displacement...
Tine Histary Graph....

Select Load Case...
Scale...
Wiew Walue. .

Update Properties

5lab Feinforcement...

Figure 2. 122
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2.11.9 Switching between load cases for

1.

2.

viewing the force/moment diagram

Steps:

To change the load case for which to view the force/moment
diagram, you may click in the list box called Active Load and
choose the one you want.

GREEZED ||Da@adm ey MA

—

LR ®aQ®aretQ oo $!|?J
-GH-G JJ'Fx‘ F”r_é@ﬂ%@ﬁql? Active Load 'u

Figure 2. 123

Alternatively, either click on the Symbols and Labels icon or, go to

View | Structure Diagrams menu option as shown below.

Wiew Toolz Select Fesults Repor
Zoom k
Pan
Wiew Selected Objects Only

v Alwayz Fit i Current Window

Tables...
Wwhole Structure

Orientation... F4

Structure Diagrams. ..

[Hpeniew...
[Ew Wiew. .
Wiew M anagement 4

Toolbars...
Options...
— Set Structure Colors...

0 &

. & I'LI e %3. % 5 M I Structural Toaol Tip Options ..

£ 3D Rendering

o S—
Symbols and Labels Refrazh

Figure 2. 124
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In either case, the Diagrams dialog box comes up. Select the Loads
and Results tab and choose the second load case (LIVE LOAD)
from the Load Case list box. Also, let us check the Shear yy check
box. Then, click on OK.

x

Force Limits | Animation I Drezign Resultz
Stucture Loads and Results | Scales I Labels
( Load Case: |2 LIVE LOAD [ ]
[ Loads Deflection Beam Forces Diagram—
[ Loads: Direct [ || ¢ Mone ;
! Delocton . & Hatch " Fil
Moment _| " = Outling
] G L i &+ Section Displacement
—Mode Shape
Mode Shape: INnne "I [ Mode Shape .
r Beam Forces
I doial C T From To =
. . . =-119982 :-11.99352
) Diagram £ Colon C4T)

-11.9982 -10.4385
% [ntensity ————————— -10.4935 -5.99868

i -5.99868 -7.4989
i |-11.9982
Finimm; - ages
M axirnurn: |11.9932 -5.99912 -4 49934
7 -4.499354 -2.99956
Mo of values: |1B E g -2,99956 -1 49978
9 -1.49373 o

. q10 ] 1.48978
IV Shearyy W I Bendingwy || |37 [iassre 2gagss

[ Shearzz . [ Bendingzz . 12 299956 4.49934
13 4.43934 599912

[~ Torsion . i5,99912 7.4989
Cores: -l 1 H 4] | Plv

QK I Cancel | Apply | Help |

Figure 2. 125
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4. The figure below shows the shear force diagram for load case 2.

Ed rcframe.std - Whole Structure =] 3

]
T
]
L
A

T
=

LTS
|

T%X Shear Y

Figure 2. 126

5. To display the bending moment diagram for say, load case 4 (DEAD
+ LIVE), follow steps 1 to 3 above and select load case 4.
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The following diagram should appear in the drawing area:

Ed rcframe.std - Whole Structure =] B3

TEX Load 4 : Bending Z

Figure 2. 127
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2.11.10 Changing the size of the force/
moment diagram

Steps:

If the diagram appears too imperceptible, it may be because it may
be drawn to too small a scale. To change the scale of the moment
plot, you may

a) click on the Scale icon

EEer e e
¢ ) & [5 DEAD +wiND |
%28 -mm

Figure 2. 128

b) choose Scale from the Results menu

Results

B Animation. ..

Bending Moment
D eflection

,g Section Digplacement
Utilization R atia. ..

9 Beam Stresses
ﬁ Flate Stress Contour...
g Solid Stress Cartour...

C}) IMode Shape Displacement..
Time Histany Graph,..

Select Load Caze...

Wiew Value... %

Update Properties

Slab Feinforcement...

Figure 2. 129

or
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c) go to View | Structure Diagrams | Scales menu option. All
of the above will bring up the following dialog box.

x
Force Limits I Animation ign Results
Stucture I Loads and Results Scales Labels
 Load Scales

[~ &pply Immediately

Paint Force: IW M per mn
Diizt, Force IWE IbEAft per rim
Paint. M anment: ME kipin per mm
Dzt Moment; IWE Ibrindine per mnm
Pressure: IWE psi per mm

 Fesul Scales

[ BendingY: [787402 ] kip‘inpermm]

Bending £ : IWE kiprin per mnm
Shear r: |1 TRA1ZY E M per mni
Shear £ IWE M per mni
Anial: IWE M per mni
Torsion: IWE kipin per mm

Dizplacement; IEIE—E A QEr i
Beam Stress: |196.85 E psi per mm Save Az Default |

Mode Shape:  [0.00333701 E Resst To Defaul |

lcon Size

Support [can : |3 E % Master Block ; |3 E %
ok I Cancel | Apply | Help |

Figure 2. 130

In the Bending field, specify a smaller number than what is
currently listed, and click on OK. The moment diagram should now
be larger.

In the above dialog box, if you switch on the check box Apply
Immediately, pressing the up or down arrow keys alongside the
number will produce immediate results in terms of a smaller or a

2-127
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larger diagram depending on whether you click the up or the down

arrow keys.
5]
Farze Limits I Animation | Design Results
Stucture I Loads and Flesults Scales | Labels
_ r©
Load Scales l v Apply Immediately
Paoint Force: |1 7E127 M per mm

Diist. Farce IWE IbE/ it per mm
Proint. b orment; WE kiprin per mnm
Diizt. bament: WE Ibminin per mm
Pressure: IWE psi per mm
 Result Scales
Bending " IWE kiprin per mnm
Bending 2 : IWE kiprin per mm
Shear v IWE M per mm
Shear = IWE M per mm
Auxial IWE M per mm
Torzion; IWE kiprin per mnm
Dizplacernent: IDE—E T PEr nm
Beam Stess: IWE P pEr M save As Defaul |
Mode Shape: ID.DDSSS?W E Feset To Default |

lcon Size

Support |eon ; |3 E % Master Block ; |3 E %
0K I Cancel | Apply | Help |

Figure 2. 131
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2.11.11 Changing the degree of freedom for
which forces diagram is plotted

Force and moment diagrams can be plotted for 6 degrees of
freedom — Axial, Shear-Y, Shear-Z, Torsion, Moment-Y, Moment-
Z. One may select or de-select one of more of these degrees of
freedom from View | Structure Diagrams | Loads and Results.

x

Farce Lirnits | Animation I Desigh Results I
Structure Loads and Results I Scales I Lahels
LoadCase: |2 LIVE LOAD [~
[ Loads Deflection Beam Forces Diagram—

[~ Loads: Direct e
irect [ - ET . o & Hatch € Fil
gloes J sreehen = Outline

] el ¥ Section Displacement
—Mode Shape
Mode Shape: INone VI [~ ModeShape [
— Beam Forces
[~ Avial CH "H
€ Diagram € Calor £/
& [ntensity ——————— ! -3.99965

Mlirimr: |-171.95952
Mairnirn: |11.9982
Mo of values: |1E E g -2.99956 -1.49975
9 -1.49975 0

_ 1w |0 1 4a57a
[ Ghearyy W [ Bendngw || |79 [idae7s ™ Sadass

[ Shear 2z . v Bending zz . 12 299956 449934

. 13 449934 £.99912
™ Tarzion . i599912?4989 i
Pl . T. . b_l

ok I Cancel | Apply | Help |

Figure 2. 132

All degrees of freedom currently plotted will be indicated with a
tick mark.
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The icons of the Results toolbar may also be used to turn on/off
specific degrees of freedom.

et A @ AP ED o L OB

Figure 2. 133

For the sake of easy identification, each degree of freedom (d.o.f)
has been assigned a different color. One may change the color for
that d.o.f. by clicking on the color button alongside the d.o.f, and
make a new choice from the color palette.

rBeamForces ————————————— |
[ Asial C . T.
€ Djagram € Color E4T
% [rtensity

Minimurm: |'11.9982
M arirnurn: I11 3382
Mo of values: |1 G E

I~ Shear . [~ Bending py J
™ Shearz2 . v Bending zz .

™ Torsion -
I Stress E . T.

Figure 2. 134

The appearance of the diagram may also be set to one of the 3 —
Hatch, Fill or Outline by turning on the relevant option in the
dialog box shown earlier.

Beam Forces Diagram—

f* Hatch " Fill
 Outline

Figure 2. 135
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2.11.12 Annotating the force/moment diagram

Steps:

1.  Annotation is the process of displaying the force/moment values on
the screen. Select the View Value option from the Results menu.

Fesultz

B &nimation...

Bending tMoment
Deflection

I? Section Displacement
Utilization Ratio...

@ Beam Stresses
) Plate Stress Contour...
g Solid Stess Contaur..

C{) tode Shape Dizplacement...
Time History Graph...

Select Load Case. .

Scale...

by

|Update Froperties
5lab Femforcement...

Figure 2. 136

2. The following dialog box comes up. From the Ranges tab, select
All members. If you wish to annotate the force/moment for just a
few members, specify the beam numbers in the beam list.

& Fanges  Modes: I
Beams: |1 4

Remave Al | Annotate | Cloze

Figure 2. 137

We will annotate the results for all members. So, keep the button
on All.
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From the Beam Results tab, check the Bending - Maximum option.
Click the Annotate button and notice that the values appear on the
structure. Click the Close button to close the dialog box.

1 Annotation - rcframe._std - Whole Structure

Flanges Beam Results |Nnde I Fieactionsl

— Bending
[~ Ends ¥ Maximum [ bid point

—Shear
[~ Ends [~ Maximum [ bid point

— Aial
[ Ends

— Displacement
[ Max Resultant

— Combined Bending and Axial Stress
[~ Ends [~ Maximum [ bid point

Remowe Al | Amnotate | Cloze

Figure 2. 138
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The following figure shows the annotated MZ diagram for load
case 5.

Ed rcframe. std - Whole Structure =] B3

Wax: 22.200 kNm
3 Max: 17.469 kNm

Tix Bending Z
Moment - kNm

Figure 2. 139
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2.11.13 Changing the units in which
force/moment values are annotated
Steps:

1.  The units in which force and moment values are displayed in the
post-processing mode are referred to as the display units.

Display units may be modified by using any one of the following
methods:

a. by clicking on the Change Graphical Display Unit icon

Oagdalmulpls v A
[t Q blEhange Graphical Display Lnit| j| ?
PP EBr L dmm

Figure 2. 140

b. by going to Tools | Set Current Display Unit menu option

Select Geometry Commands Analyze Mode Window
Checdk Multiple Structures...

Check Duplicate 4
Orphan Modes 4
Chedk for Warped Plates...

Chedk Zero Length Members

Check Improperly Connected Plates

Calculator...

Unit Converter,..

-+ Dimension Beams. ..
[%} Display Mode to Mode Distance

‘a..-, Set Current Input Unit...

Set Current Display Unit...

£ Cut Section...

Query 4

Figure 2. 141

or,



c. by selecting the View | Options menu option.

View Tools Select Results
Zoaim

Fan

‘Wiew Selected Objects Only
Always Fit in Current ‘Window

<

Repor

»

Tables...
Whole Structure

Orientation... F4

Stucture Diagrams...

[Hpen Yiew...
e Wiew..
‘Wiew M anagement

Toolbars. ..

Set Structure Colors...

Structural Tool Tip Options ..

£ 3D Rendering

Refresh

Figure 2. 142

Tutorial 2

In the Options dialog box that comes up, select the Force Units
tab. For bending moments, change the Moment unit from its
current setting to one of the choices available, say, Mton-m or kip-
ft or anything else you desire, and select OK.

Options
E Tolerance
E 7ables - Foree
Agzign DI
E NsoségenLabg;S Force IN vl Show FE dec places
E Beam Labels .
Distr. Force IkNJ' vl Show |3 dec places
B Flate Labek: " I_E p
i Solid Labels ( Maoment - Show |3 < dec places
B LoadLabel: m FE
E Annatation Diztr. Moment IkNm!m vl Show |3 dec places
E Structure Units
B Section Units Stress IN!mm’ vl Show FE dec places
[{] Force Unitz
= Dimension Acceleration Im.i'sec:2 vl Shiow IS_E dec places
Fiatation rad - Show FE dec places

[ <]

.

=
=]
=2
=

| Cancel |

Help

Figure 2. 143

2-135
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The diagram will be updated to reflect the new units.

Ed rcframe. std - Whole Structure =] B3

Max: 16.374 kip-ft
ax: 12.885 Iil(ip-ft

EX Bending Z
Moment - kip-ft

Figure 2. 144
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2.11.14 Beam Forces Table

When we select the Beam | Forces page from the page control area
on the left side, the screen that appears is shown below.

STAAD.Pro - reframe. std O]
File Edt “iow Tools Select Resuls Repot Mods Window Help

ddr iRt G BEN” [BReenal |Dad-an s A ||Baes |
PRI+ o & [Haaa®aq @ et Q &[ren0n =K

AYARGODLWBEBS :TOB KR40 w2 @RnPEaBs b fa @ ||l
= il o i - Goam Enl oS =T
W g E LA IR Al A Summar: F”"EIUFE:" - - - - — —
g e e LS Hoda n [ N Kip-ft Kip-ft Kip-ft
e [— 1 [1DEADLOA 1 ZB01BA61 5534 667 96.331 0117 0477 4877
B g 2 2 Af7eaT{i " daad EeT -9 531 0447 {0728 ‘a4
m = E ZLIVE LORD 1 17477887 5145367 90,001 0108 0442 ‘448
g |—| B 2 ATATTEET 5145367 -30.001 0109 0675 a7
=2 3 WAIND LOAD)| 1 Saigriz asTeisd3e31ss 0115 0757 7308
b =]l 2 iaiaiz]iezngd . E831ss ERAL 0150 2415
m g 2] 4DEAD + LIV 1 STAN 36T 14363648 241543 0307 1255 2529
|| 8 2 ETTEAGS  1430364E 341543 0.307 1873 24551
s 5 DEAD + 1 28763107 SaedTEs.  Ev2asE 0025 1532 4088
R = 2 Agea25T1 T96H2 37235 0025 -0.560 7245
— £ 2 [IDEADLOA 2 8534230 18799736 99211 0726 0117 a481
k| & 3 Be34230 1817372 89211 0725 0322 0288 o
= ST AR 5 cincnTn a7i7RnA FEREN e nina a7an
=g ] oy
= frame.std - Beam Fo =iolxi
" A4 [\ All AMax Axial Forces j Max Bending Moments A\ Max Shear Forces 7
Dist Fx Fz Mx Mz [«
] = e mm n Fuy 1 Kip-ft k::)-’ﬂ Kip-ft j
1 [1DEADLOA 0000] 26016461 5534667 35,331 0117 0477 4827
B75.000] 24213774 5534 66T 96331 0117 0538 K
1750000| 22409.085 5534667 96.331 0117 0.601 2317
2625000 20604309 5534 6E7 98351 0417 063 5885
3500000 15789713 5534 667 96331 0117 0735 9481
2LIVELOAD 0000| 17477887 5145307 90.001 0109 0442 4487
E75.000] 17477887 5145367 40.001 0109 0500 g7
17E0000| 17477987 8145387 40001 6103 0558 3984
265000 1747787 5145397 90.001 0109 0617 5475
FE00000| 174TTEET 5145367 90.001 0109 0675 5738
3WIND LOAD) oooo| Asimriz Eereisd3631sE 0118 0757 7208
Tﬁx B75.000 1419712 B3I AT. -363.155 0118 0523 2310
Bending Z FvEnnnnl iaiawds | ATST AT ReR AEE AAAE e} Erehd|
4] | iy
For Help, press F1 [Post Mode: [Load 1: DEAD LOAD Input Units: Memm 2

Figure 2. 145

The axial forces and shear forces, bending and torsional moments
in all selected beams for all selected load cases are displayed in a
tabular form along the right half of the screen. Load cases may be
selected or de-selected for the purpose of this table from the

Results | Select Load Case menu. (See section 2.11.16 for details)
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If you happen to close down any of these tables, you can restore
them from the View | Tables menu.

Tables
Tables:
[ Section Properties -]
[ Materials
[~ Supparts

™ Supported Modes

[ Mode Dizplacements

[ Eeam End Displacements
[~ Eeam Displacemant Detai
[~ Suppart Beactions

e ¥ Beam End Forces
Wiews Toolz Select Resultz Repol I Beam Force Detail
Zoom ¥ [~ Max Farces by Section Property
[~ Plate Cantre Stess
P:an ) [ Solid Centre Stress Jid
Wiew Selected Objectz Only List
v Always Fit in Current Window ’]7 Analyzsis lnput [V Analysis Results

Tables..
Wwhhole Structure

ok I Cancel

Figure 2. 146

The Beam End Forces table window has three tabs: All, Summary
and Envelope.

B8 rcframe. std - Beam

(A4 » [oT Al A Summary & Envelope £

Beam LiC Hode F; Far F“z
1 1 DEAD LA, 1 26015.465 -5534 66T 96.331
2 -18799.715 5534 BEY -96.331
2 LIVE LOAD 1 17477 957 -5145.387 90.001
2 -17477 957 5145387 -90.001
FWIND LOAD 1 1419712 8876163 -363.155
2 1419.712 1420520 363155

Figure 2. 147
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All - This tab presents all forces and moments corresponding to all
6 degrees of freedom at the start and end of each selected member
for all selected load cases.

&8 rcframe.std - Beam End Forces: M=l E3
[ 4w R AllA Summary A Envelope
Fx Fz Mz Mz rs
femm| U (L2 KH :ﬁ KH MTon-m m':ﬁ.m MTonm | |

1 1 DEAD LOA 1 26015 -5.535 0.096 -0.016 0.066 -0.667
2 -15.800 5535 -0.096 0016 -0.100 -1.308

2 LIWE LOAD 1 17475 -5.145 0.050 -0.015 0.061 -0.620

2 -17.475 5145 -0.090 0015 -0.093 -1.216

3WIND LOAD 1 -1.420 G676 -0.363 0016 0105 0.996

2 1.420 1.421 0.363 -0.016 0.025 0.334

4 DEAD + LI 1 o744 -14 364 0.242 -0.042 0174 -1.732

2 -45.779 14.364 -0.242 0.042 -0.260 -3.394

5 DEAD + il 1 26763 5470 -0.372 0.003 0210 0.565

2 -15.823 7916 0.372 -0.003 -0.077 -1.002

2 1 DEAD LOA 2 5.534 18.500 0.099 -0.100 -0.016 1.308
3 -5.534 19174 -0.099 0100 -0.044 -1.422

2 LIWE LOAD 2 5145 17475 0.0s92 -0.093 -0.015 1.216

3 -5.145 17626 -0.092 0.093 -0.041 -1.322

3WIND LOAD 2 1.420 -1.420 -0.363 0.025 0016 -0.334

3 -1.420 1.420 0.363 -0.025 0.206 -0.535

4 DEAD + LI 2 14361 45779 0.258 -0.260 -0.042 3.5394

3 -14 361 49745 -0.259 0.260 -0.116 -3.690

5 DEAD + il 2 74825 18623 -0.366 -0.077 0.003 1.002

3 -7.925 22945 0.366 007y 0.220 -2.264

3 1 DEAD LOA 3 38345 5434 -5.434 -0.000 1.5322 1.5322
4 -46. 766 -5.434 5434 0.000 0617 0617

2 LIWE LOAD 3 35652 50582 -5.052 0.000 1.229 1.229

4 -35.652 -5.052 50582 -0.000 0.574 0.574

3WIND LOAD 3 1.474 2285 -0.227 -0.143 0.038 0.251

4 -1.474 -2.295 0227 0143 0.042 0.565

4 DEAD + LI 3 99.450 14.087 -14.097 -0.000 3.430 3.430

Figure 2. 148

Summary - This tab, shown in the next figure, presents the
maximum and minimum values (forces and moments) for each
degree of freedom. All beams and all Load Cases specified during
the Results Setup are considered. Maximum values for all degrees
of freedom are presented with the corresponding Node of
occurrence and Load Case number (L/C).
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rrrErTrr——
4[4[ » [P AT Y Summary £ Envelope f
My
4 DEAD + LIV 4 109.593 14.097 4 7 -1.601

hin Fx 1 5 vWIND LOAD) 1 -1.420 G876 00g 0105 0.996
Ilax Fy 2 4 DEAD + LIY 2 14.361 48779 -0.260 -0.042 3.394
Win Fy 2 4 DEAD + LIY 3 14.361 -49.745 -0.260 0116 3.690
Wax Fz a3 5 DEAD + WAl B 5.809 20,609 0482 -0.225 1.413
Win Fz 4 5 DEAD + WAl 3 20.549 -5.909 -0.225 3148 -0.696
Ila Wl El 5 DEAD + WAl 5] 5.809 20,609 0.462 -0.225 1.413
Iolin b 2 4 DEAD + LIY 2 14.361 46.779 -0.260 -0.042 3.394
Mg ety El 4 DEAD + LIY E] 99.480 14.097 -0.000 3.430 3.430
Iofin by El 4 DEAD + LIY 4 109.583 14.097 -0.000 -1.601 -1.601
g Mz 2 4 DEAD + LIY E] 14.361 -49.745 -0.260 0116 3.690
Win Mz 1 4 DEAD + LIY 1 57441 -14.364 -0.042 0474 -1.732

Figure 2. 149

Envelope : This tab shows a table consisting of the maximum and
minimum for each degree of freedom for each member, and the
load case responsible for each of those values.

[ A » [T AT A Summary b Envelope f
Fx

Hode Env
FWIND LOAD: 4 DEAD + LIV i3 WiIND LOAD:S DEAD +' (3 WIND LOAD
Ve -1.420 -14.364 -0.372 -0.042 0.000 -1.732
3WIND LOAD: 4 DEAD + LIY 5 DEAD +'01 (4 DEAD + LIY - 4 DEAD + LIY
1 2 +VE 45779 0.000 0.242 0016 0.260 3.394
4 DEAD + LIV - 4 DEAD + LIN i3 WIMD LOAD: 4 DEAD + LIV 14 DEAD + LIV
-WE -1.420 -14.364 -0.372 -0.042 -0.025 -0.334
FWIND LOAD: 4 DEAD + LIV 5 DEAD +'W1 4 DEAD + LIV (3 WIMD LOAD: 3 WWIND LOAD:
2 2 +VE 14361 45779 0.259 0.025 0016 3.394
4 DEAD + LIV 4 DEAD + LIV 14 DEAD + LI% :3WWIND LOAD: 3 WIND LOAD: 4 DEAD + LIV
Ve 0.000 -1.420 -0.366 -0.260 -0.042 -0.334
- FWIND LOAD:S DEAD +' (4 DEAD + LIV :4 DEAD + LIV (3 WiIND LOAD:
2 3 +We 14.361 0.000 0.259 0.025 0116 3690
4 DEAD + LIV - 4 DEAD + LIN i3 WIMD LOAD: 4 DEAD + LIV 14 DEAD + LIV
Ve 0.000 -49.745 -0.366 -0.260 -0.220 0.000
- 4 DEAD + LIV (5 DEAD +1 4 DEAD + LIV (5 DEAD +' -
3 3 +VE 99.490 14.087 0.000 0.000 3.430 3.430
4 DEAD + LIV 4 DEAD + LIV - 2 LIWE LOAD (4 DEAD + LIV :4 DEAD + LIV
-WE 0.000 0.000 -14.097 -0487 0.000 0.000
- - 4 DEAD + LIN 5 DEAD +' - -
3 4 +VE 109.593 14.087 0.000 0.000 0.000 0.000
4 DEAD + LIV 4 DEAD + LIV - 2 LIWE LOAD - -
Ve 0.000 0.000 -14.097 -0487 -1.601 -1.601
- - 4 DEAD + LIN :5 DEAD +' (4 DEAD + LIV 14 DEAD + LIV
4 5 +We a7 .44 0136 0.000 0.042 3145 0029
4 DEAD + LIY 3 WIND LOAD: - 4 DEAD + LIY |5 DEAD +W [ 3WIND LOADT
Ve -0.054 -14.364 -21.328 -0.225 -0.174 -1.732

Figure 2. 150



Tutorial 2 | 2-141

2.11.15 Viewing the force/moment diagrams
from the Beam | Graphs page

The Graphs page in the Post Processing Mode allows us to
graphically view moments and forces such as Axial, Bending zz,
Shear yy and Combined Stresses for individual members. Select the
Graphs sub-page nested under the Beam page from the left side of

the screen as shown below.

PR/ | K rcframe. std - Whole Stiucture [_ O] x|
S| &
2| g
i
O
E
8
[
4 E
74 B
E s
g L SN
gl I __,,—-“"'H ™
o L =
— \z 2 -3
- [ f =
= L~ 5
= ? 3 4
& \\
C \
i b
1 2]
4
7]
7]

Figure 2. 151
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The Main Window area of the screen shows the loading on the
structure. On the right side of the screen, the force/moment
diagrams appear (see figure below). When we highlight a member
in the main window by clicking on it, the graphs are plotted for
that member in the data area.

The following figure shows the graphs plotted for member 1 for
load case 4.

Fle Edt View Toth Select Resuti Repot Mode Window Hep

[dsd@miex-: igga’ | [SRR=caD [De8-ur Bk LA |[Bael

e e R M e T e S o — I
[proscanpads: "O8 [2A4G AR SPED L] Jm @ | nfwio)
— El relrame. std 3 P 3 || B rchame sid - Boam Graphs - e 1 |
Bal # g ; e S i) — =gz
b = ey ] a0
= o ol 20
=1y % aua bl
B =1 10. 00 200 EEUE L

--._: = s A
A ﬁ .T' n 0
il i. fi 3’,1
L G s Tyt ‘1 1
eling| == rt 4
g 5 5 "y
z(E 1
=7 i
™ ]
]
2 ']
{g'
[ -
(73

5 Lo

For Help, prest F1 ; [Pt Mode Losd 4 DEAD « LV Irput Uity Herm

Figure 2. 152
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The following figure shows the graphs plotted for member 2 for
the same load case.

Fle Edt View Toth Select Resuti Fepot Mode Window Hep

[des@mynx-: iwnnit” | [SRasndd [Oe8 By XA | [BavA

leasaaaaestt ool aaaaanametQ slom.ue St |
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Figure 2. 153

We can change the degree of freedom for which results are plotted
by doing the following. Go into one of the 3 drawing windows on
the right side, and click the right mouse button. The following
dialog box will appear.
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rcframe.std - Beam Graphs - Beam 2 =] 3
FyiH}
0000 S o0ao
25000 Copy Picture 25000
T ake Picture
2 3
Diagrams... &00
25000 [w  Follow View Selection 25000
50000 Save data i a text file.. _49466 Loy
rcframe.std - B ;lglgl

I T

Figure 2. 154

Select Diagrams. In the dialog box which appears, switch

on/switch off the degrees of freedom you desire.

—Forces

™ Bendingws || [~ Shearzz
" Bendingzz ] [ Shearw
¥ Tarsion W T 2

[ Stréks [ |

0k I Cancel | Help

Figure 2. 155

Click on OK and that degree of freedom will be plotted in that

window.
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2.11.16 Restricting the load cases for which
results are viewed

Steps:

1. To restrict the load cases for which results are viewed, either click

. #]
on the Results Setup icon L or, go to Results | Select Load Case
menu option as shown below.

Rezultz

& Animation...

Bending Mament
Deflection

A" Section Dizplacement
Ltilization R atio...

@ Beam Shresses
{f§ Flate Stress Contour...
‘ Solid Stress Contour...

Cl; Miode Shape Displacement...
Tinie Histary Graph....

Select Load Caze. . k

Scale...

Wiew Value

Update Properties
5lab Feinforeement...

Figure 2. 156
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2. In the Results Setup dialog box that comes up, let us first un-select

the already selected load cases by clicking on the button.

Results Setup

X

Loads ‘ Range || Resutt View Options |

(®) Envelope of Load Cases in Selected List
Load Cases

Available:

1DEAD LOAD
2 LIVE LOAD

3WIND LOAD -,--,-
4 DEAD + LIVE
5 DEAD + WIND

Selected:

ok J[m J[ e
Figure 2. 157

3.  Select load cases 1 (DEAD LOAD) and 3 (WIND LOAD) by

holding the “Ctrl” key down. Then, click on the button. After
the load cases have been selected, click on the OK button.

Results Setup

3

Loads | Range || Result View Option5|
(&) Envelope of Load Cases in Selected List
Load Cases
Available: Selected:
2 LIVE LOAD i 1 DEAD LOAD
4 DEAD + LIVE - JWIND LOAD
5 DEAD + WIND

ok J [ J[ e
Figure 2. 158
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2.11.17 Using Member Query

Member query is a facility where several results for specific
members can be viewed at the same time from a single dialog box.
It is also a place from where many of the member attributes such as
the property definition, specifications (releases, truss, cable, etc.)
and beta angle can be changed for input purposes.

Steps:

To access this facility, first select the member. Then, either go to
Tools | Query | Member menu option or, double-click on the
member. Let us try double-clicking on member 4.

B rcframe._std - Whole Structure 9 [=] 3

-
L
L -3
L \\
F
f "1 -]
;1 \5\
f
\

2 3 \\

\
1 2

Figure 2. 159
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As we double-click on member 4, the following dialog box comes
up. Let us take a look at the Property tab.

i rcframe_std - Beam E
Geometry  Property | Loadingl ShearBendingI Deflectionl Concrete Designl

Beam no. = 4. Section: Rect 0.30:0.28

I
Length = 3500 275.000
r— Physical Properties [Unit: mm]
A 2300 I 9.49335e+00
Ry F2500 Iy 5.19922e+00 hssign/Changs Property |
Az 2300 Iz 6.1575e+005
) 300 W 273

— Material Propertie:

Elasticity(kMimm2) |22 Densty(kaim3)f2549.29 l—_[MATEmAU =

Poisson o7 Mlpha jo
Azzign Material |
Frint | Cloze I

Figure 2. 160

The figure above shows where the buttons are located on the
member query box. If the member contains output result tabs
(Shear/Bending, Deflection, Steel Design, etc.) in the query box,
changing member attributes like releases will cause these result
tabs to disappear. This is due to the fact that the current output no
longer reflects the new input.

NOTE: If you assign or change property by clicking on the
Assign/Change Property button in the above dialog box, ensure
that you keep the check mark on “Apply to this Member only” in
the ensuing dialog box. Else, changing the member attributes for
one member will subsequently change the attributes of all other
members belonging to the same attribute list. For example, if the
current member's property is also assigned to other members,
changing the property on the current member will change the
property of all the members.
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Let us click on the Shear/Bending tab. The following dialog box
appears.

i rcframe._std - Beam
Geometl_l,ll F'n:upert_l,JI Loading Shear Bending |Def|ectinn| Concrete Designl
Beam Mo =4
946
SD‘I/_/ 1162.40
-4 53
!\ 1
|
—Section Forces Digt Fy r_wz
T Fy = ;I mm M kip-ft
mm H kip-ft [0.000 G
233333 -5a34 66T 4 635
2625 -5a34 66T 5889 Selection Type
296 67 -5534 66T T.080 Load Caze : 1:DEAD LOAD -
3208 .33 -5a34 66T 5270
3500 5534 667 046 * Bending-Z ¢ Bending -
| - { Shear-Y " Shear-Z2
Print | Cloze I
Figure 2. 161

The above page contains facilities for viewing values for shears
and moments, selecting the load cases for which those results are
presented, a slider bar (see next figure) for looking at the values at
specific points along the member length, and a Print option for
printing the items on display. Experiment with these options to see
what sort of results you can get. Grab the slider bar using the
mouse and move it to obtain the values at specific locations.

2-149
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b

Section FDICBﬁ

izt Fu iz
Hi=e Fy i ;I ] M kMm
mm H khm [7500 [EEaeer [4iz
2EE3.33 -5534 BET B.370
Figure 2. 162

Another page (Deflection) of the above dialog box is shown below.

i rcframe._std - Beam
Geometl_l,ll F'n:upert_l,JI Loadingl Shear Bending  Deflection |E0ncrete Designl
Beam Mo =4
SD
-0.041
\ 1
|
Digt Disp
— Deflection mim Cim
Dist Displ | [0.000 [0.000
mm cm
233333 0017 Selection Tuoe
5635 Y] L
saeer o0 [tDEADLDAD ~]
223333 ggi: (+ Global Deflection  ©* X Dir
| : 7 Dir
-  Local Deflection " Z Dir
Prirnt Cloze

Figure 2. 163
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The Concrete Design page of the above dialog box is shown
below.

i rcframe._std - Beam
Geometl_l,ll F'n:upert_l,JI Loadingl ShealBendingI Deflection  Concrete Design |
Beam no. =4 Design code ;. AC-02
—Deszsign Load——— [~ Deszign Parameter
Load 5 Fyihpa) 415
Location STA Feihpa) 25
2
200,000 Pulnz)  |28.55 A Regd(mm?) | 1056
hziKn=-ht) |6 .52 Az (%) 1523
My(Hns-ht | 2087 Bar Size 20
R —"
275000 mm
Print | Cloze |
Figure 2. 164

To look at the results of another member using this query facility,
simply close down this query dialog box and repeat the steps
outlined earlier in this section for the desired member.
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2.11.18 Producing an on-screen report

Steps:

Occasionally, we will come across a need to obtain results
conforming to certain restrictions, such as, say, the resultant node
displacements for a few selected nodes, for a few selected load
cases, sorted in the order from low to high, with the values
reported in a tabular form. The facility which enables us to obtain
such customized on-screen results is the Report menu on top of the
screen.

1. Let us create one such report. We will create a table that shows the
member major axis moment (MZ) values sorted in the order High
to Low, for members 1 and 4 for all the load cases. The first step to
do this is to select members 1 and 4 from the structure. With the
beams cursor active, select members 1 and 4 using the mouse, or
use the Select | By List | Beams option of the Select menu and type
1 and 4 as the member numbers. Next, go to the Report | Beam
End Forces menu option as shown below.

Mu:ude Window Help

Beam Property...

Joint Displacement. ..

Support Reactions. ..

Beam End Forces...

Section Displacement...
Section Forces...

Beam Stresses...

Plate Results 4

Floor Vibration Report. ..
Figure 2. 165
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In the dialog box that appears, select the Sorting tab. Let us select
Moment-Z as the End Force, set the Sorting Order to List from
High to Low, and switch on Absolute values under If Sorting
done. (If we wish to save this report for future use, we may select
the Report tab, provide a title for the report, and turn on the Save
ID option.) Under the Loading tab, make sure all the 5 load cases
have been selected. Then, click on the OK button.

Beam End Force

Sarting |Loading| Heportl
— Sort By End Forces

" Ayial Force

" Sheary

" ShearZ

= Torsion

 Moment-y

% Moment-Z

= List with no sort done

—If Sorting Done

v Absolute Yalugs

—Set Sorting Order
* List from High to Low
" Ligt from Low ta High

o]

Cancel

Help

Figure 2. 166

The next figure shows the member end forces sorted table with the
MZ values sorted from High to Low based on Absolute numbers.

|
‘Mﬁwﬁ i
kH kH KkH kHm kHm kHm
4 q [ 45779 14.364 0.242 0416 2547 -33.286
1 q 2 45779 14.364 -0.242 0416 -2.547 -33.286
1 4 1 57 441 -14 364 0.242 0416 1.702 -16.986
4 4 B 57 441 -14 364 -0.242 0416 -1.702 16986 |
4 5 6 -20 609 54909 -0.952 2210 473 13858 |
1 1 2 -18 800 5535 -0.096 0153 -0.984 12827 |
4 1 6 -18 800 5535 0.096 -0159 0984 128271 |
1 2 2 17478 5145 -0.030 0148 -0915 11825 |
4 2 6 -17.478 5145 0.090 -0.148 0915 18250
1 El 2 -18823 7916 0372 -0.034 -0.780 -9.823
1 3 1 -1.420 BETE -0.363 0181 1.026 9772
4 El 9 28549 -5.909 -21.328 -2.210 30.874 -6.524
1 1 1 26018 -5535 0.096 -0.159 0.647 -6.544
4 1 5 26018 -5535 -0.096 0159 -0.647 -6.544
1 2 1 17 478 -5:145 0.090 -0.148 0.600 -6.034
4 2 B 17 475 -5.145 -0.090 0145 -0.600 -6.034
1 5 1 26763 5470 -0.372 0.034 2083 5542
1 3 2 1.420 1421 0.363 -0461 0.245 3275
4 3 5 -0054 0136 -16.287 -1.822 24 188 0286 |
4 3 6 0054 -0136 -0874 1822 2785 0492 |

Figure 2. 167
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3. To print this table, click the right mouse button anywhere within
the table. A list of options will appear.

i Cut Ll

Copy L+

2 Faste Ll
DEelete el
GoTo. F&
Change Unit for thiz column 4

A5 30 Bendering

& I

@ Print Prexiew

Results Setup...

Mode Displacements Table
Beam End Dizplacements T able
Beam Relative Dizplacement Detail Table

Support Beactions T able
Beam End Forces Table
Beam Faorces Detail Table

Plate Centre Stress Table
Plate Corner Stress Table

Solid Centre Stress T able
Solid Cormer Strezs Table

[7] Other Tahles. .
Figure 2. 168

Select the print option to get a hardcopy of the report.
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2.11.19 Taking Pictures

There are several options available for taking pictures. The
simplest of these is in the edit menu and is called Copy Picture. It
transfers the contents of the active drawing window to the windows
clipboard. We can then go into any picture processing program like
Microsoft Paint or Microsoft Word and paste the picture in that
program for further processing.

Another more versatile option enables us to include any "snapshot"

or picture of the drawing window into a report. It is called Take
Picture and is under the Edit menu. Let us examine this feature.

Steps:

1.  To take a picture, either click on the Take Picture icon or, go to
Tools | Take Picture menu option.

Edit
=2 Undo CilsZ
£ Redo Chiley
& Cut Cirl+4
Copy Chil+C
B, Faste [l
2 Delete Diel
Em
Copy Picture
./ . -
re Edit Input Command File
SR aam&Dh |
Create New VB Macro...
L& & & (Teke Potwel £ Edit Esisting VB Macro...

Figure 2. 169
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2.  The following dialog box comes up. Here, we may provide a
caption for the picture so that it may be identified later on.

|D: IF'icture1
Caption: | ==
Help
Figure 2. 170

This picture will be saved till we are ready to produce a customized
report of results. Proceed to the next section for details.
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2.11.20 Creating Customized Reports

STAAD.Pro offers extensive report generation facilities. ltems
which can be incorporated into such reports include input
information, numerical results, steel design results, etc. One can
choose from among a select set of load cases, mode shapes,
structural elements, etc.. We may include any "snapshot™ or picture
of the screen taken using the Take Picture toolbar icon. Other
customizable parameters include the font size, title block, headers,

footers, etc.

1. The Report Setup utility may be accessed either by selecting the

Reports Page or by clicking on the Report Setup — icon.

Reports

I -\- Reactians l i

(| 7 Reports )34 Animation [ I EBeam I “* Hode

Figure 2. 171
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In either case, the following dialog box appears:

Ficture Album I Optiong I Mame and Logo I Load/Save
[tems | Load Cazes I Modes I Ranges I Steel Design
Avwailable Selected
Input j
Modes S ob Info
Eeams 2 |
Sections
b aterialz il
Supports
Feleazes

Frimary Load Cazes
Combination Load Cazes
Loading Generators

. -
| nadinns _I

Repart Detail Increments |1 i]

0k I Cancel | Print | Help |

Figure 2. 172

<

a5
I:Iz

Different tabs of this dialog box offer different options. The Items
tab lists all available data which may be included in the report.
Note that the items under the Selected list are the ones which have
been selected by default.

Available items are classified into seven categories: Input, Output,
Pictures, Reports, STAAD.etc output, Steel Design Output and
Advanced Query Reports.
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Picture Album I Options I
Iberns I Load Cases I og
Available

Input j

InEut -
Pictures e _>
Reports 37

I aterials i
Support

Figure 2. 173

In our report, we want to show Job Information, Node
Displacement Summary, Beam Max Moments, and Picture 1.

Job Information is already selected by default.
From the Available list box, select Output. From the available
output items, select Node Displacement Summary and Beam Max

Moments.

Then select Pictures from the Available list box and select Picture
1.

When all the items have been selected, the Report Setup dialog box
should appear as shown below.
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Picture Album I Options I MHame ahd Logo I Load/Save I
[tems | Load Cazes I Modes I Ranges I Steel Deszign
Awailable Selected

ob Info

Mode Displacement Sumnmary
> |

Beam Max Moments
Picture 1

Repart Detail Increments |1 i]

0k I\<J Cancel | Print | Help |
1%

Figure 2. 174

The Report Detail Increments check box at the bottom indicates the
number of segments into which a member would be divided for
printing sectional displacements, forces, etc.

Click on the Load Cases tab to select the Load Cases to be
included in the report. The Grouping buttons indicate whether the
report data will be grouped by Node/Beam numbers or by Load
Case number. In the first case, all Load Case results will appear
under a particular Node or Beam. In the second case, results for all
Nodes or Beams for a particular Load Case will appear together.
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Ficture Albur | Options | Mame and Loga | Load/Save |
|tems Load Cases I Modez I Fanges | Steel Design
Available Selected

1 DEAD LOAD

- | 2 LIVE LOAD

- | 3WIND LOAD
4 DEAD + LWE
<

5 DEAD +'WIND
<
|

Grouping for Load Tables |' Grouping for Result Tables

" by Load Type % by Mode/Eeam
* by Load Case " by Load Case

(n] 4 r I Cancel | Frirt Help
by

Figure 2. 175

Click on the Picture Album tab to visually identify the pictures
taken earlier. The following figure displays Picture 1 as stored by
the program.

Report Setup 1]
Itermns | Load Cases | todes I Ranges I Steel Design
Picture Alburn | Options I Mame and Logo | Load/Save
r Dizplay Size————
I arne; Ficture 1 Delete Picture | P

[+ Full Page

Height [1777 mn
f\ width: [£9.59 ﬂ

Caption;  [hole Structure Displacernents 0.0003cm: Tmen 1 DEAD LOAD

k. I Cancel | Prirt Help

Figure 2. 176
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5.

The Options tab lets you include Header, Footer, Page Numbers,
Table Grids, fonts for Column Heading and Table data, etc.

The Name and Logo tab allows you to enter the Company Name

and Logo. Click on the blank area and type the name and address

of the company. Click on the Font button in the Text group and
adjust the font to be Arial 16 Pt Bold. Click on the Right radio

button in the Alignment group under Text to right-align the

company name.

Report Setup
Iterms I Load Cazes I todes | Ranges
Ficture Album I Optiong Name and Logo

ABC CONSULTANTS|

|

Steel Design
Load/5 ave

r— Graphic
oo |
Paste | Positior: " Left % Centre  Right
 Text
Font... Arial 16 pt
Alignment: % Left  Centre € Right
0K | Cancel Print Help
Figure 2. 177

Click OK to finish or click Print to print the report. However, it is

always a good idea to first preview the report before printing it.
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To preview the report just created, select the Print Preview icon
from the Toolbar.

EGRBeHED
& BriPrevien] @ Q F

Figure 2. 178

The first and the last pages of the report are shown in the next two
figures.
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Figure 2. 179
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m ABC CONSULTANTS 4

3 sl B b s Camryule
- Iz
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Figure 2. 180

This brings us to the end of this tutorial. Though we have covered
a large number of topics, there are several more in various menus
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Tutorial Problem 3: Analysis of a slab

Section 3

This tutorial provides step-by-step instructions for modelling and
analysis of a slab supported along two edges. The following topics
are covered:

e Starting the program

e Modelling the slab using quadrilateral plate elements
o Specifying slab properties and material constants

e Specifying supports

e Specifying loads

e Specifying the analysis type

e Viewing results for individual plates
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3.1 Methods of creating the model

As explained in Section 1.1 of tutorial problem 1, there are two
methods of creating the structure data:

a) using the graphical model generation mode, or graphical
user interface (GUI) as it is usually referred to.
b) using the command file.

Both methods of creating the model are explained in this tutorial.
The graphical method is explained from Section 3.2 onwards. The
command file method is explained in Section 3.8.
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3.2 Description of the tutorial problem

The structure for this project is a slab fixed along two edges. We
will model it using 6 quadrilateral (4-noded) plate elements. The
structure and the mathematical model are shown in the figures
below. It is subjected to selfweight, pressure loads and temperature
loads. Our goal is to create the model, assign all required input,
perform the analysis, and go through the results.

\}(Fixed Edge

\_ 4.0m
Fixed Edge Free

Edge
\— Free Edge

6.0m

Figure 3. 1
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5\1 Zg L L
20m
§, 4 4 4 1
20m
N +
——20m==—220m==—20m-=—

Figure 3. 2
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BASIC DATA FOR THE STRUCTURE

ATTRIBUTE

DATA

Element properties

Slab is 300mm thick

Material Constants

E, Density, Poisson, Alpha — Default values for
concrete

Supports

Nodes along 2 edges are fixed as shown in Figure
3.2

Primary Loads

Load 1: Selfweight

Load 2: Pressure Load of 300Kg/sq.m. acting
vertically downwards

Load 3: 75 degree F uniform expansion, plus top
surface is 60 degrees hotter than the
bottom

Combination Loads

Case 101: Case 1 + Case 2

Case 102: Case 1 + Case 3

Analysis Type

Linear Elastic
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3.3 Starting the program

Select the STAAD.Pro icon from the STAAD.Pro 2006 program
group.

—_— L . —
Y I Online Services 3 ) STAAD.etc
@ Notepad IE) PrintMe Intsmet Printing » &) STAAD. foundaton
) QuickTime N () STAAD.Pro 2005 Learing Resources
E Microsoft Word i@ sonic r Eliho
@) stertup 5 [% OpenSTAAD Reference Documentation
i STAAD.Pro 2005 | [ Zone.com Deluxe Games r 2 REI Appiication Assistant
[& Adobe Reader 6.0 [E]_Revison History
@ ndebe ATt 505 o e cociorer $ staaro
Microsoft Access @3 STAAD.ProLanguage Settings
@ Mierosoft Photo Edit Microsoft Excel [ STAAD.Pro Online Documentation
[ noesoreis | @ viosoftoney 2005
[@ wicrosoft Office PowerPoint Viewer 2003
Calculator [ Microsoft Outiook
Microsaft PowerPoint
5o Micrasaft Word
Microsoft Works Task Launcher
MSN
74 start %) Outiook Express

Figure 3. 3
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The STAAD.Pro Graphical Environment will be invoked and the
following screen comes up.

=lslx|

Fie Help
|[dEadm e x o GE S SR EEm S0 ||[DA A i K [REee| 0
wapssesesstocs||Elaaaaaaarea ol 2|2 |
AHRERLFEARTTOR||NA ot CEA et 2G5 P W B[ =m

SPACL truchae. whechis & Sise-denantionsl iamed suchas vt ads socked in
ey plore. i By ered gerseril.

Length Links Fasce Units
Floch Docente FRand 0 Hewon

Rt M  KiPord  C Decahoven

 Mimate " Kirer " Fdohiewhon
I Centimeter

¥ Diinpay thes chaog bow: ot e Shamup
|

Figure 3. 4

This New dialog box will come up every time we start the program.
If you wish to turn this feature off, simply uncheck the Display this
dialog box at the Startup box at the lower left hand corner. It can
be turned on again at a later time when File | New is invoked from
the main menu.

3-7
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Note about the unit system :

There are two base unit systems in the program which control the
units (length, force, temperature, etc.) in which, values,
specifically results and other information presented in the tables
and reports, are displayed in. The base unit system also dictates
what type of default values the program will use when attributes
such as Modulus of Elasticity, Density, etc., are assigned based on
material types — Steel, Concrete, Aluminum — selected from the
program’s library (Please refer to Section 5 of the STAAD.Pro
Technical Reference Manual for details). These two unit systems
are English (Foot, Pound, etc.) and Metric (KN, Meter, etc.)

If you recall, one of the choices made at the time of installing
STAAD.Pro is this base unit system setting. That choice will serve
as the default until we specifically change it.

The place from where we can change this setting is under the File |
Configure menu. To get to that option, first close down the dialog
box shown in the earlier figure by clicking on Cancel. Then, click
on the File | Configure menu option and choose the appropriate
unit system you want. For this tutorial, let us choose the Metric
units (KN, Meter, etc.).

m Help

2] Mew Cirl+1
= Cpen... Cirl+0
Open Archive, ..

Open Backup Manager
Import...

Creste Archive...

Extract Archive...
Recent STAAD Files L4
Recent STAAD Archives L4

Exit

Figure 3.5



Tutorial 3 | 3-9

Configure Program

| STAAD Default Design Codes || Global Awis Orientation | Working Directory |
InputOutput File Format || Emor File Format || File Options |
Base Unit | Background Color || Section Profile Table || Analysis Engine |
Cument Default Base Metric
Select Baze Unit:
T |
Accept ] ’ Cancel ] [ Apphy ] Help
Figure 3.6

Click on the Accept button to close the above dialog box.
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Following this, select File | New once again.

=[-8 Help

=) = Cirl+i

(= Open Cirl+0
CQpen Archive..,

Qpen Backup Manager
Import...

Create Archive...

Extract Archive...
Configure...
Recent STAAD Files k
Recent STAAD Archives »
Exit

Figure 3.7

The dialog box shown in Figure 3.4 will re-appear.
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3.4 Creating a new structure

1. In the New dialog box, we provide some crucial initial data
necessary for building the model.

The structure type is to be defined by choosing from among Space,
Plane, Floor and Truss. A Space type is one where the structure,
the loading or both, cause the structure to deform in all 3 global
axes (X, Y and Z). In a Plane type, the geometry, loading and
deformation are restricted to the global X-Y plane only. A Floor
type is a structure whose geometry is confined to the X-Z plane. A
Truss type of structure carries loading by pure axial action. Truss
members are deemed incapable of carrying shear, bending and
torsion. For our model, let us choose Space.

Let us choose Meter as the length unit and Kilo Newton as the
force unit in which we will start to build the model. The units can
be changed later if necessary, at any stage of the model creation.

We also need to provide a name in the File Name edit box. This is
the name under which the structure data will be saved on the
computer hard disk. The name “Structure?” (? will be a number) is
recommended by the program by default, but we can change it to
any name we want. Let us choose the name Plates Tutorial.

A default path name - the location on the computer drive where the
file will be saved - is provided by the program under Location. If
you wish to save the file in a different location, type in the name,

or click the III button and specify the desired path.

After specifying the above input, click on the Next button.
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[ Flane
O Floar
O Truss

File: M arne :

IF'Iates Tutorial

Location :

Il::'\test'\

]

& SPACE structure, which iz a three-dimengzional framed structure with loads applied in
any plane, is the most general.

Lenath Urits Faree Units
" lnch " Decimeter " Pound " Newton
" Foot ' Meter  KioPound  © Decabewtan
 Milimeter € Kilometer " Kilogram " KiloMewton
" Centimeter  Metic Ton  © MegaNewton

[v Dizplay thiz dialog box at the Startup

< Back I Nexl>§ I

Cancel Help

Figure 3.8

In the next dialog box, we choose the tools to be used to initially
construct the model. Add Beams, Add Plates or Add Solids are,
respectively, the starting points for constructing beams, plates or
solids. Open Structure Wizard provides access to a library of
structural templates which the program comes equipped with.
Those template models can be extracted and modified
parametrically to arrive at our model geometry or some of its parts.
If the model is to be created initially using the STAAD command
language, the Open Editor box can take us to the STAAD editor.
Please remember that all these options are also available from the
menus and dialog boxes of the GUI, even after we dismiss this
dialog box.

Note: If you wish to use the Editor to create the model, choose
Open STAAD Editor, click Finish, and proceed to Section 3.8.
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For our model, let us check the Add Plate option. Click on the
Finish button. The dialog box will be dismissed and the
STAAD.Pro graphical environment will be displayed.

Where do you want to go ? ll

[ 4dd Beam
Add Plate

[ 4dd Selid

[ Open Stucture Wwizard
[ Open STAAD Editar
[ Edit Jab Information

1] i

Beqin building your model by creating new jointz and 3-noded and 4-noded plate elements
uging the construction grid, drawing tools and spreadsheets,

v Dizplay thiz dialog box at the Startup
< Back I Firizh I Cancel Help

Figure 3.9
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3.5 Elements of the STAAD.Pro screen

The STAAD.Pro main window is the primary screen from where
the model generation process takes place. It is important to
familiarize ourselves with the components of that window before
we embark on creating the RC Frame. Section 1.5 in tutorial
problem 1 of this manual explains the components of that window
in detail.
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3.6 Building the STAAD.Pro model

We are now ready to start building the model geometry. The steps
and, wherever possible, the corresponding STAAD.Pro commands
(the instructions which get written in the STAAD input file) are
described in the following sections.
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3.6.1 Generating the model geometry

The structure geometry consists of joint numbers, their
coordinates, member numbers, the member connectivity
information, plate element numbers, etc. From the standpoint of the
STAAD command file, the commands to be generated are :

JOINT COORDINATES
1000;2200;3202;4002
5400;6402,7600,8602
9204;10004;11404 ;12604
ELEMENT INCIDENCES SHELL
11234,22563,35786
443910;536119,6681211

In this tutorial, we will explore 4 different methods to create the
model shown in section 3.2:

1. Using a mixture of drawing an element and the Copy/Paste
facility.

2. Using a mixture of drawing an element and the
Translational Repeat facility.

3. Using the Structure Wizard facility in the Geometry menu.

4. Using the Mesh Generation facility of the main graphical
screen.
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Creating the Plates - Method 1

Steps:

The Grid Settings

1. We selected the Add Plate option earlier to enable us to add plates
to create the structure. This initiates a grid in the main drawing
area as shown below. The directions of the global axes (X, Y, Z)
are represented in the icon in the lower left hand corner of the
drawing area. (Note that we could initiate this grid by selecting the
Geometry | Snap/Grid Node | Plate menu option also.)

STAAD.Pro - Plates Tutorislstd
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Figure 3. 10
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It is worth paying attention to the fact that when we chose the Add
Plate option in section 3.4, the page control area has been
automatically set up to have the Geometry — Plate page be in focus.

[ i General I Z Geometry | Setp

I & Solid [ & Srfde I W Piate | | Beam

Figure 3. 11

2. A Snap Node/Plate dialog box also appears in the data area on the
right side of the screen. The Linear tab is meant for placing the
construction lines perpendicular to one another along a "left to
right - top to bottom™ pattern, as in the lines of a chess board. The
Radial tab enables construction lines to appear in a spider-web
style, which makes it is easy to create circular type models where
members are modelled as piece-wise linear straight line segments.
The Irregular tab can be used to create gridlines with unequal
spacing that lie on the global planes or on an inclined plane. We

will use the Linear tab.

In our structure, the elements lie in the X-Z plane. So, in this
dialog box, let us choose X-Z as the Plane of the grid. The size of
the model that can be drawn at any time is controlled by the
number of Construction Lines to the left and right of the origin of
axes, and the Spacing between adjacent construction lines. By
setting 6 as the number of lines to the right of the origin along X, 4
along Z, and a spacing of 1 meter between lines along both X and
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Z (see next figure) we can draw a frame 6m X 4m, adequate for
our model. Please note that these settings are only a starting grid
setting, to enable us to start drawing the structure, and they do not
restrict our overall model to those limits. In fact, we do not even
need this 6m X 4m grid. The method we are using here requires
just a 2m X 2m grid since we are about to draw just a single
element.

i Snap Node/Plate E
Linear |Hadia|| Ilregulall
~ Plahe————— —angle of Plane”

Ry i

Lol & vy IEI

vz CZ2Z
— Grid Origit [m)

¥ ¥ z

4 fo |0 0

r— Construction Lines

Spacing
Left Right il Skew”

«F @F @F b
2 @F @ b

r— Labels

[ Local Coordinate

[~ Rel Coords [ Asis|ds Fart... |

End(z] Freq.
%[sat AT Bz x| z|
2 e =l 8 & LY T

™ Shap to existing nodes too

Snap Hode/Plate | Cloze I

Figure 3. 12
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Creating element 1

The four corners of the first element are at the coordinates (0, 0,
0), (2,0, 0), (2,0, 2), and (0, 0, 2) respectively. To start creating
the nodes, let us first activate the Snap Node/Plate button by
clicking on it. Then, with the help of the mouse, click at the origin
(0, 0, 0) to create the first node.

(0,0, 0) - origin Rt

Figure 3. 13

In a similar fashion, click on the remaining three points to create
nodes and automatically join successive nodes by a plate.

(2,0,0), (2,0, 2)and (0, 0, 2)

The exact location of the mouse arrow can be monitored on the
status bar located at the bottom of the window where the X, Y, and
Z coordinates of the current cursor position are continuously
updated.

ot e st s, Hol CTRL ey et N0 000 2 el
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When steps 1 to 4 are completed, the element will be displayed in
the drawing area as shown below.

Ed Plates Tutorial std - Whole Structure =] B3

ENT

Figure 3. 14
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5. At this point, let us remove the grid display from the structure. To
do that, click on the Close button in the Snap Node/Plate dialog

box.

i Snap Mode/Flate E3
Linear |F|adial| Irregularl
 Plane————— —&nagle of Plane®

(el L xR

Tl ™ vy ID

Ll Czz
— Grid Origir ()

% v z

[~ [ {0 0

r— Congtruction Lines

Spacing
Left Right m Skew®

«F @F @F b
2 @ @

—Labels

[” Local Coordinate

[ Fel Coords [ Asis|ds Font... |

Endlz]  Freq
e T | O = N -
zIStart v”1_ T

[ Snhap to existing nodes too

Figure 3. 15
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The grid will now be removed and the structure in the main
window should resemble the figure shown below.

Ed Plates Tutorial.std - Whole Structure =] 3

b

Figure 3. 16

6. Itis very important that we save our work often, to avoid loss of
data and protect our investment of time and effort against power
interruptions, system problems, or other unforeseen events. To save
the file, pull down the File menu and select the Save command.

7. For easy identification, the entities drawn on the screen can be
labeled. Let us display the plate numbers. (Please refer to the
‘Frequently Performed Tasks’ section at the end of this manual to
learn more about switching on node/beam/plate labels.)
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The following figure illustrates the plate number displayed on the

structure. The structure in the main window should resemble the
figure shown below.

Figure 3. 17

If you are feeling adventurous, here is a small exercise for you.
Change the font of the plate labels by going to the View menu and
selecting the Options command, and then selecting the appropriate
tab (Plate labels) from the Options dialog box.
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Creating element 2

Examining the structure shown in section 3.2 of this tutorial, it can
be seen that the remaining elements can be easily generated if we
could copy the existing plate and then, paste the copied unit at
specific distances. The program does indeed have a Copy-Paste
facility and it is under the Edit menu.

First, select plate 1 using the Plates Cursor ‘ i |

Click the right mouse button and choose Copy from the pop-up
menu (or click on the Edit menu and choose Copy). Once again,
click the right mouse button and select Paste Plates (or choose
Paste Plates from the Edit menu) as shown below.

Copy crl+c

Copy cirl+C
aste Plates Ctrl+v

Move F2 Move F2
Select Cursor r Select Cursor kN
Selection Mode 4 Selection Mode L4

Generate Plate Mesh. .. Generate Plate Mesh, ..

Agsign Loads. .. Assign Loads...

Mew View... Mew View...

Labels... Labels...

(=¥ Structure Diagrams. ..
B Model View Details

> 30 Rendering

= Structure Diagrams. ..
® Model View Details

& 30 Rendering

Figure 3. 18

Figure 3. 19
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10. Since this facility allows us to create only one copy at a time, all
that we can create from element 1 is element 2. The four nodes of
element 2 are at distance of X =2, Y =0, and Z = 0 away from
element 1. So, in the dialog box that comes up, provide 2, 0, and 0
for X, Y and Z respectively and click on the OK button.

Paste with Move E2
Mowe current clipboard selection by
" Ia m Cancel |
Hel
v.[o m _ He |
Reference Pt |
s IEI m

Figure 3. 20

The model will now look like the one shown below.

Figure 3. 21
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12.
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Creating element 3

The nodes of element 3 are at X = 4m away from those of element
1. So, let us create the third element by repeating steps 8 to 10
except for providing 4m for X in the Paste with Move dialog box.

Alternatively, we could use element 2 as the basis for creating
element 3, in which case, the X increment will be 2m. If you make
a mistake and end up pasting the element at a wrong location, you
can undo the operation by selecting Undo from the Edit menu.

After creating the third element, the model should look like the one
shown below.

Figure 3. 22
Click anywhere in the screen to un-highlight the highlighted plate.

Creating elements 4, 5 and 6

The elements 4, 5 and 6 are identical to the first three elements
except that their nodes are at a Z distance of 2m away from the
corresponding nodes of elements 1 to 3. We can hence use the
Copy-Paste technique and specify the Z increment as 2m.

Select all three of the existing plates by rubber-banding around
them using the mouse.
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13.

14.

Click the right mouse button and choose Copy from the pop-up
menu (or click on the Edit menu and choose Copy). Once again,
click the right mouse button and select Paste Plates (or choose
Paste Plates from the Edit menu).

Provide 0, 0, and 2 for X, Y and Z respectively in the Paste with
Move dialog box that comes up. Then, click on the OK button and
observe that three new elements are created.

Since some elements are still highlighted, click anywhere in the
drawing area to un-highlight those elements.

The model, with all the six plates generated, will now look as
shown below.

s

Figure 3. 23
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If you want to proceed with assigning the remainder of the data,
go to section 3.6.2.

If instead, you wish to explore the remaining methods of creating
this model, the current structure will have to be entirely deleted.
This can be done using the following procedure.

From the Select menu, choose By All | All Geometry option. The

entire structure will be highlighted. Hit the key on your
keyboard. A message box shown below will appear. Click on the
OK button.

STAAD Pro for Windows [EX

& £ Platels] to be deleted
Cancel |

Figure 3. 24

As we click on the OK button, the following message box appears.
Let us say Yes. The message box will be dismissed and the entire
structure will be deleted.

STAAD Pro for Windows

& Deleting plates has left some nodes with no strutural element attached. Do you want to delete these nodes?

es Ma |

Figure 3. 25
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Creating the Plates - Method 2

Steps:

Creating element 1

In this method, we will be using STAAD’s Translational Repeat
facility to create our model. To utilize this facility, we need at least
one existing entity to use as the basis for the translational repeat.
So, let us follow steps 1 to 7 from “Method 1’ to create the first
element. Once that is done, our model will look like the one shown
below.

Note: If you have trouble bringing the grid settings dialog box, go
to the Geometry menu and select Snap/Grid Node Plate.

Figure 3. 26
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Creating elements 2 and 3

In Method 1, it required two separate executions of the Copy/Paste
function to create elements 2 and 3. That is because, that facility
does not contain a provision for specifying the number of copies
one would like to create. Translational Repeat is a facility where
such a provision is available.

Select plate 1 using the Plates Cursor | et | (Please refer to the
‘Frequently Performed Tasks’ section at the end of this manual to
learn more about selecting plates.)

Click on the Translational Repeat icon or select the Geometry |
Translational Repeat menu option as shown below.

[ Geometry|

Modes

Snap)Grid Node 4
.0"' Insert Mode...

Add Beam 3
Add Plate L4
sy Add Solid
ik Add Surface

Create Colinear Beamns
Connect Beams Along 4
E Create Infill Flates

Create Parametric Models. ..

Tran-.:latiu:unal Repeat... k

&\ Circular Repeat...

&P Generate Surface meshing
Generate Plate Mesh

Generate Slabfwall Connection

Move... L4
(=% Rotate,,.
-Qa— Mirrar. ..
/\ Stretch Selected Member(s)

Intersect Selected Members L4

IMerge Selected Members

Merge Selected Nodes

X @\ -&ﬂ— G Renumber L4

Split Beam
Break Beams at Selected Modes

Translational Repeat Y —

Figure 3. 27 Figure 3. 28
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The 3D Repeat dialog box comes up. By default (when the
Geometry Only option is not checked), all loads, properties, design
parameters, member releases, etc. on the selected entities will
automatically be copied along with the entities. By checking the
new option labeled Geometry Only, the translational repeating will
be performed using only the Geometry data. In our example, it does
not matter because no other attributes have been assigned yet.

To create elements 2 and 3 along the X direction, specify the
Global Direction as X, No of Steps as 2 and the Default Step
Spacing (along X) as 2m. The Link Steps option is applicable when
the newly created units are physically removed from the existing
units, and when one wishes to connect them using members.
Renumber Bay enables us to use our own numbering scheme for
entities that will be created, instead of using a sequential
numbering that the program does if no instructions are provided.
Let us leave these boxes unchecked. Then, click on OK.

3D Repeat g|
[
— "
[[] Renumber Bay
Smh [ Link Steps
Global Directi Generation Flags
obal Direction No of Steps: |2| EI @A O GeometryOnly
®@x Oy Oz e
Defaul Step Spacing: m () Geometry and Property Only
Figure 3. 29

Since element 1 is still highlighted, click anywhere in the drawing
area to un-highlight it.
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The model will now look as shown below.

Figure 3. 30

Creating elements 4, 5 and 6

Let us follow the same Translational Repeat method to create these
elements. Select all the three existing plates by rubber-banding
around them using the mouse. Make sure that before you do this,

the cursor type is the Plates Cursor | Eﬁ else, no plates will be
selected.

Repeat steps 3 and 4 but this time, specify the Global Direction as
Z, No of Steps as 1 and the Default Step Spacing as 2m. Leave all
the other boxes unchecked. Then, click on OK.

All the 6 elements are now created.

Since some of the plates are still highlighted, click anywhere in the
drawing area to un-highlight them.
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Our model will now look like the one shown below.

Figure 3. 31

If you want to proceed with assigning the remainder of the data, go
to section 3.6.2.

Instead, if you wish to explore the remaining methods of creating
this model, the current structure will have to be entirely deleted.
This can be done using the following procedure.

From the Select menu, choose By All | All Geometry option. The

entire structure will be highlighted. Hit the key on your
keyboard. A message box shown below will appear. Click on the
OK button.

STAAD.Pro for Windows [E4

& B Platefs] to be deletad

Cancel |

Figure 3. 32
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As we click on the OK button, the following message box appears.

Let us say Yes. The message box will be dismissed and the entire
structure will be deleted.

STAAD Pro for Windows

& Deleting plates has left some nodes with no strutural element attached. Do you want to delete these nodes?

es Ma |

Figure 3. 33
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Creating the Plates - Method 3

Steps:

There is a facility in STAAD called Structure Wizard which offers
a library of pre-defined structure prototypes, such as Pratt Truss,
Northlight Truss, Cylindrical Frame, etc. A surface entity such as
a slab or wall, which can be defined using 3-noded or 4-noded
plate elements is one such prototype. We can also create our own
library of structure prototypes. From this wizard, a structural
model may parametrically be generated, and can then be
incorporated into our main structure. Structure Wizard can hence
be thought of as a store from where one can fetch various
components and assemble a complete structure.

Select the Geometry | Run Structure Wizard menu option from the

top menu bar.
Geometry
Modes
Snap/Grid Node »
% Insert Node...

Add Eeam 3
Add Plate L4
e Add Solid
1o+ Add Surface

Create Colivezr Beams
Connect Beams Alang L4
Hf] Greate Infill Plates

Create Parametric Madels. ..

N Translational Repeat. ..
@M Circular Repeat..,,

&8 Generate Surface meshing
Generate Plate Mesh

Generate Slab/Wall Connection

Maove... L3
(=4 Rotate. ..

M Mirrar.

,-\ Stretch Selected Memberisy

Intersect Selected Members L4

MMerge Selected Members

Merge Selected Modes

Renumber 4
Split Beam

Break Beams at Selected Modes

Run Strucky

Figure 3. 34
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The Structure Wizard window opens up as shown below.

default.stp - Stwizard =] B3
File Edit “iew Help

s

Lo g @ IO P o PR e | ]

{* Prototype Models " Saved User Models

hodel Type:

i Y i i N

Pratt Truzs  warren Truss  Howe Bridoge

EEFN lw, [P

Lattice Truss  Howe Roof Morth Light

Ready [

Figure 3. 35

(Note that the Open Structure Wizard option in the Where do you
want to go? dialog box in the beginning stage of creating a new
structure — see Figure 3.9 — also brings up this facility.)
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2. The unit of length should be specified prior to the generation of a
model. From the File menu of this Structure Wizard window, click
Select Units. In the Select Units dialog box that comes up, we can
select one of the units of length from Imperial (inch, feet) or
SI/Metric (millimeter, centimeter, meter) system of units. Let us
choose Meters and click on the OK button.

—_—
default.stp - 5StWizard

528 Edit View Help

New Ctrl4+N
Open... Ctrl+0
Save Ctrl45
Save As...

Select Units
Select Units | %
S/ etric
i Millimeters

i Centimeters
& Meters
Cancel |

Figure 3. 36 Figure 3. 37

Add Plugin...
w Set As Top Most

Imperial
" Inches
" Feet

1 C:\SPro2006Y, .. \default.stp
2 C:\SPro2005Y,..\default.stp

Exit

3. From the Model Type list box, select Surface/Plate Models as
shown below.

default.stp - StWizard

File Edit “iew Help
R EIR
Lo 5285 4P

¢ Protatype Maodels i Saved User Models

Model Type:

Truss hModels
Frame Mocdels

i i N

Salicd Models

Pratt Truss  |Composite Models
Import CAD Models
WBA-Macro Models

EERR . [P

Lattice Truzs  Howwe Roof Morth Light

Figure 3. 38
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To select the Quad Plate option, click on it using the mouse.

Circular Plate  GQuad Plate
With Holes

Palygonal
Plate i

§ = I

Cylindrical Spherical  Coaling Tower
Surface Surface
Hyperbolic
Paraboala...
Figure 3. 39

Then, using the mouse, either double-click on the Quad Plate
option or, drag the Quad Plate option to the right side of the
Structure Wizard window as shown below.

Flsady

Figure 3. 40

default.stp - Swizard [_[olx] I
File Edit “iew Help
DFEEfEB(E(7]
R A I |
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§ = 1

Cylindrical ~ Spherical  Conling Tower

Surface Surtace

Hyperboiic Z/

Paraholo

Input Uit [m 4

3-39
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A dialog box by the name Select Meshing Parameters comes up. In
this box, we specify, among other things, two main pieces of
information - a) the dimensions of the boundary (or superelement
as it is commonly known) from which the individual elements are
generated b) the number of individual elements that must be
generated. (a) is defined in terms of the X, Y, Z coordinates of its
Corners A, B, C and D. (b) is defined in terms of the number of
divisions along sides AB, BC, etc.

Let us provide the Corners, the Bias and the Divisions of the
model as shown in the figure below. Then, click on the Apply
button.

Select Meshing Parameters
b adel Marme: IE!uad Plate
— Corner —Length, Biag & Division——————— [~ Element Tppe——
s v = Length(m) Bias Divn ® Tl
afo o Jo 4B: |6 f1 |2
% [Juadilateral
s o o BC: |4 f1 B
cfls o [« co: 8 [1 E
p: o o [« Da: 4 [1 E
Al unitz arein m Apply I Cancel
Figure 3. 41

If you made a mistake and wish to bring up the above dialog box
again, click the right mouse button in the drawing area and choose
Change Property.

Figure 3. 42
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7.  To transfer the model to the main window, select File | Merge
Model with STAAD.Pro Model as shown below.

default.stp - StWizard
=8 Edit View Help

Mew Ctrl -+
Cpen... Ctrl+0
Save Ctrl+5
Save As...

Select Units

Merge Model with STAAD.Pro Model

v Set As Top Most

1 C:\SPro2006Y, .. \default.stp
2 C:\SPro2005Y, . \default.stp

Exit

Figure 3. 43

8.  When the following message box comes up, let us confirm our
transfer by clicking on the Yes button.

stwizard i

:;:) ‘Whonld vou like to transfer or merge this model ko STAAD.Pro?

Yes Mo |

&
Figure 3. 44

The dialog box shown in the next figure comes up. If we had an
existing structure in the main window, in this dialog box, we will
be able to provide the co-ordinates of a node of the structure in the
main window to which we want to connect the piece being brought
from the wizard.

If there isn’t any existing structure, this box is a means of
specifying any distances along X, Y and Z axes by which we want
the unit (being brought from the Wizard) to be shifted.
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In our case, since we do not have an existing structure in the main
window, nor do we wish to shift the unit by any amount, let us
simply click on the OK button.

Paste Prototype Model

Mowe pratotype madel by:
58 IU " Cancel |
Hel
v:[o m Ll
z ID— m

Figure 3. 45

The model will now be transferred to the main window.

T
e

&5

Figure 3. 46
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If you want to proceed with assigning the remainder of the data,
go to section 3.6.2.

Instead, if you wish to explore the remaining methods of creating
this model, the current structure will have to be entirely deleted.
This can be done using the following procedure.

From the Select menu, choose By All | All Geometry option. The

entire structure will be highlighted. Hit the key on your
keyboard. A message box shown below will appear. Click on the
OK button.

STAAD Pro for Windows [EX

& £ Platels] to be deleted
Cancel |

Figure 3. 47

As we click on the OK button, the following message box appears.
Let us say Yes. The message box will be dismissed and the entire
structure will be deleted.

STAAD Pro for Windows

& Deleting plates has left some nodes with no strutural element attached. Do you want to delete these nodes?

es Ma |

Figure 3. 48
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Creating the Plates - Method 4

Steps:

The STAAD.Pro GUI contains a facility for generating a mesh of
elements from a boundary (or superelement) defined by a set of
corner nodes. This facility is in addition to the one we saw in
Method 3. The boundary has to form a closed surface and has to be
a plane, though that plane can be inclined to any of the global
planes.

The first step in defining the boundary is selecting the corner
nodes. If these nodes do not exist, they must be created before they
can be selected. So, either click on the Snap Node/Quad Plates
icon or select Geometry | Snap/Grid Node | Plate | Quad menu
option as shown in the figures below.

STAAD _Pro - Plates Tutorial.std

File Edit “iew Toolz Select Geometry Command: Analyze Mode Window  Help
[osd@mierxotcrw BN ” ||BR5B
|lpoooaanesrdocsw|Elaaad
|[arvnminBBER: TOB | |KK 46 [

B Snap Mode/ Quad Plates;

Figure 3. 49
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[ Geometry Commands Analyze  Made

Modes

Snap,Grid Node

=¥ Insert Mode. ..

Window  Help

I o
gﬁ:mﬂﬂfaé[& I

]
BT

Add Beam
Add Plate
sy Add Solid
$it Add Surface
Create Colinear Beams
Connect Beams Along
i Greate Infill Flates

Solid B Triangle

3
Al
3

Figure 3. 50

A Snap Node/Plate dialog box appears in the data area on the right
side of the screen. (We have already seen this dialog box in
methods 1 and 2.) As before, let us select the Linear tab. In our
structure, the elements lie in the X-Z plane. So, in this dialog box,
let us choose X-Z as the Plane of the grid. The size of the model
that can be drawn at any time is controlled by the number of
Construction Lines to the left and right of the origin of axes, and
the Spacing between adjacent construction lines. All that we are
interested in is the 4 corner nodes of the super-element. So, let us
set 1 as the number of lines to the right of the origin along X and Z,
and a spacing of 6m between lines along X and 4m along Z.
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i Snap Node/Plate | X]
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Ry i
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Left Right il Skew”
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[~ Rel Coords [ Asis|ds Fart... |

End(z] Freq.
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Figure 3. 51
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The main drawing area will now look similar to the one shown
below.

1]
.—"‘\
- .
- ~
- \\.
o .
.- -
a L .
.
- .
N e
N -
. -
" - .
. -
4

Figure 3. 52
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To start creating the nodes, let us first activate the Snap
Node/Plate button by clicking on it. Holding the ‘Ctrl” key down,
click at the four corners of the grid as shown below. Those four
points represent the four corners of our slab and are (0, 0, 0), (6, 0,
0), (6, 0, 4), and (0, 0, 4). In fact, keeping the ‘Ctrl’ key pressed
and clicking at points on the grid successively, is a way of creating
new nodes without connecting those nodes with beams or plates. If
the “Ctrl” key weren’t kept pressed, the nodes would become
connected.

Figure 3. 53

It is worth noting that the purpose of the previous four steps was to
merely create the four nodes. Consequently, any of the several
methods available in the program could have been used to create
those nodes. We could have typed the data into the editor, or in the
grid tables of the Geometry-Plate page control area, or even used
the Snap Grid/Node — Beam option of the Geometry menu from the
top of the screen to graphically create the points.
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Let us now Close the Snap Node/Plate dialog box as shown below.

i Snap Node/Plate E
Linear |Hadial| Inegularl
— Plane Angle of Plane”
Ry LT
& wZ oy ID
O E O Z2Z
— Gind Qrigin [m)
# Y z
R fo fo 0
r— Congtruction Lines
Spacing

Left Right il Skew®
< @F @F b
zfo B0 Bl o

— Labels

[ Local Coordinate

[~ Rel Coords [ #xizlds  Font. |

End(z] Freq.
% st =T B v | 2|
zIStart v”1_ B |

™ Shap to existing nodes ton

Figure 3. 54

We are now ready to utilize the second method available in the
program for mesh generation.
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5.  For this, either click on the Generate Surface Meshing icon or go
to Geometry | Generate Surface Meshing menu option as shown
below.

STAAD _Pro - Plates Tutorial.std

File Edit Yiew Tools Select Geomehy Commands Analze Mode ‘Windo
e A I E
loosaaaasst+scx|Baq
|avrnanneg@@®.c i T QHE

= Ed Plates Tutorial.std - Whole St [E] e

ho | &

Figure 3. 55
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o Insert Node. ..

Add Beam 4
Add Plate 4
sy Add Solid
$it Add Surface

Create Calimear Beams
Conneck Beams Along 4
m Create Infill Flates

Create Parametric Madels. .,

o Translational Repeat. .,
&N Circular Repeat. ..

@ Generate Surface meshing

Generate Blate Mest

Generate Slabwall Connection

Figure 3. 56
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We now have to select the points which form the boundary of the
superelement from which the individual elements will be created.
The four points we just created are those four points. So, let us
click at the four node points in succession as shown below. Lastly,

close the loop by clicking at the start node (or the first clicked
point) again.

Figure 3. 57
As we click at the start node the second time, the following dialog

box comes up. Let us choose the Quadrilateral Meshing option
and click on the OK button.

Choose Meshing Type E3

Type of Mesh Generation

" Polygonal Meshing

% Quadrilateral Meshing

Cancel |

Figure 3. 58
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7.  The Select Meshing Parameters dialog box (as we saw earlier in
Method 3), comes up. Notice that this time however, the data for
the four corners is automatically filled in. The program used the
coordinates of the four nodes we selected to define A, B, C, and D.
Provide the Bias and the Divisions of the model as shown in the
figure below. Click on the Apply button.

odel Mame: IQuad Flate
Corners Length, Biag & Division————————————————— Element Type
% v 2 Lenathim) Biaz Diivn. ® i

afo o o 4B: |6 [1 |2

' Quadilateral
2 R TR BC: [4 [1 B
o R T co: [6 1 1
oo b fs DA 4 [ 4

Al unitz are in m

Cancel |

Figure 3. 59

As we click on the Apply button, our model will appear in the

(==s]
drawing area as the one shown below. Click on the . button to
exit the mesh generating mode.

Figure 3. 60
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3.6.2 Changing the input units of length

As a matter of convenience, for specifying element properties for
our structure, it is simpler if our length units are centimeter instead
of meter. This will require changing the current length units of
input. The command to be generated is:

UNIT CM KN
Steps:

1.  Click on the Input Units icon from the appropriate toolbar.

—
|t &
f—
Input Units

Figure 3. 61

Alternatively, one may select the Tools | Set Current Input Unit
menu option as shown below.

G Select Geometry Commands  Analyze Mode  Window
Check Multiple Structures. ..

Check Duplicate 4
Orphan Modes 4
Check for Warped Plates...

Check Zero Length Members

Check Improperly Connected Plates

Caleulator. ..

Unit Converter...

=4 Dimension Beams...
R& Display Node to Node Distance

=W <t Current Input Unit....

Set Current Display Unit...
#% Cut Section. ..

Query 4

List Format...

Figure 3. 62
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2. In either case, the following dialog box comes up. Set the Length
Units to Centimeter and click on the OK button.

Set Current Input Units |

—Length Units———————— — Force Units
" nch " Decimeter " Pound " Mewtan
" Foot " Meter O KiloPound 7 DecaMewton
O Milimeter  © Kilameter ' Metiic Ton % KilaMewtan
¢ Cenlimeter " Kilogram " Megahlewton

Ok I Cancel

Figure 3. 63
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3.6.3 Specifying Element Properties

Just as properties are assigned to members, properties must be
assigned to plate elements too. The property required for plates is
the plate thickness (or the thickness at each node of elements if the
slab has a varying thickness).

The corresponding command which should be generated in the
STAAD command file is:

ELEMENT PROPERTY
1 TO 6 THICKNESS 30

Steps:

1.  Click on the Property Page icon located on the Structure Tools
toolbar.

|Blges

Property Page
Figure 3. 64
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Alternatively, one may go to the General | Property page from the
left side of the screen as shown below.

Ed Plates Tutorial std - Whole Structure : i ] 4]

Geometry [ # Setup
I R Material [ k= Load [ 8- Gupport [ 2 Gpec F;rﬂp%

X

[ & Design | W, anaiysisiPrint

Figure 3. 65
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2. In either case, the Properties dialog box comes up as shown
below. Plate thickness is specified through the dialog box available
under the Thickness button.

i Properties - Whole Structure E2
Section | Eeta Angle I

Ref Section bd aterial

¥ Highlight &ssigned Geametry
Edt. | Delete.. |

Walues. .. | Section Database Define... |

b aterialz. . | dzer Table... |

Azgignment Method

) Agsign To Selected Beams & Use Cursor To Assign

€~ fesign To Edit List € fesign To View
Azgign | Cloze Help

Figure 3. 66
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The dialog box shown below comes up. Let us provide the plate
thickness as 30cm. Notice that the field called Material is presently
on the checked mode. If we keep it that way, the material
properties of concrete (E, Poisson, Density, Alpha, etc.) will be
assigned along with the plate thickness. The material property
values so assigned will be the program defaults. (To see those
default values, click on the Materials button in the dialog box
shown in the previous figure.) Since we want to assign just the
default values, let us keep the Material box in the checked mode
itself. Then, click on the Add button followed by the Close button
as shown below.

Plate /Surface Property EI

R Pl Plate/Surface Thickness
h Surface Thickness

4 3 Mode 1: |3':| cm
+2 24
3 Mode 2: |3D cm
L Mode 3: |3D cm
i 2t Mode 4: |3D om
¥ Material

IEDNEHETE Vl

]

Add Assigh | Cloze Help
1

Figure 3. 67
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At this point, the Properties dialog box will look as shown below.

i Properties - Whole Structure E2

Section | Beta Anglel

Ref Section bd aterial

1 Flate: Thick COMCRETE

¥ Highlight &ssigned Geometry
Edt. |  Delete. |

Walues... | Section D atabase | Define. .. |

M aterialz... | Thickness... I User Table... |

Agzzignment Method
€ fesign To Selected Flates {* Use Cursor To Assign
" Agsign To Edit List ' Azsign To Wiew
Aszign | Cloze | Help
Figure 3. 68

Since we want the thickness to be applied to all elements of the
structure, let us select the Assignment Method called Assign To
View and then click on the Assign button as shown in the above
figure.

As we click on the Assign button, the following message box
comes up. Let us click on the Yes button to confirm our choice.
STAAD Pro for Windows B

The dzsignment method vou have chozen iz Azzign bo Wiew,
Do you want to procesed 7

Yes Mo |

Figure 3. 69
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The structure will now look as shown below.

Figure 3. 70

Click anywhere in the drawing area to un-highlight the selected
entities. We do this only as a safety precaution. When an entity is
highlighted, clicking on any Assign option is liable to cause an
undesired attribute to be assigned to that entity.
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3.6.4 Specifying Material Constants

In Section 3.6.3, we kept the Material check box “on” while
assigning the element properties. Consequently, the material
constants (E, Density, Poisson’s Ratio, etc.) of concrete got
assigned to the plates along with the properties, and the following
commands were generated in the command file:

UNIT METER KN

CONSTANTS

E 2.17185e+007 MEMB 1 TO 6
POISSON 0.17 MEMB 1 TO 6
DENSITY 23.5616 MEMB 1 TO 6
ALPHA 1e-005 MEMB 1 TO 6

Hence, there is no longer a need to assign the constants separately.
However, if we hadn’t assigned them as before, we could go to the
menu option Commands | Material Constants and assign them
explicitly as shown in the figure below.

Commands Analyze Mode ‘wWindow Help

Plate Thickness & 5 & HJ | g_.n_l
Surface Thickness

tember Property 3 @l a @ @ @ Iy Sj? Q
Material Constants Material Table... |
Geometiic Constants 3

Ciensity... I

5 t 5 pecificati } -
upport 5pecifications e,

tember 5pecfications L4 Poisson's Fatio,..

Plate Element Spec.if.icat.ions 3 Alpha...

Master/Slave Specification » D amping Ratio. .

Pre: Analysis Print b G [Shear Modulug] ...
Fo? Define Damping for Dynarnics Clear Above Commands...

Loading 3

Analygis »

FPost-Analysis Print 3

Dresign »

Mizcellansous 3

Figure 3. 71



3-62 | Tutorial 3

3.6.5 Specifying Supports

The slab is fixed-supported along the entire length of two of its
sides. However, when modelled as plate elements, the supports can
be specified only at the nodes along those edges, and not at any
point between the nodes. It hence becomes apparent that if one is
keen on better modelling the edge conditions, the slab would have
to be modelled using a larger number of elements.

In our case, the commands we need to generate are:

SUPPORTS
1245710 FIXED

Steps:

1.  To create supports, click on the Support Page icon located in the
Structure Tools toolbar as shown below.

| B

N

Support Page

Figure 3. 72
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Alternatively, one may go to the General | Support Page from the
left side of the screen.

£ Plates Tutorial std - Whole Stucture 10l =|
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Figure 3. 73
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2. In either case, the Supports dialog box comes up as shown in the
next figure.

3.  For easy identification of the nodes where we wish to place the
supports, let us turn the Node Numbers on.

4. Since we already know that nodes 1, 2, 5, 7, 4 and 10 are to be

associated with the Fixed support, using the Nodes Cursor [%_Ol

select these nodes.

5.  Then, click on the Create button in the Supports dialog box as
shown below.

! Supports - Whole Structure E |

Ref Dezcription

51 Mo support ><

Edit | Create Delete

—&gzignment kethod
%" Assign To Selected Modes
" Azzign To View

" Usze Cursor To Assign

" Azzign To Edit List

Azzign Cloge Help

Figure 3. 74
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6. The dialog box shown below comes up. The Fixed tab happens to
be the default which is convenient for this case. Click on the

Assign button as shown below.

Create Support E3

Enforced But | bultilinear 5 pring | Foundation I Inclined I
Fixed | Pifned | Fized But I Enforced
— Restraint
Y. 7 M
Z Fye v
¥ rz ¥ Mz
Add Cancel Azzigh l}%l Help
Figure 3. 75

It is important to understand that the Assign button is active
because of what we did in step 4 earlier. Had we not selected the
nodes before reaching this point, this option would not have been

active.
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After the supports have been assigned, the structure will look like
the one shown below.

Figure 3. 76
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3.6.6 Specifying Primary Load Cases

Three primary load cases have to be created for this structure.
Details of these load cases are available at the beginning of this
tutorial. The corresponding commands to be generated are listed
below.

UNIT METER KG
LOAD 1 DEAD LOAD
SELF Y -1.0

LOAD 2 EXTERNAL PRESSURE LOAD
ELEMENT LOAD
1TO 6 PR GY -300

LOAD 3
TEMPERATURE LOAD
1TO 6 TEMP 40 30

Steps:

1.  To create loads, click on the Load Page icon located on the
Structure Tools tool bar.

IBmaele

Load Page
Figure 3. 77
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i General

[ i Design | . anatysiseprint

Alternatively, one may go to the General | Load Page from the left
side of the screen.

I R Material [FL_UEH 8- Support = spec [ H Property
X 7

Ed Plates Tutorial std - Whi - O x|

b

Figure 3. 78

Notice that the pressure load value listed in the beginning of this
tutorial is in KN and meter units. Rather than convert that value to
the current input units, we will conform to those units. The current
input units, which we last set while specifying THICKNESS was
CENTIMETER. We have to change the force unit to Kilogram and
the length units to Meter. To change the units, as before, click on

the Input Units icon E from the top toolbar, or select the Tools |
Set Current Input Unit menu option from the top menu bar. In the
Set Current Input Units dialog box that comes up, specify the
length units as meter and the force units as Kilogram.
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LOAD CASE 1

A window titled “Load” appears on the right-hand side of the
screen. To initiate the first load case, highlight Load Cases Details
and click on the Add button.

Load X
v

=)
Load Cases Details {1. Highlight Load Cases Dela\\s]
L) Load

[ Toggle Load : 2. Click on the Add button I
Assignment Method

| (Coese ) [ ]
Figure 3. 79

The Add New Load Cases dialog box comes up. The drop-down list
box against Loading Type is available in case we wish to associate
the load case we are creating with any of the ACI, AISC or IBC
definitions of Dead, Live, Ice, etc. This type of association needs
to be done if we intend to use the program's facility for
automatically generating load combinations in accordance with
those codes.

Notice that there is a check box called Reducible per UBC/IBC.
This feature becomes active only when the load case is assigned a
Loading Type called Live at the time of creation of that case.
Please refer to STAAD.Pro 2004 Release Report for further details.

As we do not intend to use the automatic load combination
generation option, we will leave the Loading Type as None. Enter
DEAD LOAD as the Title for Load Case 1 and click on Add.
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Add New : Load Cases x|
B

E Load Generation
E Defing Combinations
B 4uto Load Combination

Murnber |1 Loading Tppe INone j

I Feducible per UBCABL

Title IDEAD 04D

Add Cloze Help

Figure 3. 80

The newly created load case will now appear under the Load Cases
Details in the Load dialog box.

+-[D) Definitions
= Load Cases Details
1: DEAD LOAD
Load Envelopes

Figure 3. 81

To generate and assign the first load type, highlight DEAD LOAD.
You will notice that the Add New Load Items dialog box shows
more options now.

+-[D] Definitions
= Load Cases Details

1: DEAD LOAD

[L] Load Envelopes

Figure 3. 82
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Selfweight Load
@ Nodal Load
@ Member Load
0 Physical Member Load
@ Area Load
Q Floor Load
@ Plate Loads
Q Surface Loads
@ Solid Loads
@ Temperature Loads
Q Seismic Loads
@ Time History
@ Wind Load
@ Snow Load
Q Response Spectra
@ Repeat Load
Q Frequency

|~

6 Seffweight

|

Tutorial 3
In the Add New Load Items dialog box, select the Selfweight Load
option under the Selfweight item. Specify the Direction as Y, and
the Factor as -1.0. The negative number signifies that the
selfweight load acts opposite to the positive direction of the global
axis (Y in this case) along which it is applied. Click on the Add
button. The selfweight load is applicable to every member of the
structure, and cannot be applied on a selected list of members.

(%]
Direction
Ox @Y oz
Factor
Add ] [ Close ] [ Help

Figure 3. 83
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LOAD CASE 2

Next, let us initiate the creation of the second load case which is a
pressure load on the elements. To do this, highlight Load Cases
Details. In the Add New Load Cases dialog box, once again, we are
not associating the load case we are about to create with any code
based Loading Type and so, leave that box as None. Specify the
Title of the second load case as EXTERNAL PRESSURE LOAD
and click on the Add button.

Add New : Load Cases x|
B

E Load Generation
E Defing Combinations
B 4uto Load Combination

Murnber |2 Loading Tppe INone j

I Feducible per UBCABL

Title IEXTEF\NAL PRESSURE LOAL]

[ Addl\J| Cose | [ HReb |
L

Figure 3. 84

To generate and assign the second load type, highlight
EXTERNAL PRESSURE LOAD.

+

[D) Definitions
Load Cases Details
- 1: DEAD LOAD
& SELFWEIGHT Y -1
2 : EXTERNAL PRESSURE LOAD
Load Envelopes

Figure 3. 85
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In the Add New Load Items dialog box, select the Pressure on
Full Plate option under the Plate Loads item enables the load to be
applied on the full area of the element. (The Concentrated Load is
for applying a concentrated force on the element. The Trapezoidal
and Hydrostatic options are for defining pressures with intensities
varying from one point to another. The Partial Plate Pressure
Load is useful if the load is to be applied as a “patch” on a small
localised portion of an element.)

Let us keep our focus on the Pressure on Full Plate option.
Provide -300kg/m2 for W1 (Force), GY as the Direction and click
on the Add button followed by the Close button.

@ Seffweight
@ Nodal Load
@ Member Load Load
Q Physical Member Load
@ Area Load
Foor Load
3 Plate Loads oeal Y w1 kg/m2
Pressure on Full Plate
[ Concentrated Load
i Partial Plate Pressure
E Trapezoidal
B Hydrostatic
| Hlemert Joirt Load
Q Surface Loads
@ Solid Loads
Temperature Loads
Q Seismic Loads
0 Time Histary
@ Wind Load
@ Snow Load
Q Response Spectra
0 Repeat Load
@ Frequency

Direction

Unifarrily Loaded
Area

(O Local Z

QGx @Gy @]

[ Add ] [ Close ] [ Help

Figure 3. 86
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Since the pressure load is to be applied on all the elements of the
model, the easiest way to do that is to set the Assignment Method to
Assign To View. Then, click on the Assign button in the Load
dialog box as shown below.

Load

-2 Definitions
E-[L] Load Cases Details
=5 1:DEAD LOAD
e SELFWEIGHT v -1
: 1. Highlightthisl
New. | red Edit .. Delete... |

[~ Toggle Load

—dzsignment b ethod

| Azsign Tio Selected Entities
" Azzign To Yiew

% Lsge Cursor To Assign
™ Azsign To Edit List

{-2. Click on Assign to View]

Lizzign

| Cloze Help |

: 3. Click on Assignl

Figure 3. 87

After the load has been assigned, the model will look as shown

below.

W
W

.

Figure 3. 88
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LOAD CASE 3

Next, let us create the third load case which is a temperature load.
The initiation of a new load case is best done using the procedure
explained in step 7. In the dialog box that comes up, let us specify
the Title of the third load case as TEMPERATURE LOAD and
click on the Add button.

Add New : Load Cases x|
B

E Load Generation
E Defing Combinations
B 4uto Load Combination

Murnber |3 Loading Tppe INone j

I Feducible per UBCABL

Title ITEMF’EHATUHE LOAD

Add NJ Close Help
1

Figure 3. 89

To generate and assign the third load type, as before, highlight
TEMPERATURE LOAD.

Temperature Loads are created from the input screens available
under the Temperature option in the Add New Load Items dialog
box.
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12. In the Add New Load Items dialog box, make sure that the
Temperature item is selected under the Temperature Loads
option. Then, provide 40 as the Temperature Change for Axial
Elongation and 30 as the Temperature Differential from Top to
Bottom and click on the Add button followed by the Close button.

Add New : Load Items fz

6 Seffweight

@ Nodal Load

0 Member Load

% Physical Member Load Temperature Change
@ Area Load for Auial Elongation
0 Floor Load
@ Plate Loads
@ Suface Loads
@ Soid Loads
0 flempactiss Loads Temperature Differential

gf“‘_"e'ﬁ*“"a from Sidls to Side (Local 7)
rain

Temperature Differential
from Top to Bottom

Wi

@ Seismic Loads
0 Time Histary

@ Wind Load

@ Snow Load

@ Response Spectra
Q Repeat Load

0 Frequency

[ Add ] [ Close ] [ Help

Figure 3. 90

13. Since we intend to apply the temperature load on all the plates, as
before, choose Assign To View and click on the Assign button in
the Loads dialog box (see step 9 for explanation).
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3.6.7 Creating load combinations

The specifications at the beginning of this tutorial require us to
create two combination cases. The commands required are:

LOAD COMBINATION 101 CASE 1 + CASE 2
110210
LOAD COMBINATION 102 CASE 1 + CASE 3
110310

Steps:

LOAD COMBINATION 101

1. To initiate and define load case 4 as a load combination, once
again, highlight the Load Cases Details option. In the Add New
Load Cases dialog box, click on the Define Combinations option
from the left-hand side. Enter the Load No: as 101 and the Title as
CASE 1 + CASE 2.

Add New : Load Cases x|
E Primary Define Combinations
E Load Generation
[l Define Combinations Load MNo: |1D1 Hame IEASE 1+ CasEd

B 4uto Load Combination

Type

& Nomal General Folmat:

 SRSS

- Factor |1 I™ Algebraic Component
ABS Default |1

Available Load Cases: Load Combination Definition: [A] = Algebraic.

1. DEAD LOAD Load Cases | | Factor ‘
2 EXTERMAL PRESSURE LOs

3 TEMPERATURE LOAD N

|

«
[]

Add Cloze Help

Figure 3. 91
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2. Next, in the Define Combinations box, select load case 1 from the

left side list box and click on the button. Repeat this with load
case 2 also. Load cases 1 and 2 will appear in the right side list box
as shown in the figure below. (These data indicate that we are
adding the two load cases with a multiplication factor of 1.0 and
that the load combination results would be obtained by algebraic
summation of the results for individual load cases.) Finally, click
on the Add button.

Add New : Load Cases x|
E Primary Define Combinations
E Load Generation
[l Define Combinations Load Mo |1D1 Name IEASE 1+CASE 2

B 4uto Load Combination Type

@ Nomal General Format : _

 SRSS
- Factor |1 I™ Algebraic Component
ABS Default |1

Available Load Cases: Load Combination Definition: [A] = Algebraic.
3 TEMPERATURE LOAD Load Cases Factor
Load Caze 1 @& =1
Load Caze 2 @& =1
>
<<
=]
Add NJ Close Help
L&Y
Figure 3. 92

Case 101 has now been created.
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LOAD COMBINATION 102

To initiate and define load case 5 as a load combination, as before,
enter the Load No: as 102 and the Title as CASE 1 + CASE 3.

Next, repeat step 2 except for selecting load cases 1 and 3 instead
of cases 1 and 2.

Add New : Load Cases x|
E Primary Define Combinations
E Load Generation
[l Define Combinations Load Mo |102 Name IEASE 1+CASE3

B 4uto Load Combination

Type

@ Nomal General Format :

 SRSS
- Factor |1 I™ Algebraic Component
ABS Default |1

Available Load Cases: Load Combination Definition: [A] = Algebraic.
2 EXTERMAL PRESSURE L Load Cases Factor
Load Caze 1
Load Cage 3

al
al

2
|LI

EE

Add I}J Close Help
La¥

Figure 3. 93

Thus, load 102 is also created.
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If we change our mind about the composition of any existing
combination case, we can select the case we want to alter, and
make the necessary changes in terms of the constituent cases or

their factors.

Load

[D Definitions

=-[L Load Cases Details
=1L 1:DEAD LOAD

g SELFWEIGHT Y -1

2. EXTERMAL PRESSURE LOAD
B PRGY-300 kg/m2

3: TEMPERATURE LOAD

g3 TEMP 4030

01:CASET +CASE2\

0

\{ Highlight the cases I

[11% Load 3

N I field] Edil_ | Delele _l_ Use EditDelete huttons to
L_.--'—'""_- alter or delete entries

™ Toggle Load

- Assignment Method
= Assign To Selected Entities € Wse Gursor Tio Assign
& fssign To View € Aasign To Edit List
Assign | Close | Help I
Figure 3. 94

Let us exit this dialog box by clicking on the Close button.

It is also worth noting that as load cases are created, a facility for
quickly switching between the various cases becomes available at
the top of the screen in the form of a load case selection box as

shown below.

Mode ‘wWindow Help

e ‘JJ@@@B&[&‘JJD%&%&THH@% 2 ﬁﬁ‘“@@@f@
B afaaanaq®stQ H[roeeaomo jm

R [1: DEAD LOAD
o o G HJW‘ B @ A 12 EXTERNAL PRESSURE LOAD & ‘
% TEMPERATLIRE LOAD
1||1 CASET + CASED

i — ) S
Figure 3. 95
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We have now completed the task of creating all load cases.

Let us once again save our model by pulling down the File menu
and selecting the Save command or by holding the ‘Ctrl’ key and
pressing the ‘S’ key.
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3.6.8 Specifying the analysis type

The analysis type we are required to do is a linear static type. We
will also obtain a static equilibrium report. This requires the
command:

Steps:

PERFORM ANALYSIS PRINT STATICS CHECK

1.  To specify the Analysis command, first go to Analysis/Print Page
from the left side of the screen.

bign @alpis@ i General | & Geomelry | # Setup

| B Post-print

Analysis/Print Commands

Perform Cable Analysis | PDelta Analysis
Perform Analysis |

Change
Pedorm Impedection Analysis

Pedorm Pushaover Analysis

Print Option
() No Prirt
() Load Data
) Statics Check
() Statics Load
() Mode Shapes
") Both
Oa

[] After Cument

(oo ]|

Help

Figure 3. 96
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In the Analysis/Print Commands dialog box that appears, the
instruction for specifying a linear elastic type analysis is provided
using the Perform Analysis tab. To obtain the static equilibrium
report, check the Statics Check print option. (In response to this
option, a report consisting of the summary of applied loading and
summary of support reactions, for each load case, will be produced
in the STAAD output file. See section 3.10 for information on
viewing this report).

Analysis/Print Commands [z|

Perform Cable Analysis | PDelta Analysis | Change || Perform Pushover Analysis
Perdom Arialysis | Perform Imperfection Anatysis

Prirt Option
() Mo Prirt
() Load Data
{*) Statics Check
{7 Statics Load
() Mode Shapes

(") Both
O Al

[] After Cumert Close ] [ Help

Figure 3. 97

Finally, click on the Add button followed by the Close button.
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The Analysis dialog box in the data area with the newly added
instruction will look as shown below.

i Analysis - Whole Structure

----- ~ STAAD SPACE SLAB SUPPORTED ALOMG 2
E-E3 START JOB INFORMATION
----- A INPUT wIDTH 73
----- # UMIT METER KM
----- # JOINT COORDIMNATES
----- # ELEMEMT IMCIDEMCES SHELL
----- A UMIT CM KN
i-[Z3 ELEMENT PROPERTY
H-Z3 DEFIME MATERIAL START
H-[Z3 COWSTAMTS
f-[Z3 SUPPORTS
----- # UMIT METER kG
E-E3 LOAD 1 L0ADTYPE Mone TITLE DEAD LOAL
E-E3 LOAD 2 L0ADTYPE None TITLE EXTERNAL
E-E3 LOAD 3L0ADTYPE Mone TITLE TEMPERAT
M-E3 LOAD COME 101 CASE 1 + CASE 2
M-E3 LOAD COME 102 CASE 1+ CASE 3
----- + PERFORM &NALYSIS PRINT STATICS CHEC
..... # FINISH

Define Commands...

Azgign | Cloze | Help |

Figure 3. 98

Let us save the data once again using the File | Save option.
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3.6.9 Specifying post-analysis print commands

Two types of element results can be requested: a) ELEMENT
STRESSES at the centroid or any point on the element surface b)
the element forces at the nodes. The former consists of stresses and
moments per unit width, as explained in sections 1.6.1 and 3.41 of
the STAAD Technical Reference Manual. The latter consists of the
3 forces and 3 moments at each node of the elements in the global
axis system (see section 3.41 for details).

We would like to obtain both these results. We will also set the
units in which these results are printed to KN and Meter for
element stresses and Kg and Meter for element forces. This
requires the specification of the following commands:

UNIT METER KN

PRINT ELEMENT STRESSES LIST 3
UNIT KG METER

PRINT ELEMENT FORCE LIST 6

These results will be written in the STAAD output file and can be
viewed using the procedure explained in section 3.10.

Steps:

1. Goto Tools | Set Current Input Unit menu option. Set the length
and force units to Meter and Kilo Newton respectively.

2. The dialog box for requesting element results is available in the
Post-Print sub-page of the Analysis | Print page.

Click on the Define Commands button in the data area on the right
hand side of the screen.
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EJ Plates Tuto hole Structure Post Analysis Print - Whole Struckur |
- | STAAD SPACE

(E3 START JOB INFORMATION
# INPUTWIDTH 73
# UNIT METER KN
/ JOINT COORDINATES
# ELEMENT INCIDENCES SHELL
# UNITCM KN
(3 ELEMENT PROPERTY
{3 DEFINE MATERIAL START
(E3 CONSTANTS
{3 SUPFORTS
o UNIT METEFR K&
{E3 LDAD 1 LOADTYPE None TITLE DEAD LOAL
[E2) LOAD 2LOADTYFE None TITLE EXTERNAL
{22 L0AD 3LOADTYPE Nane TITLE TEMPERAT
(E3 LOAD COMB 101 CASE 1+ CASE 2
{2 LOAD COMB 102 CASE 1+ CASE 3
»# PERFORM ANALYSIS PRINT STATICS CHEC
/ FINISH

1., Post-Print ) pnaysis | B Pre-Print

K [ — |

I# Highlight Assigned Geometry

I~ Togge Assi
Défine Commands.

Metha
€ Assian T Selected Beams
' Assign Ta Yiew
@ Use Cursar To Assign
' Assign To Edit List

|

[ & Des\gr@t AnalysisiPrint

Figure 3. 99

3. In the Analysis/Print Commands dialog box that appears, select the
Element Forces/Stresses tab. Choose the Print Element Stresses
option and click on the Add button followed by the Close button.

| Mode Shapes |  Elemert Stress Solid | Section Displacement | Force |
| MaxForce | Story Dt | Cag | Surface Forces | Physical Member Forces |
| Load List | Section | Joint Displacement | Member Forces | Support Reactions

| Analysis Results | Member Section Forces | Member Stresses | Element Forces/Stresses

() Print Element Forces
() Print Element Stresses
() Print Element Joirt Stresses

() Print Element Stresses at

Local X Position |:|
Local ' Position l:l

Dt coms [
Figure 3. 100
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Again, go to Tools | Set Current Input Unit menu option. Set the
length and force units to Meter and Kilogram respectively.

Then, repeat steps 2 and 3. In step 3, select the Print Element
Forces option and click on the Add button followed by the Close

button.

At this point, the Post Analysis Print dialog box will look as shown

below.

i Post Analysis Print - Whole Structure

=-(E3
=-(E3
=-(E3
=-E3

&
i

ELEMEMT INCIDEMCES SHELL
UMIT CH KM

ELEMEMT PROPERTY
DEFIME MATERIAL START
CONSTANTS

SUPPORTS

UMIT METER KG

q-Z3 LOAD 1 LOADTYPE Mare TITLE DEAD L
q-Z3 LOAD 2 LOADTYPE Mare TITLE EXTERN
f-Z3 LOAD 3 LOADTYPE Mare TITLE TEMPEFR
f-[Z3 LOAD COME 101 CASE 1 + CASE 2

H-[Z3 LOAD COME 102 CASE 1 + CASE 3

----- PERFORM AMALYSIS PRINT STATICS CH
UMIT METER KN

PRIMT ELEMEMT STRESSES
UMIT METER KG

PRIMT ELEMENT FORCE

# FINISH

1 |

¥ Highlight Assighed Geometry

[~ Toggle Assign

Define Commands...

-

5

—bzzignment Method
) Agsion To Selected Beams
 Agsign To View
% Use Curzor To Assign
€ fesign To Edit List

Azgign | Cloze | Help

Figure 3. 101
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To associate the PRINT ELEMENT STRESSES command with
element 3, first select the command as shown in the previous

| |

figure. Then, using the Plates Cursor , click on element no.

3.

As we select the plate, the Assignment Method automatically
becomes Assign to Selected Plates. Click on the Assign button as
shown below.

—bzzignment Method
' Agsign To Selected Plates
 Agsign To View
€ Use Cursor To Assign
= Azsign To Edit List

Aszign | Cloze | Help

Figure 3. 102

To associate the PRINT ELEMENT FORCE command with element
6, repeat step 5 except for selecting element no. 6 in the place of
element no. 3.

We have now completed the tasks of assigning the input for this
model. Let us save the file one last time using the File | Save
option.
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3.7 Viewing the input command file

Let us now take a look at the data that has been written into the file
that we just saved earlier. As we have seen in the previous
tutorials, while the model is being created graphically, a
corresponding set of commands describing that aspect of the model
is being simultaneously written into a command file which is a
simple text file. An abstract of those commands was also
mentioned under the title “commands to be generated are . .” at the
beginning of each section of this tutorial.

The contents of that text file can be viewed in its entirety either by
clicking on the STAAD Editor icon or, by going to the Edit menu
and choosing Edit Input Command File as shown below.

STAAD Pro - Plates Tutorial. std

File Edt %iew Toolz Select Geometry Commands Analyze Mode

%@iE%EXQiQiE/\iE B & A
e Gy
|[arvmnapnmwpBEde: THE || N

Figure 3. 103

Edit
= Undo Cirlez
L2 Fedo Ll
g Cut Ll
Copy L+
R Faste Ll
75 Delete el
& Take Picture

Copy Ficture

Edit Input Cormmand File

Create Mew B Macro...

Edit Esizting WB Macro...

Figure 3. 104
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A new window will open up with the data listed as shown here:

[E Plates Tutorial.std - STAAD Editor M=] E3
File Edit “iew Toolz Help
DEHSR || | ~1& R

AGBKR|=E= BB TR
STAAD 3PACE 3LAE SUPPORTED ALONG 2 EDGE3
START TOE INFORMATION

ENGINEER DATE

END JOE INFORMATION

INFUT WIDTH 79

TNIT METEE FN

JOINT COORDINATES

1Lo000; 2200320 4002;5400;,6402Z;7600 861
9 204; 1000411 404; 1260 4;

ELEMENT INCIDENCES 3HELL

11234; 22563 357686;:443910; 5361185 668512 1]
TNIT CM KN b
ELEMENT FROPERTY

1 TO & THICKNEIS 30

DEFINE MATERIAL START

I30TROFIC CONCEETE

E 2171.85

POISE0N 0.17

DENSITY Z.35616e-003

ALFPHA le-005

[*]

DAMP 0.05
END DEFINE MATERIAL
CONZTANTS =
: »
For Help, press F1 Line 1Col 1 l_ l_ ’_ I— 4

Figure 3. 105

This window and the facilities it contains is known as the STAAD
Editor.

We could make modifications to the data of our structure in this
Editor if we wish to do so. Let us Exit the Editor without doing so
by selecting the File | Exit menu option of the editor window (not
the File | Exit menu of the main window behind the editor
window).

Instead of using the graphical methods explained in the previous
sections, we could have created the entire model by typing these
specific commands into the editor. This was one of the methods
mentioned in section 3.1 of this tutorial. If you would like to
understand that method, proceed to the next section. If you want to
skip that part, proceed to section 3.9 where we perform the analysis
on this model.
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3.8 Creating the model using the command file

Let us now use the command file method to create the model for
the above structure. The commands used in the command file are
described later in this section.

The STAAD.Pro command file may be created using the built-in
editor, the procedure for which is explained further below in this
section. Any standard text editor such as Notepad or WordPad may
also be used to create the command file. However, the STAAD.Pro
command file editor offers the advantage of syntax checking as we
type the commands. The STAAD.Pro keywords, numeric data,
comments, etc. are displayed in distinct colors in the STAAD.Pro
editor. A typical editor screen is shown below to illustrate its general
appearance.

EXPlates Tutorial.std - STAAD Editor [_[O]x]
File Edit “iew Tools Help
[EHSR| 4 2R =
| & R
ASARKR|E= | B TR
ATAAT FPACE 5LAE SUPPORTED ALONG Z EDGES

START JOE INFORMATION

ENGINEEF. DATE Z1-Mar-04

END JOE INFORMATION

INFUT WIDTH 79

TNIT METEER EN

JOINT COOFDINATES

loo0;2200; 32802;400%2; 5400;64d40c 760
920410004y 11 4047 12 6 0 4;

ELEMENT INCIDENCES 5SHELL
11234 2250633578644 39210; 53611059606

TMIT CM EN

ELEMENT PROFPERTY -
(o o
For Help, press F1 Lre 1Ca 1 [ [ [ 2

Figure 3. 106
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To access the built-in editor, first start the program using the
procedure explained in Section 3.3. Next, follow step 1 of Section 3.4
(also, see Figures below).

File Name

IF'IaIes Tutorial

Location :

[Eteats [=]

A SPACE structure, which is a three-dimensional framed stiucture with loads applied in
any plane, is the most general

Length Units—————————————— Force Units
" Inch " Decimster " Pound  Newton
 Foot @+ Meter " KilPound ¢ Decaewton
€ Milimeter € Kilometer  Kilogram " KilaNewton
" Centimeter " MeticTon ¢ MegaNewton

¥ Display this dialog box at the Startup

< Back I Nekl>|: I Cancel Help
Figure 3. 107

You will then encounter the dialog box shown below. In that dialog
box, choose Open STAAD Editor.

Where do you want to go ? 5[

[ Add Beam
[ &dd Plate
[ &dd Solid
[ Open Stuchue Wizard
Open STAAD Editar
[ Edit Jab Information

KX} B
Begin buiding vour model using STAAD syntax commands [non-graphical interface) through
the STAAD editor.

¥ Display this dialog box at the Startup

< Back I Finish I Cancel Help

Figure 3. 108
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At this point, the editor screen will open as shown below.

Plates Tutorial_ztd - SproEdit M=l E
File Edit Wiew Toolz Help

Uw &
o B |
aRe L LA EN TN

ISTAAD SPACE 3lab supported along 2 edges =
STLRT JOB INFORMATION =
ENGINEEE DLTE

END JOE INFORMATION
INPUT WIDTH 79
FINISH

IH o

For Help, presz F1 Line 1 Cal 2
Figure 3. 109

Delete all the command lines displayed in the editor window and
type the lines shown in bold below (You don’t have to delete the
lines if you know which to keep and where to fill in the rest of the
commands). The commands may be typed in upper or lower case
letters. Usually the first three letters of a keyword are all that are
needed -- the rest of the letters of the word are not required. The
required letters are underlined. (“SPACE” = “SPA” = “space” =
“spa”)



3-94

Tutorial 3

Actual input is shown in bold lettering followed by explanation.

STAAD SPACE SLAB SUPPORTED ALONG 2 EDGES

Every input has to start with the word STAAD. The word SPACE
signifies that the structure is a space frame structure (3-D) and the
geometry is defined through X, Y and Z coordinates.

UNIT METER KN
Specifies the unit to be used for data to follow.

JOINT COORDINATES
1000:2200:3202:4002
5400:6402:7600:8602
9204:10004:11404:12604

Joint number followed by X, Y and Z coordinates are provided
above. Semicolon signs (;) are used as line separators. That enables
us to provide multiple sets of data on one line. For example, node 6
has (X, Y, Z) coordinates of (4, 0, 2).

ELEMENT INCIDENCES SHELL
11234;22563:35786:443910;
536119:6681211

The incidences of elements are defined above. For example,
element 3 is defined as connected between the nodes 5, 7, 8 and 6.

UNIT CM KN
ELEMENT PROPERTY
1TO 6 THICKNESS 30

The length unit is changed from meter to centimeter. Element
properties are then provided by specifying that the elements are 30
cm thick.
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UNIT METER KN
CONSTANTS
E 2.17185e+007 ALL
POISSON 0.17 ALL
DENSITY 23.5616 ALL
ALPHA 1e-005 ALL

Material constants, which are E (modulus of elasticity), Density,
Poisson’s Ratio and Alpha, are specified following the command
CONSTANTS. Prior to this, the input units are changed to Meter
and KN.

SUPPORTS
1245710 FIXED

Joints 1, 2, 4, 5, 7 and 10 are defined as fixed supported. This will
cause all 6 degrees of freedom at these nodes to be restrained.

UNIT KG
LOAD 1 DEAD LOAD

Force units are changed from KN to KG to facilitate the input of
loads. Load case 1 is then initiated along with an accompanying
title.

SELFWEIGHT Y -1

Load case 1 consists of selfweight of the structure acting in the

global Y direction with a factor of -1.0. Since global Y is vertically

upward, the factor of -1.0 indicates that this load will act
downwards.

LOAD 2 EXTERNAL PRESSURE LOAD
Load case 2 is initiated along with an accompanying title.

ELEMENT LOAD
1TO6 PR GY -300

3-95
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Load 2 is a pressure load on the elements. A uniform pressure of
300Kg/m2 is applied on all the elements. GY indicates that the load
is in the global Y direction. The negative sign (-300) indicates that
the load acts opposite to the positive direction of global Y.

LOAD 3 TEMPERATURE LOAD

Load case 3 is initiated along with an accompanying title.

IEMPERATURE LOAD
1 IO 6 IEMP 40 30

Load 3 is a temperature load. All the 6 elements are subjected to a
in-plane temperature increase of 40 degrees and a temperature
variation across the thickness of 30 degrees. This increase is in the
same temperature units as the Alpha value specified earlier under
CONSTANTS.

LOAD COMB 101 CASE 1 + CASE 2
11.021.0

Load combination 101 is initiated along with an accompanying
title. Load cases 1 and 2 are individually factored by a value of
1.0, and the factored values are combined algebraically.

LOAD COMB 102 CASE 1 + CASE 3
11.031.0

Load combination 102 is initiated along with an accompanying
title. Load cases 1 and 3 are individually factored by a value of
1.0, and the factored values are combined algebraically.

PERFORM ANAL YSIS PRINT STATICS CHECK

The above command instructs the program to proceed with the
analysis. A static equilibrium report is also requested with the help
of the words PRINT STATICS CHECK.

UNIT METER KN
PRINT ELEMENT STRESS LIST 3
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The stresses and unit width moments are requested at the centroid
of element 3 in KN and Meter units.

UNIT KG METER
PRINT ELEMENT EQRCE LIST 6

The forces and moments for all 6 d.o.f at the corner nodes of
element 6 are requested in KG and Meter units.

EINISH

This command terminates the STAAD run.

Let us save the file and exit the editor.
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3.9 Performing the analysis and design

In order to obtain the displacements, forces, stresses and reactions
in the structure due to the applied loads, the model has to be
analyzed. If the pass-fail status of the members and elements per
the requirements of steel and concrete codes is to be determined,
that involves a process called design. Both these processes are
launched using the Run Analysis option from the Analyze menu.

File Edit ‘“iew Tools Select Geomety Eommands|fqna|yze Mode ‘Window Help
|loseEE s B2l B
Figure 3. 110

If the structure has not been saved after the last change was made,
you should save the structure first by using the Save command
from the File menu.

When you select the Run Analysis option from the Analyze menu,
the following dialog box appears:

Select Analysis Engine Ed

Analyziz Optiot |

f+ STAAD Analpsis

" Stardyne Advanced Analysis

Run Analysiz ! Cancel | Apply | Help |
|

Figure 3. 111

We are presented with the choice of 2 engines : the STAAD engine
and the STARDYNE Advanced Analysis engine. The STARDYNE
Analysis engine is suitable for advanced problems such as
Buckling Analysis, Modal Extraction using various methods, etc.
However, if the calculations call for steel or concrete design, UBC
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load generation, etc., we have to select the STAAD engine. For
this problem, let us use the STAAD engine.

Then, click on the Run Analysis button.

As the analysis progresses, several messages appear on the screen
as shown in the next figure.

STAAD Analysis and Design o ]

++ Proce=sing Element Stifines=s Hatriw. 21:40: 0 a
++ Processing Global Stiffness Matriz. 21:40: 0
++ Finished Processing Global Stiffness Hatrix. 0 =ec
++ Processing Triangular Factorization. 21:40: 0
++ Finiszhed Triangular Factorization. 0 =ec
++ Calculating Joint Displacement=. 21:40: 0
++ Finished Joint Displacement Calculation. 0 =ec
++ Calculating Hember Forces. 21:40: 0
++ Analy=i= Succes=fully Completed ++

++ Processing Element Forces. 21:40: 1
++ Processing Element Stresses. 21:40: 1
++ Processing Element Forces. 21:40: 1
++ Proce=sing Element Corner Forces. 21:40: 1
++ Processing Element Forces. 21:40: 1
++ Processing Element Stresses. 21:40: 1
++ Creating Displacement File {(DSP). .. 21:40: 1

++ Creating Reaction File (EEA4) . .

++ Creating Element Stress File (EST). ..

++ Creating Element JT Stress File (EJT). ..

++ Creating Element JT Force File (ECEF). ..

++ Done. 21:40: 1

0 Error{s). 0 Warningis)
*% End STAAD Pro Run Elaps=ed Time = 1 Secs=

*#* Output Written to File:
FPlate=s Tutorial .anl -

£ Wiew Output File
" Goto Post Processing Mode
&+ Stay in Modeling Mods

Figure 3. 112

At the end of these calculations, two activities take place. a) A
Done button becomes active b) three options become available at
the bottom left corner of this information window.

" Wiew Output File
" Go to Post Processing Mode
* Stay in Modeling Mode

Figure 3. 113
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These options are indicative of what will happen after we click on
the Done button.

The View Output File option allows us to view the output file
created by STAAD. The output file contains the numerical results
produced in response to the various input commands we specified
during the model generation process. It also tells us whether any
errors were encountered, and if so, whether the analysis and design
was successfully completed or not. Section 3.10 (also, see section
1.9) offers additional details on viewing and understanding the
contents of the output file.

The Go To Post Processing Mode option allows us to go to
graphical part of the program known as the Post-processor. This is
where one can extensively verify the results, view the results
graphically, plot result diagrams, produce reports, etc. Section 3.11
explains the Post processing mode in greater detail.

The Stay in Modelling Mode lets us continue to be in the Model
generation mode of the program (the one we currently are in) in
case we wish to make further changes to our model.
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3.10 Viewing the output file

During the analysis stage, an output file containing results,
warnings and messages associated with errors if any in the output,
is produced. This file has the extension .anl and may be viewed
using the output viewer. Section 1.9 of this manual contains
information on viewing this file.

In Sections 3.6.8 and 3.6.9, we had provided instructions to the
program to write some very specific results in the output file. Let

us examine those results.

PRINT STATICS CHECK

This instruction was provided so that we could view a report
indicating if the structure is in equilibrium for the various load
cases. If we scroll down the output file, we will see information
which looks like the following:

**TOTAL APPLIED LOAD (KG METE ) SUMMARY (LOADING 1)

SUMMATION FORCE-X = 0.00
SUMMATION FORCE-Y = -17298.83
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-
MX= 34597.65 MY= 0.00 MZ=  -51896.48

**TOTAL REACTION LOAD(KG METE ) SUMMARY (LOADING 1)

SUMMATION FORCE-X = 0.00

SUMMATION FORCE-Y = 17298.83

SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-
MX=  -34597.65 MY= 0.00 Mz= 51896.48

MAXIMUM DISPLACEMENTS ( CM /RADIANS) (LOADING 1)
MAXIMUMS AT NODE
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X = 0.00000E+00 0
Y =-3.20681E-01 12
Z = 0.00000E+00 0
RX = 9.80406E-04 12
RY = 0.00000E+00 0
RZ = -6.49355E-04 9

For each primary load case, the report consists of:

a. Summary of total applied loads for all 6 degrees of
freedom, with moments calculated about the origin of the
coordinate system (0, 0, 0)

b. Summary of total reactions from the supports of the
structure, with moments calculated about the origin of the
coordinate system (0, 0, 0)

c. Maximum displacements (3 translations and 3 rotations) in
the structure induced by this load case

Each of the 6 terms of item (a) must be equal and opposite to the
corresponding term of item (b). A failure to meet this criteria
would mean the analysis results (for a linear elastic analysis) may
be erroneous. Factors such as instability conditions or improperly
applied loads can cause the equilibrium check to fail.

It is quite important to examine the maximum displacements since
they tell us whether the deformations are within tolerable limits.

Since the information presented above is for load case 1, and since
load case 1 is the selfweight of the structure, we can conclude that
the structure weighs 17298.83 Kgs.
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STRESSES FOR ELEMENT 3

This information consists of the stress and “moment over unit
width” values at the centroid of element 3. A typical sample is
presented below.

ELEMENT STRESSES FORCE, LENGTH UNITS = KN METE

FORCE OR STRESS = FORCE/UNIT WIDTH/THICK,
MOMENT = FORCE-LENGTH/UNIT WIDTH

ELEMENT LOAD SQX SQY MX MY MXY

VONT VONB SX SY SXY
3 1 -18.13 72.86 -3.96 -20.42 -3.35
1308.63 1308.63 0.00 0.00 0.00

TOP : SMAX= -220.33 SMIN=-1404.81 TMAX= 592.24 ANGLE=-11.1
BOTT: SMAX= 1404.81 SMIN= 220.33 TMAX= 592.24 ANGLE=-11.1

These terms are explained in Section 1.6.1 of the STAAD
Technical Reference Manual in elaborate detail. Example problem
18 of the Examples Manual explains the method involved in
calculating the principal stresses SMAX, SMIN and TMAX.
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FORCES FOR ELEMENT 6

This information consists of the force and moment values at each
of the 4 corner nodes of element 6. A typical sample is presented
below.

ELEMENT FORCES FORCE,LENGTH UNITS=KG METE

JOINT FX FY Fz MX MY Mz

ELE.NO. 6FORLOADCASE 1
6 0.0000E+00 4.5323E+02 0.0000E+00 -1.1313E+03 0.0000E+00 7.9082E+02
8 0.0000E+00 5.0615E+02 0.0000E+00 -3.2047E+02 0.0000E+00 2.3981E+02
12 0.0000E+00 -7.2078E+02 0.0000E+00 1.0346E-03 0.0000E+00 -1.3733E-03
11 0.0000E+00 -2.3860E+02 0.0000E+00 -4.6697E+02 0.0000E+00 -6.0136E+02

The corner forces are in the global coordinate system. These values
may be used to create a free body diagram of the element and
verify that the element is in equilibrium. In this case for example,
the FX and FZ forces are zero, and sum of the FY forces is also
Zero.

The complete text of the output file is shown in the next few pages.
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STAAD.Pro

Version Bld
Proprietary Program of
Research Engineers, Intl.
Date=

Time=

Ok ok % ok Ok X X %
Ok ok X Ok Ok X X %

USER ID:

. STAAD SPACE SLAB SUPPORTED ALONG 2 EDGES
- START JOB INFORMATION

- ENGINEER DATE

- END JOB INFORMATION

- INPUT WIDTH 79

- UNIT METER KN

. JOINT COORDINATES
-1000;2200;3202;4002;5400;6402;7600;8602
-9204;10004; 11404; 12604
10. ELEMENT INCIDENCES SHELL

11. 11234;22563;35786;443910;536119; 6681211
12. UNIT CM KN

13. ELEMENT PROPERTY

14. 1 TO 6 THICKNESS 30

15. DEFINE MATERIAL START

16. ISOTROPIC CONCRETE

17. E 2171.85

18. POISSON 0.17

19. DENSITY 2.35616E-005

20. ALPHA 1E-005

21. DAMP 0.05

22. END DEFINE MATERIAL

23. CONSTANTS

24. MATERIAL CONCRETE MEMB 1 TO 6

25. SUPPORTS

26. 12457 10 FIXED

27. LOAD 1 DEAD LOAD

28. SELFWEIGHT Y -1

29. LOAD 2 EXTERNAL PRESSURE LOAD

30. UNIT METER KG

31. ELEMENT LOAD

32. 1 TO 6 PR GY -300

33. LOAD 3 TEMPERATURE LOAD

34. TEMPERATURE LOAD

35. 1 TO 6 TEMP 40 30

36. LOAD COMB 101 CASE 1 + CASE 2
37.11.02 1.0

38. LOAD COMB 102 CASE 1 + CASE 3
39.11.03 1.0

40. PERFORM ANALYSIS PRINT STATICS CHECK

©CoO~NOOUAWNEL

PROBLEM STATISTICS

NUMBER OF JOINTS/MEMBER+ELEMENTS/SUPPORTS = 12/ 6/ 6

ORIGINAL/FINAL BAND-WIDTH= 8/ 5/ 36 DOF

TOTAL PRIMARY LOAD CASES = 3, TOTAL DEGREES OF FREEDOM = 72

SIZE OF STIFFNESS MATRIX = 3 DOUBLE KILO-WORDS

REQRD/AVAIL. DISK SPACE = 12.1/ 3521.0 MB, EXMEM = 461.2 MB
STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO. 1
DEAD LOAD

***TOTAL APPLIED LOAD ( KG  METE ) SUMMARY (LOADING 1)
SUMMATION FORCE-X = 0.00
SUMMATION FORCE-Y = -17298.83
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-
MX= 34597.66 MY= 0.00 Mz= -51896.48

3-105



3-106 | Tutorial 3

***TOTAL REACTION LOAD( KG  METE ) SUMMARY (LOADING 1)
SUMMATION FORCE-X = 0.00
SUMMATION FORCE-Y = 17298.83
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= -34597.66 MY= 0.00 Mz= 51896.48
MAXIMUM DISPLACEMENTS ( CM /RADIANS) (LOADING 1)
MAXTMUMS AT NODE
X = 0.00000E+00 0
Y = -3.20681E-01 12
Z = 0.00000E+00 0
RX=9.80406E-04 12
RY= 0.00000E+00 0
RZ= -6.49355E-04 9

STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO.
EXTERNAL PRESSURE LOAD

***TOTAL APPLIED LOAD ( KG  METE ) SUMMARY (LOADING 2)
SUMMATION FORCE-X = 0.00
SUMMATION FORCE-Y = -7200.00
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= 14400.00 My= 0.00 Mz= -21600.00
***TOTAL REACTION LOAD( KG  METE ) SUMMARY (LOADING 2)
SUMMATION FORCE-X = 0.00

SUMMATION FORCE-Y = 7200.00
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= -14400.00 MY= 0.00 Mz= 21600.00
MAXIMUM DISPLACEMENTS ( CM /RADIANS) (LOADING 2)
MAXTMUMS AT NODE
X = 0.00000E+00 0
Y = -1.33471E-01 12
Z = 0.00000E+00 0
RX=4.08058E-04 12
RY= 0.00000E+00 0
RZ= -2.70270E-04 9

STATIC LOAD/REACTION/EQUILIBRIUM SUMMARY FOR CASE NO.
TEMPERATURE LOAD

***TOTAL APPLIED LOAD ( KG  METE ) SUMMARY (LOADING 3)
SUMMATION FORCE-X = 0.00
SUMMATION FORCE-Y = 0.00
SUMMATION FORCE-Z = 0.00

SUMMATION OF MOMENTS AROUND THE ORIGIN-

MX= 0.00 My= 0.00 Mz= 0.00
***TOTAL REACTION LOAD( KG  METE ) SUMMARY (LOADING 3)

SUMMATION FORCE-X = -0.01

SUMMATION FORCE-Y = 0.00

SUMMATION FORCE-Z = 0.02

SUMMATION OF MOMENTS AROUND THE ORIGIN-
MX= 0.00 My= -0.10 Mz= 0.00
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MAXIMUM DISPLACEMENTS ( CM /RADIANS) (LOADING 3)
MAXTMUMS AT NODE
X = 2.01178E-01 12
Y = 8.97365E-01 12
Z = 1.66240E-01 11
RX= -3.51264E-03 12
RY= -2.41785E-04 11
RZ= 2.62398E-03 12

s END OF DATA FROM INTERNAL STORAGE s

41. UNIT METER KN
42. PRINT ELEMENT STRESSES LIST 3

ELEMENT STRESSES FORCE,LENGTH UNITS= KN  METE

STRESS = FORCE/UNIT WIDTH/THICK, MOMENT = FORCE-LENGTH/UNIT WIDTH

ELEMENT LOAD SQX SQY MX My MXY
VONT VONB SX Sy SXY
TRESCAT TRESCAB

3 1 -18.13 72.86 -3.96 -20.42 -3.35
1308.63 1308.63 0.00 0.00 0.00

1404 .81 1404 .81
TOP : SMAX= -220.33 SMIN= -1404.81 TMAX=  592.24 ANGLE= -11.1
BOTT: SMAX= 1404.81 SMIN=  220.33 TMAX=  592.24 ANGLE= -11.1

2 -7.54 30.33 -1.65 -8.50 -1.39
544.67 544 .67 0.00 0.00 0.00

584.70 584.70
TOP : SMAX=  -91.70 SMIN= -584.70 TMAX=  246.50 ANGLE= -11.1
BOTT: SMAX=  584.70 SMIN= 91.70 TMAX=  246.50 ANGLE= -11.1
3 96.73 -59.42 -30.45 -14.83 18.43
10779.68 5300.82 -5044.81 -2309.43 3890.01

10912.04 5585.51
TOP : SMAX=  269.79 SMIN=-10642.25 TMAX= 5456.02 ANGLE= -34.9
BOTT: SMAX=  624.74 SMIN= -4960.77 TMAX= 2792.75 ANGLE= -36.2
101 -25.67 103.18 -5.61 -28.92 -4.74
1853.30 1853.30 0.00 0.00 0.00

1989.51 1989.51
TOP : SMAX= -312.03 SMIN= -1989.51 TMAX=  838.74 ANGLE= -11.1
BOTT: SMAX= 1989.51 SMIN=  312.03 TMAX=  838.74 ANGLE= -11.1
102 78.60 13.44 -34.41 -35.24 15.08
10642.95 5713.09 -5044.81 -2309.43 3890.01

11074.45 6408.55
TOP : SMAX= -923.15 SMIN=-11074.45 TMAX= 5075.65 ANGLE= -37.3
BOTT: SMAX= 1848.83 SMIN= -4559.72 TMAX= 3204.28 ANGLE= -32.1

*Hx* MAXIMUM STRESSES AMONG SELECTED PLATES AND CASES ****

MAXTMUM MINTMUM MAXTMUM MAXTMUM MAXTMUM
PRINCIPAL PRINCIPAL SHEAR VONMISES TRESCA
STRESS STRESS STRESS STRESS STRESS
1.989513E+03 -1.107445E+04 5.456020E+03 1.077968E+04 1.107445E+04
PLATE NO. 3 3 3 3
CASE NO. 101 102 3 3 102

END OF ELEMENT FORCES

43. UNIT METER KG

3-107



3-108

Tutorial 3

44. PRINT ELEMENT FORCE LIST 6

ELEMENT FORCES

FORCE,LENGTH UNITS= KG

**NOTE- IF A COMBINATION INCLUDES A DYNAMI
THEN RESULTS CANNOT BE COMPUTED PROPERLY.
GLOBAL CORNER FORCES

JOINT FX

ELE.
6 0.0000E+00
8 0.0000E+00
12 0.0000E+00
11 0.0000E+00

ELE.
6 0.0000E+00
8 0.0000E+00
12 0.0000E+00
11 0.0000E+00

ELE.
6 -2.9880E+05
8 3.0633E+05
12 3.2019E+05
11 -3.2773E+05

ELE.
6 0.0000E+00
8 0.0000E+00
12 0.0000E+00
11 0.0000E+00

ELE.

6 -2.9880E+05
8 3.0633E+05
12 3.2019E+05
11 -3.2773E+05
45. FINISH

NO.
4.
5.

-7.

-2.

NO.
1.
2.

-3.

-9.

NO.
6.

-9.
4.
3.

NO.
6.
7.

-1.

-3.

NO.
1.

-4.

-7.

FY Fz

6 FOR LOAD CASE

5323E+02 0.0000E+00 -1.
0615E+02 0.0000E+00 -3.
2078E+02 0.0000E+00 1.
3860E+02 0.0000E+00 -4.

6 FOR LOAD CASE

8864E+02 0.0000E+00 -4.
1067E+02 0.0000E+00 -1.
0000E+02 0.0000E+00 8.
9306E+01 0.0000E+00 -1.

6 FOR LOAD CASE

6190E+02 -3.0717E+05 6.
9013E+02 -3.2773E+05 4.
6301E-03 3.2019E+05 -6.
2822E+02 3.1471E+05 -4.

6 FOR LOAD CASE

4187E+02 0.0000E+00 -1.
1681E+02 0.0000E+00 -4.
0208E+03 0.0000E+00 3.
3790E+02 0.0000E+00 -6.

6 FOR LOAD CASE

1151E+03 -3.0717E+05 5.
8398E+02 -3.2773E+05 3.
2078E+02 3.2019E+05 -6.
-9625E+01 3.1471E+05 -4.

xwxwxwxwxkx END OF THE STAAD.Pro

*x** DATE= TIME=

METE

C CASE OR

MX

1
1313E+03
2047E+02
0346E-03
6697E+02

2
7087E+02
3338E+02
9143E-05
9436E+02

3
3684E+03
3052E+03
0036E+03
0135E+03
101
6022E+03
5385E+02
8188E-04
6133E+02
102
2371E+03
9847E+03
0036E+03
4804E+03

S

oooo OhrWN oooo [ejeloNe)

OBrWN

AN SRSS OR ABS COMBINATION

MY

-0000E+00 7.
_0000E+00 2.
-0000E+00 -1.
_0000E+00 -6.

_0000E+00 3.
-0000E+00 9.
_0000E+00 1.
-0000E+00 -2.

-7912E+03 -5.
_7431E+03 4.
.0162E-03 6.
_5183E+02 -2.

_0000E+00 1.
-0000E+00 3.
_0000E+00 -9.
-0000E+00 -8.

-7912E+03 -4.
_7431E+03 4.
.0162E-03 6.
_5183E+02 -3.

RUN sk

Fokkk

USA:
CANADA
CANADA
UK
FRANCE
GERMANY
NORWAY
SINGAPO
INDIA
JAPAN
CHINA

ok o 3 b ok X ok o % b R X X b % % ok X

Europe
Asia

For questions on STAAD.Pro, please contact
Research Engineers Offices at the following locations

RE

North America

Telephone
+1 (714)974-2500
+1 (905)632-4771
+1 (604)629 6087
+44(1454)207-000
+33(0)1 64551084
+49/931/40468-71
+47 67 57 21 30
+65 6225-6015/16

+81(03)5952-6500
+86(411)363-1983

Email
support@reiusa.com
detech@odandetech.com
staad@dowco.com
support@reel .co.uk
support@reel .co.uk

info@reig.de
staad@edr.no

support@reiasia.net
+91(033)2357-3575 support@calcutta.reiusa.com
eng-eye@crc.co.jp
support@reiasia.net

support@reiusa.com
support@reel .co.uk
support@reiasia.net

Ok Rk b R X ok o X ok Ok X X b X % ok X

MZ

9082E+02
3981E+02
3733E-03
0136E+02

2915E+02
9813E+01
6633E-05
5029E+02

5444E+03
3521E+03
0036E+03
8311E+03

1200E+03
3963E+02
6018E-05
5165E+02

7536E+03
5919E+03
0036E+03
4325E+03
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3.11 Post-Processing

If there are no errors in the input, the analysis is successfully
completed. The extensive facilities of the Post-processing mode
can then be used to

a) view the results graphically and numerically

b) assess the suitability of the structure from the standpoint of
safety, serviceability and efficiency

c) create customized reports and plots

The procedure for entering the post processing mode is explained
in section 2.11.1 of this manual.

Node results such as displacements and support reactions are
available for all models. The methods explained in the first two
tutorials — see sections 2.11.2 to 2.11.7 — may be used to explore
these. If beams are present in the model, beam results will be
available too (see sections 2.11.8 to 2.11.18 for information on
these). For this example, we will look at the support reactions. We
do not have any beams in our model, so no results will be available
for this type of entity.

For plates, the results available are stresses, and “unit width”
moments. There are several different methods for viewing these
results, as explained in the next few sections.
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3.11.1 Viewing stress values in a tabular form

From the View menu, select Tables (or click the right mouse
button in the drawing area and select Tables). Choose Plate Centre

Stress.

Wit

Zoanm 4

&% Pan

Wiew Selected Objects Only
’T Alwayz Fit in Current Window

ﬂm
[E #fhole Structur

Orientatian. .. F4

= Structure Diagrans. .

Hpen Wiew...
Hew Wiew..

Wiew Management 4

Toolbars...

Optiong. ..

Set Structure Colors. ..
Structural Tool Tip Optiong ..

&5 3D Rendering

Refresh F&

Figure 3. 114

Tables

T ables:

[ Section Properties ;l
[ Materials

™ Supparts

™ Supported Modes

¥ Mode Dizplacements

[~ Beam End Displacements

[ Beam Displacement Detail

™ Suppart Reactions

[ Eeam End Forces

[~ Eeam Force Detail

[~ Max Forces by Section Property
\CFate Centre Stress

[ Solid Centre Stress LI

List
’]7 &nalyziz Input W Analysiz Fesults

==

Cancel

Figure 3. 115
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The following table will be displayed.
4[4[ > [pI] Shear, Membrane and Bending & Summary A Principal and Yon Mis A Summary ), Global Moments /
Shear Membrane Bending Moment ]
Plate Lic Sax By
1 04
2 EXTERMAL

3 TEMPERAT 0.046

101 CASE1 03

102 CASE 1 + 0.037

2 [1DEsDLOA -0.030

2 EXTERNAL 0012

3 TEMPERAT 0076

101 CASE 1 -0.043

102 CASE 1 + 0.046
3 [1DEADLOA -0ma -

2 EXTERMAL -0.005

3 TEMPERAT 0.097

101 CASE1 -0.026

102 CASE 1 4 007

4 [1DEADLOA 0071

2 EXTERMAL 0029

3 TEMPERAT -0.077
101 CASE 0.100 LI

Figure 3. 116
The table has the following tabs:

Shear, Membrane and Bending: These terms are explained in
Section 1.6.1 of the STAAD Technical Reference Manual. The
individual values for each plate for each selected load case are
displayed.

Summary: This tab contains the maximum for each of the 8 values
listed in the Shear, Membrane and Bending tab.

Principal and Von Mises: These terms too are explained in
Section 1.6.1 of the STAAD Technical Reference Manual. The
individual values for each plate for each selected load case are
displayed, for the top and bottom surfaces of the elements.

Summary: This tab contains the maximum for each of the 8 values
listed in the Principal and Von Mises tab.

Global Moments: This tab provides the moments about the global
X, Y and Z axes at the center of each element.
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3.11.2 Printing the tables

All of these tables may be printed by clicking the right mouse
button in the table area and selecting the Print option.

& Cut [Chrl#

Copy [Ztr|+

2 Faste Tl
Celete el
GoTo.. F&
Change Unit for this column L4

A5 3D Bendering

Pre

[ﬂ] Frint Prexiew

Results Setup...

Mode Displacements Table
Beam End Dizplacements Table
Beam Relative Dizplacement Detail T able

Support Beactions Table
Beam End Forces Table
Beam Faorces Detail Table

Flate Centre Stress Table
Flate Corner Stress Table

Solid Centre Strezz Table
Solid Comer Stress Table

7] Other Tables...
Figure 3. 117
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3.11.3 Changing the units of values which
appear in the above tables

The length and force units of the stresses and moments are
displayed alongside the individual column headings for the terms.
To view the values in a different set of units, go to the Tools menu
and select Set Current Display Unit.

Gl Select Geometry  Commands  Analyze Mode  Window

Check Multiple Structures. ..
Check Duplicate L4
Orphan Modes L4
Check for Warped Plates...

Check Zero Length Members

Chedk Improperly Connected Plates

Calculator...
Unit Converter...

b Dimension Beams. ..
t%‘} Display Mode to Mode Distance

&n Set Current Input Unit..

ﬂ Set Current Display Unit..

=% Cut Section...
Query ¥
Figure 3. 118
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In the dialog box that comes up, click on the Force Units tab and
specify the required unit from the Stress and Moment fields. Click
on the Apply button for the changes to take effect immediately.
Once you are sure that you have chosen the proper unit
combination, click on the OK button.

B Tolerance
B Tables - Force
E Aszzign Digs r Show| dec ol
E Mods Labsls arce kg - ol I_E e places
B EeamLabels .
Diztr. Force IkN_J' v| Shaow |3 dec places
B Flate Labels " I_E F
E Solid Labels M ament kNm - Showw FE dec places
B LoadLabels
E Annotation Diiatr. kament IkN m/m vl Show FE dec places
E Shess IN!mm‘ v| Show I?E dec places
l Acceleration Im!secz j Show I?E dec places
Fiotation rad - Show IB_E dec places

(1] I Apply | Cancel | Help

Figure 3. 119
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3.11.4 Limiting the load cases for which the
results are displayed

When we entered the post-processing mode, we chose all load
cases in the Results Setup dialog box. The tables hence contain
results for all the load cases. To change that load list, choose
Select Load Case from the Results menu.

Results

B Animaticn...

Bending Mament

[v  Deflection

44 Sechion Dizplacement
Itilization Fatio...

O Beam Stresses
@ Flate Stress Contour...
" Solid Stress Contour...

c}:) tMode Shape Displacement. ..
Time Higtomy Graph...

Select Load Caze. .. k

Scale...

Wiew Value. ..

|lpdate Properties
Slab Reinforcement. .

Figure 3. 120
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In the dialog box that comes up, select the load cases you want,

. . 3
and click on the single arrow so they are transferred from the
Available category to the Selected category. Then, click on the OK
button.
Resultz Setup
Loads |Hange| Fesult Wiew Elptic-nsl
—Load Cazes
Available: Selectad:

1 DEAD LOAD
3 TEMPERATURE LOAD

2EXTERMNAL PRESSURE LOAD
101 CASE 1 + CASE 2
102 CASE 1 + CASE 3

=]

o~
!ll

oK I}| Apply Help
1%

Figure 3. 121
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3.11.5 Stress Contours

Stress contours are a color-based plot of the variation of stress or
moment across the surface of the slab or a selected portion of it.
There are 2 ways to switch on stress contour plots:

a) From the left side, select the Contour sub-page under the
Plate page.

Edl Plates Tutorial.std - Whole Structure

3 MNode

kf_contour

1'% Results Along Line

[

II_T Reports [ % pnimation (M Plate

Load 1

Figure 3. 122

or
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b) From the top of the screen, click on the Results menu and
select the Plate Stress Contour option.

| Results

Bl Animation...

Bending fMoment
Deflection

4 Section Displacement
Utilization Ratio...

€ Bcam Stresses

'@l Plate Stress Contour...

4 -olidStess Contour...

% lade Shape Mizplacement. .
Timne Histom Graph...

Select Load Case...
Scale...
Wiew Walue...

llpdate Froperties

Slab Reinforcement. .

Figure 3. 123
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In each of the above cases, the following dialog box appears.

Diagrams El
Structure Loads and Resuts Scales Labels
Force Limits Animation Design Results Plate Stress Contour
Load Case: | [HEISEN] ~
Stress Type
Stress type: | None -
Contour Type [[] Use Custom Divisions
N
@ Normal Fil A s
O Enhanced Fil i Lo L& |
© Normal Line z
] Absolute Values g

o[

Index Based on Center Stress

[¥] View Stress Index

Re-Index for new view

[ Show Displaced Shape

[ Contour Based on Visible Entities Only

o

=

o

©

[ Use Custom Limits 11
1z
Winimum: [N/A 13
1
Madmum; |N/A 15
No of i
. E
Note: Stress contours and index values are computed on the basis of weighted
average values

Figure 3. 124

e From the Stress type field, select the specific type of stress
for which you want the contour drawn.

e From the Load Case selection box, select the load case
number.

e Stress values are known exactly only at the plate centroid
locations. Everywhere else, they are calculated by linear
interpolation between the center point stress values of
adjacent plates. The Enhanced type contour chooses a
larger number of points compared to the Normal type
contour in determining the stress variation.

e View Stress Index will display a small table consisting of
the numerical range of values from smallest to largest
which are represented in the plot.
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Let us set the following:

e Load case - 102

e Stress Type — Von Mis Top
e Contour Type — Normal Fill
e Index based on Center Stress
e View Stress Index

e Re-Index for new view

Diagrams
Structure Loads and Results Scales
Farce Limits Animation Diesign Results |
Load Case: |1D2.CASE1+CASE3 v‘
Stress Type
Stress type: ‘Vun Mis Top V|
Cortour Type [] Use Custom Divisions
(&) Nomal Fill
A
() Enhanced Fil 7
() Nomnal Line 2
[] Absolute Values i
Index Based on Center Stress 5
[¥] View Stress Indesc [
Re-Index for new view ;
[ Show Displaced Shape 3

DCnmnur Based on Visible Entities Only 10

[ Use Custom Limits i
12
Minimum: 13

Maxdmum 15
e [ H

average values.

Mote: Stress contours and index values are computed on the basis of weighted

[ ok [ cancsl | [ eply

Figure 3. 125

Click on the Apply button.
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The following diagram will be displayed. We can keep changing
the settings and click on Apply to see all the various possible
results in the above facility.

[ Plates Tutorial std - Whole Structure 10l =|

“on Mis Top
M /mma

266

.3.98

o
[at]

E.62
7.94
926
ne
1.3
132
145
15.3
17.2
185
193
211
225
238

BEEOOOODOONNENNNN

Load 102

L

Figure 3. 126

Let us keep the dialog box open to examine the feature (Animation)
explained in the next section.
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If some portion of the structure appears truncated, we can bring
that portion into view by choosing one of the following methods:

a

a. Click on the Zoom Out button to shrink the size of the
region drawn.

Before After

Figure 3. 127 Figure 3. 128

b. Use the Pan button g to physically shift the position of
the structure away from the index.

Before After

Figure 3. 129 i Figure 3. 130
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3.11.6 Animating stress contours

The same dialog box shown in the previous section may be used to
obtain the stress contours in an animated view. This is a method of
getting a “dynamic” instead of static representation of the plot.
After making the choices as explained in that section, click on the
Animation tab of that dialog box. Switch on Stress followed by

Apply.
Diagrams
Structure | Loads and Results | Scales I Labels I
Force Limits Animatian | Design Resultz I Flate Stress Contour
— Diagram Type

 Na Animation

" Deflaction

€ Section Displacement
) Mode

* Shess h

— &nimation Setup

= FullSereen [ This zan actualy use less memany than a large winda |

Extra Frames |1 E Extra frames above minirmum needed.

I Mote: The speed cannot be
Target FPS |10 puarantzed

[ Use Metafiles for offscreen data.
[Mate: Map zave mem at expense of speed)]

MHate: *While animating hit F12 to view full screen

Ok I Cloze | Apply Help

Figure 3. 131

To stop the animation, click on No Animation and click Apply
again.
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3.11.7 Creating AVI Files

AVI files are a mechanism by which a dynamic result, such as, a
deflection diagram in animation, may be captured and recorded.
Presently, this facility is available in STAAD for node deflection,
beam section displacement, mode shape and plate stress contour
diagrams.

The facility in STAAD for creating AVI files is under the Tools
menu and is called Create AVI File. These files can then be
viewed using tools such as the Windows Media Explorer.

Select Results Report Mode Window Help

Check Duplicate 4
Orphan Nodes 4

Check Improperly Connected Plates

Calculator...

Unit Converter...

I Dimension Beams...
[%'} Display Mode to Mode Distance

épr_‘..-, Set Current Input Unit. ..

Set Current Display Unit...
% Cut Section...
Query 3

List Format...

Section Wizard...
Modify Section Database..

/ﬁf Insert Text...

Figure 3. 132
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The following dialog box will appear.

Create AVl File

Tatal Ma. of Frames IBD
Frame Rate fsec IE

—Animation Type

&+ Deflection

" Sectional Displacement

| Wode Shape I "l

Stress Contour Setup
" Stress Contour

Plate Stress Type IVon iz Top 'l
Solid Skress Type I VI

Ok [: I Cancel |

Figure 3. 133

In an animated view, the movement from one extremity to the other
is captured as several frames. The number of frames that comprise
such a movement is controlled by specifying a value for Total No.
of Frames. The speed of motion is controlled by the Frame Rate
/sec. The rest of the options in the above dialog box are for the
type of diagram from which the AVI file is to be created. Certain
items such as Mode Shape and Plate Stress contour do not become
active (remain grayed out) if the required data of that type are not
present in the STAAD file, such as a modal extraction, or finite
elements.
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After making the appropriate selections, click OK. Following this,
another dialog box appears, where we are instructed to specify a
file name for the .AVI file. Subsequently, we are prompted for the
type of video compression. AVI files can be quite large, and
compression is a technique by which one may reduce the size of
these files.

Video Compression x|

Compressar:

o A

Eompression Hualit:

;I _’I Configure... |
TN

Aot

Figure 3. 134

Finally, a message indicating that the operation was successful will
appear at the end of the file creation process as shown below.

File Created |

Ay File successfully Created

=

Figure 3. 135

As mentioned earlier, other tools like Windows Media Explorer
may be used to view the AVI file. The file with the extension .AVI
should be located in the same folder where the STAAD input file is
present.
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3.11.8 Viewing plate results using element

query

Element Query is a facility where several results for a specific
element can be viewed at the same time from a single dialog box.
Let us explore this facility for element 4. Select element 4 and
double click on it. Alternatively, select element 4, and from the
Tools menu, choose Query — Plate.

Select Results Report Mode Window Help

(& &= & 5 &
Check Duplicate 4
Orphan Modes 4 @l @‘

Check Improperly Connected Plates

Caleulator. ..
Unit Converter...

k= Dimension Beams...
[%3- Display Mode to Mode Distance

'ém Set Current Input Unit...
Set Current Display Unit...
% Cut Section...

List Format...

Flate

Section Wizard...

Modify Section Database. .

Figure 3. 136

The various tabs of the query box enable one to view various types
of information such as the plate geometry, property constants,
stresses, etc., for various load cases, as well as print those values.
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Some typical screens are shown.

: E3
Frinc Strezz and Disp I Cormer Stresses I
Geometry | Froperty Constants I Center Stresses
Flate Mo : 4
% Y z
Hode m m m
4 1) 1) 2
3 2 1) 2
9 2 i 4
10 1) 1) 4
Edge Lengths & Area
AB BC (1] DA
Length (m)|2 2 2 2
Area (cm2)40000

Flate Spec :

Frint | Cloze I

Figure 3. 137

i Plates Tutorial.std - Plate 3

Frinc Strezz and Disp | Cormer Stresses I
Geometry Property Constants | Center Shesses
Flate Mo : 4

— Physical Properties

Thickness
Hode m
4 0.3
3 0.3
9 0.3
10 0.3

Azszign/Change Property |

Material Propertie:
Elaticitytkhinm2) |21 7185 Density(kaima) | 2402 61 [concree =]
Poisson o7 Jie-008 CONCRETE g

Apha
Azzign Material |

Frint | Cloze |

Figure 3. 138
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i Plates Tutorial.std - Plate
Frinc Strezz and Disp I Cormer Stresses |
Geometry I Property Caonstants Center Stresses
Flate Mo : 4

Load List : I‘I:DEAD LOAD 'l

Flate Center Stresse:

50X SQY 5% 5Y
Himm2 Himm2 Himm2 Himm2
00705626 -0.0219774 0 o
SXY Mx MY MXY
Himm2 KkH KkH KH
1) -11 8626 -3.55841 -5.48485

Frincipal / Won Mises / Tresca

Principal Yon Mis Tresca
Top (Mimmz) 0972647 0.946155 0917227
Bottom (Minm2) |0.972647 0.946155 0917227

Frint Cloze

Figure 3. 139

Geometry | Froperty Constants I Center Stresses I

Frinc: Stress and Disp Carner Shresses

Flate Mo : 4

Load List : I‘I:DEAD LOAD 'l

Flate Corner Dizplacement:

X ¥ z
Hode cm cm cm
4 [ 1 450920090
3 i 0034433 0
B i 04063 i
10 i -2 23409e-00 0
Flate Principal Stresse:
SMAX SMIN TMAX Angl
Himm2 Himm2 Himm2 ngle

Top -0.0334201  -D.972647 0455614 264357
Bottom |0.972647 00554201 0.4:38614 264369

Frint Cloze

Figure 3. 140
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i Plates Tutorial.std - Plate 3

Geometry I Froperty Constants | Center Stresses |
Princ Stress and Disp Carner Stresses

Load List : I‘I:DEAD LOAD 'l

— Plate Carner Stresse:

Hode 4 3 4 10 =
b 0915746 147106 0.7:32406 301445
Top
Mimm2
b 0915746 147106 0.7:32406 301445
Bottom
Mimm2
S o o o o
Mimm2
s o o o o

Mimm2
i E E E =l

Frint | Cloze |

Figure 3. 141

The length and force units in which the values appear in the above
tables can also be modified using the method explained in section
3.11.3.
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3.11.9 Producing an onscreen report

Occasionally, we will come across a need to obtain results
conforming to certain restrictions, such as, say, the resultant node
displacements for a few selected nodes, for a few selected load
cases, sorted in the order from low to high, with the values
reported in a tabular form. The facility which enables us to obtain
such customized on-screen results is the Report menu on top of the
screen.

Let us produce a report consisting of the plate principal stresses,
for all plates, sorted in the order from Low to High of the Principal
Maximum Stress (SMAX) for load cases 101 and 102.

The first step to do this is to select all the plates using the Plates

Cursor m Then, go to the Report | Plate Results | Principal
Stresses menu option as shown below.

Mode Window Help
Beam Property... ) & i EE! &. @
Joint Displacement. .. 1 @\ @\ @ [y
Support Reactions. ..
(= BFEA

Flate Stresses. ..

Flate Results L

Floor Vibration Report...
Figure 3. 142

Principal Stre
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In the dialog box that appears, select the Loading tab. Make sure
that load cases 101 and 102 are selected as shown below.

Plate Forces E

Sorting  Loading |F|3|:u:|rt|

— Load Cases
Available; Selected:
1 DEAD LOAD ;l 101 CASE 1 + CASE 2
2EXTERMAL PRESSURE LDAD 102 CASE 1+ CASE 3
I TEMPERATURE LOAD s |

e
|LI

0K | Cancel Help

Figure 3. 143



Tutorial 3| 3-133
Next, select the Sorting tab. Choose SMAX under the Sort by
Plate Stress category and set the Sorting Order List from Low to
High. (If we wish to save this report for future use, we may select
the Report tab, provide a title for the report, and turn on the Save
ID option.) Then, click on the OK button.

Plate Forces E

Sarting ||_|:.ading| Hepnrtl

— Sort By Plate Stregs—————————————— ~ I Sorting Done
¥ Shipx
" SMIN ™ Absalute Values
7 THAx
— Set Sorting Order

= List from High to Low
& List from Low to High

€ List with no sart done

0K Cancel Help
1%

Figure 3. 144
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The following figure shows the table of maximum principal stress
with SMAX values sorted from Low to High.

ES| Plates Tutonal.std - Plate Forces =]
S

SMAX SMIN TMAX

AR LiE KHim2 KkHim2 KHim2 KOl —
7 02 Top 14460033 25380348 54B0.155 33310
2 02 Top 5006584 24016435 D4EDATE 35434
3 02 Top 4B07 0457 25810491 10503 621 437338
3 02 Top 718747 20732025 10006 540 3108
B 02 Top Bapnos’Eegass 4133528 35686
5 02 Top ‘4257147 7ee1e00; sEi18083 30 461
3 o1 Top 2030 desnsis a3 4n 7843
7 01 Top 10458 le4nara T 2eaosT 45074
3 T Top Foaa7 ] Aa7TaTe. G4ados 96 457
2 01 Top s5a4s 301 sEs . BaD207 B 75
7 02 Bottom J04161 1 ag79955 . s041 708 38739
B 01 Top aie0. 524483 41632 53 363
B o Bottom so4 4831 Aoeqen; 4B H2 53 363
7 01 Bottom Bagara. ii0qsa. eansT 45074
5 o Top 7as 308 EO0408. 792854 54 971
5 01 Bottom soo40a. 7asaoa 792854 54 571

r 02 Bottom 11400 ATFrEna0 | B4SE RN WP
2 01 Bottom 1301 568 spmas T saEn 07 B3 75
r T Bottom 1377 476 784E7 " Ran a0s 56 457
5 02 Bottom 13a4B58 . Tazemie4E3mo0 3 445

] M1 Rt nm 1050 5173 M2 033 AR F4AN Ta O LI

Figure 3. 145
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To print this table, click the right mouse button anywhere within

the table. A list of options will appear.

o Cut

Copy

2 Faste
Delete
GoTo..

[Tyl
[+
[Crl
e
F&

Change Unit for thiz column

A 30 Bendering

(& Print Prexisw

P

Resultz Setup...

Mode Displacements Table
Beam End Dizplacements Table

Beam Relative Dizplacement Detail Table

Support Beactions Table
Beam End Forces Table

Beam Forces Detail Table

Flate Centre Stress Table

Flate Cormer Stress Table

Solid Centre Stress Table
Solid Corner Strezs Table

[7] Other Tables...

Figure 3. 146

Select the print option to get a hardcopy of the report.

To transfer the contents of this table to a Microsoft Excel file,
click at the top left corner of the table with the left mouse button.
The entire table will become highlighted. Click the right mouse
button and select Copy. Then, open an Excel worksheet, click at

the desired cell and click Paste.

3-135
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3.11.10 Viewing Support Reactions

Since supports are located at nodes of the structure, results of this
type are available along with other node results like displacements.
To view the reactions graphically, click on the Node page on the
left side of the screen, and select the Reactions sub-page.

Jeaa Joaa

EA Plates Tutorial std - Whole Structure M=l &3

- Reacm p| Displacement

| 7% Reports | % animation | 3 Piate
i

Load 1 : Displacement

Figure 3. 147
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The reactions at the supports will be displayed on the drawing as
shown below.

Ed| Plates Tutorialstd - Whole Structure _ O] x|

= =

0.000]Ky - o
5071.908 k%= 33.146 kipft
= 0.000 kip-fi
N1 45600 [ReLre 12,129 kip-ft
X = : 0.000 kip-ft
Y - 524 KX 0.033 kip-ft
Z = 0.000 ki
MX = . 296 _1@‘ 0.039 kip-ft
My = %0.000 kip-ft| 0.000 1‘ T
MZ = ¥0.294 kip2#51.007 ky
7 = 0.000 ky Z2
MX = N143 kip.t
MY = X 0.900 kipftD-000 ky
MZ = ¥23.201 ki 49p-783 kg
= 0.000 ky
X = 11.220 kip ft
MY = 0.000 kipft
MZ = 27.042 kip-ft

Load 1

Figure 3. 148

The six values — namely, the 3 forces along global X, Y and Z, and
the 3 moments Mx, My and Mz, in the global axis system are
displayed in a box for each support node. The words N1, N2, etc.
stand for the node numbers of the supports.
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We may choose to “un-display” one or more of the 6 terms of each
support node in the following manner.

From the Results menu, choose View Value.

Results

& &nimatian...

Bending Moment
Deflection

7 Section Dizplacement
Itilization R atia...

£ Beam Stiesses
@ Plate Strezs Contaur...
€ olid Stiess Confour...

Cl; tode Shape Dizplacemert. ..
Time History Graph..

Select Load Case...
Scale...

|Ipdate Froperties

Slab Reinforcemert. ..

Figure 3. 149
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In the dialog box that comes up, click on the Reactions tab. Let us
switch off Global X and Global Z under the Direct category.
Then, click on the Annotate button followed by the Close button.

1 Annotation - Plates Tutorial_std - Whole Structure |

Hangesl Beam Hesultsl Mode Reactions I

—Direct————————— Bending
[ Global ¥ Global i
¥ Globaly ¥ Global v
" GlohalZ ¥ Glohal @
— Diagram
[~ Show Line

Sale |1E-UU7" E ka per m
Seale [1=007 E Kiprft per m

Remove All Annatate %l Cloze

Figure 3. 150
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The drawing will now contain only the remaining 4 terms (see

figure below).

N1

Ed| Plates Tutorial std - Whaole Structure

MX
MY =
MZ =

ks

sl p-
0.033 kipft

4096.783 ky
11.220 kipft
0.000 kip-ft
27.042 kip-ft

(O]

Load 1

Figure 3. 151

To change the load case for which the reactions are displayed,

select the desired case from the load selection box.

[F1 & g8 al ™ i 18 07 2

g ot

102 CASE 1 + CASE 3

[

I

|

1: DEAD LOAD
& EXTERNAL PRESSURE LOAD
2 TEMPERATURE LOAD
107: CASE 1+ CASE 2
AL CASE T + CASE 3

Envelope

Figure 3. 152
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For better clarity in viewing the results in the drawing area (and
for reducing the clutter on the screen), a variety of methods are
available. For example, keep the mouse pressed on top of Zoom In
button, and watch the drawing get progressively bigger. Use the
Pan button to physically shift the drawing around. Other options
like Dynamic Zoom and Zoom Window buttons may also be used.
To restore the original view, click on the Display Whole Structure
button. (Some of these options are explained in greater detail in the
‘Frequently Performed Tasks’ section at the end of this manual.)

lcon Name

Zoom In

®

Pan

Dynamic Zoom

Zoom Window

= Display Whole
Structure




3-142

Tutorial 3

The table on the right side of the screen contains the reaction
values for all supports for all selected load cases.

ol %]
[A[ A% eI Al A Sumrmary A Envelope £
Horizontal Vertical Horizontal Moment
Fx Fz Mx Mz
Hode Lic kg :; kg KHm k'::‘n KHm
1 1 DEAD LOA 0.000 -54 524 0.000 -0.401 0.000 0339
2 EXTERMAL 0.000 -22735 0.000 0167 0.00a 0166
3 TEMPERAT 172 .8E3 2649422 152 5E3 -75.4M 70558 783682
101 CASE 1 + 0.000 -77.359 0.000 -0.563 0.000 0565
102 CASE 1 + 172.8E3 2594 799 152 5E3 -75.802 70.559 T8.7581
2 1 DEAD LOA 0.000 1816.168 0.000 -23458 0.000 0053
2 EXTERMAL 0.000 755913 0.000 -A7E3 0.00a 0oz2
3 TEMPERAT -20818E3 5522880 177 2E3 -148.111 361 463 2814
101 CASE 1 + 0.000 2572082 0.000 -3322 0.000 0.0vs
102 CASE1 4 -208.18E3 7339.049 177 2E3 -171.568 361 463 25194
4 1 DEAD LOA 0.000 2591 007 0.000 -5.287 0.00a 31 456
2 EXTERMAL 0.000 1078 411 0.000 -3.449 0.00a 13.092
3 TEMPERAT 295497E3 3055179 =241 91E3 16182 -35.685 106 855
101 CASE 1 + 0.000 3669418 0.000 11737 0.000 44 545
102 CASE 1 + 2895 9VE3 2646186 =241 ME3 9.595 -35.685 135344
Figure 3. 153

This table can also be displayed from any mode by clicking on the
View menu, choosing Tables, and switching on Support Reactions.
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The method explained in section 3.11.3 may be used to change the
units in which these values are displayed. The summary tab
contains the maximum value for each of the 6 degrees of freedom
along with the load case number responsible for it.

EE| Plates Tutorial. std - Support Reactions: | _[O) x|
[A[ A8 [MIF A Y Summary 4 Envelope /
Horizontal Vertical Horizontal Moment

kHm

3 TEMPERAT k]
-261.486

7 3 TEMPERAT -3326E3: 7389239 237 BTE
5 102 CASE1 + -26741E3 9209.981 : 42301 565 -150.203 -163.694
10 3 TEMPERAT 33942E3: -T766.295: -367.75E3 23.440 32.043
i 3 TEMPERAT -332BE3:  -T589.239 237.67E3 24.478 -261 486
10 3 TEMPERAT 33042E3:  TVEEZ9S. -3BV.V5E3 23.440 32043
10 102 CASET 4 33942E3: 36695130 367 .TaE3 38.652 32043
2 102 CASE1 + -208.18E3 7339.049 177 2E3 -171.568 361 463
T My 2 3 TEMPERAT -208.18E3 5542 580 177 263 -148.111 361.463
Tl ity i 3 TEMPERAT -332BE3:  -T589.239 237 BTE3 24.478 -261.486
hlaz Wiz 4 102 CASE1 +  20597E3 SE46.186 0 24 9E3 9.593 35680
tlin Wiz 7 102 CASE T 4 -3328E3: 3021 673 237 BVE3 -20.452 - 261 486
Figure 3. 154

This brings us to the conclusion of this tutorial. Additional help on
using plates is available in Examples 9, 10 and 18 in the Examples
Manual.
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Tutorial Problem 4. Interoperability
(using STAAD.Pro and STAAD.etc)

Section 4

This tutorial is relevant only for users who have
purchased the program called STAAD.etc. Since this
tutorial is created using the Demo CD, the user will
not have the ability to alter certain input items.

This chapter provides a step-by-step tutorial on using the
interoperability features between STAAD.Pro and the program
called STAAD.etc. The structure created in Tutorial Problem 1 will
be used as the basis for this tutorial. This tutorial covers the
following topics:

e Understanding STAAD.etc

e Description of the tutorial problem

e Using the Interactive Mode in STAAD.Pro

e Designing a footing based on results from STAAD.Pro

e Designing a base plate based on results from STAAD.Pro

e Saving the Interactive Design information as a STAAD.etc file
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4.1 Understanding STAAD.etc

STAAD.etc is the “engineer’s structural toolkit” containing various
component analysis and design module groups including
foundations, masonry, timber, steel, concrete and general analysis.
As a standalone product, STAAD.etc can be used to design small
portal frames, continuous beams, footings, retaining walls one-way
slabs, connections, shear walls and much more. STAAD.etc allows
the engineer to complete the design cycle on the primary structure
by analyzing and designing several structural components or
accessories within the STAAD.Pro environment using
STAAD.Pro’s results database.
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4.2 Description of the tutorial problem

Using the structure created in Tutorial Problem 1 as the primary
model, STAAD.etc will be utilized to analyze and design a footing
and a base plate inside the STAAD.Pro environment for the model.
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4.3 Using the Interactive Mode in STAAD.Pro

Start the STAAD.Pro 2006 Program from your STAAD.Pro
program folder, as explained in Section 1.2. From File | Open,
open the file “Tut_01_ portal.std” from the
..ISPRO2006/STAAD/Examp/US directory as shown below (please
note that the .. represents the drive or root directory the program
was installed in) or from wherever the file was saved:

Open
Lock in: I@US j L] £ FE-
[2]ExaMP19STD [2]EXAMP25STD  [2]VEROISTD [2]vERC
[#]ExaMP20.STD  [2]EXAMP2ESTD  [2]VERO2STD [2]vERL
[2]ExaMP21.5TD  [2]ExaMP2ZSTD (2] VEROISTD [2]vERC
[#]ExaMPzZSTD [2]INTRO.STD [2]vERD45TD [2]vERT
[ElExamPzasT DDA [z)vERosSTD [2]vER
[2]ExaMP24.5TD [2] Tut_02_rchrame.std 2] VEROB.STD [2]vER1
Kl | i

File name: ITut_D‘I_portaI.std Open I
Files of type:  [STAADYPra Files [~std) =l Cancel |

~ Presview

¥ Werify list data while reading
Job |

Client |
Job Mo, |

Part I
Fef I

Figure 4. 1

The picture in the preview pane is made possible by a file with the
extension .emf. When a model is created using the graphical
method, or when a model is saved from the graphical mode, the
.emf file is created alongside the .std file. If you follow the
procedure explained in Section 1.5 of this manual for creating
tutorial 1, the Tut-01-portal.emf file will be produced, and if you
re-open the Tut-01-portal.std subsequently, you will see the picture
in the preview pane.
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If you have not performed the analysis and design for
“Tut_01_portal.std”, please execute the following steps:

After opening the file in STAAD.Pro, go to Analyze | Run
Analysis from the top menu bar as shown below.

STAAD Pro - tut_D1_portal_std

File Edit “iew Toolz Select Geomety Commands | Analyze Mode “Window Help

H?@'ﬁinéﬁﬁﬂiggﬁfa

I R N "

Figure 4. 2

A dialog box providing a choice of engines to run the file with will
then popup. Select the STAAD Analysis engine as the default
engine and click on the Run Analysis button.

Select Analysiz Engine E3

Analysiz Dption |

& STAAD Analysiz

" Stardyne Advanced Snalysis

Run .-’-‘mal_l,l;i'sl Cancel | Apply | Help |
X,

Figure 4. 3

If the analysis is successfully completed, a dialog box showing the
different steps STAAD took to analyze the structure will come up.
Click Done to proceed to the next step. If a message reporting
errors in the input file were found, please refer to Tutorial 1 to

rectify those problems.

45
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STAAD Analpsis and Design

++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++
++

k3
*X

Performing Steel Design

Start Steel Design . ..

Finished Design .. .

Processing and setting up Load Vector.
Processing Element Stiffness Matriz.
Processing Global Stiffness Hatrix.

Finished Processing Global Stiffness Matriz.

Processing Triangular Factorization.
Finished Triangular Factorization.
Calculating Joint Displacements.
Finished Joint Displacement Calculation.
Calculating Hember Forces.

Analy=is Succes=fully Completed ++
Calculating Section Forces

Ferforming Steel Design

Start Steel Design ...

Finished Design ...

Creating Displacement File (DSP) . ..
Creating Reaction File (REA). ..
Calculating Section Forces

Creating Section Force File (BMD) . .
Creating Section Displace File (SCHY . ..
Creating Design information File (DGHY . ..

End S5TaAD . Pro Run Elapsed Time = 3 Sec=
Output Written to File:

PORTAL . anl

= View Output File

" Go to Post Processing Mode
% Stay in Madeling Mode

10:11:41
0 sec

10:11:41
10:11:41
0 sec
10:11:41
1 =ec
10:11:42
0 sec
10:11:42

10:11:42
0 =ec

Execute | Dane I

-

Figure 4.4

Starting the Interactive Mode in STAAD.Pro

After “tut_01_portal.std” has been successfully analyzed and
designed, click on Mode | Interactive Designs | Component
Design from the top menu bar as shown in the next figure. If this
menu item is “grayed-out”, the STAAD.etc program has not been
installed properly or is missing. Please install or reinstall the
STAAD.etc program from the STAAD.suite CD.




Tutorial 4

tMode ‘Window Help

Iﬁ Madeling
bed Post Processing

Interactive Designs

|0 &8 0 A

Steel Design

Bridge Deck Preprocessor

IE Fage Control

Concrete Design

Figure 4.5

The STAAD.etc interface to STAAD.Pro is shown in the bottom
right-hand corner of the screen. At the time of release of
STAAD.Pro 2003 Build 1001, there are only three STAAD.etc
modules interfaced with STAAD.Pro 2003. These modules are the
footing, slab and base plate analysis/design as shown below.

ECIEs |

|[dgs@n g tigpE i’ |[SRRSGED [Dadrar b1 KA |[BRARL ||Nn<d
|lopeaaaassttock | [@RBAAAEQ A Q oitw0-un F
|pvnanwnsBBs: "0 [|aadc wt@awlads [ @@
| [ — =l %
[k g i Wode | _support_|
& z [0 | 52 swez
m o T Gas|
R - : i LT
@ § s
o § =
W o —
=
= |
=8 I
- Olnegn Cinde: U] =]
L ]
3 - & =
— Fexting Base Pl Slab Dwsign
i &
7]
i
]
o Lo

ol Jobs I View Rewits

Tt Help. press F1 lickainctive Dadion Load 1 DEAD s LIVE  Inguat Uit (ki

Figure 4.6
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Using the Drag and Drop Facilities

To run any of the STAAD.etc modules, hold the left-mouse button
down over a particular module and drag it to a specific joint or
node in the main structure window.

Drag and Drop icon over a joint in the structure

Interactive Desiyin

Design Code : IUS[Imp] j
h =
&% Footing Slab Design
Edit Job Wiew Results

Figure 4.7
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4.4 Designing a Footing based on results from
STAAD.Pro

In this section of the tutorial, a footing will be designed for node
#1. The details of the input of the footing will not be discussed
here. For further information about the input for the STAAD.etc
footing module, please refer to the STAAD.etc HTML Help
accompanied with the STAAD.etc program.

To identify Node #1, click on Select | By List | Nodes... from the
main menu bar. Select number 1 in the list box.

Select
Iz Modes Cursor
’E Beams Cursor
L Fhyzical kember Cursar
m Plates Cursor
E] Surface Cursor
m Solids Curzor
Plates & Solids Cursor
@ Geometry Cursor

Selection Mode 3

Ign Load Edit Cursor
m Support Edit Cursor
If# Release Edit Cursor

%, Text Cursor
Beams Parallel To 3 Select Nodes [ %]
By Range 3
By Group Name...
2 Cloze |
Entity at node. 4 3
Entity Connects Beam » 4
Entity Connects Plate 3 Selection Type
Entity Connects Solid 3
Y N % Select from list by cursor
" Select using typed list
By Inverse 3
|
m Select Listed Ertities
By Specification (3 Beams...
T T ' Flates...
» Missing AfriBues Solids... Enter list :
Highlight Entities S equentially Geometry...

Figure 4. 8 Figure 4.9
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Node #1 is now marked by a red dot in the main structure window
as shown below.

Node # T is now highlighted in
red.

Figure 4. 10

Once Node #1 is identified, drag the footing icon from the
Interactive Design dialog box and drop it over #1. The input for
the footing pops up. Provide the name of the footing in the Job
Name edit box.
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Staad. etc Interactive Design B2
Service Load Factors I I aterial Drata I Reinforcement Data
Geomatry | Pedestal | Loading I Design Load Factors

Mode: 1

Job Mamne : Iabcdefg

[T Concrete Pedestal Code IUS VI

Important to fill
this information

— Footing Min-ka:
Minimurn Width : 72 Jin i
M asimum Width f720 jin =l
Minirmum Length : |?2 in j
P aximum Length ; |?2U Iin j
Ratio : I'I 5
Firi Faoati i -
i O [ =l
r— Colurn D ata
Colurnr Depth: |-| ] Iin j
Column Width: 12 [ =]
— Soil Depth
Soil Depth: |24 Jin =l
r Iteration Increment
Increment in Lenath I‘I 2 Iin j
Increment in Thickness I‘I Iin j
Figure 4. 11

If the Column Depth and Width are not provided under the Column
Data box, obtain those data (either from the member query or from
the property table) and provide them. STAAD.etc defines the
Column Depth as the dimension of the supported column along the
local Y axis of the column. The Column Width is defined as the
dimension of the supported column along the local Z axis of the

column.

4-11
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Leave the Concrete Pedestal option unchecked. Switch to the
Loading tab and select the Dead Load as Load Case 1 (the
Selfweight load case) and the Live Load and Wind Load as None.
Check the Reversal of Wind option off as shown below.

Staad.etc Interactive Design | x|
Service Load Factors I M aterial 0 ata | Feinforcement D ata I
Geometry I Pedestal Loading | Design Load Factors

Select Load Cazes to Design for

Deadload: |1 DEAD + LIVE =
Live Load : INone j
wind Load : I Mone j

[ Reversal of wind

0K [:I Cancel I Apply Help

Figure 4. 12

Keep all the other data as the defaults. Click on OK to begin
designing the footing for Node #1. If the design completes
successfully, the results for the footing will be displayed in a
separate window. Each interactive design module produces a
separate results window containing three tabs at the bottom. These
tabs are Results, Calculations and Output Drawing.



The different facets of the results output are as follows:
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Tab

Description

Sample

um Tut_0E_postalstd - Foundation Besign - Support Ne.
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[ et i1y
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and design) in tabulated RO || | wisser | ieeoe | R | s |
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Reizrin e Reanfoacing {indp
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explaining the derivation of FmACtE ”j"""' y
all results. (24 4B 100 = (24 40 D001 3200001 000+ 200,000
From ACT £g. 1156, Vum
[+ i by b s 1000°F) =2+ 20721 D0/ 32 009192 D021 D00~ 2000 000
Beom ACT By 1127, Wum
At L0 - 44132 000°21 D00*~/ 400,000 2

[ w—

Output
Drawing

Detailed output drawing
schematic

A

Toe

Figure 4. 13
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Editing and Viewing Interactive Designs

All interactive design results for a particular STAAD file are listed
in the Interactive Design dialog box which can be brought up by
clicking on Mode | Interactive Design from the top menu bar. To
view any interactive design result, select the design job and click
on View Results. To edit any job, select the job and click on Edit
Job to bring up the input dialog box with the existing data.

Interactive Design E
Deszign Code - IUS[Imp] j
Footing Baze Plate Slab Design

Foundation S dema

Edit Job I Yiew Results

Figure 4. 14

STAAD.Pro also has the ability to design group footings. This
tutorial does not cover the basics of running a group footing inside
of STAAD.Pro.
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4.5 Designing a base plate based on results from
STAAD.Pro

The base plate and other modules in the Interactive Design mode of
STAAD.Pro are similar to the footing module explained

previously. A brief description of the base plate input will be
explained here. For a detailed description of the base plate
module, please refer to the STAAD.etc HTML Help.

Following the steps in the footing module tutorial in Section 4.4,
the input for a base plate can be supplied after the base plate icon
is dragged and dropped over a particular support joint. A base plate
can be designed only for a member with a support.

Staad.Elc Interactive Design
Geamelty Data | Stifeners Data | Anchor Ball Data | Shear Lug Data |
Job: [Test

Design option Select Load Cass to Design for
[Deslgr\ Code: [A50 x| Analsis: [FEM x| ( Load: [1 DEAD +LWVE =]
- Geometr Balt Distanc

Min. Plate Length, 14 in =] || Bolsalnglength: [o

Max. Plate Lergth: 120 n x| | |Bobsalngwidth: [z

Al o ] 1 G T

|z Plate Width: i -

Increment Length 0.25 in z g; £ Im

Flate Thickness 05 n =] Ek]

Thickness Increment: 0125 i | Dé: 55

Pier Length 28 in x| —Wp—

Pier Width E n v S

Fy IBS ksi
E: IZBDDD ksi

d1
e ]
“5u | B .
& 8
Fe: |3 ksi ¥ Fp & per 401 318-99 n_“‘{ A
-

Lellelle

’TI Cancel | Hpply Help
Figure 4. 15

To check the adequacy of an existing base plate for a specfic load
case, provide the Plate Length, Plate Width and Thickness of that
plate. However, to have the program design a base plate, set the
Plate Length, Plate Width and Thickness to zero (0).
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4.6 Saving the interactive design as a STAAD.etc
file

All interactive design jobs are saved with the STAAD.Pro “.std”
input file as a separate file with the extension “.etc”. For example,
in this tutorial, the STAAD file is named tut_01_portal.std .
Thus, the name of the interactive design file will be
tut_01_portal.etc and will be saved in the same directory as the
“tut_01_portal.std” file.

STAAD.Pro is capable of inherently reading STAAD.etc files
without the need for importing or exporting the file. Similarly, any
“.etc” file generated by STAAD.Pro can be read in STAAD.etc.
This is particularly useful when the engineer wants to design other
structural components on top of the ones already produced in
STAAD.Pro.
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Frequently Performed Tasks
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1. Selecting nodes, beams, plates, etc.

The Selection Toolbar]

E Modelin

& le] g

ol A

|z |—

|z lio | Modes Cursor

o1& IE Beams Cursor

km ﬂ L& | Plates Cursor

b = K] | Surface Cursor

L 5 I¥ | Solids Cursor

| |= L% | Geometry Cursor

|

E - % | Select Text

— | | [#m | Load Edit Cursor

E 2 li | Support Edit Cursor

" & i | Member Release Edit Cursar
|

[ . =k | Filtered Selection

= o IS

— 18

= 1

o | —

e

I

52




FPT-2

Frequently Performed Tasks

Icon Corresponding Menu/Sub-menu
options

Purpose

Description

Select | Nodes Cursor

[:%':i Select Geometry  Commands 1

[ Beams Cursor
Cursor X Fhysicalltdember Cursar
m Plates Curgor
] Surface Cursor
% Solids Corzor
Plates & Solids Curzor

Nodes

[ Geometry Cursor

Selection Mode 3

[#1 Load Edit Cursor
[ Support Edit Cursor
[@E}' Releaze Edit Cursor

Used to select
nodes
graphically

First, select the Nodes
Cursor. Then, click on
the nodes you wish to
select. To select
multiple nodes, hold
down the Control key
while selecting, or
create a rubber-band
style window around
the desired nodes.

Select Geometry  Commands

Beams lio Modes Cursor
Cursor M B '
L Phuyzical tember Cursor
L2 Plates Cursor
E] Surface Curzor
I3 Solids Cursor

Plates & Solids Curzor
[ Geometry Cursor

Selection Mode 3

[g1 Load Edit Cursor
[ Support Edit Cursor
[%Ef Releasze Edit Cursor

':5\ Text Curzar

%, Text Cursor
Select | Beams Cursor Used to select First, select the Beams
t% beams Cursor. Then, click on
graphically the members you wish

to select. To select
multiple members, hold
down the Control key
while selecting, or
create a rubber-band
style window around
the desired beams.
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Icon

Corresponding Menu/Sub-menu
options

Purpose

Description

L%

Plates
Cursor

Select | Plates Cursor

Select Geometry Commands A
lyo Modes Cursor
[ Beams Cursor
L Phuyzical Membern Curzor,
B
E] Surface Cursor
I3 Solids Cursor

Plates & Solids Cursor
[ Geometry Cursor

Selection Mode 3

Ign Load Edit Cursor
t@ Support Edit Curzor
laf Release Edit Cursor

. Tiext Cursor

Used to select
plates
graphically

First, select the Plates
Cursor. Then, click on
the plates you wish to
select. To select
multiple plates, hold
down the Control key
while selecting, or
create a rubber-band
style window around
the desired plates.

=

Surface
Cursor

Select | Surface Cursor

Select Geometry  Commandz
lip Modes Cursor

[+ Beams Cursor

L FPhwsizal i ember, Eurzar
m Plates Curzor

5] Suiace
§ Solids Cursor

Plates & Salids Cursor
@ Geometry Curzor

Selection Mode »

[gn Load Edit Cursar
t@ Support Edit Curzor
laf# Release Edit Cursor

%, Text Cursar

Used to select
surface
graphically

First, select the
Surface Cursor. Then,
click on the surface
you wish to select. To
select multiple
surfaces, hold down
the Control key while
selecting, or create a
rubber-band style
window around the
desired surfaces.
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Frequently Performed Tasks

Icon

Corresponding Menu/Sub-menu
options

Purpose

Description

R

Solids
Cursor

Select | Solids Cursor

Select Geometry  Commands 4

lio Modes Cursor

[y Beams Cursor

L FPhwsizal Member, Cursar,
m Plates Curgor

] Surface Cursor

2

Plates & Solids Cursor
[ Geometry Cursor

Selection Mode 3

[#1 Load Edit Cursor
[ Support Edit Cursor
lfs Release Edit Cursor

%, Text Cursor

Used to select
solids
graphically

First, select the Solids
Cursor. Then, click on
the solids you wish to
select. To select
multiple solids, hold
down the Control key
while selecting, or
create a rubber-band
style window around
the desired solids.

L5

Geometry
Cursor

Select | Geometry Cursor

Select Geometry  Commandz

lip Modes Cursor
[+ Beams Cursor
L Phuyzical tembern Cursor
L2 Plates Cursor
E] Surface Cursor
I3 Solids Cursor
Plates & Solids Cursor

FFY Geometry Curso

Selection Mode k

[gn Load Edit Cursor
t@ Support Edit Curzor
[%Ef Releaze Edit Curzor

':5\ Text Curzar

Used to select
any geometry
graphically. It is
a mechanism for
selecting nodes,
beams, plates
and solids, or,
any combination
of these,
simultaneously.

First, select the
Geometry Cursor.
Then, click on the
entity you wish to
select. To select
multiple entities, hold
down the Control key
while selecting, or
create a rubber-band
style window around
the desired entities.
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Icon Corresponding Menu/Sub-menu Purpose Description
options
Select | Load Edit Cursor .
Used to First, select the Load
[@ graphically Edit Cursor. Then,
select a double-click on the

Load Edit
Cursor

Select Geometry Commands
[+ Modes Cursor
[+ Beams Cursor
L Fhysical M ember Cursor
EE Plates Curzor
[E] Surface Cursor
% Solidz Curzor
Flates & Solids Cursor
[@ Geometry Cursor

Selection Mode k

[Fal Load EditC
[% Support Edit Cursor

[:fs Release Edit Cursor

% Tiest Cursar

component of an
existing load
case for
modification.

diagram of the load
component you wish to
edit.

EL

Select | Support Edit Cursor

Support Edit
Cursor

Select Geometry  Commands
lio Modes Cursor
[+ Beams Cursor
L Phuyzical tember Cursor
L2 Plates Cursor
] Surface Cursor
% Solids Cursor
Plates & Salids Cursor
@ Geometry Curzor

Selection Mode »

[gn Load Edit Cursar

@ Support Edit

laf# Release Edit Cursor

%, Text Cursar

Used to
graphically
select a support
whose
parameters one
may wish to
modify.

First select the Support
Edit Cursor. Then,
double-click on the
support icon at the
node where you wish
to modify the details of
the existing support.
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Frequently Performed Tasks
Icon Corresponding Menu/Sub-menu Purpose Description
options
Select | Release Edit Cursor .
Used to First, select the
[:ht-"l graphically Release Edit Cursor.
select and Then, double-click on
Select Geometry  Commands modify an the member on which a
I3 Modes Cursor existing member | currently defined
. Beams Cursar release START or END release
Release Edit & , specification condition has to be
Cursor L Ehpsical Member Curzar modified.

[z7 Plates Cursor
E Surface Cursor
[¥ Salids Cursor
Flates & Solids Cursor
L% Geometry Cursor

Selection Mode 3

[F71 Load Edit Cursor
[@ Support Edit Cursor
& Edit Cursar

% Tiest Cursor

Select Text

Select | Text Cursor

Select Geometry Commands 4
lss Modes Cursar
I+ Beams Cursor
L Fhysizal Member Cursar
m Plates Cursor
[§] Surface Cursar
% Solidz Cursor

Plates & Solids Cursaor
[@ Geometry Cursor

Selection Mode 3

[¥7 Load Edit Cursor
w Support Edit Cursar
laf# Releass Edit Cursor

M

Used to enter
the mode for
editing pre-
created text
labels

To edit any pre-created
text, first, select the
Text Label Cursor.
Then, double-click on
the text that you wish
to modify.
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Icon

Corresponding Menu/Sub-menu
options

Purpose

Description

o

Filtered
Selection

| Select  Geometry Commands  Analyze
[ o Modes Cursor

,E Bearns Cursor

& Physical Member Cursor

Eﬁ Plates Cursor

E] Surface Cursor

ﬁ Solids Cursar

Plates & Solids Cursor
[ Geametry Cursor

Enables the user
to select
multiple types of
geometric
entities (nodes,
beams,

surfaces, etc.)
with specific
attributes in one
pass.

Please refer to

STAAD.Pro 2004 2™

Edition Release
Report.
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2. Viewing the structure from different angles

The Rotation Toolbar]

File Edit “iew Tool: Select Geometry Command:  Analyze

|[azs@®: s eorcra B BN
ﬂ@@@@@@@ s b b oo k|

looooae o
T EEEE;
o o 1]

2 £z £ 35 3
- T Tm T T m o=
_|—|—|EEE_.
S 353 33 ¢
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Icon Description Example
Displays the structure as seen
@ from the front. When the
global Y axis is vertical, this is
the elevation view, as looking
towards the negative direction
View From of the Z-axis.
+Z
=]
Displays the structure as seen
@ from the back. When the
global Y axis is vertical, this is
the elevation view, as seen
looking towards the positive
direction of the Z-axis.
View From -
z
& & b

il

View From
+X

Displays the structure as seen
from the right side. When the
global Y axis is vertical, this is
the side elevation, as seen
looking towards the negative
direction of the X-axis.
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Icon

Description

Example

&7

View From -
X

Displays the structure as seen
from the left side. When the
global Y axis is vertical, this is
the side elevation, as seen
looking towards the positive
direction of the X-axis.

(7

View From
+Y

Displays the structure as seen
from the top looking down.
When the global Y axis is
vertical, this is the plan view,
as seen from the sky looking
down.

&7

View From -
Y

Displays the structure as if one
is looking up skywards.
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Icon Description Example
Displays the structure in the )
E] isometric view. The angle o -
which defines isometric view is < .
generally X =30,Y=30,Z2=0 S .
e [
. o ""‘\_ - -"\_\
Isometric ) TS S
View o ™ )
\\\\. '\.\ - ——
rh 1

FPT-11
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3. Switching on labels for nodes, beams, plates, etc.

Labels are a way of identifying the entities we have drawn on the
screen. To demonstrate this facility, let us open EXAMPO1.std.
The structure will look as shown below.

E EXAMPO1.5TD - Whole Stucture 1=l B3 I
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1.  To switch the node and beam labels on, we may utilize any one of
the following methods:

a. Click on the Symbols and Labels icon as shown below.

D& ad e sz il iz 2 M
g% & |1 14DL+ thml:n:uls and Labels| =] ‘

b. Click the right mouse button anywhere in the drawing area. In
the dialog box that appears, choose Labels (as shown in the
figure below).

[Cuit [l

&
Copy Ctrl+C
2 Faste [l

Select Curzor r
Selection Mode r

Wl Take Picture

#% Add Beam
7] Iables...

Hpen Yiew..

Orientatio. .. F4

= Structure Diagrams...

todel View Details

£+ 3D Rendering
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c. Select the View menu followed by the Structure Diagrams
option from the top menu bar, and the Labels tab of the dialog

box that comes up.

Wit

Zoom

g%‘ Fan

Yiew Selected Objects Only
’7 Alwaysz Fit in Current Window

7] Tables...
[ & whole Stiucture

Orientation... Fd

Dpemn iew...

e Wiew

Yiew M anagement 4

Toolbars...

Optiors. ..

Set Structure Colors...
Structural Tool Tip Options ..

£ 3D Rendering

Refrazh Fa




2.

Diagrams
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In all of the above three cases, the following Diagrams dialog box
will appear. Make sure that the Labels tab is selected. Then,
switch the appropriate labels on and click on OK.

3
Force Limits Animation Design Results
Structure Loads and Results Scales | Labels
Modes Physical Members Properties
Node Numbers (N})] | ] Member Number ("M) © References (I
[ Mode Paints (k) [ Design Group ("G) ©) Sections IX}.
Suppurts (5) [] Design Envelope (“E) ® None )

[C] Dimension (0}

Beams

Beam Numbers [B}]

[[] Beam Criertation {0}
[ Beam Spec (%)
Releases (R)
[]Beam Ends (E)

! Start Color
! End Colar

Plates
[] Plate Numbers ()

[C] Plate Crientation (T)

Solids
[ solid Mumbers {C)

Surfaces

[ 5uface Mumbers ("P)
[ surface Orientation {“T}

] Design Brief ("B)

Pipes
[1Pipe Node Numbers

] Pipe Mode Tags

Loading Display Cptions
] Load Values (V)

Display Floor Loading (F)

Display Floor Load Digtrbution ()
Display Wind Load Cortributory Area (H)
Digplay Wind Load (W)

General

Show Axes Window (™A)

] Show Axes At Org ()
] Material (M}
Show Diagram Info (G)

(%) Mways Use STAAD Pro Default Label Settings.
() Mways Use Cument Label Settings.

[ Master Slave (L)

Far quick access to the labels using keyboard hothkeys,
press Shift +the letter shown in brackets.

OK || cancel || pply || Hep
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The following figure shows the structure with the node and beam
labels displayed on it.
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To change the font of the node/beam labels, go to the View menu

and select the Options command. Then, select the appropriate tab
(Node Labels / Beam labels) from the Options dialog box. Choose
the Font option and make the necessary changes.

Wit

Zoom

g%‘ Fan

Yiew Selected Objects Only
’7 Alwaysz Fit in Current Window

7] Tables...
[ & whole Stiucture

Orientation... Fd

= Structure Diagrams. .

Dpemn iew...
e Wiew

Yiew M anagement

Toolbars...

ECTS——

et Structure Colors...
Structural Tool Tip Options ..

£ 3D Rendering

Refrazh Fa

Options. E‘

E Tolerance
Tabl
S soe
Node Labels jorizartal Alignment
M=) Horaorta A
B e Laves ©let  OCene ORght  Pueks gt [0 5]
E Solid Labsls Vettical Aignment
Load Labels
B toad icons ®Top  (OBaseine OBottom  Pixsls Up EE
B Annotation
B stucture Units Font Sample
| Section Units
| Force Units Opaque
i Dimension %

ok | [ ey | [ Cancel | [ ek

| FPT-17
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4. Displaying a portion of the model by isolating it from
the rest of the structure

Sometimes, the large number of entities that are drawn on the
screen may make it difficult to clearly see the details at any
particular region of the structure. In such cases, one is confronted
with the task of de-cluttering the screen or looking at specific
regions or entities while removing the rest of the structure from
the view.

There are different methods in STAAD.Pro by which the user can

view a portion of the structure. The following pages demonstrate
three different methods.

Method 1 - View | New View
Steps:

1.  To demonstrate this method, let us open EXAMPO08.STD file. The
structure will look as shown below.

K EXAMPOB.STD - Whole Structure 1H[=] E3




Frequently Performed Tasks | FPT-19

Let us say that we wish to view only the members which are at the
midheight level. The first step to doing this is to select those
members. The quickest way to select them is to bring up the View

WY .
From + Z “: and creating a rubber-band around them, after
making sure that the Beams Cursor | h | is the active cursor.

@@@@@@@ | |

To visually verify that the correct members have been selected,

.
click on the Isometric View icon —— . The selected members will
appear in one color and the rest of the structure in another.

P EHPEE AT
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4.  Next, either click the right mouse button and select the New View
option or, pull down the View menu and select the New View

option.
Wiew
Zoom 4
g? Pan
‘;% Cut Tl Wiew Selected Objectz Only
Copy Chl+C IT Alwayz Fit in Current WWindaw
2 Faste Ll [ Tables..
Morve F2 B8 whole Stucture
Select Curzar 3 . .
S election Mode " Orientation. . F4
& Insert Node... (=¥ Structure Diagrams...
i fermiber Open Wiew..
Agzign Loads...
Properties. .. Wiew M anagement L4
Toolbars. ..
Labels... Options...
Orientation... Fd Set Structure Colors...
= Structure Diagrams... Structural Toaol Tip Optiohs ..
todel View Details 4> 30 Rendering
& 3D Rendering Refrazh F5
5. In either case, the following dialog box comes up. These radio

buttons determine whether the selected view would be opened in a
new (‘child”) window or whether it would replace the current
(‘parent’) view window. Let us select the Create a new window
for the view option and click on the OK button.

MNew Yiew |
Do you want to: oK %—
f* [Create a new window for the view Cancel

" Display the view in the active window
Help
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The portion of the structure that we selected will now be displayed
in a new window as shown below. We can create more than one

‘child” view window this way.
3 £ 5TD ol Stuc ISR [ o cx5P08 5 %
w o

Fliant

E) EXAMPO8.STD - <Untitled 1>

All sorts of operations can be performed inside the ‘New View’
such as adding and deleting members, assigning properties, loads,
supports, etc. A new view of a selected portion offers the
advantage of de-cluttering the screen and limiting the displayed
objects to just a few chosen entities.

To return to the ‘parent’ view window, simply close the new view
(‘child”) window.
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Frequently Performed Tasks

7.

Next, let us try the Display the view in the active window option.
Follow steps 2 to 4. Then, select the Display the view in the
active window option and click on the OK button.

MNew Yiew

Do you want ko

i~ Create a new window for the view

& Display the view in the active window

]|

Cancel

EIK[:

The original structure will be hidden and, the portion of the
structure that we selected will instead be displayed in the current

(‘parent’) window as shown below.

EJ EXAMP08.5TD - <Untitled 1>

_[olx]

Job
Client

Job Ma.
Part
Ret

Filename. EXAMPOBSTD

Directory

Date / Time - 19Mar-2000  04:10 P
Flesize 1143 ore.._ |

Engnesr  Checker  Approved

s I
P izl m— —

Comment

|

Help

Help |

=10/ x|




Frequently Performed Tasks | FPT-23

We may restore the original view of the structure by simply
clicking on the Display Whole Structure icon.

Jﬂﬂ@aaa@@m

A Display Whole Stucture| 01F 5 T

These new views may be saved by going to the View | View
Management | Save View menu option. Provide a title for the new
view. These saved views may later be opened by going to the View
| Open View menu option.

Method 2 — Tools | Cut Section
Steps:

To demonstrate this method, let us once again open
EXAMPO08.STD file. The structure will look as shown below.

B EXAMPO8.STD - Whole Structure - Ol =]
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We will once again try to view just the members at the mid-height
level.

2.  Click on the Symbols and Labels icon and in the Diagrams dialog
box that comes up, switch the Node Numbers on. The reason for
doing this will become evident in the next step.

JD%#"&Q&J']JT RS L 7 B A
L2
gt {3-|13[1-4D|-+|S_I,Iml:uulsandLal:uels| j ‘
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3. From the Tools menu, select Cut Section.

Gl Select Geometry Commands  Analyze Mode  Window
Check Multiple Structures. ..

Check Duplicate »
Orphan Modes ¥
Check for Warped Plates. ..

Check Zera Length Members
Check Overlapping Collinear Members

Calculatar. ..

Unit Converter. ..

b+ Dimension Beams...
[%'} Display Node to Mode Distance

‘5‘.1._..-, Set Current Input Unit...

Set Current Display Unit...

Cuery ¥
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The following dialog box comes up.

Section [ x| |

Range By Joint | R ange By bin/tdax I Select to Wiew I

{* .Y Plane

wrhith Mode #
i~ % -Z Plane I "I
i ¥ -Z Plane

] [“_«; I Cancel Show Al Help

The Range By Joint method

Since the beams of the mid-height level happen to contain joint #
10 (or any of the joint numbers from 7 to 12), it would be
convenient if we could instruct the program to display the entities
lying in the X-Z plane, and passing through any one of those joints
7 to 12. The facilities of the Range By Joint tab enable us to do
that.

Let us select that tab (it happens to be the default). Here, we can
select the plane of the section by clicking on one of the options -
X-Y, Y-Z, or X-Z. We have to choose the X-Z plane for our
example. Then, in the Node # drop down list, provide a joint that
lies on the sectional plane. In our example, we may choose any one
of the nodes between 7 and 12. Let us choose node # 10. Click on
the OK button.
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The following figure shows the cut portion of the original structure
displayed in the drawing area.

10

To restore the original view, simply click on the Display Whole
Structure icon.

ﬂ@aaa@@m

-lespIa_l,l Whu:ule Struu:ture| (I

Alternatively, go to the dialog box shown in step 4 and click on
the Show All button.



FPT-28

Frequently Performed Tasks

The Range By Min/Max method
Steps:

Another convenient way of choosing the beams at the mid-height
level is to specify that those beams lie in the X-Z plane between
the Y range values of 12ft - a and 12ft + a, where, “a” is an
arbitrary value such as say, 2ft.

To do this, let us select the Range By Min/Max tab. Here, we can
again select the plane of the section by clicking on one of the
options — X-Y, Y-Z, or X-Z. We have to choose the X-Z plane for
our example. The Minimum and Maximum edit boxes represent the
boundary distances along the axis perpendicular to the sectional
plane. Every object lying between these two distances will be
displayed. In our example, let us provide 10 as the Minimum and
14 as the Maximum distance. (Before doing so, make sure that the
current input units of length, displayed at the bottom right corner
of the STAAD program window, are feet.) Then, click on the OK
button.

Section §|
Range By Joint | Range By Min/Max | Select to View

() %-Y Plane Minimum
m
(Y -Z Plane Mazimum

i m

(%) ¥-Z Plans

OK || Cancel || Showal |[ Hebp
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The following figure shows the cut portion of the original structure
displayed in the drawing area.

10

To restore the original view, again, click on the Display Whole
Structure icon or click on the Show All button in the dialog box
shown in step 6.

Jﬁﬂ@e&@z&@@m
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The Select to View method

For demonstrating this method, instead of viewing specific beams,
let us look at the nodes instead.

Steps:

Using this option, the portion of the structure we wish to view can
be selected by specifying the objects which lie in that portion. The
Window/Rubber Band option allows us to select the portion of the
structure to view by specifying a rubber-band window around it.
The View Highlighted Only option displays only the selected
(highlighted) objects on screen and, the members and elements we
wish to view must be selected before choosing this option. The
Select To View option allows us to view only Beams, Plates, and/or
Solids, depending on the corresponding check boxes that are
activated.

For our example, let us choose the Select To View option and
check the Nodes check box. Then, click on the OK button as
shown below.

Section

Range By Jaint I Fange By Mindas  Select to View |

" Window ¢ Fubber Band
= View Highlighted Only
&+ Select ToYiew

[ Beams
[ Plates
[T Solids
¥ Modes

0K |:| Cancel |  Showal Help
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The following figure shows the view of the structure with only the
nodes displayed.

[ EXAMPO8.5TD - Whole Structure ] S ||

To restore the original view, click on the Display Whole
Structure icon or click on the Show All button in the dialog box
shown in step 8.

Jﬁﬂ@aaa@z@m
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These new views may be saved by going to the View | View
Management | Save View menu option. Provide a title for the new
view. These saved views may later be opened by going to the View
| Open View menu option.
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Method 3 - View | Zoom

The Zoom menu option allows us to zoom in (magnify) or out
(reduce) on a portion of the structure, as one would, using a
telescope.

Steps:

1.  To demonstrate this method, let us open EXAMP09.STD file. The
structure will look as shown below.

B EXAMP09.5TD - Whole Structure =] 3
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2.  Say, we want to magnify the portion of the structure shown in the
figure below.

3.  To select the plates as shown in the above figure, click on the

View From + Z icon. Then, using the Plates Cursor ‘ ket | select
the plates by rubber-banding around them as shown below.

J%@®®®®@
| [VewFom+2Z], £ B .2

By the way, looking at the model from View From + Y, or, View
From - X, and using the rubber-band window methods can be just
as effective in selecting these elements.
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4.  To restore the original isometric view, click on the Isometric

View icon. We do this only to make sure that we have selected the
correct entities.

@@@@@@@J%%fh
/i P B e BB Jisometic Vien)

5.  To magnify the selected portion of the structure, either click on the
Zoom Window icon or, pull down the View menu and select the
Zoom | Zoom Window menu option as shown below.

QAAAQR QB QL
G |57 @ oo 4

Wiew Toolz Select Geometry Commands  Analyze  Mode  wine

() Zoom Factor. ..

Wiew Selected Objects Only @l Zoarm In
I ’T Alwayz Fit in Current Window a Zoom Dut
[ Tables.. a Zoam Fxtents
[E Whaole Structure @‘ D_I,JnE-II'nIC Zoom
@ Fresious
Orientatian. .. F4

" 5 Structurs Diagrams. .

Dpemn iew...
Mew Wiew.

Yiew M anagement 4

Toolbars...

Optiors. ..

Set Structure Colors...
Structural Tool Tip Options ..

£ 3D Rendering

Refrazh Fa
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The cursor changes as shown below.

_|_

Using the cursor, drag a window around the selected portion of the
structure.

The magnified view of the selected portion of the structure will
now be displayed in the drawing area as shown below.

El EXAMPD9.5TD - Whole Structure i =]

AW

[ S AN
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If we click on the Zoom In icon, it magnifies or enlarges the view
of the structure even further by a pre-defined factor. You can keep
the mouse cursor pressed over the Zoom In or Zoom Out icons,
and the screen will continuously refresh to draw the structure
larger or smaller.

S S

HleagaaeabstQe

X4 G |[znr] = & 7P E

To display the enlarged view in a new window, use the Dynamic
Zoom icon instead of the Zoom Window option.

Haaaaeaapst Qo
o~ DynamicZqur R @ 5 9 i ‘i

The region you wish to see will have to be selected by creating a
rubber-band window around it. That region will now be displayed
in a new window in the drawing area as shown in the next figure.
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2 EXAMPD3.STD - Whole Stucture
| A

|

7.  To restore the view of the full structure, click on the Display
Whole Structure icon.

Jﬂﬂ@aaa@@m

A Display Whole Stucture| 01F 5 T

These new views may be saved by going to the View | View
Management | Save View menu option. Provide a title for the new
view. These saved views may later be opened by going to the View
| Open View menu option.
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5. Creating Groups

Group names are a means for easily identifying a collection of
entities like Beams, Plates or Solids using a single moniker. By
grouping these entities, we need to assign attributes such as
member properties and material constants just to the group, a
simple process, compared to the task of assigning them to the
individual members.

Steps:

1.  To demonstrate this, let us open EXAMPO01.STD file. The structure
will look as shown below.

E EXAMPO1.5TD - Whole Structure |_(Of x|
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Let us classify the members of the topmost level of this structure

into three groups — Top Chords, Bottom Chords and Transverse
Truss.

Top Chords:

Make sure that the Beams Cursor ‘ R | has been selected. Then,
using the mouse, select the inclined members as shown in the
figure below.
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3. From the Tools menu, choose Create New Group.

Select Geometry Commands Analyze Mode Window

Check Multiple Structures...

Check Duplicate L4
Orphan Modes L4
Check for Warped Flates. ..

Check Zero Length Members

Check Overlapping Collinear Members

Calculator. ..

Unit Converter...

4 Dimension Beams. ..
%3- Display Mode to Mode Distance

'ém Set Current Input Unit...
Set Current Display Unit...
-3 Cut Section...

Query k
List Format...

Create User Table. ..
Section Wizard. ..
Modify Section Database. .

Create Mew Group... Ctrl+G

A2 Insert Text...
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In the Give Group Name dialog box, type TOPCOR for Group
name (Group Names must begin with the underscore *_’ character).
Since group names can be assigned to Nodes, Beams, Plates,
Solids as well as a general category called Geometry, it is very
important that we choose the proper entity type. Hence, specify the
Select Type as Beam.

Give Group Hame I

Group Mame : I_TEIF'EEIH
Select Type : IBeam vI

DK& I Cancel | Help I

Click on the OK button. Notice that the Assign Methods in the
Create Group dialog box is presently set to Associate to Selected
Geometry. Click on the Associate button.

Create Group EH

. TOPCOR [Beam)

Create
Delete
Highlight

Cloze

4

—Asgigh methods
© Azsociate to View

% Aszociate to Selected Geometry

 Associabe to List
Ligt [3Ta13

Agzociate { ! Help

Click anywhere in the drawing area to un-highlight the highlighted
members. This is necessary before we start selecting the members
for the next group name.
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Bottom Chords:

6.  Using the mouse, select the bottom chords as shown in the figure
below.
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7.  Next, to bring up the Give Group Name dialog box, click on the
Create button. Then, follow steps 4 and 5 and assign the Group
Name BOTCOR to these members.

£ EXAMPO1.5TD - Whole Structure _ 10l =|

Create Group | |

Create

2. BOTCOR [Beam]

Delete
Highlight

Cloze

diild

—Azzign methods
7 Asgociate to View

' Aszociate to Selected Geomatry

7 Asgociate to List
List |20 To 23

Aszzociate I Help

Load 1

L

Click anywhere in the drawing area to un-highlight the highlighted
members.
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Transverse Truss:

8.  Using the mouse, select the Transverse Truss members as shown in
the figure below.




Frequently Performed Tasks FPT-45

9.  Next, follow step 7 except for specifying the Group Name as

_TRNTRUS.
E EXAMP01.STD - Whole Stucture 1=l B3
X
1:_TOPCOR [Beam)] Create
2: BOTCOR (Beam —I
3: TRNTRUS [EBeam) Delete |
Highlight |
/ Cloze |
—Assign methods—————————————————
7 Asgociate to View
' Aszociate to Selected Geomatry
7 Asgociate to List
List [14Ta 19
Aszzociate | Help
4
Load 1

Click anywhere in the drawing area to un-highlight the highlighted
members. Also, Close the Create Group dialog box.

Three groups have now been created. If we now go to the Select
menu, an option called By Group Name should be available. Let us
click on that option, and the following dialog box comes up.
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Geomeh’y Commands  Analyze N

Iso Modes Cursor
l% Beams Cursor
& Physical Member Cursor
m Plates Cursor
E Surface Cursor
13 solids Cursor
Plates & Solids Cursor
@ Geometry Cursor
+ Filtered Selection Cursor

Selection Mode

[T Load Edit Cursor
I support Edit Cursor
136/ Release Edit Cursor

Beams Parallel To
Plates Parallel To
By Range

Configure Selection Filter...

3

»

»

By Group Name...

Select Groups

Group Mame

G1: _TOPCOR
G2 _BOTCOR
G3 _TRMTRUS

Show Label

G1:
o

[wG3:

It is apparent that we can now select the members using the group
name method. If the check boxes for Show Label are switched off,
labels such as beam numbers will not be displayed for these

specific members, even if the beam numbering icon is switched on
for the entire structure.
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6. Displaying Loads on the screen

Steps:

1.  To demonstrate this feature, let us open EXAMP08.STD file. The
structure will look as shown below.

[ EXAMPO8.STD - Whole Stiucture =] 3
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2.  The easiest way to display a load is to click on the Loads icon as
shown below. To choose a specific load, we can click in the list
box called Active Load and choose the one we want.

[0 & 88« AL M 15 b5 2 B A
£t & [1:01.40L + 1.7 Loads | ‘

—— i

4 [1: [1.4DL + 1.7LL)

Alternatively, we may pull the View menu down and select the
Structure Diagrams menu option. In the Diagrams dialog box that
opens, select the Loads and Results tab. Check the Loads check
box and select the load case we want from the Load Case list box.

Then, click on the Apply button.
=

Farce Limits | Animation I Design Results |
Shucture Loads and Results I Scales | Labek:
( Load Case: 1 DEAD LOAD =] ]
I\__oafs 4 ?-e”ection Beam Forces Diagram
- v g
[View sads: Direct [ - g”;e t o & Halch  Fil
Zoom 3 Moment _| lesen  Outline
ge o ¥ Show Load Amow £ Section Displacement
iew Selected Objects Only |'M°‘:|E Shape
Mode Sh il >
’TAIways Eitin Current Windaow i o o I"HadzShepe W
Tabl i~ Beam Forces
[™] Tables... T sl cl TH From To =
= -0.64344e+ -5.64 344
BH whole Stucture € Disgram € Color /T
Ojientation.. F4 & [rtensiy
- i : [BE4344e+03
ELELE ams.. L o -9.40215e+03 -4.3217 2+
) 3 I—B TR -4.321726+03 -3.241 29+
Dpen Vigw... Hasimum -3.241202+03 -2.16086e+
Mew View.. No of values |—1 5 E 8 -2.16086e+03 -1.0804 e+
Wi et b B 1 0B043e+03 0
) 10 a 1 08043e+0
Toolgars... lsteayy T Berdinory B 01 0anaaesis 2 1a0apes_|
0 t_ I~ chearz: ™| Bending zz H 2 2160B6e+03 324129+
[ i 3241280403 432172040
Set Stucture Colors... Fliosen W 4 32172403 5 40215040
Structural Tool Tip Options I” | Stress C . T. 4 3

&> 3D Rendering

1] % I Cancel | Apply | Help |

Refresh F5

Drag the dialog box out of the way if it obstructs the view of the
structure.
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The following figure shows load case 1 displayed on our structure.

[ EXAMP08.5TD - Whole Stiucture =] B3
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3. We can change the color in which load icons are drawn. Click on
the color button alongside the Loads checkbox, and make a new
choice from the color palette (see figure below).

x

Farze Limits | Animation I Dezign Results
Stucture Loads and Results | Scales I Labels
LoadCase:  [1: DEAD LO&D =l
=t Deflection Eeam Forces Diagram——
¥ Loads: Diect [ || & Mone )
 Dufloot . & Hatch " Fil
eflection .
Moment _| " Dutline
2] Sl el e { Section Displacement
~ Mode Shape
tode Shape: INDne "I [" | tode Shape .
 Beam Forces
= il cH H From To =
oo - = -5.64344e+ -5 B4344e+
Dizgrarn ) Coler C/T -5 E4344e+03 -7 56301 e+l
% |htersity ————— -7 56301e+03 -6 43258e+
.. -6.45258e+03: -5 4021 5+l
7] ;|8 64334e+03
i I 5402156403 4321726+
P |854344B+D3 -4 3217 2e+03 -3 241 29+
: 7 -3.24128e+03 -2 1 6036+
Mo of valuies: |71 = E B 3 {BiiBe+05 1 NAN43e+
9 -1 .08043e+03:0

_ m_ | 1 D04 3e+0
I Sheary T Bendiowy | §9 [i080435+03 13 16086e+0_|

[~ Shear zz . ™| Eending zz . 12 2.16086e+03 |3.24129e+0
13 324129e+03 (4 3217 2e+0

I~ Tarsiar | | T[4 32175405 5 4021 Gl w
[T Stiess C . T. ‘I I »

0K I Cancel | Apply | Help |

Let us assign say, blue color, as shown in the above figure. Select
load case 2 from the Load Case list box.
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The following figure shows load case 2 displayed (in blue) on our

structure.

I[=] 3

- Whole Structure

E EXAMPO8.STD

Load 2<kip=
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7. Displaying Load Values on the screen

Steps:

1. Inthe previous exercise, we saw the method for turning on load
icons, but not the numeric value of those loads. To view load
values, let us open EXAMPO1.STD file. The structure will look as
shown below.

[ EXAMPO1.5TD - Whole Structure =] B3
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Let us first display the load by clicking on the Loads icon .
After this, click the right mouse button and choose the Labels
option. Alternatively, we may click on the Symbols and Labels
icon or go to View | Structure Diagrams and select the Labels
tab in the Diagrams dialog box.

[ EXAMPO1.5TD - Whole Structure =] B3

(i3 trl+
& [l
Capy CHl+E
2 Paste [Ctrl+4

Select Cursor 3
Selection Mode 3

W Take Picture

#% Add Beam
[ Iables..

penView...

Orientation... ! F4

=¥ Structure Diagrams...

Model View Details

&> 3D Rendering

& Load 1 (SELF Y)<kip>
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3. The dialog box shown below appears. Switch on the Load Values
option under the Loading Display Options category as shown

below.
Diagrams E|
Force Limits Animation Design Results

Structure Loads and Results Scales | Labels
MNodes Physical Members Properties
[IMode Numbers (N} | [ Member Number ("M} O References ()
[ Mode Poirts {K) [ Deesign Group ("G) O Sections (X
Supports (S) [[] Design Envelope {"E) ® None )
[] Dimension (D} [ Design Brief ("B)

Pipes
Beams ["] Pipe Mode Mumbers
] Beam Mumbers (B} ] Pipe Mode Tags
] Beam Orientation {0}
[] Beam Spec (A) Loading Display Options
Releases (R) Load Values (V) <
] Beam Ends (E) Display Floor Loading (F)
: Display Floor Load Distribution (Y)

= E:Z”EDI'” Display Wind Load Cortributory Area (H)

e Display Wind Load (W)
Flates General
[ Plate Numbers (F) Show fxes Window ("8) [ ] Master Slave (L}
[ Plate Orientation (T) | [] Show fAxes At Org (I}
Solids [ ] Material (M)
[ Solid Numbers (C) [+] Show Diagram Info (G)
é”ga';es T (® Always Use STAAD Pro Defaut Label Settings.

Sl L et () Mlways Use Cument Label Settings.
[J 5urface Orientation {*T)
For quick access to the labels using keyboard hotleys,
press Shift +the letter shown in brackets.
oK || Cancel || Mpply ][ Heb
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The following figure shows our structure with the load values
displayed on it.

[ EXAMPO1.5TD - Whole Structure =] 3

& Load 1 (SELF Y)<kip>
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4.  To change the unit in which load values are displayed, go to Tools
| Set Current Display Unit menu command.

Select Geometry Commands Analyze Mode Window
Chedk Multiple Structures. ..

Check Duplicate »
Orphan Modes k
Check for Warped Plates...

Chedk Zero Length Members
Check Overlapping Collinear Members

Calculator. ..

Unit Converter...

b Dimension Beams. ..
@- Display Mode to Mode Distance

‘Fw_‘n-, Set Current Input Unit...

=18|set Current Display Unit...
=1 Cut Section...

Query »
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In the Options dialog box that comes up, select the Force Units

tab. Then, change the selection under the Force, Distributed
Force, etc. options as shown below.

Options le
| View Highlight
B Tolerance
B Tables Force
Assign Dl

E NoscllgenLabg:ls Force kip w Show E dec places
E E;::Lj::l: Distr. Force  |kN/m ~ | | Show El dec places
E Esgj LL:E:Z Moment kNm v Show E dec places
E I:;a:tlacfons Distr. Moment Show E dec places

notation
E gtrudureuunns Stress Show E dec places

cti it
s Acceleration Show E dec places
E Dimension Rotation rad Show E dec places

[ ok ][ ey | [ cancel | [ Heb |

The following figure shows our structure with the load values
displayed in KN/m.

B EXAMPO1.5TD - Whole Structure =] B3
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8. Structural Tool Tip Options

Structural tool tips offer a facility for displaying any customized
input or output information about a node, beam, plate or solid
element when the mouse cursor is placed over the structural entity.
The tool tips are similar to the ones displayed when the mouse
cursor hovers over a toolbar icon. When the mouse cursor is
moved away from that spot, the information displayed is switched
off too.

To activate the structural tool tips, go to View | Structural Tool
Tip Options from the top menu.

Wiew Toolz Select Geomety Comman

Zoom 4

g? Pan

Wiew Selected Objectz Only
IT Alvayz Fit i Current windaw

[7] Tables..
[E ¥ whole Stucture

Orientation. . F4

(=¥ Structure Diagrams...

Hpenwiew...
TEw Wiew..
Wiew M anagement 4

Toolbars. ..
Options...
Set Structure Colors...

Structural Tool Tip Optiohs .

£ 3D Rendering

Refresh F&
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The dialog box shown in the figure below will prompt for the data
to be displayed when the mouse hovers a particular structural
entity.

Tool Tip Options
¥ Show Tool Tip Tip Delay: 700
Tool Optiong
NODE - Mode Mumber
S Coordinate
PLATE .
SOLID Dizplacement
SURFACE [#-|w] Suppart

To turn the structural tool tips on or off, check the Show Tool Tip
box in the upper left hand corner. The Tip Delay box signifies the
amount of time it takes from when the mouse cursor first appears
over an entity to when the tool tip actually pops up. This number is
expressed in milliseconds (i.e. 1000 = 1 second). The options
(items that can be displayed) for each entity are shown under the
Options box. A check mark signifies that the particular data item
will be displayed in the tool tip. An option with a “+” next to it
signifies that further options can be enabled or disabled.
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The figure below shows the options that can be turned on or off for
Node Displacements.

Tool Tip Options Ed |
¥ Show Tool Tip Tip Delay: 700
Tool: Optiohz ;
MODE e Mode Murber N
BEAM . Coordinate
PLATE = Disol t
SOLD EIEI izplacemen

SURFACE

----- bl b i,

----- bl b ity

----- bl anhd i -
----- bl b inF

..... M a:-:.h-'!?nHY LI

=1 ——

A red “X” indicates the data will not be shown in the tool tip.
Simply click on the check box to turn an option on or off.
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The resulting tool tip that is displayed from the options chosen in
the previous figure is shown in the figure below.

#4 (20.000,0.000,20.000)

Displacement for Load Case #1 ..
Y¥=-0.000inZ=0.000inry=0.000 rad
tZ=10.000rad

Mode Reaction For Load Case #1
FR=0.000kipFy=234917 kip FZ=-75.287 kip
W= 467,881 kip-in My =-0.000 kip-in MZ =-0.000 kip-in

The tool tips automatically display the results for the active load
case. All values are reported in the current display units.
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9. lIdentifying Beam Start and End

When assigning attributes like member releases or member offsets,
one additional item of information which accompanies this
information is whether that attribute is applied at the “START”
node of a member or the “END” node. Hence, there has to be a
way to quickly identify these two points without mistaking one for
the other.

Steps:

1.  To demonstrate this, let us open EXAMPO01.STD file. The structure
will look as shown below.

E EXAMPO1.5TD - Whole Structure |_(Of x|
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2. There are two different ways to identify the start and/or end of a
beam:

a) simply place the mouse over a specific beam. The
resulting tool tip will display the start node and end node
of that beam in two distinct colors along with their
corresponding coordinates. Of course, it is necessary to
have the tool tips display turned on for this method to
work.

[ EXAMPO1.5TD - Whole Stiucture =] B3

—

/ Bearm #6 Length 10.000 ft

Start Mode:#4 (10.000, 20.000, 0.000)
End Mode:#5 (20.000, 20.000, 0.000)

23 Load 1
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b)

Click the right mouse button

area and choose Labels.

anywhere in the drawing
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Chil+C
[+

F2
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The following Diagrams dialog box will appear. Make sure
that the Labels tab is selected. Then, switch the Beam Ends
option on. To alter the color in which the start and/or end is
displayed, simply click on the color palette next to the Start
Color and/or End Color options and choose the color you
want. Then, click on Apply for the changes to take effect
immediately. Click on OK to close the dialog box.

Diagrams El
Force Limits Animation Design Results
Structure Loads and Results Scales | Labels
Nodes Physical Members Properties
[ Node Numbers (M) [] Member Number {“M) O References (J}
[ Node Paints {K) L] Design Growp ('G) ) Sections |X}.
Supports (S) [] Design Envelope ("E) ® Nore g
[] Dimension (D} [ Design Brief (°E)
Fipes
Beams []Pipe Node Numbers

[[] Beam Mumbers (B) []Pipe Node Tags
[] Beam Orientation {2)
[ Beam Spec (A) Loading Display Options
Releases (R) [ Load Values (V)
Beam Ends (E} Display Floor Loading (F)
: Display Floor Load Distribution ()
! Start Color " " . 2
B 6 ol Display Wind Load Contributory Area (H)
| ete Display Wind Load (W)
Plates General
[ Plate Numbers (F) Show Axes Window ("A)  [] Master Slave (L)
[] Plate Orientation (T} [ Show Axes At Org ()
[ Matesial (M)
Show Diagram Info {G)

Solids
[ Solid Mumbers {C)

E”ga;es P (®) Mways Use STAAD Pro Defautt Label Settings
0 Tzl s (O Always Use Cument Label Settings.
Surface Orientation (“T)

For quick access to the labels using keyboard hotkeys,
press Shift +the letter shown in brackets.
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The following figure shows the structure with the start and end of
all beams displayed in two separate colors.
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10. Plotting from STAAD.Pro

Explained below are 5 methods for plotting the drawing of the
STAAD model and STAAD result diagrams.

Method 1 : Using the Print Current View option

1. We shall use example problem 14 to illustrate this feature. Open
the example. The model should appear as shown below.
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2.  To plot this picture, click on the Print Current View icon as
shown in the following figure.

alvze  Mode window  Help
G mam&h 04
'@. ﬁ ':ﬂ. El ':El I:EqMF‘{:*il'ﬂ: Current '-.-'iewl-r

(===
L

3. The standard Windows Print dialog box will appear asking you to
choose the printer to which you wish to plot the drawing.

T 20
— Prinker
Properties. .. |

M ame: # DiocuTech B1

Status: Ready
Type: #erow DocuTech 6135 PS2 1.3
Wwiherer  WEROXE135DPE135

Comment: ™ Frint to file
— Print range Copies
e 4l Mumber of copies; 1 -

" Pages from: |1 ke I

) Selection @ ™ Collate

] 4 I Cancel
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4, If you wish to catch a glimpse of the plot, as it would appear on
paper, select the Print Preview Current View option.

ze Mode ‘Window Help

|G mam &R |08
| @ ﬁ @"'- Ia~- @l CET I:fl:‘gr;?F‘rE;El.-wlmli:l_lrnerlt '-.-'iewl

A preview screen similar to the one shown below will be
displayed.
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Method 2 : Using the Take Picture option

1.  Bring up the diagram of the STAAD model you wish to print. On
the Print toolbar of the STAAD screen, you will find an icon of a
camera called Take Picture.

=R E =]

Qlﬁ ) |l (Tﬂake F'ic:tureb% ki

Alternatively, this option can be accessed from Edit | Take Picture.
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> Delete Del
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r.;: Edit Input Cammand File
Create Mew B Macro...
Edit Esizting WB Macro...

2. A dialog box will appear prompting you to provide a Picture 1D
and caption.

0k I Help
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Next, select Report Setup from the File menu, or click on the
Report Setup icon as shown below.
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A Report Setup dialog box will appear. In the Items tab, select
Pictures from the available list of items.
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5. If more than one picture is available, select the one you wish to

plot by pressing the button. Next, go to the Picture Album
tab and switch on Full Page. Click OK.

Report Setup
ltems | Load Cazes I todes I Ranges I Steel Design
Ficture Album | Options | Mame andLoge | Load/Save

 Displap Size————
M arne: IF'icture 1 j Delete Picture | pieY
¥ Full Page

Height [174.7 ron
width: |1E|2.81 ﬂ

Captior: I\A-"hnle Stucture

0K I Cancel | Print | Help

6. From the File menu, select Print — Report. The diagram will be
plotted.

Alternatively, from the File menu, select Export Report | MS
Word File.



7.

Frequently Performed Tasks

STAAD.Pro - Structure1.std
=N Edit View Tools Select Geometry Commands Analyze M
2) new Cirl+M

- | 4 ==
Qpen... Ctrl+0
& o b b oo |8
Open Archive... I.; HF T @ i) fh
Open Backup Manager Mhole Structure
View 3

Job Information

Report Setup...

Printer Setup...
Print 4
@ Print Preview Repaort

In the Save As dialog box, type in the name of the “.doc” file you
want and click on the Save button. In the template dialog box,

select the Normal template.

2

Laak in: Ia Templates j - rj{ -

]~$N0rma|.dot

File name: — [Momal.dot Open I
Files af bype: ITempIates[“.dot] j Cancel |

2

Microsoft Word will now start building the file with the picture in

it. Once this task is completed, Word will open this file, and

program can be accessed from the Windows Taskbar. Browse the
file, and if you are sure the image meets your needs, select Print

from the File menu and follow the instructions.
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Method 3 : Using the Export View option

1. STAAD.Pro has a facility to export the drawing to a graphic image
file. The icon for this facility is called Export View and is
available in the Print toolbar.

R eamn/a8Dh |0
@ @ R [Caprven] B £2

2. When the diagram that you wish to plot is displayed on the screen,
click on the Export View icon. Select the graphic format in which
you wish to save the file (i.e., .bmp, .jpg, .tif, .gif, etc.)

T [ T T T

Save As K E3
Save in:lﬁzzz j L =F ER-

File: narme: Save I

Save as type: | Bitmap File* brp) j Cancel |
Bitrnap File[* brny |

A

Tiff File[* if]

Gif File[*.gif]
P File[*. pox)
Targa File[*.tga)

Provide a file name and save the file.
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Then go to a document publishing or graphic editing program such
as Microsoft Word or Adobe Photoshop. Import the drawing from
the file saved above. In Word, this can be done using Insert |
Picture | From File. Once you are sure the image meets your
needs, select Print from the File menu and follow the instructions.

Method 4 : Using the Copy Picture option

Highlight the window containing the diagram that you wish to plot.
This can be done by making sure the title bar of that window has
the color which indicates that it is in focus. From the Edit menu,
choose Copy Picture.

Edit

=3 Unda Cirlez
L2 Fedo Ll
g Cut Ll
Copy L+
R Faste Ll
75 Delete Del
& Take Picture

r.;: Edit Input Cammand File

Create Mew B Macro...
Edit Esizting WB Macro...

Next, run a graphics program which offers facilities for handling
graphic images such as Microsoft Paint, Adobe Photoshop, etc. In
the Edit menu of that program, select Paste. You will notice that
the drawing from the STAAD window is now pasted in that
program. Using the tools provided by the graphics program, you
can modify the drawing if you wish. Once you are sure the image
meets your needs, select Print from the File menu and follow the
instructions.
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Method 5 : Using the Windows Clipboard

When the diagram that you wish to plot is displayed on the screen,
press the "Print Screen” key on your keyboard or “Shift-Print
Screen”, depending on how your keyboard is set up. The entire
image currently in view will be copied to the Windows clipboard.
Next, run a graphics program which offers facilities for cropping
portions of a graphic image (such as Microsoft Paint, Hijaak, Full
Shot, etc.). In the Edit menu of those programs, select Paste. You
will notice that the entire STAAD screen including the diagram,
menus, toolbar icons, tables, etc., which were in view, are part of
the pasted image. Using the tools provided by the graphics
program, crop the image so as to preserve just the drawing and
eliminate unwanted portions. Using the File | Print option, print
the drawing.
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